**Introduction**

**About SigmaPlot**

SigmaPlot 10.0 makes it easier for you to present your findings accurately using precise, publication-quality graphs, data analysis and presentation tools. SigmaPlot 10.0 offers numerous scientific options such as automatic error bars, regression lines, confidence intervals, axis breaks, technical axis scales, non-linear curve fitting and a data worksheet for powerful data handling.

SigmaPlot is a state-of-the-art technical graphing program designed for the Windows platform. It is certified for Windows NT, Windows 2000, Microsoft Office 98, 2000, and Windows XP. SigmaPlot is specifically designed to aid in documenting and publishing research, specializing in the graphical presentation of results.

Creating and editing graphs is easy. Just click a Graph toolbar button, pick your data with the Graph Wizard, and you can create a graph in seconds. You can also use templates to apply favorite graphs again and again.

SigmaPlot 10.0 also includes a powerful nonlinear curve fitter, a huge scientific data worksheet that accommodates large data sets, summary statistics, a mathematical transform language and much more.

**OLE2** technology is fully supported. You can annotate graphs with the Microsoft Word Equation Editor, edit your graphs directly inside Word or PowerPoint, or plot your data with an Excel spreadsheet right inside SigmaPlot 10.0.

**Graph Types and Styles**

SigmaPlot 10.0’s selectable *Graph Type* determines the structure of your graph. SigmaPlot 10.0 provides many different types of two- and three-dimensional *Cartesian* (XY and XYZ) graphs, as well as pie charts and *polar plots*.

*Graph Style* determines how data is plotted on a graph. Available styles depend on the selected Graph Type. SigmaPlot 10.0’s *Graph Wizard* conveniently displays all available graph styles associated with each graph type.
The Graph Style Gallery and Templates

Use the SigmaPlot Graph Style Gallery create and store true graph templates using any existing graph style as the model. For more information, see “Using the Graph Style Gallery” in Chapter 4.

Every graph that you add to the Graph Style Gallery is saved as a bitmap image. You can later apply this as a template for future graphs, saving you time and effort. For more information, see “Using the Graph Style Gallery” on page 157.

Figure 1-1
The Graph Style Gallery

Templates. The SigmaPlot 10.0 template notebook contains a variety of page layouts. Apply these predetermined template attributes to previously saved pages and graphs, or create a user-defined template. Store your templates in a SigmaPlot Notebook Template file (.JNT). You may want to create your own template notebook. For more information, see “Using Graph Pages as Templates” on page 237.
**Graph Defaults**

Preset graph attribute default settings, such as size and position, font, and symbol, line and bar settings.

**Axis Scales**

Create multiple axes for 2D graphs. SigmaPlot 10.0, by default, automatically calculates axis ranges and enables each plot to contain separate X and Y axes.

**Tick Marks.** Use both major and minor axis tick marks and grid lines. Tick intervals, length, direction, thickness, and color are all adjustable; grid line types are also adjustable. Tick labels can be numeric, time series, or customized, using labels in a worksheet column.

**Axis Breaks.** You can specify an axis break with a different post-break tick interval.

**Automatic Legends**

Generate legends automatically, or ungroup legends and individually customize text labels.

**Smooth Data**

Smooth sharp variations in dependent values within 2D and 3D data sets using SigmaPlot 10.0 smoothing algorithms.

**SigmaPlot 10.0 Worksheet**

The SigmaPlot 10.0 worksheet is capable of containing data up to 32,000,000 rows by 32,000 columns. Enter data in columns or rows, and perform calculations either row-wise or column-wise.

Worksheet cells within columns are adjustable, and capable of holding up to 14 significant digits. Place labels, customized fill colors and patterns, and error bar direction codes into these cells in order to specify changes to graphs.
Microsoft Excel

SigmaPlot 10.0 uses automation communication standards to create and open Excel workbooks within SigmaPlot 10.0. This functionality enables you to run transforms, perform statistical tests, and graph data stored in Excel worksheets.

Statistics

Descriptive statistics are available for all your worksheet columns. The Statistics Worksheet lists basic statistics for all worksheet columns.

Display linear regression lines with confidence and prediction intervals, chart error bars for graphs of column means, and run paired and unpaired t-tests between worksheet columns. Use the Histogram feature to compute and plot distributions for data sets.

Regression Wizard

The Regression Wizard steps through curve fitting, plotting, and generating a report.

Transforms

Modify and compute data using SigmaPlot 10.0’s comprehensive transform language.

Drawing Tools

Change the font, size, and style of any text, and change the color, line type, thickness, and fill pattern of graphs and drawn objects with drawing tools.

Reports

The SigmaPlot 10.0 Report Editor displays regression results and features complete text editing functionality.
New Features in SigmaPlot 10.0

New features in SigmaPlot 10.0 include:

- **More line types.** SigmaPlot now offers seven new line types for line plots and line scatter plots, free-form lines, boxes and ellipses. There are also new line types available in the Graph Properties dialog box and the Page toolbar. Use these line types in 2D and 3D graphs.

- **More patterns.** Twenty-five new fill patterns for bar charts, box plots, pie charts, area plots and free-form boxes and ellipses. New fill patterns have been implemented in the Graph Properties dialog box and the Page toolbar. Use the new fill patterns in 2D and 3D graphs.

- **Dynamic Curve Fitting.** Compliments the Regression Wizard by providing hundreds of initial parameter estimates to minimize the squared residual errors, produce individual curve fits for each, and choose the best in a matter of seconds. Greatly increase the likelihood that the answer you get is the correct answer for your data. Achieves the best fit by automatically choosing and trying numerous initial parameter estimates to find the global minimum, even if you supply a complicated model with problematic data. Solve harder problems that normally don't converge.

- **Added New Weighting Options to Curve Fitter.** Allows the choice between using reduced chi-squared weighting or not in nonlinear regression. Now you can use whichever weighting method preferred by your field. Many packages use reduced chi-square weighting but certain fields believe that this is not the correct way.

- **New 3D Mesh Plots with Contour Projection.** Allows you to put contour plots into 3D graphs to reflect the Z values of the plotted data.

- **Select Positive Direction for Polar Plots.** Now you can select a positive direction for polar plots. Automatically create both clockwise and counterclockwise polar graphs. Automatically chooses most common orientation and starting point for both types of graphs. Create clockwise graphs without having to transform your data.

- **Automatically Graph Irregularly Spaced 3D Data.** Automatically interpolate unordered 3D data. X,Y,Z data is interpolated into a grid for mesh plots. X,Y,Z data is interpolated into a grid for contour plots.

- **Weibull Axis Scale.** This new Weibull transformation scale allows you to plot Weibull distributions for Weibull analysis graphs.

- **Reciprocal Axis Scale.** New 1/x scale type. Allows creation of reciprocal scale distributions including Arrhenius Scales.
New Axis Scales for 2D and 3D Contour Plots. Natural log, probability, logit, probit, Weibull, reciprocal.

More Selectable Graph Objects. Select Grid lines - major and minor. Select Error bars. Select Break Marks. Select Drop Lines. "Click through" overlapping objects.

Automatic Resizing and Positioning Groups of Graphs. Can now be used to size and/or position multiple objects simultaneously. Can now be used to change the properties of more objects.


SAS and Minitab Import. Directly import SAS data sets and export files (.sd2 and .sas7bdat files). Directly import Minitab data files and export files (up through Version 12, .mtw & .mpj files).

Audit Trails. Tracks changes to notebooks and login names of users Useful for 21 CFR Part 11 change logging.

Program Startup Wizard. Power users will enjoy easy access to previously used documents, quick Excel import, quick access to data base import and the ability to use older documents as templates for new work. New users will enjoy easy access to help and other tutorials while being guided through creating a blank worksheet, importing data from an excel file or other database files. Use older documents as templates for new work.

Transforms In JNB File. Transforms are now kept in notebook files as JNB files for easier organization of transforms. This allows easier organization of transforms.

Create Transform libraries. Associate Transforms with data sets. Protect and track changes to transforms for 21 CFR Part 11.

Import Graphic Files. Load popular graphic file formats into SigmaPlot graphic page. Import BMP, JPEG, GIF, TIFF, Cursor and Icon Files, and many more.

Submission Assistant. Stores an extensible list of publication requirements and is used to double check whether exported figures meet standards of publication. Also allows creation of customized output profiles.

Confidence Lines and Prediction Bands in Curve Fits. Automatically generate 95% confidence and prediction bands (lines) for curve fits. No longer necessary to generate confidence bands manually.

Additional piecewise-linear models for regression. SigmaPlot now provides 2, 3, 4, and 5-segment piecewise-linear models come with automatic parameter estimation.
Real Time Mouse-over Coordinate Feedback. Get instant feedback of graph coordinates with your mouse cursor on the graph. Selecting a plot will allow to see the exact value of the data corresponding to the data points.

ROC Curves. Create single or multiple ROC curves and their data dot density graphs. Compare ROC areas for significant difference when the data is correlated or not. Handle missing values in all situations. Use either pair-wise or case-wise deletion of missing values when comparing ROC areas. Compute likelihood ratios, post-test probabilities and the optimal cutoff using pre-test probability and cost-ratio. Allow laboratory scientists to determine which clinical test is the best.

Installing SigmaPlot 10.0

Install SigmaPlot 10.0 on your computer from the CD. The installation program automatically starts up when the CD is placed in the CD-ROM drive. The dialog boxes that guide you through the installation process are simple and self-explanatory.

Note: In order to accomplish your installation, you will need to have your product registration number available.

System Requirements

SigmaPlot 10.0 runs under the following systems:
- Windows 2000
- Windows NT 4.0 SP6
- Windows XP

Excel Workbooks:
Excel for Office 2000 and 97 takes full advantage of SigmaPlot 10.0’s functionality. Import excel workbooks into SigmaPlot.

Hardware:
Minimum requirements are Pentium 200 or better
- 64MB of RAM
- 48MB available Hard Disk space
Chapter 1

- CD-ROM drive
- SVGA/256 color graphics adapter (800 x 600, High Color recommended)

Serial Numbers

This unique serial number is located on the CD cover. Have this number available when you call for product support, payment, or system upgrade. Copy this number to the registration card and send it in to Systat Software, Inc.

Registration entitles you to:
- Unlimited technical support.
- System upgrades.

About SigmaPlot's User and Program Files

SigmaPlot 10.0 is installed for all users that have user accounts on a machine. It installs its program files into a Program Folder - these are necessary for the program to run - and then creates files in User Folders for each user on a machine.

This means that two or more separate users can share SigmaPlot using his or her own set of SigmaPlot files and settings. When someone uses SigmaPlot for the first time, it creates a User Folder just for that person. In this way, many people can use the same version of SigmaPlot without risking damage to others' files.

SigmaPlot's User Files

When SigmaPlot starts, it checks to see if a user folder exists for the current user. The User Folder is either in:

- C:\Documents and Settings\user\My Documents\SigmaPlot\SPW10 for SigmaPlot, or
- C:\Documents and Settings\user\My Documents\SigmaStat\Stat3 for SigmaStat.

The user files for SigmaPlot include:

- Submission Profiles. This directory contains all the available submission profile .ini files. For more information, see “The Submission Assistant” in Chapter 12.
Introduction

- **Gallery.jgg.** This is the Graph Gallery file including any user-defined graph styles. For more information, see “Using the Graph Style Gallery” in Chapter 4.

- **GraphWizard.ini.** This file stores all Graph Wizard settings. For more information, see “Creating Graphs Using the Graph Wizard” in Chapter 4.

- **HistogramWizard.ini.** This file stores Histogram Wizard settings. For more information, see “Creating Histograms” in Chapter 10.

- **Layout.jnt.** This notebook file is the layout file used when formatting or arranging graphs.

- **SigmaPlot Macro Library.jnt.** This notebook file contains the Standard Macro Library and user-defined macros. For more information, see “Automating Routine Tasks” in Chapter 13.

- **SPW.ini.** This file stores all SigmaPlot user’s settings.

- **Standard.jfl.** This Standard Equations Library includes all user-defined equations. For more information, see “Regression Equation Libraries and Notebooks” in Chapter 16.

- **Template.jnt.** This notebook file is where all the graph page templates are stored. For more information, see “Using Graph Pages as Templates” in Chapter 5.

Similarly, when SigmaStat starts for a new user, it copies user files to the Stat3 user folder:

- Stat32.ini
- Stat32.opt
- GraphWzd.ini
- Samples.snb

**SigmaPlot’s Program Files**

During installation, SigmaPlot by default installs the following directories and files into C:\Program Files\SigmaPlot\SPW10.

The installed files include spw.exe, all the Help files, .dll files, .pdf manuals, and the following sub-folders:

- **FAQs directory.** This directory contains all the .html and graphics files used in the SigmaPlot FAQs. For more information, see “SigmaPlot FAQs” on page 27.
Chapter 1

- **Macro Transforms directory.** This directory contains the .xfm files used for the macros Frequency Plot, Power Spectral Density, Rank and Percentile, and Vector Plot. For more information, see “Using SigmaPlot’s Macros” in Chapter 13.

- **Samples directory.** This directory includes sample graphs, data and nonlinear curve fit examples.

- **Submission Profiles.** This directory contains all the available submission profile .ini files. For more information, see “The Submission Assistant” in Chapter 12.

- **Transforms directory.** This directory contains sample transforms.

**SigmaPlot Basics**

SigmaPlot runs under the Windows operating system and functions within the standard Windows interface. For information on how Windows works, refer to your Windows documentation.

Figure 1-2
*The SigmaPlot Desktop*
Using Toolbars

Toolbars contain buttons for the most commonly used commands.

Figure 1-3
Standard Toolbar

Figure 1-4
Formatting Toolbar
Chapter 1

Figure 1-5
2D Toolbar

Figure 1-6
3D Graph Toolbar
**Viewing Toolbars**

- On the View menu, click Toolbars. The Toolbars dialog box appears.
- Select a toolbar to view.
- Click OK.

**Hiding Toolbars**

There are two ways to hide toolbars:

- Using a shortcut menu.
- Using the Toolbars dialog box.

*To hide toolbars using the shortcut menu:*

- Right-click the toolbar.
- On the shortcut menu, click Hide.
To hide toolbars using the Toolbars dialog box:

- On the View menu, click Toolbars. The Toolbars dialog box appears.
- Clear the Toolbar you want to hide.
- Click OK.

Changing Toolbar Button Appearance

The Large Buttons check box increases the size of Standard, Drawing, Properties, and Arranging toolbar buttons. The Color Buttons check box displays color toolbar buttons on your screen, rather than monochrome. The Show Tool Tips check box hides the toolbar help tags that appear as you drag the mouse over the toolbar.

Positioning Toolbars

You can move a toolbar from its default position to anywhere in the screen, and you can change its from horizontal to vertical. To position a toolbar:

- Drag the move bar on a docked handle or drag the title bar on a floating toolbar to move it to another location.

Setting Program Options

Use SigmaPlot’s program options to control application settings, as well as how worksheets and new pages and graphs will appear. To change program options:

- From the menus select:
  
  Tools
  Options

- The Options dialog box appears.

- Choose the appropriate tab and make changes.
Worksheet. Worksheet options include settings for numbers, statistics, date and time, worksheet display, default column width, number of decimal places, and use of engineering notation.

Page. Page options control graph page properties.

General. The General tab controls application settings.

Report. Set report options, such as measurement units or to display rulers, on the Reports tab.

Graph. Graph defaults control attributes that are applied to all new graphs.

Macro. Select macro options, such as code colors and which macro library to use on the Macro tab.

▶ Click OK to apply the changes and close the dialog box.

Undoing Mistakes

▶ On the Standard Toolbar, click the Undo button.

If you later decide that you didn’t want to perform an undo, click the Redo button.

These commands also appear on the Edit menu, or you can click Ctrl+Z to undo, or Ctrl+Y to redo.

You can perform multiple instances of Undo or Redo.

Anatomy of SigmaPlot Graphs

A SigmaPlot graph consists of one or more plots of data, and one or more sets of axes. It uses a specific coordinate system (e.g., 2D Cartesian, 3D Cartesian, pie, or polar) and has a specific size and location on the page.

Plots are graphical representations of worksheet data. For example, view data as a vertical bar chart or change the plot to a horizontal bar chart, even after creating the graph. You can even display more than one plot on most graphs.

Axes are the scales that determine position of the graph’s data points. Each axis contains tick marks that indicate the type of scale used. Scales range from linear to
nonlinear within a Cartesian coordinate system. Customize tick mark labels with worksheet cells or use numeric or time series labels.

The X, Y, and for 3D graphs, Z coordinates, are indicated on each axis by tick marks. An axis can use a linear numeric scale, nonlinear scales such as log, natural log, and probability, or a date/time scale. 2D graphs can have multiple sets of X and Y axes. The axes’ tick marks and tick labels, can be numeric, time series, or customized with worksheet column labels.

**2D Cartesian Graph**

The following figures show examples of 2D Cartesian graphs available in SigmaPlot...

Variable box widths can be used to express another variable dimension

Shaded graph **backplane** with Y axis **grid lines**

**Tick mark** direction pointing out

**Box Widths = Final Population**

**Diet**

**5th and 95th percentiles** displayed as symbols

**Tukey box plot** with mean value lines

**X axis tick labels** using a **category axis** scale.
Introduction

Population Growth with and without Inhibitor

- Time (hours)
- Population (colonies)
- Without Inhibitor
- With Inhibitor

Graph Title
- Top X axis with tick marks turned off
- Y axis with a linear axis scale

Left Y axis title
- Left Y axis with major tick marks
- Numeric major tick labels

X axis with a linear axis scale
- 0 2 4 6 8 10 12

Left Y axis with major tick marks

Reference line

Scatter plot of column averaged data points, with Y error bars computed from the standard deviations

Spline line plot of data generated with the nonlinear curve fitter

Automatically generated legend

Right Y axis with tick marks turned off

Bottom X axis title

Common log scale
- Y axis with major and minor tick marks

Scatter plot of color gradient filled symbols using a point plot style

99% confidence and predicted interval linear regression lines

Base and exponent log axis tick labels

Counts per Area
- 10^1 10^2 10^3

Counts
- 1st Order Regression
- 95% Confidence Interval
- 95% Prediction Interval

99% confidence and predicted interval linear regression lines

Scatter plot of column averaged data points, with Y error bars computed from the standard deviations

True Date and Time axis scale, displaying months and weeks
Chapter 1

Post break tick interval set to a new value

Y axis break at 75% along the axis length

Error bars using worksheet column data

Bar fill colors use a pattern from a worksheet column

Image art cut from a paint program and pasted onto the page using the Windows Clipboard

Legend symbols and text labels

Grouped bar chart with specified bar and group widths

X axis tick labels using text from a worksheet column
**Polar Plot Example**

Use Polar plots to display modular data such as average monthly temperatures, or satellite positioning in the sky over a period of time.

Average Monthly Temperatures

Up to four radial axes can be displayed and the angles and lengths modified.

The outer and inner angular axis can be made larger or smaller in diameter.

Monthly series labeling.

Major grid lines for the radial axis, and minor grid lines for the angular axis are shown.
Contour Plot Example

Use 2D Contour Plots to graph three dimensional data in two dimensions. The following example includes:

- Major and minor contour lines
- Contour labels
Introduction

3D Cartesian Graph Examples

3D Cartesian Graphs include scatter, 3D trajectory and waterfall plots, mesh plots, and bar charts.

The following figures contain examples of these plots, as well as some additional 3D features.

Waterfall Plot Example

3D waterfall plots are stacked line plots along the Y axis of a 3D line plot. Because hidden lines are eliminated, waterfall plots are useful for showing trends of line plots.

The following example includes:
- Incremented line fill color
- Eliminated "hidden" lines
Chapter 1

Scatter plot with drop lines

Z axis drawn at left side

Grid lines at major tick intervals

Y axis drawn at front bottom

Axes automatically move to the front view at any rotation

Overlapping and transparent meshes

Light source shading

Mesh plot with colored fills and lines

3D graph view can be displayed at any horizontal and vertical rotation

X axis drawn at front bottom

Front view frame lines

3D graphs can be displayed with varying perspectives (depth)
Stacked line plots are along the Y axis.

Hidden lines are eliminated

Line fill color is incremented
Chapter 1

3D Cartesian Graph Examples

3D Cartesian Graphs include scatter, 3D trajectory and waterfall plots, mesh plots, and bar charts.

The following figures contain examples of these plots, as well as some additional 3D features.
Introduction

Scatter plot with drop lines

3D graphs can be displayed with varying perspectives (depth)

Overlapping and transparent meshes

Light source shading

Mesh plot with colored fills and lines

3D graph view can be displayed at any horizontal and vertical rotation

Axes automatically move to the front view at any rotation

Z axis drawn at left side

Grid lines at major tick intervals

Y axis drawn at front bottom

Front view frame lines

X axis drawn at front bottom

Scatter plot with drop lines

3D graphs can be displayed with varying perspectives (depth)


**Area Plot Example**

Area plots are 2D line plots with regions below or between curves filled with a color or pattern. Most commonly, an area plot is a line plot with shading that descends to the axis. You can add shade below a curve and shade in different directions. You can also identify intersecting sections.

This example consists of two plots, and includes:

- A simple bar chart using hairline bars.
- A multiple area plot using the X many Y data format.

![Average Daily Temperature Range and Precipitation, Oakland CA](image)

**SigmaPlot Help**

SigmaPlot’s online help uses new HTML online Help. View the HTML Help using Microsoft Internet Explorer version 4.0 or higher.
**SigmaPlot FAQs**

Some of SigmaPlot’s most frequently asked questions (and answers) are available on the Help menu. The SigmaPlot FAQ includes helpful tips and work-arounds.

*To view the SigmaPlot FAQs:*

- On the Help menu, click SigmaPlot FAQs.

**Customer Service**

If you have any questions concerning your shipment or account, contact your local office. For more information, see “Contacting Systat Software, Inc.” on page 28. Please have your serial number ready for identification when calling.

**Training Seminars**

Systat Software, Inc. provides both public and onsite training seminars for Systat Software, Inc. products. All seminars feature hands-on workshops. Systat seminars will be offered in major U.S. and European cities on a regular basis. For more information, see “Contacting Systat Software, Inc.” on page 28.

**Tell Us Your Thoughts**

Your comments are important. Please send us a letter and let us know about new and interesting applications using Systat products. Write to Systat Software, Inc. Marketing Department, 501 Canal Blvd, Suite E, Richmond, CA 94804.

**Getting Technical Support**

The services of Systat Technical Support are available to registered customers. Customers may call Technical Support for assistance in using Systat products or for installation help for one of the supported hardware environments. To reach Technical Support, see the Systat home page on the World Wide Web at http://www.systat.com, or contact us:
In the U.S.:  

Telephone: (510)-231-4780 (8:00 A.M. to 5:00 P.M. Pacific Time)  
Fax: (510) 412-2909  
E-mail: techsupport@systat.com  
Mail: 501 Canal Blvd., Suite C Richmond, CA 94804

In Europe:  

Telephone: 49 2104 / 95480  
Fax: 49 2104 / 95410  
Email: eurotechsupport@systat.com

Contacting Systat Software, Inc.  

If you would like to be on our mailing list, contact one of our offices or distributors below. We will send you a copy of our newsletter and let you know about Systat Software, Inc. activities in your area.

In the U.S.:  

Systat Software, Inc.  
510 Canal Blvd. Suite C  
Richmond, CA 94804  
Tel: 866.797.8288  
Fax: 510.231.4789  
http://www.systat.com

Outside the U.S.:  

Systat Software, Inc. GmbH  
Schimmelbuschstrasse 25 40699
Introduction

Erkrath, Germany

Tel: +49.2104.9540

Fax: 49.2104.95410

Or contact the distributor nearest you:

http://www.systat.com

References

We have found the following references very useful for graph design and layout.


Chapter 1
Notebook Manager Basics

SigmaPlot Notebook files contain your SigmaPlot data, graphs, transforms and macros and are organized within the SigmaPlot Notebook Manager. This chapter covers:

- Notebook Manager organization. For more information, see “Notebook Manager Overview” on page 31.
- Saving your work. For more information, see “Saving Your Work” on page 36.
- Creating notebooks and adding notebook items. For more information, see “Working with Sections in the Notebook Manager” on page 37.
- Opening notebooks and notebook items. For more information, see “Opening Files in the Notebook Manager” on page 40.
- Copying, pasting, and deleting notebook items. For more information, see “Copying and Pasting Items in the Notebook Manager” on page 41.
- Protecting the contents of notebooks and creating audit trails. For more information, see “Protecting Notebooks” on page 42.

Notebook Manager Overview

When you first start SigmaPlot, the Welcome to SigmaPlot start up screen appears, asking you what you would like to do first. You can follow the steps of the start up screen, or you can click Cancel which closes the dialog box. If you never want to see the start up screen again, select Do not show this again and then click Cancel.

The Notebook Manager is a dockable or floating window that displays all open notebooks.

The first time you see the Notebook Manager, it appears with one open notebook, which contains one section. That section contains one empty worksheet. Contents of the Notebook Manager appear as a tree structure, similar to Windows Explorer.

Each open notebook appears as the top level, with one or more sections at the second level, and one or more items at the third level. Within each section you can create one worksheet and an unlimited number of graph pages, reports, equations,
Chapter 2

macros and transforms. The most recently opened notebook file appears at the top of the Notebook Manager.

Figure 2-1
The Notebook Manager in a Docked Position

Modified Notebooks

An asterisk next to an item in the Notebook Manager indicates that the item has been modified since the last time you saved the notebook.

Naming Notebook Items

The default startup notebook is named Notebook1. It contains one notebook section, Section 1, and one worksheet, Data 1. When you save your notebook file, the name of the file appears at the top of the Notebook Manager window. Notebook files use a (.jnb) extension. The default names given to notebook sections and items are, Section (number), Data (number) or Excel (number), and Report (number). Regression equations, macros and transforms are named when they are created. New items are numbered sequentially.
To give a notebook item a new name:

- Select the notebook item in the Notebook Manager.
- From the right-click shortcut menu select: Rename

For more information, see “Editing Notebook Summary Information” on page 39.

Renaming Notebooks

Although you can’t rename a notebook inside Sigmaplot, you can save it with a new name.

- Select the notebook in the Notebook Manager.
- From the right-click shortcut menu select: Save as

- In the Save As dialog box, enter the new name in the File name field.

Note: This does not replace the notebook. For more information, see “Editing Notebook Summary Information” on page 39.

Opening and Closing Notebooks in the Notebook Manager

You can open as many notebooks within the Notebook Manager as you like, and navigate through the different open notebooks, just as you would in your Windows Explorer.

To open a notebook:

- From the menus select:
  
  File
  Open
The Open dialog box appears.

- Select a notebook (.jnb) file from the list, and click Open. The notebook appears in the Notebook Manager.

To close a notebook:

- Select the notebook to close in the Notebook Manager.
- Right-click, and from the shortcut menu, click Close Notebook.
  You can also choose Close Notebook from the File menu.

**Sizing and Docking the Notebook Manager**

The Notebook Manager can appear in six states:

- Docked with summary information in view.
- Docked with summary information hidden.
- Floating with summary information in view.
- Floating with summary information hidden.
- Docked and collapsed.
- Hidden.

- To undock the Notebook Manager, double-click the title bar and drag it to the desired location.
- To dock the Notebook Manager and move it back to its original position, double-click the title bar again.
To view summary information, click Show summary information. To hide it, click Hide summary information.

Figure 2-2
An Undocked Notebook Manager Displaying Summary Information

To collapse the Notebook Manager, click the arrow button on the top right-hand corner of the Notebook Manager when docked. To view again, click the graph icon.

To drag and drop the Notebook manager, click the title bar and drag the Notebook Manager anywhere on the SigmaPlot desktop.
Printing Selected Notebook Items

You can print active worksheets, graph pages, reports and other selected notebook items (but not macros and transforms) by clicking the Print button on the Standard toolbar. You can print individual or multiple items from the notebook, including entire sections.

To print one or more items or sections from the notebook:

► Select one or more items or sections from the notebook.

► Click the Print button on the Standard toolbar to print the worksheet using all the default settings.

To set printing options before printing a report, graph page, or worksheet:

► Open each item.

► Press Ctrl+P. The Print dialog box appears.

► Click Properties.

Saving Your Work

Be sure to save your work at regular intervals.

To save a notebook file for the first time:

► Click the Save button. The Save As dialog box appears.

► Navigate to the directory where you want to save your notebook.

► Type a name for the notebook in the File Name text box.

► Click Save to save the notebook file and close the Save As dialog box.
To save changes with the same name and path:

- Click the Save button on the Standard toolbar. You can also click Save on the right-click menu.

To save to a new name and path:

- On the File menu, click Save As. The Save As dialog box appears.
- Navigate to the directory where you want to save your notebook.
- Type a name for the notebook in the File Name text box.
- Click Save to save the notebook file and close the Save As dialog box.

Automatically Saving Your Work

You can set how often you want SigmaPlot to automatically save your work.

- From the menus select:
  Tools
  Options

- Click the General tab.
- Select Save AutoRecover info every.
- In the minutes box, enter an interval for how often you would like SigmaPlot to save its notebook files automatically.

Working with Sections in the Notebook Manager

Notebook sections are place-holders in the notebook. You can name, open, and close notebook sections.

You can create as many new sections as you want in a notebook. You may also create reports within each section to document the items in each section.
To expand or collapse a section, double-click the section icon or click the (+) or (-) symbol.

Creating New Items in the Notebook Manager

Using the right-click shortcut menu, you can create new sections and items in the Notebook Manager, such as:
- Worksheets
- Excel Worksheets
- Graph pages
- Reports
- Equations
- Sections
- Macros
- Transforms

To create a new section or item:

- Right-click anywhere in the Notebook Manager that you want the new section or item to appear.

- On the shortcut menu click New, and then select the item to create. The new section or item appears in the Notebook Manager.

Copying and Pasting to Create New Sections

Another method for creating a new notebook section is to copy and paste a section in the notebook window. Whenever you copy and paste a section, its contents appear at the bottom of the notebook window. SigmaPlot names and numbers the section automatically. For example, if you copy notebook Section 3, the new section is named Copy of Section 3. Copied sections create copies of all items within that section as well.
Editing Notebook Summary Information

You can change summary information for all notebook files and items.

To change summary information:

► If the summary information is hidden on the Notebook Manager, click View summary information.

► Select the notebook item and edit as appropriate.

In-place Editing Section and Item Names

You can change the name of a notebook section or item in the notebook itself without opening the Summary Information dialog box.

To in-place edit:

► In the Notebook Manager, click the section or item you want to rename.

► Click it a second time or press F2.

► Type the new name.

► Press Enter. The new section or item name appears.

Note: To change the name of the notebook, use the Save As dialog box. For more information, see “Saving Your Work” on page 36.

Copying a Graph Page to a Section with No Worksheet

If you copy a graph page into an empty section or a section that has no worksheet, you create an independent page. The independent page retains all its plotted data without the worksheet. You can store the pages from several different sections that have different data together this way. However, if you ever create or paste a worksheet into a section, all independent pages will revert to plotting the data from the new worksheet.
Use independent pages as templates, or to draw or store objects. You cannot create graphs for an independent page until it is associated with a worksheet (and no longer independent).

**Opening Files in the Notebook Manager**

You can open SigmaPlot files and other types of files as SigmaPlot notebooks. To open a notebook file that is stored on a disk:

► Click the Open button on the Standard toolbar. The Open dialog box appears.

*Figure 2-3  
*Open Dialog Box

► Choose the appropriate drive and directory of the notebook file to open.

► Double-click the desired notebook file.

► **If you want to open another type of file**, choose the type of file from the Files of type list.

► Click Open. The opened notebook appears in the Notebook Manager.
Opening Worksheets, Reports, Pages and Transforms

You can open a worksheet, report, page or transform by double-clicking its icon in the Notebook Manager. You can also right-click the item, and on the shortcut menu, click Open. Open worksheets, pages, reports and transforms appear in their own windows and in the notebook as colored icons. Double-clicking an item that is already open brings the item’s window to the front.

Opening Multiple Items. You can open as many items as your system’s memory allows. You can open multiple items from multiple notebooks. The selected item appears highlighted in the Notebook Manager.

Copying and Pasting Items in the Notebook Manager

You can copy and paste items from one open notebook file to another in the Notebook Manager; however, you cannot copy a worksheet into a notebook section that already contains a worksheet.

Copying and pasting pages and worksheets between sections results in using graph pages as templates. For more information, see “Using Graph Pages as Templates” on page 237.

To copy and paste a notebook item:

- Right-click the item in the Notebook Manager that you want to copy, and on the shortcut menu, click Copy.

- Right-click the section where you want to paste the item, and on the shortcut menu, click Paste. The selected item is pasted to the current notebook and section.

Deleting Items in the Notebook Manager

To delete an item from the Notebook Manager:

- Right-click the item and click Delete. The item is deleted.

Items removed from a notebook file using the Delete button or menu command are removed permanently.
Protecting Notebooks

To ensure security of notebook contents, you can lock notebooks using a password. This is particularly useful if two or more users are using the same version of SigmaPlot. You can also use a password to send confidential data to other SigmaPlot users.

A password can be up to 250 characters in length, with any combination of letters, numbers or symbols. If you use a password, write it down and keep it in a safe place. There is no way to retrieve lost passwords.

Setting a Password

To set a password:

► Select the notebook so that the notebook itself appears in bold type in the Notebook Manager. The easiest way to do this is to double-click an item in the notebook.

► From the menus select:
  
  Tools
  Protections

The Protections dialog box appears.

Figure 2-4
Setting a Password for Notebook
Click the Set Password tab.

In the New Password box, type a password.

In the Reconfirm box, type the password again.

Click OK.

**Changing or Removing a Password**

To change or remove a password:

- Select the notebook in the Notebook Manager.

- From the menus select:
  
  Tools
  Protections

  The Protections dialog box appears.

- Click the Set Password tab.

- In the Old Password box, type the old password.

- In the New Password box, type a new password.

  If you want to remove this password, leave this box and the Reconfirm box empty.

- In the Reconfirm box, type the password again.

- Click OK.

**Creating a Notebook Audit List**

Use SigmaPlot Auditing to create a record showing who has modified and saved a Notebook file and what operations he or she has performed during a given period of time.
To create an audit list:

- From the menus select:
  Tools
  Protections

The Protections dialog box appears.

- Click the Auditing tab.

Figure 2-5
Setting a Password for an Audit List. Passwords are optional.

- To create an audit trail, select Enable Audit List.

- To prevent other users from disabling the audit list, enter and reconfirm a password in the Auditing Password (optional) and Reconfirm fields.

Creating an Auditing password is optional. Passwords can be any combination of letters, symbols or numbers, up to 250 characters in length. It is strongly advised that if you create a password, write it down! Lost passwords can not be retrieved.
To view the audit list, click View Audit List.

The Audit List dialog box appears.

Figure 2-6
Viewing the Audit List

To save the contents of the Audit List to a separate file, click Copy. You can then paste this to a text file that accompanies the notebook.

Click Close to close the Audit List.

Click OK to save passwords and settings and to close the Protections dialog box.
Chapter 2
Worksheet Basics

Worksheets are the containers for the data you analyze and graph. They are spreadsheet-like in appearance but are limited in function, and are column rather than cell oriented.

The following figure provides some worksheet definitions:

Figure 3-1
Example of a SigmaPlot Worksheet

To enter data, you can type in, paste, or import data from other sources. You can also automatically generate and place data in worksheet columns by data transforms and statistical procedures.

This chapter covers:

- Setting worksheet display options (see page 48).
- Moving around the worksheet (see page 50).
- Entering data (see page 52).
- Importing files from other applications (see page 53).
- Exporting worksheets (see page 65).
- Viewing worksheet statistics (see page 66).
- Displaying worksheet data (see page 70).
- Formatting worksheets (see page 81).
Cutting, copying, pasting, moving and deleting data (see page 84).
Entering and promoting column and row titles (see page 89).
Removing outliers and other data (see page 94).
Using Excel Workbooks in SigmaPlot (see page 97).
Printing worksheets (see page 104).

Setting Worksheet Display Options

Use the Options dialog box to set the default display settings for worksheets.

Note: You can also change individual cells or blocks of cells using the Format Cells dialog box. These custom formats remain even after editing options in the Options dialog box. For more information, see “Formatting Worksheets” on page 81.

To set worksheet display options:

From the menus select:

Tools
Options

The Options dialog box appears.

Click the Worksheet tab. For more information, see “Displaying Worksheet Data” on page 70.

Options include:

General. Select to turn Worksheet undo on or off, or to set SigmaPlot to display an error message if duplicate column titles appear when running transforms. Turn Worksheet undo off if you are using a large data set and have a small amount of memory.

Numeric. Select to control how many decimal places you want to appear in the worksheet, or if you want to use E notation. For more information, see “Changing Numbers Display” on page 74.
- **Date and Time.** Select to set the display for the specified columns. For more information, see “Changing Date and Time Display” on page 76.

- **Statistics.** Use the Show and Hide buttons to move the statistics between the Shown and Not Shown lists. These buttons are available only if a Statistics worksheet is in focus. For more information, see “Statistics Options” on page 68.

- **Appearance.** Set column widths, row heights, color and thickness of the worksheet grid lines, adjust data feedback colors, and select a font style and size. For more information, see “Displaying Worksheet Data” on page 70.

**Figure 3-2**
The Options Dialog Box Worksheet Tab Data and Time Options

---

**Freezing Panes**

You can freeze panes to keep rows and columns visible as you scroll through the worksheet.
To freeze panes:

► Select a cell below and to the right of where you want the split to appear.

► From the menus select:

Window
Freeze Panes

Moving Around the Worksheet

You can move around the worksheet using scroll bars or, move the highlighted worksheet cursor with the keyboard.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move one column right/left</td>
<td>→ or ←</td>
</tr>
<tr>
<td>Move one row up/down</td>
<td>↑ or ↓</td>
</tr>
<tr>
<td>Move one window view up/down</td>
<td>Page Up or Page Down</td>
</tr>
<tr>
<td>Move to end of column</td>
<td>End</td>
</tr>
<tr>
<td>Move to end of worksheet</td>
<td>End+End or Ctrl+End</td>
</tr>
<tr>
<td>Move to top of column</td>
<td>Home</td>
</tr>
<tr>
<td>Move to column one, row one</td>
<td>Home+Home or Ctrl+Home</td>
</tr>
<tr>
<td>Move to last column of next data block</td>
<td>Ctrl + →</td>
</tr>
<tr>
<td>Move to first column of previous data block</td>
<td>Ctrl + ←</td>
</tr>
<tr>
<td>Move to top row of previous data block</td>
<td>Ctrl + ↑</td>
</tr>
<tr>
<td>Move to last row of last data block</td>
<td>Ctrl + ↓</td>
</tr>
<tr>
<td>Put cells into Edit mode</td>
<td>F2</td>
</tr>
</tbody>
</table>

Going to a Cell

You can move the worksheet cursor to any cell in the worksheet by specifying the column and row number in the Go to Cell dialog box.

To go to a cell:

► From the menus select:

Edit
Go To
The Go to Cell dialog box appears.

Figure 3-3
Moving to a Specific in the Worksheet

<table>
<thead>
<tr>
<th>Column</th>
<th>OK</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row</td>
<td></td>
</tr>
</tbody>
</table>

- Enter the desired column and row number. To select the block of cells between the current highlight location and the new cell, click Extend Selection to Cell.

- Click OK to move to the new cell.

Using the Worksheet Shortcut Menu

In addition to the menu commands and toolbar buttons, right-clicking the worksheet displays a shortcut menu.

Figure 3-4
Right-click Edit Worksheet Menu

The commands on the right-click shortcut menu include the Cut, Copy, Paste, Transpose Paste, Insert Cells and Delete Cells commands. The Edit menu also includes the Go To, Find and Replace, Undo, Clear, Select All and Insertion Mode commands.
Entering Data into a SigmaPlot Worksheet

This section describes entering data into SigmaPlot worksheet columns, and formatting the columns for numeric, label, or date and time display.

To enter data in a SigmaPlot worksheet:

► Place the cursor in a cell.

► Type a number, label, or date and time value.

► Press Enter to move down one row, or use the arrow keys to move around the worksheet.

If you make a mistake entering data, click Undo on the Standard toolbar. For more information, see “ Undoing Mistakes” on page 15.

Entering Dates and Times

Enter dates and times using delimiters. The delimiters used are determined by the Windows Regional Settings. For more information, see “ Regional Settings” on page 79.

Date Delimiters. The default date delimiter for most systems is a forward slash. An entry that displays only two fields of a date value is assumed to be day and month. If the second field’s value is greater than 31, months and years are assumed. Entries with two delimiters assume month/day/year. If you enter only two digits for the year, the century defined in your Regional Settings is implied.

Time Delimiters. The default time delimiter is usually a colon (:). Entries displaying two fields of a time value are assumed to be hours and minutes. If PM is not specified, hours less than 12 are assumed to be morning hours. An entry with two colons assumes hours:minutes:seconds.
Insertion and Overwrite Modes

Press the Insert key or use the Edit menu Insertion Mode command to switch between overwrite and insert data entry modes.

If in Insertion Mode, Ins appears in the status bar. A check mark next to the Insertion Mode command on the Edit menu also indicates that the worksheet is in insertion mode.

If in Insertion Mode, new data entered in a cell does not erase the previous contents. Any existing data in the column is moved down one row. Pasting a block of cells pushes existing data down to make room for the pasted cells. If you cut or clear data, data below the deleted block moves up.

If not in Insertion Mode, the worksheet is in overwrite mode. Data entered into a cell replaces any existing data. If you paste a block of data, the block overwrites existing data.

Importing Files from Other Applications

You can import data from other applications into an existing worksheet for graphing, worksheet display, or running regressions. When you import data, it appears at the position of the worksheet cursor.

- SAS Data Set (V6) (*.sd2)
- SAS Data Set (V8 and V9) (*.sas7bdat)
- SAS Export File (*.xpt)
- Minitab (v8 to v12) (*.mtw, *mpj)
  You can import the following file types into SigmaPlot worksheets:
- SPSS (.sav). For more information, see “SPSS (.SAV)” on page 64.
- SigmaPlot 1.0 and 2.0 files (.spw). For more information, see “SigmaPlot, SigmaStat, SigmaScan, and Mocha Worksheets” on page 61.
- SigmaPlot Macintosh 4 Worksheet.
- SigmaPlot Macintosh 5 Worksheet.
- SigmaStat 1.0 files (.spw).
- SigmaPlot and SigmaStat DOS files (.spg, .sp5).
- TableCurve 2D and 3D files.
Microsoft Excel files (.xls). For more information, see “MicroSoft Excel, Lotus 1-2-3 and Quattro Files” on page 61.

Lotus 1-2-3 files (.wks, .wk*). For more information, see “MicroSoft Excel, Lotus 1-2-3 and Quattro Files” on page 61.

Quattro/DOS files (.wk*). For more information, see “MicroSoft Excel, Lotus 1-2-3 and Quattro Files” on page 61.

Plain Text files (.txt, .prn, .dat, .asc). For more information, see “Importing Text Files” on page 63.

Comma Delimited files (.csv)

SigmaScan. For more information, see “SigmaPlot, SigmaStat, SigmaScan, and Mocha Worksheets” on page 61.

SigmaScanPro Worksheets. For more information, see “SigmaPlot, SigmaStat, SigmaScan, and Mocha Worksheets” on page 61.

SigmaScan Image

Mocha Worksheets. For more information, see “SigmaPlot, SigmaStat, SigmaScan, and Mocha Worksheets” on page 61.

Axon Text and Binary formats. For more information, see “Importing Axon Files” on page 64.

Paradox (.db)

Symphony (.wkl, .wri, .wrk, .wks)

SYSTAT (.sys, .syd)

Microsoft Access (.mdb)

When you import data from another application that is left-justified, SigmaPlot assumes it is text.

**To import data:**

- Place the cursor to the worksheet cell where you want the imported data to start.

- From the menus select:
  
  File
  Import

  The Import File dialog box appears.
Select the type of file you want to import from the Files of Type drop-down list.

Change the drive and directory as desired, select the file you want to read, then click Import, or double-click the file name. Depending on the type of file, the data is either imported immediately, or another dialog box appears.

**Copying and Pasting Data from Other Applications**

Perhaps the easiest way to import data from another application is to simply copy and paste it from that application’s spreadsheet into SigmaPlot. This is perhaps the simplest method, especially if you cannot directly import the data into SigmaPlot. For more information, see “Cutting, Copying, Pasting, Moving, and Deleting Data” on page 84.

Once you have copied and pasted the data, you can promote the top row of data - the variable names - to become the column titles. For more information, see “Using a Worksheet Row for Column Titles” on page 90.

**Importing ODBC Databases**

You can import ODBC compliant databases into SigmaPlot. To import a database, first define an ODBC Data Source. After defining the data source, you can then either import tables or import using SQL (structured query language).

*Note:* For more information on SQL, see the many sources and tutorials available on the Internet.

*To define the ODBC data source:*

From the menus select:

File
   Import
      Database

The ODBC Options dialog box appears.
Click the Select ODBC Data Source tab. The User and System Data Sources list contains all defined ODBC data sources.

**Figure 3-5**
Selecting the ODBC Data Source

To add a data source that is not on the list, click Add. The ODBC Data Source Administrator dialog box appears.

**Figure 3-6**
Adding a Data Source
**Tip:** Click Help to learn more about the ODBC Data Source Administrator’s use.

- Click the User DSN tab.

- Select a name from the User Data Sources list.

- Click Add. The Create New Data Source dialog box appears.

![Creating a New Data Source](image)

- Select a driver for which you want to set up a data source from the Name list, and click Finish.

  An ODBC Setup dialog box specific to the driver you selected for the data source appears.
Enter a name to identify the new data source.

Figure 3-8
Identifying the Data Source

Click Select. The Select Database dialog box appears.

Select the database, and click OK.

Click OK again to close the ODBC Microsoft Access Setup dialog box.

Click OK in the ODBC Data Source Administrator.

Click OK in the ODBC Options dialog box.

If the data source already appears in the User and System Sources drop down-list, select it. The Import Table dialog box appears.

In the Import Table dialog box, select a table from the Select Table/Query drop-down list.

Select fields in the table by moving fields from Unselected fields to Selected fields by double-clicking a selection in the list. You can also click << and >> to move all the selections, or < and > to move them individually.
Click **Import** to import the fields into the worksheet. Field names in the database become column headings in the worksheet. All records in the table are imported.

Figure 3-10  
*Data that has been imported into a Worksheet*
To import using SQL, on the ODBC Options dialog box click the SQL Query tab.

Figure 3-11
Setting ODBC Options

Under Recently Used SQL, type the name of the path where the SQL is stored, or select a recently used SQL (SigmaPlot Query) from the drop-down list.

Click Open to open an .spq file.

Click Import to run the query and import the data.

- If the SQL is valid, SigmaPlot imports that data into the worksheet based on the SQL statement. Field names in the database become column headings in the worksheet. Only the records defined by the SQL (rows) are imported.
- If the SQL is invalid, you are prompted to correct the SQL.

Importing Excel as ODBC

When importing Excel spreadsheets using the ODBC Options dialog box, you must first assign a name to each data set (or a range of data) which is then imported as a table; otherwise, the Excel file will not import.

Select a range of data in the Excel spreadsheet.
From the Excel menus select:

- Insert
- Name
- Define

In the Define Name dialog box, enter a name for the range of data in the Names in workbook box.

Follow the steps above for as many data sets that you would like to create, and then save the Excel file.

Now you can import this file as a database. For more information, see “Importing ODBC Databases” on page 55.

**SigmaPlot, SigmaStat, SigmaScan, and Mocha Worksheets**

If you are importing a SigmaPlot, SigmaStat, SigmaScan, or Mocha file, a dialog box appears prompting you to select a range of data to import.

- Select the range of data by specifying the start and end of the range; the default is the entire range.
- Click Import to place the data in the SigmaPlot worksheet.

**MicroSoft Excel, Lotus 1-2-3 and Quattro Files**

To import a spreadsheet:

- From the menus select:

  - File
  - Import
  - File

The Import File dialog box appears.
Select an .xls or .wks file to import, and click OK.

The Import Spreadsheet dialog box appears.

![Import Spreadsheet Dialog Box](image)

Select either the entire spreadsheet or a specified range of cells. Specify cells using the standard Lotus 1-2-3 notation (for example, A1:C50 for a range from cell a1 to cell c50).

When you have finished specifying the range to import, click Import. The selected data is imported.

*Note:* The dialog box indicates whether or not the worksheet is in overwrite or insert mode, and where the imported data will begin.

To import spreadsheet data from non-compatible programs, save the spreadsheet as either an Excel or text file, then import that file.

If you want to use an Excel workbook as an actual Excel workbook within SigmaPlot, you must open the workbook instead of importing it. Importing places the Excel data into a SigmaPlot worksheet, and does not open the workbook as an actual Excel workbook. For more information, see “Using Excel Workbooks in SigmaPlot” on page 97.
**Importing Text Files**

If you are importing a text file, the *Import Text* dialog box appears. Use this dialog box to view the text file and to specify other delimiter types, or to build a model of the data file according to custom column widths.

![Figure 3-13 Import Text Dialog Box](image)

*Note:* A quicker method of importing text is copying the data in your source application, then opening SigmaPlot and pasting the data.

> **To specify a different column separator**, select *Delimiter* to activate the delimiter options; then select the appropriate type. You can select commas, hyphens, or any other characters. For example, many databases use semicolons (;) as delimiters.

> **To specify a model of the data**, use dashes (-) to specify column widths, and bracket characters [ and ] to define the column edges. Use a vertical bar | character to indicate a single-character width column. Click *Analyze* to re-display the appearance of the file using the new model.
To save text import formats, enter a name into the Format scheme box, then click Add. Delete unwanted import formats using the Remove button.

To specify a different range, enter the rows and columns to read, then click Analyze. You can use this feature to eliminate file headers and other undesired text.

When you are finished specifying the file parameters, click Import. The specified data from the file is imported.

Importing Axon Files

SigmaPlot can import data files produced by Axon Instruments, Inc. laboratory equipment and data acquisition programs. SigmaPlot imports both text and binary data files; if you select one of these options, the Import Axon dialog box appears prompting you to select a range of data to import. The File selected is indicated in the dialog box title.

Select the range of data by specifying the Row and Column ranges; the default is the entire range. Click Import to place the data in the SigmaPlot worksheet.

Figure 3-14 Import Axon File Dialog Box

**SPSS (.SAV)**

If you are importing SPSS (.sav) files, the Import Worksheet dialog box appears prompting you to select variables to import.

To select variables to import:

- In the Unselected Variables list, select a variable you want to import.
- Click the single > arrow to move that variable to the Selected Variables list.
Click the double >> arrow to move the entire contents of the Unselected Variables list to the Selected Variables list.

Click Import to place the data in the SigmaPlot worksheet.

*Note:* SPSS data files use category data as the default data format. For more information, see “Plotting Category and Grouped Data” on page 304.

**Exporting Worksheet Data**

Exporting worksheets does not export associated graphs. To export the worksheet and the graph, export the graph page to a SigmaPlot Graph (.spw) file.

You can only export the entire SigmaPlot Worksheet. If you want to export a portion of the worksheet, delete the portion you do not want to export, then export the remainder of the worksheet.

**To export a SigmaPlot worksheet:**

- Select the worksheet you want to export by opening and viewing it, or selecting it in the notebook window.

- From the menus select:
  
  File
  Export

  The Export File dialog box appears.

- Select a file format from the Files of type drop-down list, and then enter the file name, directory, and drive for the exported file.

- Click Export to create the file.

**Exporting Worksheets as Text Files**

When you export a SigmaPlot worksheet as a text file, tabs or commas are used to separate data columns and data is saved at full precision. If you want to save a text file
with data as it appears in the worksheet rather than at full precision, copy the selected data to the Clipboard, paste it into a text editor, and save it as a text file.

**Exporting to SYSTAT**

When exporting SigmaPlot data to SYSTAT, make sure that there are no text cells or indefinites in data columns you export, or they will be converted by SYSTAT into text instead of numbers.

**Descriptive Statistics for Worksheets**

SigmaPlot automatically calculates a number of basic statistical values for all the data in your worksheet columns. For more information, see “Printing Column Statistics” on page 105.

**Figure 3-15**

Column Statistics Worksheet

To view the statistics for the currently selected worksheet:

From the menus select:

View
  Statistics
The running calculations performed for each column appear in a **Column Statistics** window for that worksheet.

### Available Statistics

To determine the statistics shown in the Statistics windows, use the Statistics Options dialog box. Most calculations ignore empty cells, missing values, and text. The following statistics appear in the Column Statistics window.

**Mean.** The arithmetic mean, or average, of all the cells in the column, excluding the missing values. This is defined by

\[ x = \frac{1}{n} \sum_{i=1}^{n} x_i \]

**Std Dev.** The sample standard deviation is defined as the square root of the mean of the square of the differences from their mean of the data samples \( x_i \) in the column. Missing values are ignored.

\[ s = \left[ \frac{1}{n-1} \sum_{i=1}^{n} (x_i - \bar{x})^2 \right]^{\frac{1}{2}} \]

**Std Err.** The standard error is the standard deviation of the mean. It is the sample standard deviation divided by the square root of the number of samples. For sample standard deviations

\[ \text{Std Err} = \frac{s}{\sqrt{n}} \]

**95% Conf.** The value for a 95% confidence interval. The end points of the interval are given by:

\[ \bar{x} \pm t(v, z) \frac{s}{\sqrt{n}} \]

where \( \bar{x} \) is the mean, \( s \) is the sample standard deviation, and \( t(v, z) \) is the \( t \) statistic for \( v = n - 1 \) degrees of freedom and \( z = 1.96 \) standard normal percentile equivalent.

**99% Conf.** The value for a 99% confidence interval. The end points for this interval are computed from the equation for the 95% confidence interval using \( z = 2.576 \).
**Size.** The number of occupied cells in the column, whether they are occupied by data, text, or missing values.

**Sum.** The arithmetic sum of the data values in the column.

**Min.** The value of the numerically smallest data value in the column, ignoring missing values.

**Max.** The value of the numerically largest data value in the column.

**Min Pos.** The smallest positive value.

**Missing.** The number of cells in the column occupied by missing values, denoted with a double dash symbol (--).

**Other.** Either text or an empty cell.

**Statistics Options**

To display only a portion of the available statistics, use the Worksheet Options dialog box, then select the **column statistics** to show or hide. For more information, see “Displaying Worksheet Data” on page 70.

**To specify which statistics are shown or hidden:**

- From the menus select:
  
  View
  Statistics

  The Column Statistics worksheet appears.

- From the menus select:
  
  Tools
  Options

  The Options dialog box appears.

- Click the Worksheet tab.

- Select the statistic(s) you want shown or hidden.
Click Show and Hide to move the statistics between the Shown and Not Shown lists.

Figure 3-16
The Statistics Options Dialog Box

Select the appropriate options to change the column widths and data display.

**Engineering and E Notation**

In SigmaPlot, *E Notation* is synonymous with *scientific notation*. The *E* expresses the power of 10.

For example, 1.23 e+03 is 1230, or, equivalently, 1.23 e+03. Select E Notation When Needed or E Notation Always on the Worksheet tab of the Options dialog box if you want to use Scientific Notation. For more information, see “Changing Numbers Display” on page 74.
Engineering Notation, which you can select as an option on the Worksheet tab of the Options dialog box, uses integral powers of 3 (with 10 as the base).

<table>
<thead>
<tr>
<th>Number</th>
<th>Scientific Notation</th>
<th>Engineering Notation (SigmaPlot)</th>
<th>Engineering Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1230</td>
<td>1.23 e+03</td>
<td>1.23 e+03</td>
<td>1.23 x 10^3</td>
</tr>
<tr>
<td>12300</td>
<td>1.23 e+04</td>
<td>12.3 e+03</td>
<td>12.3 x 10^3</td>
</tr>
<tr>
<td>123000</td>
<td>1.23 e+05</td>
<td>123 e+03 or 0.123e+06</td>
<td>123 x 10^3 or 0.123 x 10^6</td>
</tr>
</tbody>
</table>

**Displaying Worksheet Data**

You can display data in your worksheet columns as:

- Text
- Numbers
- Date and Time values
- Graphic information

*Figure 3-17*

Numbers are displayed in Column 1, dates are displayed in Column 2, and text is shown in Column 3.

You can enter numbers, labels, and dates and times directly into the worksheet. You can also convert numbers to dates and times and vice versa. You can change column widths, number decimal places, or date and time format, and you can also change the color and thickness of the worksheet gridlines, and adjust data feedback colors.
**Sizing Columns and Rows**

If the contents of your column exceed the column width, cell contents display as pound symbols (###). Label entries are truncated.

**To change a column width:**

- Drag the boundary on the right side of the column heading until the column is the size you want.

**To change a row height:**

- Drag the boundary below the row heading until the row is the size you want.

**To adjust column width and row height using the Options dialog box:**

- From the menus select:
  
  Tools
  
  Options

  The Options dialog box appears.

- Click the Worksheet tab.

- In the Settings For list, click Appearance.

- Set column width and row height in the Column Width and Row Height drop-down lists.

- Click OK to apply the changes and close the dialog box.

SigmaPlot’s worksheet can display up to fourteen digits of precision regardless of how many decimal places you specify.
Chapter 3

Changing the Appearance of the Worksheet Grid

You can change the color and thickness of worksheet grid lines.

To change the grid appearance:

- From the menus select:
  - Tools
  - Options

  The Options dialog box appears.

- Click the Worksheet tab.

- In the Settings For list, click Appearance.

- Set color and thickness in the Color and Thickness drop-down lists.

- Click OK to apply the changes and close the dialog box.

Setting Data Feedback Colors

Data Feedback highlights the cells and columns on the worksheet that correspond to the X and Y values of the selected curve or data point. You can change these colors on the Options dialog box.

To change the data feedback colors:

- From the menus select:
  - Tools
  - Options

  The Options dialog box appears.

- Click the Worksheet tab.

- In the Settings For list, click Appearance.
Set data feedback colors and thickness in the X and Y drop-down lists.

Click OK to apply the changes and close the dialog box.

**Setting Decimal Places**

To set the number of decimal places used for worksheet values:

- From the menus select:
  - Tools
  - Options

The **Options** dialog box appears.

![Setting Worksheet Decimal Places](Image)

**Figure 3-18**

**Setting Worksheet Decimal Places**

- Click the Worksheet tab.
In the Settings For list, click Numeric.

Select the number of decimal places from the Decimal Places drop-down list.

Click OK to accept the changes and close the dialog box.

If the number of decimal places exceeds the column width they appear as # symbols.

**Changing Numbers Display**

You can display numbers in the worksheet in four ways:

<table>
<thead>
<tr>
<th>Numeric Display</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>E Notation When Needed</td>
<td>Displays worksheet data as scientific notation only when the length of the</td>
<td>12.00</td>
</tr>
<tr>
<td></td>
<td>value exceeds the width of the cell. The default column width is twelve.</td>
<td></td>
</tr>
<tr>
<td>E Notation Always</td>
<td>Always displays data as scientific notation. The number of decimal places</td>
<td>12.00e+0</td>
</tr>
<tr>
<td></td>
<td>is set in the Decimal Places edit box. Displays data with a fixed number of</td>
<td></td>
</tr>
<tr>
<td></td>
<td>decimal places. Set the number of decimal places in the Decimal Places edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>box. The number of decimal places allowed is limited by the column width—</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the maximum number of decimal places cannot exceed the column width or it</td>
<td></td>
</tr>
<tr>
<td></td>
<td>appears as a series of # symbols. The default setting for decimal places is</td>
<td></td>
</tr>
<tr>
<td>Fixed Decimal</td>
<td>displays data exactly as you enter it in the worksheet.</td>
<td>12.00</td>
</tr>
<tr>
<td>General</td>
<td></td>
<td>12</td>
</tr>
</tbody>
</table>

**To set the numeric display for your worksheet:**

View the worksheet.

From the menus select:

Tools
Options
The Options dialog box appears.

**Figure 3-19**

*Selecting Numbers Display Format*

- Click the **Worksheet** tab.
- In the **Settings For** list, click **Numeric**.
- Select a **Numeric** format setting from the **Display As** drop-down list.
- **To use engineering scientific notation for worksheet values**, select **Engineering Notation**. For more information, see “Engineering and E Notation” on page 69”.
- Click **OK** to accept the settings and close the dialog box.
Chapter 3

Changing Date and Time Display

SigmaPlot has a variety of date/time displays. When you enter a value into a date/time formatted cell, SigmaPlot assumes internal date/time information about that value from the year to the millisecond. For example, if you enter a day and month, you can display the month and year.

To view and modify the current settings:

► From the menus select:
  Tools
  Options

The Options dialog box appears.

Figure 3-20
Selecting a Date Display Format

► Click the Worksheet tab.
Select the Date and Time from the Settings for list.

Type one of the following examples into the Date box, or select a format from the drop-down list:
- **M/d/yyyy.** 10/8/2005
- **M/d/yy.** 10/8/05
- **MM/dd/yy.** 10/08/05
- **MM/dd/yyyy.** 10/08/2005
- **yy/MM/dd.** 05/10/08
- **yyyy-MM-dd.** 2005-10-08
- **MMMM.** Complete month
- **dd-MMMM-yy.** 08-Oct-05
- **dddd, MMMM dd, yyyy.** Tuesday, October 08, 2005
- **MMMMM dd, yyyy.** October 08, 2005
- **dddd, dd MMMM, yyyy.** Tuesday, 08 October, 2005
- **dd-MMMM-yy.** 08-October-05
- **dd MMMMM, yyyy.** 08 October, 2005
- **gg.** Era (AD or BC)

To change the display Time format, type one of the following examples into the Time box, or select a format from the drop-down list:
- **hh or h.** 12 hour clock
- **HH or H.** Military hours
- **mm or m.** Minutes
- **ss or s.** Seconds
- **uu or u.** Milliseconds
- **H: h: m: s: or u.** No leading zeroes for single digits
- **HH: hh: mm: ss: uu.** Leading zero for single digits
- **tt.** Double letter AM or PM
- **t.** Single letter AM or PM

Click OK to accept the settings and close the dialog box.


Setting Day Zero

SigmaPlot provides three date systems:

- 1900
- 1904
- -4713

Note: SigmaPlot by default uses the system zero date of 4713 BC.

Setting a Start Date is only necessary if you are importing numbers to be converted to
dates, or converting dates to numbers for export. The starting date must match the date
used by the other application.

Note that SigmaPlot recognizes day zero as starting at 0. Some spreadsheet software
products begin day zero at 1. This means that you may have to set your starting date in
SigmaPlot to one day prior.

Also, unlike Microsoft Excel, SigmaPlot correctly treats the year 1900 as a normal
year and not a leap year (a century year, to be a leap year, must be divisible by 400). If
you’re importing from Microsoft Excel, dates from January 1st 1900 to the day before
March 1st 1900 will differ by one day.

To set the start date:

- From the menus select:
  Tools
  Options

  The Options dialog box appears.

- Click the Worksheet tab.

- Select a date from the Day Zero drop-down list, or type your own start date. The
default start date is 1/1/1900.
Day Zero becomes the number 01.00 when you change from Date and Time to Numbers format. The basic unit of conversion is the day; that is, whole integers correspond to days. Fractions of numbers convert to times. Zero becomes Day Zero, and negative numbers entered into the worksheet convert to days previous to the Day Zero start date.

Conversion between date/time values and numbers can occur for the calendar range of 4713 BC to beyond the year 4,000 AD. The internal calendar calculates dates using the Julian calendar until September, 1752. After that, dates are calculated using the Gregorian calendar.

Note: If you convert numbers to dates, a start date is applied. If you convert the dates back to numbers, be sure you use the same start date as when you converted them, or they will have a different value.

**Regional Settings**

Drop-down lists in the Options dialog box worksheet tab use the current date/time settings in your operating system. The Windows Regional Settings control date/time **delimiters**, 12 or 24 hour clock, and AM/PM display.

Date and time display formats may be affected by your operating system’s Regional Settings. For example, if your Time Zones are specified as British (English), your date
values appear as dd/mm/yy. If the setting is US (English), your date values appear as mm/dd/yy. If you want to view or modify the current settings, or view alternative settings available on your system, click the **Regional Settings** button, or modify them directly from the **Windows Control** tab.

*Note:* Date and time values appear on the worksheet using the date and time delimiters, generally a forward slash (/) or colon (:). For more information, see “Entering Dates and Times” on page 52.

**Using Date/Time Format with Other Programs**

You can copy date/time values from a SigmaPlot worksheet and paste them into other programs, such as an Excel workbook, or, you can copy date/time values from another program and paste them into a SigmaPlot worksheet. If the date/time format you are pasting is larger than the worksheet column width, you may need to change the column width.

If you are copying date/time values from another program to SigmaPlot, make sure that the program is displaying dates/times in a format that SigmaPlot accepts as valid data entry. For example, if you are pasting dates from Excel, make sure the dates are displayed as numbers separated by slashes (/), or whatever date delimiter Windows is set to.

▶ **To change Excel formats,** see your Excel reference, or, with an Excel worksheet active in SigmaPlot, click **Microsoft Excel Help** on the **Help** menu to view the topic about Date and Time formats.

Keep the following in mind when copying or importing date and time formatted data:

- Pasted or imported numeric data does not automatically convert to Date and Time format. You must convert it using the same start date (Day Zero) that is used by the other program.
- When copying worksheet values, values are copied as numeric strings, not date/time.
- SigmaPlot recognizes Date and Time formats imported from Excel, but you will need to convert most other non-text dates and times from numbers to dates and time.
Formatting Worksheets

You can format entire columns even if they contain no data. If a populated cell in a column is already specifically formatted, as you enter data the entire column continues to use the same format, provided the data is appropriate to that format.

When importing data, the import format takes precedence over the column format.

*Note:* Formatting worksheets is not the same as setting worksheet display options. Setting worksheet display options sets the default for the entire worksheet. For more information, see “Setting Worksheet Display Options” on page 48. You can override these defaults by formatting worksheet columns using the Format Cells dialog box.

*To format worksheet columns:*

- Select an entire column.

- From the menus select:
  
  Format
  
  Cells

  The Format Cells dialog box appears.

- Click the Data tab.

- Select a Type. The Type you select determines which Settings are available. Available Types are:
  
  - **Numeric.** Select Numeric to control how many decimal places you want to appear or if you want to use E notation in a selected worksheet column.
  
  - **Text.** Select text to wrap text using the existing column width.
  
  - **Date and Time.** Select Date and Time to set the display for the specified columns. For more information, see “Switching Between Date and Time and Numeric Display” on page 83.
Setting Row and Column Size

To set row and column size for a selected block of data:

- Select a block of data on the worksheet.
- From the menus select:
  Format
  Cells

The Format Cells dialog box appears.

Figure 3-22
The Format Cells Dialog Box

- Click the Rows and Columns tab. The selected box reflects the selected block of rows and columns.
- Set column width and row height from the Column width and Row height drop-down lists.
- To apply the row and column formats to the whole worksheet, select Apply to entire data region.
- Click OK to apply the changes and close the dialog box. The worksheet appears with new column and row sizes for the selected cells.
Note: Setting row height and column width from the Format Cells dialog box only changes the selected block of data. Set row and column defaults on the Worksheet tab in the Tools menu Options dialog box.

**Switching Between Date and Time and Numeric Display**

Use the Format Cells dialog box to convert between date/time and numeric display. You can convert between date/time and numeric display when:

- Importing data.
- Switching numbers to dates.
- Modifying the display between date, time and date/time.

Figure 3-23  
The Format Menu Cells Dialog Box

To display worksheet cells in Date and Time format:

- View the worksheet.
- Select the data you wish to display in date/time format.
Chapter 3

From the menus select:
Format
Cells

The Format Cells dialog box appears.

► Click the Data tab.

► In the Type list, click Date and Time.

► Select date and time formats from the Date and Time drop-down lists. The sample box changes according to your choice.

► Click OK. The data is displayed showing the date, time, or date and time as specified. The dates and times that are entered as dates and times are automatically displayed as such.

Cutting, Copying, Pasting, Moving, and Deleting Data

Use the Edit menu commands to Cut, Copy, Paste, and Clear a selected cell or block. You can also use the Ctrl+X, Ctrl+C, and Ctrl+V shortcut keys or Standard toolbar buttons.

Selecting a Block of Data

There are several ways to select a block of worksheet cells. You can:

- Drag the mouse over the desired worksheet cells while pressing and holding down the left mouse button.
- Hold down the Shift key and press the arrow, PgUp, PgDn, Home, or End keys.
- Use the Go To command on the Edit menu.
To select an entire column, move the pointer to the column title row and click.

To select entire rows, move the pointer to the row title column and click.

**Cutting and Copying Data**

Cut removes a selected cell or block from the worksheet and copies it to the Clipboard. Copy copies data to the Clipboard without deleting it from the worksheet.

**Pasting Data**

To paste data:

- Click or move the worksheet cursor to the cell where you want to paste the data, or to the upper-left corner of the block.

- From the menus select:
  - Edit
  - Paste

  or

  Click the Paste button on the Standard toolbar,
or

Press Ctrl+V. Any data in the Clipboard is placed in the worksheet.

**Moving Data**

Move a block of data by cutting it, selecting the upper-left cell of the new location, then pasting the block. For more information, see “Deleting Data” on page 86.

**Deleting Data**

Use the Edit menu Clear command to permanently erase selected data. This operation does not copy data to the Clipboard, and is faster than cutting.

**Inserting Blocks of Cells, Columns, and Rows of Data**

You can insert blank blocks cells, rows, and columns into the worksheet, and fill them with data. If you’re moving and copying cells, you can insert them between the existing cells to avoid pasting over data.

*To insert a column, row, or blocks of cells into the worksheet:*  

- Drag the mouse over the region where you want the empty block of cells, column, or row to appear. The selected region of cells indicates exactly which cells will be inserted.

- Right-click, and then on the shortcut menu, click Insert Cells. The Insert Cells dialog box appears.
Select the direction you want the existing data to shift when the cells are inserted, or to insert an entire column or row, select **Insert Columns** or **Insert Rows**.

Click **OK**. The column, row, or block of cells appears on the worksheet.
**Deleting Blocks of Cells, Columns, and Rows of Data**

When you delete blocks of cells, columns, and rows, you are also permanently erasing the data. It will not be available on the Clipboard.

To delete columns, rows, and blocks of cells from the worksheet:

- Drag the mouse over the block of cells, column, or row you wish to delete.
- Right-click, and on the shortcut menu, click **Delete Columns**. The **Delete Cells** dialog box appears.
- Select the direction you want the existing data to shift when the cells are deleted.
- Click **OK**.

**Switching Rows to Columns**

You can rearrange data from a row-oriented format to a column orientation, or vice versa. When you swap data, SigmaPlot pastes contents with the row and column coordinates transposed.

To swap data column and row positions:

- Select the block of data to transpose.
- Cut or copy the selected data.
- Select the cell where you want to begin pasting the data,
- From the menus select:
  - **Edit**
  - **Transpose Paste**

The data is pasted to the worksheet with the column and row coordinates reversed.
Entering and Promoting Column and Row Titles

Column and row titles label and identify columns and rows of data. Column titles appear in the Graph and Regression Wizards when you pick columns, identify columns for legends, and can be used instead of column numbers in transforms.

To enter or edit a worksheet column or row title:

- Double-click the title, and enter or edit the title.
- Press Enter to accept the new title. The new column or row title appears along with the original column or row number.

You must use at least one text character in every column title. If you need to use a number as column title, type a space character (by pressing the space bar) before the number.

Using the Column and Row Titles Dialog Box

Enter and edit column and row titles using the Column and Row Titles dialog box.

To enter or edit a column title:

- From the menus select:
  - Format
    - Column and Row Titles

  The Column and Row Titles dialog box appears.

- Click the Column tab.

- Enter the column title in the Title box.

- To edit an existing title, move to that column by clicking Next or Prev, then edit the title.
Click OK to close the Column Titles dialog box when you are finished editing column titles.

**To enter or edit a row title:**

- From the menus select:
  - Format
    - Column and Row Titles

  The Column and Row Titles dialog box appears.

- Click the Row tab.

- Enter the row title in the Title box.

- **To edit an existing title,** move to that row by clicking Next or Prev, then edit the title.

- Click OK to close the Column and Row Titles dialog box when you are finished editing row titles.

**Using a Worksheet Row for Column Titles**

Enter labels into a row, then use that row for worksheet column titles. This is useful for data imported or copied from spreadsheets.

All the cells of the selected row are promoted, not just those cells which contain column titles. This may effect other data sets in the worksheet.

**To use a row for column titles:**

- If necessary, enter the column titles you want to use in a single worksheet row.

- Select the cells in the row you want to use as column titles.
From the menus select:

Format
Column and Row Titles

The Column and Row Titles dialog box appears.

Figure 3-27
Using a Row for Column Titles

Click the Column tab. The number of the row you wish to promote appears in the Promote row to titles box.

To delete the original row once it has been promoted, select Delete Promoted Row.

Click Promote. The selected row contents appear as column titles and the Column and Row Titles dialog box closes.
**Using a Worksheet Column for Row Titles**

Enter labels into a column, then use that column for worksheet row titles. This is particularly useful for data imported or copied from spreadsheets.

All the cells of the selected row are promoted, not just those cells which contain column titles. This may effect other data sets in the worksheet.

**To use a column for row titles:**

- If necessary, enter the row titles you want to use in a single worksheet column.
- Select the cells in the row you want to use as row titles.
- From the menus select:
  
  Format
  
  Column and Row Titles

The Column and Row Titles dialog box appears.

Figure 3-28  
Promoting a Column of Data as Row Titles
Click the Row tab. The column you wish to promote appears in the Promote column to titles box.

Select Delete Promoted Column to delete the original column once it has been promoted.

Click Promote. The selected column contents appear as row titles and the Column and Row Titles dialog box closes.

Using a Cell as a Column or Row Title

Use the Column and Row Titles dialog box to promote individual cells to column and row titles.

To promote individual cells:

Click the cell on the worksheet that you want to promote to a column or row title.

From the menus select:

Format
  Column and Row Titles

The Column and Row Titles dialog box appears.

Click the Row tab to promote a row cell to title; click the Column tab to promote a column cell to a title.

Click Promote. The content of the cell appears as the column title.

Select Delete Promoted Column or Delete Promoted Row to delete the original cell once it has been promoted.

Click Next or Prev to move to the next desired column or row, then follow steps above.
Removing Outliers and Other Data

You can manually omit or ignore an outlying point or group of points by converting the number to a text cell which removes the data point from both graphing and computation.

To remove or ignore an outlier:

- Find the outlier on the graph, then click it to select the curve, pause, and then click again (do not double-click).
- View the worksheet. The data for the selected symbol is indicated with colored highlighting.

Note: It is possible to highlight data points only if you create graphs using symbols.

Figure 3-29
When you find the outlier on the graph, click it once to select it, and click it again, but make sure not to double-click.
Select the highlighted worksheet cell(s).

From the menus select:

Format
Cells

The Format Cells dialog box appears.

Figure 3-30
Format Cells Dialog Box

Click the Data tab.

Select Text from the Type list, then click OK. This converts the number to text characters; you can tell this if the alignment of the cell changes to be left aligned.
The data point is no longer plotted, and if you perform additional statistics on the graph, the data point will also be ignored.

Figure 3-31
Graph with Removed Outlier

**Highlighting Outliers**

Another way to remove an outlier is to cut the data and move it to another part of the worksheet. This is useful if you still want to plot the data but ignore the outlier. Then you can plot the moved outlier data with a second plot to continue displaying the outlying data.

**To plot outlier data as a separate plot:**

- Identify the worksheet cell(s) corresponding to the outlier(s).
- Select (highlight) the cells, and press Ctrl+X to cut them.
- Move to another location in the worksheet and paste the data.
Plot the outlier data by adding it as a second plot to your graph. Change the symbol color or other attributes to distinguish the data.

**Figure 3-33**
*A Highlighted Outlier*

---

**Using Excel Workbooks in SigmaPlot**

SigmaPlot supports Microsoft Excel workbooks which you can use to create graphs, run transforms, and perform regressions and other statistics on your data.

Most Excel commands are available when Excel workbooks are viewed, as are the Excel toolbars. The SigmaPlot Graph, Statistics, and Transforms menus are also
available. When an Excel worksheet is in focus, all keyboard shortcuts are assigned to Excel’s hotkeys, not SigmaPlot’s.

Figure 3-34  
A New Excel Worksheet in SigmaPlot

Excel workbooks created by SigmaPlot are initially limited to a single worksheet. Excel workbooks with multiple worksheets that are opened by SigmaPlot as notebooks retain all sheets, but only the first sheet can be used for graphs and statistics.

To open a new Excel worksheet:

» From the menus select:
  File
  New
The New dialog box appears.

- From the New drop-down list, select Worksheet.
- Under Type, click Excel.
- Click OK. An Excel worksheet appears and is added to the notebook. The Excel Standard Toolbar appears as well.

**Unprotecting Excel Workbooks**

Before you add, delete or move Excel worksheets or macros within workbooks within SigmaPlot you must first unprotect the workbook. However, if you choose to unprotect an Excel workbook, do not delete the worksheet that is used by SigmaPlot.

To unprotect an Excel workbook:

- Open an Excel workbook.
- From the Excel menus select:
  - Tools
  - Protection
  - Unprotect Workbook

**Using Excel as Default Workbooks**

You can use Excel workbooks as the default SigmaPlot worksheet.

To set Excel as the default worksheet:

- Close all open Excel workbooks.
- From the SigmaPlot menus select:
  - Tools
  - Options
The Options dialog box appears.

- Click the General tab.
- Select New Notebooks use Excel Workbook.
- Click OK to apply the changes and close the dialog box. All new notebooks will use Excel workbooks as the default worksheet.

**Opening Other File Types With Excel**

Using an Excel workbook as the default SigmaPlot worksheet, you can use Excel’s Open options and also open file types available to Excel. The following file types use the Excel Import filters if Excel workbooks are the default worksheet:

- MS Excel
- Lotus 1-2-3
- dBase
- Plain Text
- SYLK


*To format data that opens into a single column:*

- From the Excel menus select:
  Data
  Text Columns

**SigmaPlot Functionality within Excel Workbooks**

To understand how Excel works with other applications, please see your Excel documentation. The following functions are unavailable when working with data in an in-place active Excel workbook:
You cannot insert graphic cells into an Excel workbook for customized sequences of colors, lines, symbols, and patterns. When an Excel workbook is the active window, there is no Edit menu Insert Graphic Cells command.

An Excel workbook does not have an associated Statistics worksheet. To view statistics for data in an Excel workbook, use Excel’s own statistics, or copy and paste the data into a SigmaPlot worksheet. To display the statistics worksheet for the active SigmaPlot worksheet, on the View menu, click Statistics.

Additional Features With Excel

Within sigmaPlot, you can use Excel’s advanced Print functions. You can also export Excel workbooks to the Excel *.xls file format with the File menu Export command.

Printing Excel Workbooks. To specify page setup functions for the active Excel workbook, on the File menu, click Page Setup to open the Page Setup dialog box. You can modify page, margins, headers and footers, and sheet settings.

Figure 3-35
Setting Printing Options Using the Excel Page Setup Dialog Box

Exporting Excel Workbooks. You can export in-place active Excel workbooks to Excel’s native *.xls file format, as well as any other format supported by Excel.
To export Excel Workbooks:

- View the Excel worksheet.
- From the menus select:
  - File
  - Export

  Excel’s Save As dialog box appears.
- Select the desired format from the Save as type drop-down list.
- Specify the drive and directory in which to save the file.
- Enter a file name.
- Click Save to save the file.

Excel Toolbars

An Excel workbook in SigmaPlot always uses Excel toolbar default settings of your last Excel session.

You can view any of Excel’s toolbars by clicking Toolbars on the View menu. Select a toolbar to use from the Excel Toolbars dialog box; the toolbars appear near the workbook window.

Note: Switching from or closing an Excel workbook hides any Excel toolbars you may have displayed.

Creating SigmaPlot Graphs With Excel Workbooks

An Excel worksheet works the same as a SigmaPlot worksheet when creating graphs. You can pre-select data before beginning a graph, or click or highlight columns from the Graph Wizard.
You can also create SigmaPlot graphs using Excel. For more information, see “Creating SigmaPlot Graphs Using Microsoft Excel” on page 179.

Figure 3-36
Picking data to plot from an Excel worksheet

Using Transforms on Data in Excel Workbooks

You can perform Transform menu commands and user-defined transforms on data in Excel worksheets. The transform language uses syntax which refers to columns numerically, or by the column titles currently assigned. When prompted to pick columns, you can select columns as you would on a SigmaPlot worksheet.

To perform user-defined transforms on an Excel worksheet, use the corresponding column number in place of the column letter that appears in the gray heading area at the top of the column. For example, the transform function:

\[
col(1) = \text{data}(1,100)
\]

corresponds to inserting data values from 1 to 100 into column A of an Excel workbook.
Using Statistics with Excel

You can use the Statistics menu commands, including the Regression Wizard, with Excel worksheets.

When prompted to pick columns, select the columns from the Excel worksheet just as you would from a SigmaPlot worksheet. Results for statistics can be placed in Excel worksheets as well.

Figure 3-37
Using the Regression Wizard with an Excel Worksheet

Printing Worksheets

You can print active worksheets by clicking the Print button on the Standard toolbar. You can print any worksheet in a SigmaPlot notebook. This section explains:

- Printing the current worksheet (see page 105).
- Previewing worksheets before printing (see page 105).
- Printing column statistics (see page 105).
- Setting printing options (see page 106).
- Configuring printer settings (see page 107).
Printing the Current Worksheet

► Select and view the worksheet. If you want to print only a portion of the columns in the active worksheet, select a block from the worksheet.

► From the menus select:
  File
  Print

Previewing Worksheets

► With a worksheet in view, from the menus select:
  File
  Print Preview

A preview of the worksheet appears.

Printing Column Statistics

► From the menus select:
  View
  Statistics

The column statistics worksheet appears.

► From the menus select:
  File
  Print

The Print dialog box appears.

► From the Name drop-down list, select the printer you wish to use.
Click OK. The Print Data Worksheet dialog box appears.

Figure 3-38
The Print Data Worksheet Dialog Box for Columns Statistics

To print the names of the statistics that appear in the row region of the worksheet, under Headers select Row Headings.

Click OK to print.

Setting Printing Options

From the menus select:

File
Print

The Print Data Worksheet dialog box appears.

Figure 3-39
The Print Data Worksheet Dialog Box
Specify whether you want to print the entire worksheet, only the selected cells in the worksheet, or a specified range of columns by selecting one of the options under Area to Print.

Click OK to print the worksheet.

**Configuring Printer Settings**

- With a worksheet in view, from the menus select:
  - Print
  - Print Data Worksheet

  The Print Data Worksheet dialog box appears.

- Click Setup. The Print dialog box appears.

- Click OK when you are satisfied with the Printer settings, or click Properties to edit the printer properties.

  *Note:* The Properties dialog box options vary from printer to printer.
Chapter 3
Creating and Modifying Graphs

A graph is a representation of selected worksheet columns on a graph page. You select the representation, or graph type (for example, 3D scatter plot, vertical bar chart, and so on), when you create a plot or graph, but you can change it at any time.

Most plot types can graph many worksheet columns, column pairs, or column triplets. Depending on the plot type, a separate curve or set of bars represents each column. A graph must have at least one plot, but most graphs can hold many more plots, each with a different type and style.

This chapter provides an overview of the graph creation process using the Graph Wizard, including descriptions of the different graph types and styles available, and common modifications.

This chapter covers:
- Setting graph defaults (see page 109).
- Arranging data for graphs (see page 138).
- Creating graphs (see page 151).
- Creating graphs using templates, layouts, and the Graph Style Gallery (see page 157).
- Modifying graphs (see page 163).
- Creating and modifying embedded SigmaPlot graphs (see page 178).
- Changing symbol type and other symbol options (see page 180).
- Changing line type and other line options (see page 191).
- Changing bar and box widths and spacing (see page 203).
- Adding and modifying drop lines (see page 207).
- Plotting and solving equations (see page 209).

Setting Graph Defaults

Changing graph defaults affects only new graphs created.
To change existing graphs:

- Select the graph.
- Change its properties using the Graph Wizard, Graph Properties, or other dialog boxes and commands.

The graph default options are intentionally limited and simple. If you want to use more complex graph defaults, use templates or the Graph Style Gallery to create complex graphs that can be applied to data as a template, bypassing graph creation entirely. For more information, see “Using the Graph Style Gallery” on page 157.

To change graph defaults:

- From the menus select:
  
  Tools
  Options

  The Options dialog box appears.

- Click the Graph tab.

- Change the graph defaults options as desired.
SigmaPlot Graph Types

There are more than a dozen graph types available in SigmaPlot. Choose a graph type using the Graph Wizard or the graph toolbar.

*Scatter Plot*

Plots data as XY points using symbols. For more information, see “Arranging Data for 2D Plots” on page 138.
Chapter 4

**Line Plot**

Plots data as XY points connected with lines. For more information, see “Arranging Data for 2D Plots” on page 138.

**Line and Scatter Plot**

Plots data as XY points using symbols connected with lines. For more information, see “Arranging Data for 2D Plots” on page 138.

**Area Plot**

Plots data as XY points with regions below or between curves filled with a color or pattern.

**Polar Plot**

Plots data using angles and distance from center. For more information, see “Arranging Data for 2D Plots” on page 138.

**Ternary Plot**

Plots data on a coordinate system based on three different components which always add up to 100%. For more information, see “Arranging Data for a Ternary Graph” on page 144.
**Vertical Bar Chart**

Plots data as Y points with vertical bars. For more information, see “Arranging Data for 2D Plots” on page 138.

**Horizontal Bar Chart**

Plots data as X points with horizontal bars. For more information, see “Creating 2D Plots” on page 302.

**Box Plot**

Plots data as the median and percentiles. For more information, see “Creating Box Plots” on page 331.

**Pie Chart**

Plots data as a percent of the total. For more information, see “Arranging Data for a Pie Chart” on page 138.

**Contour Plot**

Plots data as XYZ values in 2D space. Format data columns as: many Z; single XY, many Z; or XYZ triplet. For more information, see “Arranging Data for 3D Graphs” on page 148.
Chapter 4

3D Scatter Plot

Plots data as XYZ data points in 3D space. Format data columns as: many Z; single XY, many Z; or XYZ triplet. For more information, see “Arranging Data for 3D Graphs” on page 148.

3D Line Plot

Plots data as XYZ data points connected with lines. Format data columns as: many Z; single XY, many Z; or XYZ triplet. For more information, see “Arranging Data for 3D Graphs” on page 148.

3D Mesh Plot

Plots data as a 3D surface. Format data columns as: many Z; single XY, many Z; or XYZ triplet. For more information, see “Arranging Data for 3D Graphs” on page 148.

3D Bar Chart

Plots data as Z values on an XY grid. Format data columns as: many Z; or single XY, many Z. For more information, see “Arranging Data for 3D Graphs” on page 148.

SigmaPlot Graph Styles

Many graph types have several styles to choose from. When you select a graph type, either from the graph toolbar or from the Graph Wizard, you are prompted to choose a graph style.
Scatter Plots

Simple Scatter

Plots a single set of XY pairs. Format data columns as:
- XY Pair
- Single X
- Single Y

Multiple Scatter

Plots multiple sets of XY pairs. Format data columns as:
- XY Pairs
- Single Y, Many X
- Single X, Many Y
- Many X
- Many Y
- XY Category
- X Category
- Y Category

Simple Regression

Plots a single set of XY pairs with a regression line. Format data columns as:
- XY Pair
- Single X
Multiple Regressions

Plots multiple sets of XY pairs with regression lines. Format data columns as:

- XY Pairs
- Single Y, Many X
- Single X, Many Y
- Many X
- Many Y
- XY Category
- X Category
- Y Category

Simple Error Bars

Plots a single set of XY pairs with error bars. If using worksheet columns or asymmetric error bar columns, format data columns as:

- XY Pair; or Single Y

If using columns means, the first column entry, or the last column entry as symbol values, format data columns as:

- Single X, Many Y
- Many Y

If using Row Mans, Row Median, First Row Entry, or Last Row Entry as symbol values, format data columns as:

- Single X, Single Y Replicate
- Y Replicate
**Multiple Error Bars**

Plots multiple sets of XY pairs with error bars. If using worksheet columns, asymmetric error bar columns, columns means, the first column entry, or the last column entry as symbol values, format data columns as:

- X Many Y
- Many Y

If using row means, row median, first row entry, or last row entry as symbol values, format data columns as:

- Single X, Many Y Replicates
- Many Y Replicates

**Simple Error Bars & Regression**

Plots a single set of XY pairs with error bars and a regression line. If using worksheet columns or asymmetric error bar columns, format data columns as:

- XY Pair
- Single Y

If using columns means, the first column entry, or the last column entry as symbol values, format data columns as:

- Single X Many Y
- Many Y

If using Row Means, Row Median, First Row Entry, or Last Row Entry as symbol values, format data columns as:

- Single X, Single Y replicate
- Y replicate
If using By Category, Mean, or By Category, Median, format data columns as:
- Category, Many Y

**Multiple Error Bars & Regressions**

*Plots multiple sets of XY pairs with error bars and regression lines.* If using worksheet columns, asymmetric error bar columns, columns means, the first column entry, or the last column entry as symbol values, format data columns as:
- Single X Many Y
- Many Y

If using Row Means, Row Median, first Row Entry, or last Row Entry as symbol values, format data columns as:
- Single X, Many Y Replicates
- Many Y Replicates

If using By Category, Mean, or By Category, Median, format data columns as:
- Category, Many Y

**Simple Horizontal Error Bars**

*Plots XY pairs with horizontal error bars.* If using worksheet columns or asymmetric error bar columns as the as symbol values, format as:
- XY pairs
- Single X, Single Y, Many X
- Many X

If using column means, column median, the first column entry, or the last column entry as symbol values, format data as:
- Single Y, Many X
Many X

If using Row Means, Row Median, the First Row Entry, or the Last Row Entry as symbol values, format data columns as:
- Single X Replicates
- Single Y, single X Replicates
- Many X Replicates
- Single Y, Many X Replicates

If using By Category, Mean, or By Category, Median, format data columns as:
- Category, Many Y

**Bi-directional Error Bars**

*Plots XY pairs with both horizontal and vertical error bars.* Format data columns as XY pairs. If using worksheet columns or asymmetric error bar columns as the as symbol values, format as:
- XY pairs
- Single X
- Single Y, Many X
- Many X

If using column means, column median, the first column entry, or the last column entry as symbol values, format data as:
- Single Y, Many X
- Many X
Chapter 4

**Vertical Point Plot**

![Vertical Point Plot Icon]

Plots columns of data as Y values. Format data columns as:

- Many Y
- Single X, Many Y
- Many Y Replicates
- Single X, Many Y Replicates

**Horizontal Point Plot**

![Horizontal Point Plot Icon]

Plots columns of data as X values. Format data columns as: Many X

- Single Y, Many X
- Many X Replicates
- Single Y, Many X Replicates

**Vertical Dot Plot**

![Vertical Dot Plot Icon]

Plots a column of data as Y values. Format data columns as:

- Many Y
- Single X Many Y
- XY pairs
- X Category
Horizontal Dot Plot

Plots a column of data as X values. Format data columns as:
- Many X
- Single Y, Many X
- YX pairs

Line Plots

Simple Straight Line

Plots a single set of XY pairs connecting the data points with straight lines. Format data columns as:
- XY Pairs
- Single X
- Single Y

Multiple Straight Lines

Plots multiple sets of XY pairs connecting the data points with straight lines. Format data columns as:
- XY Pairs
- Many X
- Many Y
- Single X, Many Y
- Many X
- Single Y
Chapter 4

Simple Spline Curve

Plots a single set of XY pairs connecting the data points with a spline curve. Format data columns as:
- XY Pairs
- Single X
- Single Y

Multiple Spline Curves

Plots multiple sets of XY pairs connecting the data points with spline curves. Format data columns as:
- XY Pairs
- Many X
- Many Y
- Single X, Many Y
- Single Y, Many X

Simple Vertical Step Plot

Plots a single set of XY pairs connecting the data points with vertical and horizontal lines, starting with vertical. Format data columns as:
- XY Pairs
- Single X
- Single Y
Creating and Modifying Graphs

Multiple Vertical Step Plot

Plots multiple sets of XY pairs connecting the data points with vertical and horizontal lines, starting with vertical. Format data columns as:
- XY Pairs
- Many X
- Many Y
- Single X, Many Y
- Single Y, Many X

Simple Horizontal Step Plot

Plots a single set of XY pairs connecting the data points with vertical and horizontal lines, starting with horizontal. Format data columns as:
- XY Pairs
- Single X
- Single Y

Multiple Horizontal Step Plot

Plots multiple sets of XY pairs connecting the data points with vertical and horizontal lines, starting with horizontal. Format data columns as:
- XY Pairs
- Many X
- Many Y
- Single X, Many Y
- Single Y, Many X
Line & Scatter Plots

Simple Straight Line

Plots a single set of XY pairs connecting symbols with straight lines. Format data columns as:
- XY Pairs
- Single X
- Single Y

Multiple Straight Lines

Plots multiple sets of XY pairs connecting symbols with straight lines. Format data columns as:
- XY Pairs
- Many X
- Many Y
- Single X, Many Y
- Single Y, Many X

Simple Spline Curve

Plots a single set of XY pairs connecting symbols with a spline curve. Format data columns as:
- XY Pairs
- Single X
- Single Y
**Multiple Spline Curves**

Plots multiple sets of XY pairs connecting symbols with spline curves. Format data columns as:
- XY Pairs
- Many X
- Many Y
- Single X, Many Y
- Single Y, Many X

**Simple Error Bars**

Plots a single set of XY pairs as symbols with error bars connected with straight lines. If using worksheet columns or asymmetric error bar columns, format data columns as:
- XY Pair
- Single Y

If using columns means, the first column entry, or the last column entry as symbol values, format data columns as:
- X Many Y
- Many Y

If using row means, row median, first row entry, or last row entry as symbol values, format data columns as:
- X, Y Replicate
- Y Replicate
Multiple Error Bars

Plots multiple sets of XY pairs as symbols with error bars connected with straight lines. If using worksheet columns, asymmetric error bar columns, columns means, the first column entry, or the last column entry as symbol values, format data columns as:

- X Many Y
- Many Y

If using row means, row median, first row entry, or last row entry as symbol values, format data columns as:

- X, Many Y Replicates
- Many Y Replicates

Simple Vertical Step Plot

Plots a single set of XY pairs connecting symbols with vertical and horizontal lines, starting with vertical. Format data columns as:

- XY Pairs
- Single X
- Single Y

Multiple Vertical Step Plot

Plots a multiple sets of XY pairs connecting symbols with vertical and horizontal lines, starting with vertical. Format data columns as:

- XY Pairs
- Many X
- Many Y
Creating and Modifying Graphs

1. Single Y, Many X
2. Single X, Many Y

**Simple Horizontal Step Plot**

Plots a single set of XY pairs connecting symbols with vertical and horizontal lines, starting with horizontal. Format data columns as:

- XY Pairs
- Single X
- Single Y

**Multiple Horizontal Step Plot**

Plots a multiple sets of XY pairs connecting symbols with vertical and horizontal lines, starting with horizontal. Format data columns as:

- XY Pairs
- Many X
- Many Y
- Single Y, Many X
- Single X, Many Y

**Area Plots**

**Simple Area**

Plots single set of XY pairs as a line plot with a downward fills. Format data columns as:

- XY Pairs
Chapter 4

- Single X
- Single Y

**Multiple Area**

*Plots multiple sets of XY pairs as line plots with downward fills.* Format data columns as:

- XY Pairs
- Many Y
- Single X, Many Y
- Many X
- Single Y, Many X

**Vertical Area**

*Plots single set of YX pairs as a line plot with a left direction fill.* Format data columns as:

- Single X
- YX Pair

**Multiple Vertical Area**

*Plots multiple sets of YX pairs as line plots with left direction fills.* Format data columns as:

- Many X
- Single Y, Many X
Complex Area Plot

Plots multiple line plots with downward fills and intersections. Format data columns as:

- XY Pairs
- X Many Y
- Y Many X
- Many X
- Many Y

Polar Plots

Scatter

Plots angle and distance data as symbols. Format data columns as:

- Theta, R Pairs
- XY Pairs
- Many Theta
- Many R
- Single Theta, Many R
- R, Many Theta

Lines

Plots angle and distance data points connected with lines. Format data columns as:

- Theta, R Pairs
- XY Pairs


**Chapter 4**

- Many Theta
- Many R
- Single Theta, Many R
- R, Many Theta

*Scatter & Lines*

Plots angle and distance data as symbols connected with lines. Format data columns as:
- Theta, R Pairs
- XY Pairs
- Many Theta
- Many R
- Single Theta, Many R
- R, Many Theta

*Ternary Plots*

*Scatter*

Plots ternary triplet data as symbols. Format data columns as:
- Ternary Triplets
- Ternary XY Pairs
- Ternary YZ Pairs
- Ternary XZ Pairs
Lines

Plots ternary triplet data as data points connected with lines. Format data columns as:
- Ternary Triplets
- Ternary XY Pairs
- Ternary YZ Pairs
- Ternary XZ Pairs

Scatter & Lines

Plots ternary triplet data as symbols connected with lines. Format data columns as: X,Y, and Z values; or data.
- Ternary Triplets
- Ternary XY Pairs
- Ternary YZ Pairs
- Ternary XZ Pairs

Vertical Bar Charts

Simple Bar

Plots a single column of data as Y values. Format data columns as:
- XY Pair
- Single Y
**Grouped Bar**

![Grouped Bar Chart](image)

Plots multiple columns of data in a series of bars. Format data columns as:
- Single X, Many Y
- Many Y
- Many Y Replicates
- Single X, Many Y Replicates

**Simple Error Bars**

![Simple Error Bars Chart](image)

Plots data as Y values with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as:
- Single Y
- XY Pair

If using columns means, the first column entry, or the last column entry as symbol values, format data columns as:
- Single X Many Y
- Many Y

If using row means, row median, the first row entry, or the last row entry, format data columns as:
- Single Y Replicate
- X, Y Replicate
Creating and Modifying Graphs

**Grouped Error Bars**

Plots data as multiple sets of Y values in a series of bars with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as:
- Many Y
- Single X, Many Y

If using row means, row median, the first row entry, or the last row entry, format data columns as:
- Many Y Replicates
- Single X
- Many Y Replicates

Error bar values are from the worksheet.

**Stacked Bars**

Plots multiple columns of data as a series of stacks in bars. Format data columns as:
- Single X, Many Y
- Many Y
- Many Y Replicates
- Single X, Many Y Replicates
Chapter 4

Horizontal Bar Charts

Simple Bar

Plots a single column of data as X values. Format data columns as:

- XY Pairs
- Single X

Grouped Bar

Plots multiple columns of data in a series of bars. Format data columns as:

- Single Y, Many X
- Many X, Many X Replicates
- Single Y, Many X Replicates

Simple Error Bars

Plots data as X values with error bars. If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as:

- Single X
- YX pair

If using columns means, the first column entry, or the last column entry as symbol values, format data columns as:

- Many X;
- Single Y, Many X
Creating and Modifying Graphs

If using row means, row median, the first row entry, or the last row entry, format data columns as:

- Many X Replicates
- Single Y, Many X Replicates

Error bar values are from the worksheet.

**Grouped Error Bars**

*Plots data as multiple sets of X values in a series of bars with error bars.* If using worksheet columns or asymmetric error bar columns as the symbol value source, format data columns as:

- Single Y
- Many X
- Many X

If using row means, row median, the first row entry, or the last row entry, format data columns as:

- Many X Replicates
- Single Y, Many X Replicates

Error bar values are from the worksheet.

**Stacked Bars**

*Plots multiple columns of data as a series of stacks in bars.* Format data columns as:

- Single Y, Many X
- Many X
- Single Y
- Many X Replicates
Chapter 4

Box Plots

**Vertical**

![Vertical Box Plot]

Plots the median, 10th, 25th, 75th, and 90th percentiles as vertical boxes with error bars.
Format data columns as:
- Many Y
- Single X, Many Y

Error bar values are column means.

**Horizontal**

![Horizontal Box Plot]

Plots the median, 10th, 25th, 75th, and 90th percentiles as horizontal boxes with error bars.
Format data columns as:
- Many X
- Single Y, Many X

Error bar values are column means.

Contour Plots

**Contour**

![Contour Plot]

Plots data XYZ values in 2D space. Format data columns as:
- XYZ Triplet
- Many Z
- XY, Many Z
Creating and Modifying Graphs

**Filled Contour**

Plots data XYZ values in 2D space filling in the area between contour levels. Format data columns as:
- XYZ Triplet
- Many Z
- XY, Many Z

**3D Line Plots**

**3D Trajectory**

Plots data as XYZ data points connected with lines.

**3D Waterfall**

Plots data as XYZ data points, but only displays X or Y gridlines. Format data as:
- Many Z
- Single XY
- Many Z
Arranging Data for Graphs

For most graph types, the Graph Wizard prompts you to select a data format. Your selection determines how your worksheet data is associated with points on the graph. For example, an XY Pair data format means that graph uses two columns; one column corresponds to the X-axis and the other corresponds to the Y-axis. In the XY, Many Z data format, one column corresponds to the X-axis data, another column corresponds to the Y-axis, and the remaining columns correspond to Z-axis data.

Arranging Data for 2D Plots

Organize data for 2D graphs by columns. Place data for the X values of a graph in a single column, and place data for the corresponding Y values in another column.

Arranging Data for a Pie Chart

To organize data for a pie chart, place data in a single worksheet column.

Figure 4-2  
When creating pie charts, all data is placed into a single column.

Arranging Category Data

Use Category Data formats (indexed data) if your data is organized row wise by categories with corresponding data, as is often the default data organization for both statistics data tables and databases. Using this format, you can plot data files from other
statistical packages, such as SigmaStat or SPSS, without having to divide the data into groups.

**Figure 4-3**

In this worksheet, the data is arranged for an **XY Categories** data format. The "Animals" column is what you would select as the "category" column in the Graph Wizard.

The Category Data format is available when creating summary plots. Graph types and styles that can use a category data format are:

- **Scatter Plot.** Multiple Scatter; Multiple Regression
- **Line Plot.** Multiple Straight Lines; Multiple Spline Curves; Multiple Vertical Step Plot; Multiple Horizontal Step Plot; Multiple Vertical Midpoint Step Plot; Multiple Horizontal Midpoint Step Plot

For more information, see “Plotting Category and Grouped Data” on page 304.

**XY Pair Format for a Single Curve**

If the graph you are creating uses only one set of X and Y values, enter all X data in one column, and all corresponding Y data in another column. Depending on the setting, these columns do not need to be adjacent or the same length (missing values are ignored).
Chapter 4

Figure 4-4
Data for a 2D Graph Arranged and Picked as XY

XY Pair Format for Multiple Curves

If the graph style you are creating plots more than one curve, place as many additional X and Y values in worksheet columns as you want to plot. Enter X and Y data in the worksheet in consecutive columns, or in any order you want.

Figure 4-5
Data for a 2D Graph Arranged and Picked as XY Pairs
Creating and Modifying Graphs

**Using the Same Column for Multiple Curves (Single X or Y vs. Many Y or X)**

SigmaPlot can graph many curves using the same X or Y data column. There is no need to duplicate a column that is used for more than one curve; for example, enter the X data into only one column, and enter the corresponding Y data into as many columns as you have curves. Order and length of columns does not matter.

Figure 4-6
*Data for a 2D Graph Arranged and Picked as X Many Y*

---

**Using Row Numbers for X or Y Values (Single X; Single Y; Many X; or Many Y)**

SigmaPlot can also graph data as only X or Y values, and use the row numbers of the columns as the corresponding Y or X coordinates. If you want to graph data as only X or Y values, enter the data for each plot into a column, and do not enter data for corresponding coordinates.
Chapter 4

Figure 4-7
Data for a 2D Graph Arranged and Picked as Many Y Only

<table>
<thead>
<tr>
<th></th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>4.00</td>
<td>4.00</td>
<td>4.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>8.00</td>
<td>8.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Arranging Data for Plots with Error Bars**

**Arranging Data for Column Averaged Error Bar Plots.** Certain graph styles plot data by representing the mean of an entire column as a single data point. In these cases, place the values you want represented as a single X or Y value into one column.

**Arranging Data for Asymmetric Error Bar Plots.** Asymmetric error bar plots use two columns as the error bar source from which you can independently control the values of error bars. Place the values you want to represent the error bars to the right of the plotted column.

**Arranging Data Using Column Means.** Plots the average of an entire worksheet column as a single data point, then uses the column statistics to compute error bars, as specified by the Error Calculation.

**Arranging Data Using the Column Median.** Plots the median of an entire worksheet column as a single data point, then uses the column statistics to compute error bars, as specified by the Error Calculation.
Arranging Data for Polar Plots

Data for polar plots can be entered in either one of two ways:

- R, θ values
- X,Y coordinates

Data for Radial and Angular Values (R, Theta)

To arrange data using θ (angular) and R (radial) values, enter all θ values in one column, and enter the corresponding R values in another column. Data is plotted as θ versus R, which is similar to X,Y plots in organization, but differs from X,Y plots in that R is usually the dependent variable.

Using X,Y Values for Polar Plots

Polar plot X,Y data is arranged the same as 2D plot X,Y data, with all X values in one column, and all Y values in another column; however, polar plots are plotted as R,θ pairs defined as:

\[ R = \sqrt{x^2 + y^2} \]

and

\[ \theta = \tan^{-1}\left(\frac{y}{x}\right) \]

where R is the radius, and θ is the angle of the data point from the origin.

Data for Multiple Curves

Since SigmaPlot can graph more than one curve per plot, place as many additional θ, R values, or X,Y coordinates, as you want to plot in worksheet columns.
**Using Data from One Column for Multiple Curves**

SigmaPlot can also graph many curves using the same column as the θ or R data (or, X or Y data). There is no need to duplicate a column that is used for more than one plot; for example, enter the θ data into only one column, and enter the corresponding R or dependent data into as many columns as needed.

**Arranging Data for a Ternary Graph**

Data for ternary plots can be XYZ data in three separate columns or SigmaPlot can extrapolate a third column from data pairs in two columns. Ternary graphs must have at least one single or multiple curve plot, but can hold many more plots, each with a different style and data format. If your raw values do not add up to 100% or 1, SigmaPlot can convert them to normalized ternary data. If you have XY, YZ, or YZ pair data, SigmaPlot can compute the third-column values shown in the resulting graph.

**Data for a Single Curve Plot (Ternary Triplets)**

If you are creating a graph with a single curve plot using only one set of XYZ values whose sum is 100% or 1, enter all X data in one column, all Y data in another column, and the corresponding Z data in another column. The columns do not have to be adjacent to one another, but they must be the same length. Ternary triplet data should always add up to 100% or 1. For more information, see “Normalizing Ternary Data” on page 569.

**Data for a Multiple Curve Plot (Ternary Triplets)**

If you are creating a graph with a multiple-curve plot using multiple sets of XYZ values where the sum of each set is 100% or 1, enter into worksheet columns as many additional ternary triplet data sets as you want to plot. Each set of ternary triplet data is a separate plot-curve. All ternary triplet data sets should add up to 100% or 1. For more information, see “Normalizing Ternary Data” on page 569.
Data for a Single or Multiple-Curve Plot (Ternary XY, YZ, or XZ Pairs)

If you are creating a graph with a single or multiple curve plot using XY, YZ, or XZ pairs, enter all X, Y, or Z data in one column, and the corresponding X, Y, or Z pair values in another column. As long as all data pairs use a percentage or unitary scale, SigmaPlot will compute the third-column data shown in the resulting graph.

SigmaPlot computes third column data for plotting only. Computed third-column data is not displayed in the worksheet.

Arranging Data for Bubble Plots

Data for bubble plots can either be X, Y data in two separate columns or single X or single Y data in one column. In both cases, an additional column is needed to indicate bubble size values. Since the bubble size column corresponds to symbol diameter, you must convert the data for your third variable to diameters.

Bubble plots must have at least one plot, but can hold many more plots using different data formats if appropriate. The bubble plot type has available only the default scatter style. You can change the symbol type. However, if you use something other than a circle you will need a different equation to transform area to diameter.
Using X, Y Values for Bubble Plots

Bubble plot X, Y data is arranged in the same way as other 2D plot X, Y data, with all X values in one column and all Y values in another.

Data for Bubble Size

SigmaPlot can graph bubble plots using XY pair, Single Y, Single X, and bubble size data. Bubble size values must be entered in a separate column. Each value corresponds to the diameter of the symbol, in whatever page units are being used. If you want bubble size to correspond to area data, you must convert your area data to diameters before creating the bubble plot.

Converting Area Data to Diameters

If you want your bubble plot to display area data, you must run this transform where area is the source column number and the diameter is the results column number. This transform is derived from the formula for the area of a circle.
To convert your area data into diameters:

- From the menus select:
  
  Transforms
  User-Defined

The User-Defined Transform dialog box appears.

Figure 4-10
User-Defined Transform dialog box

- Type the transform function as follows:

  \[ \pi = 3.14159265359 \text{ col(diameter)} = \sqrt{\text{col(area)} \times \text{factor}/\pi} \]

  where diameter is the column number for your diameter data, area is the column number for your original data to be represented by area, and factor is some number to increase or decrease the magnitude of your data to a reasonable range.

  Tip: Reduce the diameters of your symbols to a reasonable size before plotting them.
Chapter 4

Figure 4-11
Transforming Area Data to Diameters

Click Run.

Your new data appears in the worksheet. If you change the symbol shape, you must use a different equation to transform area data.

Arranging Data for 3D Graphs

Organize data for SigmaPlot graphs by column. Typically, data for contour plots and 3D graphs is composed of X, Y, and Z value columns, or one or more Z columns and optional X and Y columns. 3D bar charts, scatter plots, and line plots can use any three columns as XYZ data.

Note: If multiple Z columns are plotted, they all must be next to each other. The X and Y columns can be located anywhere.

Data for 3D Bar Charts, 3D Scatter Plots, and 3D Line Plots

Arrange data for 3D bar charts, scatter plots, and line plots either as XYZ triplet data, multiple columns of Z data, or as a single column for Y values, a single column for X values, and multiple columns for Z values. For each of these graph types, the data in each row is graphed as a data point. For bar charts, each column of Z data is plotted as a row parallel to either the X axis, with Y values as the constants.
If you are formatting XYZ triplet data, you also can use one of the multiple Z column formats designed for 3D mesh plots.

*Note:* 3D bar charts cannot use XYZ triplet data. You can use the X, Y, and many Z format; however, you must have at least two columns of Z data.

**Data for Contour and Mesh Plots**

A regular rectangular mesh plot requires XYZ coordinates for each intersection of a rectangular mesh. The data for a contour or mesh plot can be in the form of either a regular rectangular mesh or an irregular mesh. If the data is a regular rectangular mesh it is graphed as-is without any modification. If it is an irregular mesh then it is interpolated to form a regular rectangular mesh and then graphed.

```
  Y1  Y2  Y3  Y4  
X1  Z1  Z4  Z7  Z10 
X2  Z2  Z5  Z8  Z11 
X3  Z3  Z6  Z9  Z12 
```

The arrangement of this data for the three possible methods of picking columns to plot are described in the following sections.

**X, Y, and Z Data in Three Columns.** To plot three columns as the X, Y, and Z values of a contour or mesh plot, the data must be in long form mesh format. This format assigns the proper Z value to each X and Y point in the mesh, in the required order.

For example, for the table of X, Y, and Z values shown above, the three column mesh format must be arranged in the worksheet as:

```
X data  Y data  Z data
X1      Y1      Z1  
X2      Y1      Z2  
X3      Z1      Z3  
X1      Y2      Z4  
X2      Y2      Z5  
X3      Y2      Z6  
X1      Y3      Z7  
X2      Y3      Z8  
```
This arrangement places the XYZ data point coordinate values in the required order. The XYZ columns must be the same length.

Figure 4-12

Data Arranged in Long Form Mesh Format

<table>
<thead>
<tr>
<th>X data</th>
<th>Y data</th>
<th>Z data</th>
</tr>
</thead>
<tbody>
<tr>
<td>X3</td>
<td>Y3</td>
<td>Z9</td>
</tr>
<tr>
<td>X1</td>
<td>Y4</td>
<td>Z10</td>
</tr>
<tr>
<td>X2</td>
<td>Y4</td>
<td>Z11</td>
</tr>
<tr>
<td>X3</td>
<td>Y4</td>
<td>Z12</td>
</tr>
</tbody>
</table>

X and Y Columns vs. Many Z Columns. You can also place the X and Y data in single columns, then place the corresponding Z data in many continuous columns. This method may work best if you have XYZ data displayed in a table, or if you have irregularly incremented X or Y values.

To use this option, you should have as many Z columns as you have Y rows, and the Z columns should be the same length as the X column, Y4

<table>
<thead>
<tr>
<th>X data</th>
<th>Y data</th>
<th>Z data</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>Y1</td>
<td>Z1</td>
</tr>
<tr>
<td>X1</td>
<td>Y1</td>
<td>Z4</td>
</tr>
<tr>
<td>X1</td>
<td>Y1</td>
<td>Z7</td>
</tr>
<tr>
<td>X1</td>
<td>Y1</td>
<td>Z10</td>
</tr>
<tr>
<td>X2</td>
<td>Y2</td>
<td>Z2</td>
</tr>
<tr>
<td>X2</td>
<td>Y2</td>
<td>Z5</td>
</tr>
<tr>
<td>X2</td>
<td>Y2</td>
<td>Z8</td>
</tr>
<tr>
<td>X2</td>
<td>Y2</td>
<td>Z11</td>
</tr>
<tr>
<td>X3</td>
<td>Y3</td>
<td>Z3</td>
</tr>
<tr>
<td>X3</td>
<td>Y3</td>
<td>Z6</td>
</tr>
<tr>
<td>X3</td>
<td>Y3</td>
<td>Z9</td>
</tr>
<tr>
<td>X3</td>
<td>Y3</td>
<td>Z12</td>
</tr>
<tr>
<td>Y4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The data in the first Z column is assigned to the first Y value, the data in the second Z column to the second Y value, etc.

The data in each row of the X column is assigned as the X value for the data in the same row in the Z columns.
The X and Y data must be strictly ascending or descending. Note that in this case, you can use columns of uneven length. Extra X, Y, or Z values created by uneven columns are not plotted, as mesh plots cannot graph missing values.

**Z Data vs. Row and Column Numbers:** You can also plot columns as Z values versus the cell columns and row numbers as the X and Y values.

This is the appropriate column assignment option to use: for mesh plots and 3D Bar Charts where X and Y values are evenly and equally spaced; for example, when graphing pixel intensity data for an image.

All data is assigned as a Z value, and the Z columns must be contiguous. To use this format for a mesh plot, no special data arrangement is required other than equal column length. The rows and columns of the cells can be used as either the X or Y values.

**Creating Graphs**

You create graphs in SigmaPlot using **Graph Wizard**. You can start the Graph Wizard either by:

- Clicking the **Graph Wizard** button on the **Standard** toolbar.
- Clicking **Create Graph** on the **Graph** menu.
- Clicking any graph type on one of the **Graph** toolbars.
- Using the **Graph Style Gallery**.

You can also create graphs using graph page **templates**. For more information, see “Using Graph Pages as Templates” on page 237.
Then follow the instructions as they appear in the Graph Wizard and click Next to move to the next panel.

*Tip:* You can either select the worksheet columns to plot before creating your graph by dragging the pointer over your data, or you can select data columns later in the Graph Wizard. You can even select data ranges. For more information, see “Entering Data Ranges into the Graph Wizard” on page 155.

**Creating Graphs Using the Graph Toolbar**

To create a graph using the graph toolbar:

- Select the desired graph type from a 2D or 3D Graph toolbar.
  
  If you selected to create a Graph Type that has more than one style, a Graph Style toolbar appears.

- Select a graph style. Graph Wizard The appears.

**Creating Graphs Using the Graph Wizard**

To create a 2D graph using the Graph Wizard:

- On the Standard toolbar, click the Graph Wizard button.
  
  The Graph Wizard appears.
Under Graph Types, select the type of graph you want to make.

Click Next.

Under Graph Styles, select the desired graph style.

Click Next. If the graph style you have chosen uses error bars, you are prompted to choose an error bar source and a value to use for the error bars. For more information, see “Creating 2D Scatter Plots with Error Bars” on page 308.

Click Next.
Under Data format, select how your data is formatted, and click Next.

Figure 4-16
Specifying the Data Format

From the Data for drop down list, select the worksheet columns that correspond to the axis or error bar of your plot.

You can also drag a range of data on the worksheet using the mouse.

Note: When creating graphs using Microsoft Excel, you can only enter ranges manually.

You can also select a range of data by entering the range manually into the Data for box. After entering the range, press Enter. The range appears in the Graph Wizard. For more information, see “Entering Data Ranges into the Graph Wizard” on page 155.

If you make a mistake while selecting data, double-click the mistaken column in the Selected Columns list to clear the selection.
Entering Data Ranges into the Graph Wizard

The simplest way to select a region of data is to drag the columns or range using the mouse. You can, however, manually enter the ranges into the Graph Wizard. This is necessary when creating graphs using Microsoft Excel where it is not possible to use the mouse to select a range of data.

The Graph Wizard supports the following formats when specifying a region in the worksheet:

- **rc Notation.** Specify a cell using the letter r to denote the row, and the letter c to denote the column. For example, to specify the cell in the third row and twelfth column, you would enter r3c12.

To specify a rectangular region, follow the upper left cell of the region by the lower right cell, separated by two periods. For example, if the upper left cell of the region is r2c1 (second row, first column), and the lower right cell of the region is r4c4 (fourth row, fourth column), you would enter r2c1..r4c4 into the Graph Wizard.

You can also specify the column first. For example, both c2r2..c4r5 and r2c2..r5c4 denote the same region in the worksheet.
Excel Notation. You can use Excel notation in the Graph Wizard. In Excel notation, the columns are alphabetized in lexicographic order and the rows are numbered. In this case, to specify a rectangular region you would again specify the upper left and lower right cells. For example, both A3:D9 and $A3;$D9 specify a region with the upper left cell in the first column, third row and the lower right cell as the fourth column, ninth row. Note that the separator is a colon. The letters are case insensitive.

Column Numbers Notation. You can make a selection of a consecutive group of entire columns by specifying the range of column indices. For example, to specify columns 1 through nine, type 1:9 or 1..9.
Using the Graph Style Gallery

You can avoid repeating the same steps over and over by using the SigmaPlot Graph Style Gallery to create a graph from a predefined graph style. When creating a custom graph style, you save all graph, plot, and axes attributes, including graph size and position. Then you can quickly use these attributes to create future graphs. All you supply is the data, and the Graph Style Gallery formats the rest.

Each graph style that you create appears as a thumbnail preview in the Graph Style Gallery. You can create new graphs by choosing one of the styles from the window. You can either double-click a graph or click Create Graph to create a graph. The graph then appears in a location defined by the graph style.

This section discusses:

- Docking the Graph Style Gallery (see page 158).
- Adding styles to the Graph Style Gallery (see page 158).
- Applying graph styles to pages (see page 159).
- Editing graphs in the Graph Style Gallery (see page 160).
- Creating Graph Style Gallery graphs from the Graph Wizard (see page 161).
Docking the Graph Style Gallery

The SigmaPlot Graph Style Gallery is a resizable window that you can dock like a toolbar, or leave floating. Double-click the Graph Gallery title bar to dock or undock it, or drag it to the desired docked or undocked position.

Adding Styles to the Graph Style Gallery

After creating and formatting a graph, you can save its style in the Graph Style Gallery, and later apply that style to future SigmaPlot graphs.

To add a graph style or object to the Graph Style Gallery:

- Open the graph that you wish to add to the Graph Style Gallery.
- If the Graph Style Gallery is not visible on your SigmaPlot desktop, from the menus select:
  
  View
  Graph Style Gallery

- From the graph page, select the graph and drag and drop it into the Graph Style Gallery window.
  
  A thumbnail of the graph appears in the Graph Style Gallery palette. The graph title appears as the graph style’s name.

To use the right-click short cut menu:

- Select the graph on the page.
- Right-click and on the shortcut menu click Add Graph. The graph style appears in the Gallery.
Applying Graph Styles to Pages

Use the Graph Style Gallery to quickly apply your own custom graph styles to data.

To apply a graph style:

- From the menus select:
  
  View
  Graph Style

The Graph Style Gallery window appears.
Double-click the graph style you want to use.

The Graph Wizard - Create Graph panel appears. For more information, see “Creating Graphs Using the Graph Wizard” on page 152.

Select the worksheet columns you want to use for the plot.

Click Finish to create the plot.

**Editing Graphs in the Graph Style Gallery**

Select the graph to edit in the Graph Style Gallery.

Right-click, and from the menu click Edit.

The graph appears in a graph page.
Creating and Modifying Graphs

- Double-click to open the Graph Properties dialog box, or use any of SigmaPlot’s editing tools. For more information, see “Modifying Graphs” on page 163.

- Close the graph page. The new style is saved in the Graph Style Gallery.

Creating Graph Style Gallery Graphs from the Graph Wizard

You can use the Graph Wizard in conjunction with the Graph Style Gallery to create graphs by selecting Graph Gallery as a graph type in the Graph Wizard.

To create a Graph Style Gallery graph from the Graph Wizard:

- On the Standard toolbar, click the Graph Wizard button. The Create Graph - Type panel of the Graph Wizard appears.

Figure 4-23
You can choose Graph Gallery as a Graph Type when creating graphs using the Graph Wizard.

- Under Graph Types, select Graph Gallery, and click Next.

The Create Graph - Gallery panel of the Graph Wizard appears. All graphs that appear in the Gallery graphs list are also in the Graph Styles Gallery.
Chapter 4

Figure 4-24
Selecting a Style from the Graph Style Gallery

E Under Gallery graphs, select the graph type that you want to apply to your data, and click Next.

The Create Graph - Select Data panel of the Graph Wizard appears.

Figure 4-25
Selecting Data in the Graph Wizard

E Under Data for, select the worksheet columns to plot. If you make a mistake while selecting data, select the correct column in the Selected Columns list.

E Click Finish to create the graph. A graph appears on the page using the applied Gallery graph style.
Modifying Graphs

Use the Graph Properties dialog box to make most graph modifications. To display the Graph Properties dialog box, double-click the graph.

Modifying Plots and Axes

To modify a plot or the axes of a selected graph, click the Plots tab or the Axes tab. Use the Plot or Axis list to specify which plot or axis in the current graph you are modifying. Use the Settings for lists in the Plots and Axes tabs to gain access to many different plot and axis modification options.

Figure 4-26
Using the Graph Properties Dialog Box Plots Tab to modify a graph. You can select a plot to modify from the Plot drop-down list.

Modifying Grids and Planes, Titles and Legends

To modify grids or planes, open the Graph Properties dialog box, click the Graphs tab, and under Settings for, click Grid Lines or Backplanes.
To hide or show graph titles and automatic legends, to hide or show plots, and to make modifications to automatic legends, click the Graph tab, and under Settings for, click Legends.

To apply your changes, click Apply, or click OK to apply your changes and close the Graph Properties dialog box.

**Selecting a Graph or a Plot**

To select a graph or plot:

- View the page window.

- From the menus select:
  
  Tools
  Select Object

A check mark appears next to the menu command.

Figure 4-27
On the Tools menu click Select Object to select objects on the graph page.

- Place the pointer over the desired graph or plot and click.
A selected graph is surrounded by small square handles.

**Alternative Method**

As an alternative method for selecting a graph, from the menus select:

Graph
Select Graph
Your Graph

Figure 4-29
To select a graph on a page, on the Graph menu, click Select Graph, and then click the graph.
Naming Plots

The default plot names are numeric; for example, Plot 1, Plot 2, etc.

**To assign a new name to a plot:**

- On the Standard toolbar, click the Graph Properties button. The Graph Properties dialog box appears.

**Figure 4-30**
*Using the Graph Properties dialog box to rename a graph. Click Rename to open the Rename dialog box.*

- Click the Plots tab.
- From the Plot drop-down list, select the plot to rename.
- Click Rename. The Rename Item dialog box appears.
Creating and Modifying Graphs

Figure 4-31
Type a new name for the plot in the Rename Item dialog box.

- Type a new name.
- Click OK. The Rename Item dialog box closes.
- Click OK to close the Graph Properties dialog box.

Naming Graphs

The default graph names are numeric, and include the graph type; for example, 2D Graph 1, 2D Graph 2, and so on.

To assign a new name to a graph:

- Double-click the graph title that appears above the graph to select it.
- Type the new name, making any font changes as necessary using the Format Text toolbar.
- Click elsewhere on the graph when finished.

Picking Different Data for the Current Plot

To change data columns for an existing plot:

- Click the plot to modify.

Square handles appear over the data points for the clicked curve. Do not click the graph, or you will add a plot to the graph.
On the Standard toolbar, click the Graph Wizard button. The Graph Wizard appears.

**Figure 4-32**
The Graph Wizard displays the available Data Formats for the current plot

> Under Data Format, select a data format, and click Next.

> **If you don’t change the data format for your graph**, your previous column choices appear under Selected Columns. To change column assignments, under Selected Columns, select the desired assignment, then under Data For, select the appropriate column from the worksheet or from the data list.

**Figure 4-33**
You can change the column assignments using the Graph Wizard.

*Note:* To clear a column assignment by double-click it in the Selected Columns list.

> **If you change the data format for your graph**, a single data type is highlighted in the Selected Columns list. To pick data, either click the corresponding column directly in the worksheet, or choose the appropriate column from the Data For list. Use this method to pick X, Y, or Z data, R and theta data, and error bar data, if applicable.
Creating and Modifying Graphs

- **If you make a mistake while picking data**, click the mistaken entry in the Graph Wizard, then choose the correct column from the worksheet.

- Repeat the process for every data column. When you have chosen the data appropriate for your style of plot, click Back to repick data columns, or if applicable, click Next to pick data for additional plots.

- Click Finish to close the Graph Wizard and view the changed graph.

### Changing Graph Type and Style

Change plots using the Graph Wizard; however, once you have defined a plot style and type, the styles and types available for you to apply to the created plot are limited. If the plot you have selected cannot be changed to the plot type or style that you want, use the Graph Wizard to create another plot using the desired style and type.

**To change graph type and style:**

- Click the plot to modify.
  
  Square handles appear over the data points for the clicked curve. Do not click the graph, or you will add a plot to the graph.

- On the Standard toolbar, click the Graph Wizard button.
  
  The Graph Wizard appears displaying the data format of the current plot.

- **To change plot style**, click Back to view the Graph Styles list. Choose from the list of available styles then click Next.
Figure 4-34
You can use Graph Wizard to change the type and style of the graph.

To change the plot type, click Back twice to view the Graph Types list. Choose from the list of available graph types, then click Next.

Click next until you can select a data format again for the new plot type or style from the Data Format list, then click Next. You are prompted to specify which worksheet columns to plot.

If necessary, repick the data columns to plot. Otherwise, click Finish to complete your plot type or style change.

Adding New Plots

Graphs can have multiple plots and plot types. Although most 2D graphs with multiple curves do not require more than one plot, if you want to mix plot types on a single graph you will need to create multiple plots.

Use multiple plots per graph rather than a single plot with many curves only if different plot types or styles are required (i.e., placing a bar chart and a line plot, or a 3D scatter and mesh plot on a graph), if different data formats are required (such as XY and Y only for a scatter plot), or if a curve requires a different axis (scale, range, etc.).

2D graphs with multiple plots can also have multiple axes.
Creating Additional Plots

Use the Graph Wizard, the Add Plot command, or Graph Wizard toolbar button to add a plot to a selected graph.

To add another plot to a graph:

- Click the graph to modify.
  Note: Small square handles surround the graph. Do not click a curve, or you will modify that curve instead.

- From the menus select:
  
  Graph
  Add Plot

The Graph Wizard appears displaying all the graph types. The available styles and types for a new plot are limited depending on the other plot types and styles in the current graph; for example, you cannot add a Polar plot to a 2D Cartesian plot, or vice versa.
Note: If the selected graph cannot accommodate the plot type or style that you want to add, the plot will be created as a new graph. You can move the graph of the new plot over the original graph so that it appears to be in the same graph.

► Select a Graph Type and click Next.

► Select a Graph Style and click Next.

► Select a Data Format and click Next.

► Pick data either by clicking the corresponding column directly in the worksheet, or choosing the appropriate column from the data list. Use this method to pick X, Y, or Z data, R and theta data, and error bar data.

Note: If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list.

► Repeat the process for every data column. When you have chosen the data appropriate for your style of plot, click Back to repick data columns, or if applicable, click Next to pick data for additional plots.

► Click Finish.

Hiding, Showing, and Deleting Plots

Occasionally, you may want to remove a plot from a graph without deleting it. You can hide plots from view without deleting them by using the right-click shortcut menu, or the Graph Properties dialog box.

To hide a plot:

► Right-click the plot.

► On the shortcut menu, click Hide.

The plot is hidden, but not removed.
Creating and Modifying Graphs

Figure 4-36
You can use the right-click shortcut menu to hide graphs.

To show a hidden plot:

- Double-click the graph. The Graph Properties dialog box appears.

Figure 4-37
Showing and Hiding Plots using Graph Properties
Click the Graph tab.

Under Settings for, click Plots.

All plots associated with the current graph are listed under Show/hide plots. A check mark in the check box next to the name of a plot indicates that the plot is displayed.

Clear a check box to hide a plot from view, or select it to show the plot.

To delete a plot:

Select the graph.

From the menus select:

Graph
Delete Plot

Choose the plot you want to delete.

To delete the individual curves of a plot, select a curve on a graph, then press the Delete key.

Sampling Fewer Data Points

If you have a graph with a large number of data points, you can plot only a portion of the column(s) or sample only a portion of the data from the column. This is useful if you are interested only in graphing part of the data, or if you want to increase drawing speed while working on the graph.
To plot only a portion of your data:

- Double-click the graph. The Graph Properties dialog box appears.
- Click the Plots tab.
- Select the desired plot from the Plot drop-down list.
- To plot only a portion of your data, under Data sampling, select Only Rows, and then enter the range to plot.

To sample the column rows by a specified increment, select by and type a number. Typing a 2 samples every other row and reduces the number of rows plotted by 50%, typing a 3 samples every third row, and so on. You can also use the By list to select a number of rows plotted.
Plotting Missing and Out of Axis Range Data Points

You can choose to either plot or ignore bad points. Bad points are either missing values, or data that lie outside the axis ranges.

Figure 4-39
Example of Graphs Plotting Bad Data Points

The graph on the left plots both a missing data point and out-of-range data point. The graph on the right ignores both missing and out of range points.

To ignore missing and out of-range points:

- Double-click the graph. The Graph Properties dialog box appears.
Click the Plots tab.

Select Data from the Settings for list.

Select the desired plot from the Plot drop-down list.

To plot data without missing values, under Ignore, select Missing values. To plot missing values, clear the option.

To plot data without out of range values, under Ignore, select Out of Range Values. To plot out of range values, clear the option.

Click OK.
Creating and Modifying Embedded SigmaPlot Graphs

When you insert a SigmaPlot graph into a document as a SigmaPlot object, some different menus and options are available than when viewing graphs inside SigmaPlot. The following describes the behavior of SigmaPlot features while editing a SigmaPlot graph.

Tip: You can also open embedded graphs inside SigmaPlot, gaining full SigmaPlot functionality.

Creating Embedded Graphs

You can create embedded graphs in any number of ways, including:

- Copying and pasting into an application that accepts embedded objects, like Word, Excel or PowerPoint.
- Using the Insert File or Object menu from an application that accepts embedded objects.
- Running any of the SigmaPlot integration routines (for example, Excel integration).
- Using the Paste to PowerPoint Slide or Insert Graphs into Word Toolbox macros.

Using Embedded Graph Menus and Commands

The following SigmaPlot menu commands are available while editing embedded SigmaPlot graphs:

- **Edit.** Undo/Redo, Cut, Copy, Paste, Paste Link, Insert New Object, Links, Object.
- **View.** Toolbar*, Stop, Refresh, Suspend Redraw.
- **Format.** Text Properties, Line, Fill, Size and Position, Bring to Front, Send to Back, Group, Ungroup, Align, Arrange Graphs.
- **Tools.** Select Object, Text, Draw Box, Draw Ellipse, Draw Line, Draw Arrow.
- **Graph.** Select Graph, Graph Properties, Add to Gallery*, Save as Web Page, Paste to PowerPoint Slide, Paste Setup.
- **Help.** Contents and Index, Tip of the Day, SigmaPlot Tutorial, SigmaPlot Automation, SigmaPlot on the Web, Publication Assistant, About SigmaPlot and more.
*Denotes a command only available from the embedded graph menus.

**Editing Embedded Graphs**

You can choose to edit a SigmaPlot graph from inside the current program, or open the embedded graph inside SigmaPlot.

**Editing "in-place".** To edit a graph in place, double-click it. You can also right-click it and select Edit the SigmaPlot Graph Object. To modify the graph at this point, right-click or double-click the graph to access the different settings.

**Opening graphs.** To open an embedded graph inside SigmaPlot, you can right-click the inactive graph, and click Open the SigmaPlot Graph Object. The graph will open as a graph page and worksheet inside SigmaPlot as an Embedded Page.

*Note:* No notebook window or file is associated with this graph. You can use the File menu to update the source document, or save a copy of the graph off as a new file.

**Viewing Data for an Embedded Graph**

If you need to view or edit the data for an embedded graph, you must open that graph inside SigmaPlot.

**Resizing Embedded Graphs**

The sizing and scaling of the SigmaPlot graph is controlled by the "container" application, that is, the program for the document where the graph has been embedded. However, you can change the size of the page for the embedded graph itself. This is particularly useful if for some reason the graph has been clipped, or you need to rescale and resize the graph or other page objects.

The embedded graph resides on a graph page that has been clipped to just contain the embedded content. You can resize this page if necessary from the Graph menu.

**Creating SigmaPlot Graphs Using Microsoft Excel**

You can launch the Graph Wizard and subsequently create a SigmaPlot graph using Microsoft Excel. Just as you would using SigmaPlot, you can select data from the
workseet. You can also select ranges of data. If you change your data in Excel, the SigmaPlot graph automatically updates.

**To create a graph using Microsoft Excel:**

- On the Excel toolbar, click the SPW button, or on the Excel Insert menu, click SigmaPlot graph. The Graph Wizard appears.
- Select Excel data and create the graph using the Graph Wizard.

**Changing Symbol Type and Other Symbol Options**

You can specify the symbol type used either for the symbols in a single curve, or for all the curves in a plot. The default is to use the same symbol for a single curve and increment symbols for multiple curves.

You can only modify symbols. Plots that normally use symbols are scatter plots, line plots, line/scatter plots, bubble plots, polar plots, box plots, 3D scatter plots, 3D trajectory plots, and ternary plots.

Bubble plots use circles as the default symbol shape. If you choose a different symbol shape, you must change the transform function used to translate area to diameter.

You cannot increment Symbols for single curves, unless there is only one curve within a plot.

**Changing Symbol Type, Size, and Color**

To change symbol attributes:

- Double-click the plot. The Graph Properties dialog box appears.
Click the Plots tab.

From the Settings for list, select Symbols.

From the Plot drop-down list, select the plot to modify.

To change the symbol type for the selected plot, from the Type drop-down list select a symbol type, or choose to increment symbols using the one of the symbol schemes. To create a plot that displays lines only, turn off symbols by choosing (none). For more information, see “Automatically Incrementing Symbols” on page 182.

To change the size of the symbol, move the Size slider, or type a new value in the Size box. By default, all symbols in a plot are the same size. Use symbols of different sizes by entering symbol sizes in a worksheet column, then selecting the column from the Size list.

To change the fill color of symbols for the selected plot, under Fill Color, select a color from the Color list, or choose to increment fill colors using the one of the incrementing schemes. To turn off symbol fills select (none). For more information, see “Using Custom Symbol, Fill, Line, and Color Increments” on page 199.
Select (Custom) to open the Color dialog box to create or choose a custom color. For more information, see “Using Custom Colors” on page 295.

*Note:* Hollow Symbols are symbols that use (none) as the fill color. They are hollow, that is, they are composed of the edge lines only. Lines, error bars, and graph background colors all show through unfilled symbols. This is useful if you have many overlapping data points.

- **To change the edge color of symbols,** from the Edge Color drop-down list, select a color, or select to increment edge colors using the one of the incrementing schemes. To turn off symbol edge color, select (none).

  Use the (Custom) option to open the Color dialog box from which you can create or choose a custom color.

- **To control the color of symbol dots and crosshairs,** or of text used as symbols, use the Edge Color option. If a symbol is filled with black and has a black edge, then dots and crosshairs automatically default to white.

- **To change the thickness of the symbol edge,** move the Thickness slider, or type a new value.

- Click OK.

For more information, see “Using Characters and Text as Symbols” on page 184.

**Automatically Incrementing Symbols**

When incrementing symbols automatically, symbol types are assigned to curves (or points, if the plot has only one curve) in the same order as the column pairs listed in the Graph Wizard. SigmaPlot increments symbols according to the selected scheme.
Both graphs use the Doubles symbol scheme and the Black and White color scheme. The first graph has only one curve; the second has four.

Symbol types and colors appear on the curves of the plot in the same order as the symbol types and colors in the right-click popup menus of the incrementing option. For more information, see “Using Custom Symbol, Fill, Line, and Color Increments” on page 199.

To automatically increment symbols:

- Double-click the plot. The Graph Properties dialog box appears.
- Click the Plots tab.
- From the Settings for list, select Symbols.
- From the Plot drop-down list, select the desired plot.
- To increment symbol types and fill and edge colors automatically, under Symbols, from the Type, Fill Color, and Color lists, select a symbol scheme.
Right-click the symbol type to select the first symbol of the incrementing scheme.

**Note:** Increment schemes do not include (None) as a symbol type.

- **To change the first symbol type or color used in the incrementing sequence,** from the Symbols Type, Fill Color, and Edge Color drop-down lists, select Incrementing. Right-click the selected Incrementing option, and from the shortcut menu, click First Symbol or First Color, then click the symbol type or color to start the incrementing sequence.

- **Click OK.**

**Using Characters and Text as Symbols**

You can use numbers, characters, and text as symbols by entering them in a worksheet column and specifying the column in the Graph Properties dialog box.
Figure 4-44
Using Text from a Worksheet Column as Plot Symbols

For more information, see “Using Different Symbol Sizes” on page 189.

To specify characters as symbols:

- Enter the text you want to use as symbols in a worksheet column in the order you want the curve(s) to use them. To use numeric values as symbols, add a space after each value in the worksheet. You can assign the numbers that appear aligned to the left as symbols.
You can use all the non-keyboard characters available for the default font. To view and access these characters, you can use the Windows Character Map utility. The Windows User’s Guide also lists these special characters, along with the keystrokes required to enter them.

- On the Standard toolbar, click the View Page button.
- Double-click the plot on which you want to use text symbols. The Graph Properties dialog box appears.
Figure 4-46
Change the font for text symbols by right-clicking the Type option and choosing Symbol Font.
► Click the Plots tab.

► From the Settings for list, click Symbols.

► Under Symbols, from the Type drop-down list select the column that contains the text or numeric values you want to use as symbols.

*Note:* The column option does not appear in the Type list unless text or symbols are entered in a worksheet column.

► Under Symbols, right-click the Type box, and from the shortcut menu, click Symbol Font. The Text Properties dialog box appears.

![Text Properties dialog box](image)

*Figure 4-47*  
*Change the font for text symbols by right-clicking the Type option and choosing Symbol Font.*

► Click the Font tab.

► Select another font from the Font drop-down list.

This feature is especially useful if you wish to use Wingdings, Zapf Dingbats, or other iconic or symbolic fonts as a symbol. The Fill Color and Edge Thickness options do not apply to text and characters.

► Click OK.
Using Different Symbol Sizes

By default, all symbols in a plot are the same size. To use symbols of varying sizes, enter symbol size values in a worksheet column, then set symbol size using the Graph Properties dialog box.

Figure 4-48
*Using Symbol Sizes from a Worksheet Column for Plot Symbols*

Symbol sizes are assigned to symbols and curves (or points, if the plot has only one curve) in the same order as the column pairs that form the curves are listed in Graph Wizard.

*To use worksheet values for symbol size:*

- Select the first cell of an empty column in the worksheet containing data for the current plot.
Type the size values to use in the order you want to use them. Since the symbol sizes correspond to symbol diameters or widths, make sure that the symbol sizes you enter are of a reasonable size, that is, small fractions of inches or only a few millimeters or points.

If desired, you can also include the measurement unit for the value. For example, for inches type *in*, for millimeters type *mm*, or for points type *pt*.

![Figure 4-49](image)

*Example of Worksheet with Symbol Sizes Entered in Column 3*

If you omit the measurement unit, the numeric values in the symbol size column are assigned the measurement unit specified in the Options dialog box Page tab.

- Click the toolbar button to view the graph page.

- Double-click the plot.

  The Graph Properties dialog box appears.

- Select the plot that contains the symbols to modify from the Plot drop-down list.

- Use the Size drop-down list to choose the worksheet column containing the symbol size values.
Changing Line Type and Other Line Options

You can change the line type, shape, thickness, and color for all lines in a plot. Because plots can also have multiple curves, you can also increment the line types and colors for any plot with multiple curves.

Lines can only be modified in or added to plots that normally use lines, i.e., scatter plots, line plots, line/scatter plots, polar plots, 3D scatter plots, 3D trajectory plots, and ternary scatter, line, and line/scatter plots.

Changing Plot Line Attributes

To change the attributes of lines in a selected plot:

► Double-click the plot. The Graph Properties dialog box appears.
Click the Plots tab.

Select Lines from the Settings for list.

Under Line style, from the Type drop-down list, choose a line type. For more information, see “Using Custom Symbol, Fill, Line, and Color Increments” on page 199.

Tip: To create a plot that displays symbols only, choose (None) to turn off lines.

To change the thickness of the line, move the Thickness slider, or by type the new value in the Type box.

Choose a line shape from the Shape drop-down list.

To change the color of the lines in the selected plot, select a color from the Color drop-down list, or choose to increment line color using one of the incrementing schemes. Select (None) to create transparent lines. This in effect turns them off.

Use (Custom) to create or choose a custom color. For more information, see “Using Custom Colors” on page 295.
To control the layering of plot lines, use the Layering drop-down list to place lines behind or in front of plot symbols.

*Note:* Hollow symbols (None) will always show plot lines.

Click OK.

**Automatically Incrementing Lines**

Line types and colors appear on the curves of the plot in the same order as the line types and colors in the right-click popup menus of the incrementing option. There are two line type incrementing schemes: Incrementing and Monochrome. There are nine different incrementing color schemes to choose from for line colors.

Figure 4-52

*Each of these graphs uses the Incrementing option, but are assigned different starting line types.*

For more information, see “Using Custom Symbol, Fill, Line, and Color Increments” on page 199.
To use automatically incrementing line types:

- Double-click the plot. The Graph Properties dialog box appears.

Figure 4-53
Graph Properties Dialog Box Plots Tab Right-click Menu

- Click the **Plots** tab.

- Select **Lines** from the **Settings for** list.

- Select a plot from the **Plot** drop-down list.

- From the **Type** and **Color** drop-down lists, choose a line scheme.

  *Note:* Windows is limited in its ability to supply the true colors for lines by the number of system colors available. For the best representation of true line colors, set your display to either HiColor (16-bit) or TrueColor (24-bit).

- Right-click the incrementing option selected in the **Type** and **Color** drop-down lists, and from the shortcut menu, select **First Line** or **First Color**.

- Choose **First Line** or **First Color** from the shortcut menu.
Choose the line type or color to start the incrementing sequence.

Use the Line Thickness, Shape, Line Color, and Layering options to modify the lines, if necessary. For more information, see “Changing Plot Line Attributes” on page 191.

Click OK.

Changing Patterns and Fill Colors

You can modify and increment the background colors, patterns, and pattern colors used for plots.

You can only modify or add fill colors and patterns to plots that normally use fills, i.e., area plots, bar charts, box plots, pie charts, 3D bar charts, and ternary plots.

Changing Plot Fill Patterns and Colors

Modern laser printing and color slides have removed much of the need for using hatch marks and other line patterns for bar and pie charts. Use gray shades and colors whenever possible.
Figure 4-54
Example of a Bar Chart with a Gray Scale Fill Color Scheme

To change fill attributes:

- Double-click the plot.
  
The Graph Properties dialog box appears.
Click the Plots tab.

From the Plot drop-down list, select the plot that contains the fills to modify.

From the Settings for list, select Fills.

To change the background fill color, under Fill Color, from the Color list, select a color, or choose to increment fill colors using the one of the incrementing schemes to change the background fill color.

To turn off background fills, select (None).

To create a custom color, select (Custom). For more information, see “Using Custom Colors” on page 295.

To change the fill pattern and density for the selected plot, under Pattern and Edge, from the Pattern list, select a fill pattern, or select to increment fill patterns using one of the fill schemes. To turn off fill patterns, select (None).

To change the thickness of the pattern lines and edges, move the Thickness slider.
Chapter 4

» Click OK.

Automatically Incrementing Chart Fills

You can increment fills for bar charts automatically using the Graph Properties dialog box. When incrementing fills, different fill colors and patterns are assigned to each bar, box and pie chart slice in the plot. If you are incrementing fills for a grouped bar chart fill colors and patterns are assigned to each group in the plot in the same order the column pairs forming the groups are listed in the Graph Wizard. For more information, see “Using Custom Symbol, Fill, Line, and Color Increments” on page 199.

There are two file type incrementing schemes: Monochrome and Incrementing.

There are nine different incrementing color schemes to choose from for fills.

To use automatically incrementing fills:

» Double-click the plot. The Graph Properties dialog box appears.

Figure 4-56
Graph Properties Dialog Box Plots Tab Right-click Menu

» Click the Plots tab.
Creating and Modifying Graphs

From the Plot drop-down list, select the plot that contains the fills to modify.

From the Settings For list, select Fills.

Select a scheme from the Color and Pattern drop-down lists. Colors and patterns appear in the bars, boxes, or pie chart slices of the plot in the same order as the right-click shortcut menu.

Right-click the incrementing option and from the shortcut menu, select First Pattern or First Color, and then select the pattern or color to start the incrementing sequence.

Click OK.

For more information, see “Changing Plot Fill Patterns and Colors” on page 195.

**Using Custom Symbol, Fill, Line, and Color Increments**

When using a series of incremented symbols, fills, lines, or colors you have defined, the increment scheme is assigned to curves or points in the same order the columns plotted for the curves are listed in the Graph Wizard.
To define and apply a series of incremented symbols, fills, lines, or colors:

- View the worksheet.
- From the menus select:
  - Insert
  - Graphic Cells

The Insert Graphic Cells dialog box appears.
Click the Colors, Lines, Symbols, or Patterns tab.

Note: Using symbol types from a column specifies the symbol shape only. If you want to change the symbol fills, create another color column and use it as the symbol fill colors. Typically, white is used for hollow symbols, and black for solid symbols.

Select the first cell in an empty column in the worksheet.

Double-click the color, line, symbol, or fill pattern in the Insert Graphic Cells dialog box you want to place in the cell.

Note: Do not mix graphic cell types within the same column; for example, place colors in one column, symbols in a different column, fills in yet another column, and lines in a fourth column. However, you can use multiple columns to define several different increments of the same graphic cell type. For example, you can have several columns containing colors of differently ordered increments. The item appears in the worksheet cell.

Continue adding to the column, in the order you want the curves to use the colors, lines, symbols, or patterns. The order of the curves is the order in which they appear in the Selected Columns drop-down list in the Graph Wizard.
Close the Insert Graphic Cells dialog box.

Click the View Page button.

Double-click the plot. The Graph Properties dialog box appears.

**Figure 4-59**
Assigning Custom Symbol Colors in a Worksheet Column to a Plot

From the Plot drop-down list, select the plot to modify.

From the Settings for list, select Fills, Area Fills, Symbols, or Lines, depending on what you have defined in the worksheet.

Choose the name of the column which contains the appropriate graphic cells from the Symbols Type, Fills Foreground Pattern, or Lines Type, or Color drop-down lists.

If you are applying a large number of colors or other property schemes, you may wish to turn off the automatic legend, which will attempt to display your first 25 different data points. For more information, see “Editing Automatic Legends” on page 286.

Click OK.
Changing Bar and Box Widths and Spacing

Control the amount of space between bars and boxes, and between grouped 2D and 3D bars by adjusting the percent of the maximum possible widths of both the individual bars and the bar groups.

Figure 4-60
*From left to right: bar charts with a group spacing of 50% and relative thickness of 100%, group spacing and relative thickness both set to 66%, and both settings set to 100%.*

To control bar and box width and spacing for bar charts and box plots:

- Double-click the plot to modify. The Graph Properties dialog box appears.
Click the Plots tab.

From the Settings for list, select Widths.

To change the width and spacing between bars for all bar charts and box plots, move the Bar thickness slider. The wider the bars or boxes, the less space between them. The narrower the bars or boxes, the more space between them.

To change the width and spacing between groups of 2D and 3D bars, move the Group spacing slider. This option is only available for grouped and 3D bar charts. SigmaPlot sets grouped bar widths and spacing to as wide or as narrow and as far or as close as possible given the corresponding spacing or width setting.

To set a constant width for all bars or boxes, from the Width drop-down list, select Uniform. This is the default setting. If the bars are set to Uniform, the Bar thickness setting has the same effect on all bars. For more information, see “Uniform versus Variable Bar Widths” on page 206.
To set potentially uneven widths for bars and boxes, select from the Width drop-down list, select Variable. If the constant column values are uneven, the bars will vary in width according to the corresponding axis values.

Change bar widths according to the percent of their total widths, if the bars are set to Variable, so that wide bars are more affected than thin bars.

*Note:* Bars created with a single plot will not overlap. However, you can create bars using separate plots and overlap them. For more information, see “Spacing Bars from Different Plots” on page 327.

To create a needle plot, move the Bar thickness slider to set bar widths to the narrowest possible widths.

Figure 4-62
*To make a histogram needle plot, create a bar chart and set the Bar Thickness to Needle.*

![](histogram.png)
To change bar alignment, from the Align drop-down list, select either Center, Left, or Right. By default, bar chart bars are centered around the data point. Use Align to alternately draw the bars right or left aligned with the data points.

Figure 4-63
From Left To Right: Bar Charts with Alignments to the Left of the X Points, to the Right of the X Points, and Centered over the X Data Points

Click OK.

Uniform versus Variable Bar Widths

Uniform bar widths set all individual bars to the same width, using the width of the narrowest bar. If the values which the bars are plotted along are unevenly incremented, the bar widths still remain constant.

Variable bar widths set the widths to be as wide as possible, as determined by the Bar Thickness and Group Spacing settings. If the values which the bars are plotted along are evenly incremented, this option has no effect. However, if the values which the bars are plotted along are unevenly incremented, the bar widths will vary according to their corresponding values.

Figure 4-64
Adding and Modifying Drop Lines

Use drop lines to produce dot plots and other types of graphs which connect data points to their axis values. You can add drop lines from plotted data points to either or both axes in a 2D scatter, line, or line/scatter plot, or to any or all back planes in a 3D scatter or trajectory plot. Drop lines are drawn for every curve in a plot.

Figure 4-65
The graphs on the left are examples of 2D plots with drop lines to the Y and X axes. The graph on the right is an example of a 3D graph with drop lines to all axes.

Drop lines always fall toward the minimum of a range; for example, if a Y axis range were reversed, a drop line to the X axis would fall to the top of the graph rather than the bottom.

Use the Drop Lines settings in the Graph Properties dialog box Plots tab to create new drop lines, and to modify existing drop line type, thickness, and color.

To add or modify drop lines for a selected plot:

- Double-click the plot to modify.

The Graph Properties dialog box appears.
Click the Plots tab.

From the Plot drop-down list, select the plot that contains the drop lines to modify.

From the Settings for list, select Drop Lines.

Select the X or Y drop-line check box. Drop lines are added to any and all planes or axes that are selected.

From the Type drop-down list specify the type of line to use for selected drop lines.

To adjust line thickness, move the Thickness slider, or type the new value in the Thickness box.

To set drop line color, select a color from the Color drop-down lists. Select any of the listed colors, or select (Custom) to select or define a custom color. For more information, see “Using Custom Colors” on page 295.

Click OK.
Drop Lines for a Single Point

You can use drop lines to indicate the position of a single point. To show a single drop line, create a second plot which graphs only the desired data point, then add drop lines to the single-point plot. If you do not want the symbol to show for the point, set the symbol type to (None).

Figure 4-67

Plotting and Solving Equations

Use the Plot Equation dialog box to create and plot equations defined using the Transform language. You can use one of over 100 built-in equations, or create an equation of your own and save it to a notebook.
To create and plot an equation and save it to a notebook:

- With the worksheet in view, from the menus select:
  
  Graph
  
  Plot Equation

The Plot Equations dialog box Equation tab appears, either with Untitled or the name of the last used equation in the Name field.

Figure 4-68
Plot Equation Dialog Box Equation Tab and Functions Palette

- To manually enter the equation, from the Name drop-down list, select Untitled.

- If necessary, delete the existing equation in the f = field, and then either type the equation, or click the Functions Palette button to open the Functions Palette. The Functions Palette provides immediate access to some of the most frequently used functions.

  You can also select one of the last ten used functions from the Name drop-down list.
  For more information, see “Plotting Saved Equations” on page 215.
From the Variables group box, select either 2D or 3D.

Set the independent variables using the Name, Minimum, Maximum, and Intervals boxes.
- **Name.** Type the name of the independent variable(s).
- **Minimum and Maximum.** Type the extent of the range of values for the corresponding independent variables.
- **Intervals.** Set the number of intervals for sampling independent variables over a specified range.

*Note:* You can also select a column in the worksheet. The range of that column appears in the Minimum and Maximum edit boxes.

To set the equation parameters, click the Options tab. For more information, see “Setting Equation Parameters” on page 214.

Click Add As. The Add As dialog box appears.

*Figure 4-69*  
*Add As Dialog Box*

Type the name of the equation in the Equation Name edit box.

Click OK. The equation name appears in the Name drop-down list on the Equation tab.
Figure 4-70
Plot Equation Dialog Box Equation Tab

► Click Plot. A graph page appears with the plotted equation, and the equation values appear in the worksheet.

► Click Close to close the dialog box.

If desired, you can add plot an equation and add it to the existing graph, or plot a new equation on a new graph page.

**Plotting Equations onto Existing Graphs**

Use the Plot Equation dialog box to plot equations onto existing graphs. This is especially helpful if you want to see how the curves change by modifying the parameters.

**To plot the equation:**

► Select the graph.

► From the menus select:

Graph
   Plot Equation

The Plot Equation dialog box appears.
Creating and Modifying Graphs

Figure 4-71  
Plot Equation Dialog Box Equation Tab

Either manually enter the equation in the \( f = \) edit box, or choose an existing equation, or use the same equation as used previously if you want to change the parameters.

To set the equation parameters, click the Options tab. For more information, see “Setting Equation Parameters” on page 214.

Figure 4-72

If you don’t want to create a second graph page, select Add to current graph and clear Create new graph.

Click ThePlot, plot appears on the current graph.
Click Close to close the Plot Equations dialog box.

**Setting Equation Parameters**

All equations that you create or use from the Standard.jfl library have editable parameters. You can either enter the parameters or modify them using the Graph Equation dialog box Options tab.

**To set equation parameters:**

- With the worksheet in view, from the menus select:
  
  Graph
  Plot Equation

The Plot Equation dialog box appears.

*Figure 4-73*
*Plot Equation Dialog Box Options Tab*

- Click the Options tab.

- In the Parameters box, enter or edit the parameters.
  
  Enter parameters with the name of the parameter first, followed by an = sign, and then the value, i.e. a=3 or b=7.231
To assign a value to the next parameter, press Enter.

Click Plot to plot the equation.

**Plotting Saved Equations**

Each equation you create is saved in the Standard.jfl library. Select the equation to plot from the Library tab of the Plot Equation dialog box.

You can also select one of the last ten equations plotted from the Name drop-down list of the Plot Equation dialog box Equations tab.

*To plot an equation using the Library tab:*

- With the worksheet in view, from the menus select:
  - Graph
    - Plot Equation

The Plot Equation dialog box appears.

Figure 4-74
*Plot Equation Dialog Box Library Tab*

- Click the Library tab.

- Select an equation category from the Equation category drop-down list. The items that appear in the Equation category drop-down list are sections in the Standard.jfl library.
Below, in the Equation Name list, are items that appear under that section name in the notebook.

- Select an equation from the Equation name list.

- Click Select. The Equation tab appears with the selected equation displayed in the Name drop-down list.

Figure 4-75
Plot Equation Dialog Box Equation Tab

Some of the settings for SigmaPlot’s built-in equations in the Standard.jfl library are read-only. To modify a built-in equation, click Add As to create an equation based on the built-in equation.

- Click Plot.

A graph page appears with the plotted equation, and the equation values appear in the worksheet.

- Click Close to close the Plot Equation dialog box.
Solving Equations

Use the Equation Solver on the Plot Equations dialog box to evaluate mathematical expressions for functions and to solve equations.

The Equation Solver uses the expression entered in the Equation tab on the Plot Equations dialog box as the basis for its results. This expression then appears on the Solve tab for evaluation.

To solve an equation:

► From the menus select:
  - Graph
  - Plot Equation

The Plot Equation dialog box appears.

Figure 4-76
Plot Equation Dialog Box

► Click the Equation tab, and enter an equation in the f = box.

You can also select one of the last ten used functions from the Name drop-down list, or you can choose any of the built-in parameterized equations used by the Regression Wizard. Select these equations from the Library, too. For more information, see “Plotting Saved Equations” on page 215.
Click the Solve tab. The entered equation appears in the $f =$ box on the Solve tab.

**Figure 4-77**
*Solve Tab of the Plot Equation Dialog Box*

Under Options, select the mode of operation. You can select from one of the following:

- **Evaluate** $f$ at. Enter a numerical value for each variable that occurs in the expression in the boxes that appear at the bottom of the dialog box.

- **Solve equation for $x$ within range.** Enter a numerical value into the box which appears to the left of the expression (the default value is 0) to complete the definition of the equation. You must also enter limits for a range of values of the equation variable. The default range limits are taken from the values entered on the Equation tab.

The Solver is only available for expressions containing a single independent variable, although any number of parameters can be present.

Under Options, click Evaluate or Solve, depending on the selected mode of operation. The resulting value or the equation solutions that lie between the prescribed ranges appear in the Results box.
The Results box keeps a tally of all evaluation and solving results relative to the given expression. If you alter this expression on the Equation tab or select a new plot expression, the Results box appears with no text. Modifying the expression also clears the other boxes on the Solve tab.

- Click Copy to place the entire contents of the Results box onto the Clipboard.
- You can annotate the results in the Results box. All annotations are preserved when you perform further computations using the same expression.
- In addition to displaying the results of evaluating functions and solving equations, the Results box also displays estimates for any singularities found in the course of solving an equation. Singularities are values of the expression variable (in the given range) where the expression is undefined. When you perform a computation, a label precedes the values in the Results box to indicate the type of output displayed.
Equation Solving Guidelines

Sometimes the solutions to an equation \( 0 = f(x) \) are not obvious and the basic methods for solving it are unavailable. If this is the case, then the simplest way to estimate the location of solutions is to:

- Using the Plot Equations dialog box, graph the function equation \( y = f(x) \).

- Observe where the graph intersects the x-axis.

This technique aids in determining range limits for the independent variable in the Function Solver (Solve tab of the Plot Equation dialog box).

If the distance between two solutions of an equation is small relative to the size of the range, then the Function Solver may not return both solutions. The resolution of the solutions is approximately two orders of magnitude less than the size of the range. You can obtain higher resolution by adjusting the range limits to reduce the range size.

There is particular difficulty, due to roundoff error, in determining solutions to \( 0 = f(x) \) at points where the graph of \( y = f(x) \) does not cross the x-axis, but lies on one side of it.

An example of this situation is the graph of \( y = x^3 + x^2 \) at \( x = 0 \). Although in many cases, as with the above equation, the Function Solver provides the solution, in some cases, however, the solution will not be found and recorded in the Results box.

If you suspect that there is such a solution and the Function Solver does not find it, then try the following technique for approximating the solution:

- Alter the value for the left side of the equation by a small amount.

- Re-solve the equation.

This is equivalent to slightly shifting the graph of the equation up or down until it lies on both sides of the axis. In general, the Results edit box then reports two solutions that are very close together. As smaller amounts are used to adjust the left side of the equation, these two solutions are seen to converge to one solution.

As an example, try solving the equation \( 0 = \sin(2x) \cdot \cos(3x) \) over the range from \( x = 1 \) to \( x = 2 \). The Function Solver will indicate that there are no solutions. Using the above technique will yield solutions that are close to the true solution of \( \pi/2 \).
Spurious Solutions

A less frequent problem involves the appearance of spurious solutions. Due to the limits of floating point numbers, the value of an expression f(x) at \( x = a \) might compute to zero even if \( x = a \) is not a true solution to \( 0 = f(x) \). This situation commonly arises when the graph of \( y = f(x) \) is very "flat" near a point where it intersects the x-axis.

For example, consider the equation \( 0 = x^{201} \). If you solve this equation over the range from \( x=0 \) to \( x=1 \), then the Function Solver will return 13 solutions even though the only true solution is \( x = 0 \). This is because each of 13 results raised to the 201st power is equal to zero in the machine’s floating point representation.
Chapter 4
Graph Page Basics

Use *Graph Pages* to display and modify graphs that plot data from your worksheets. You can create as many graph pages as you wish per worksheet. New graph pages are associated with the current worksheet, and are placed in the current notebook section. This chapter covers:

- An overview of graph pages (see page 223).
- Working with page objects (see page 226).
- Adding another graph to a page (see page 232).
- Zooming in and out (see page 234).
- Using graph pages as templates (see page 237).
- Cutting, copying, and pasting graphs and other objects (see page 245).
- Dragging and dropping graphs (see page 256).
- Hiding and deleting objects from the page (see page 257).
- Modifying object colors and lines (see page 262).
- Moving and sizing graphs and objects (see page 266).
- Aligning page objects (see page 278).
- Editing text (see page 279).
- Working with automatic legends (see page 283).
- Changing graph page format (see page 290).
- Using custom colors (see page 295).

About Graph Pages

Graph pages are true graphical representations of a printed page that contain graphs, text, and other drawn and pasted objects. You can select objects on graph pages and modify them using the *Graph* and *Object Properties* dialog boxes, and with the *Graph* and *Drawing* toolbars. You can manipulate all objects graphically using your mouse.
A page can contain an unlimited number of graphs and other objects, and you can create an unlimited number of pages for each worksheet. You can also paste graphics, OLE (Object Linking and Embedding) objects, and other objects onto a page.

Graph pages are created in several ways. You can create a graph page as a notebook item, or by using the Graph Wizard, the Graph Style Gallery or by templates. For more information, see “Creating Graphs” on page 151.

**Setting Page Options**

Control graph page properties are using the Options dialog box Page tab. To open the Options dialog box:

- From the menus select:
  Tools
  Options

- The Options dialog box appears.

- Click the Page tab to set the graph page options.

**Exporting Graphs and Pages**

You can export SigmaPlot graphs and graph pages to other files formats.

*To export a graph or graph page:*

- Select and view the graph page. If you want to export specific graph(s), select the graphs you want to export to a file.

- From the menus select:
  File
  Export

The Export File dialog box appears.
Enter the file name, directory and drive for the export file destination.

Click Export. If you chose one of the graphic file formats, a secondary dialog box appears, asking you to enter some graphic format information.

Figure 5-1
Export Tagged Info File Dialog Box

Enter the desired DPI and Color Resolutions; for EPS files, these setting only affect the resolutions of the TIFF header, not the actual PostScript resolution. For metafiles, this setting affects only 3D graphs.

The higher the DPI and Color resolutions, the better quality the image, but also the larger the file. Limit the DPI and Color resolutions to the capability of the intended output device. For example, if you are going to create 600 dpi slide output, set the DPI resolution no larger than 600.

If you want to export only the selected graph(s) or objects, select Export selected only.

Click OK to create the exported file using the specified file name and graphic resolutions, if applicable.
Chapter 5

Printing Graph Pages

You can print any graph in a SigmaPlot notebook.

To print a graph page:

► Select and view the page window.
► Click the Print button to print the page using all the default settings.

To set printing options before you print the graph page:

► From the menus select:
  File
  Print

The Print dialog box appears.

► Click Properties. The printer Properties dialog box appears.

► Click OK when you are satisfied with the printer properties settings. The Properties dialog box closes.

  Note: The Properties dialog box options vary from printer to printer.

► Click OK to print the report.

Working with Page Objects

Using SigmaPlot menu commands, dialog boxes, and wizards you can create and modify graphs and other page objects.

Graph Wizard

The Graph Wizard guides you through a series of dialog boxes to select the type and style of graph, and to select worksheet data for plotting. After you create the graph, you can open the Graph Wizard to add or modify plots and axes.
**Graph Properties**

The *Graph Properties* dialog box customizes the plots, axes, grids planes, titles and legends of your graph. Use it for more advanced modifications to your graph.

To open the Graph Properties dialog box, double-click anywhere on the graph, or on the *Graph* menu, click *Graph Properties*. The *Plots*, *Axes*, and *Graph* tabs offer many customizing features. The tab that appears depends on where you click on the graph. Click the Help button to learn more about the specific options and controls for each tab.

**Object Properties**

The *Object Properties* dialog box modifies many graph attributes including drawn objects. Use the *Object Properties* dialog box to make simple modifications to the objects and graphs. The *Line* and *Fill* tabs change fill patterns, lines of your plots and objects. The *Size and Position* tab changes position, scaling and size for all selected objects.

To open the Object Properties dialog box, select an object on the graph page, right-click, and then on the shortcut menu, click *Object Properties*.

**Text Properties**

The *Text Properties* dialog box modifies font and paragraph text attributes for all text on a page. Use the Text Properties dialog box to change attributes of non-editable text, as well as attributes for multiple text labels, and making global text changes.

Selecting text properties with no selected text sets the default attributes for new text labels.

To open the Text Properties dialog box, on the *Format* menu, click *Text Properties*.

**Selecting Page Objects**

When you select text, drawn objects, or individual elements on the graph page, and then double-click, you open the dialog box specific to that element.

To select a graph element, make sure you are in selection mode by clicking the *Page* toolbar *Select Object* button, or choose the *Tools* menu *Select Object* command, or press Ctrl+B. A check mark next to this command indicates that you are in selection mode.
Selected objects are surrounded with square handles; selected axes and text are surrounded by dotted lines.

Figure 5-2
Selecting an Axis

Selecting Multiple Objects

To select multiple objects, hold down the Shift key while clicking objects, or drag a window completely around the objects you want to select. When you select multiple objects, only the last selected object has solid black handles; the other objects have hollow handles.
You can edit, copy, paste, move, size and scale, delete or hide all selected page objects, including graphs, text, drawn objects, and pasted objects.

The following table summarizes the results of double-clicking various objects on the graph page.

<table>
<thead>
<tr>
<th>Select:</th>
<th>By:</th>
<th>Opens:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphs</td>
<td>Double-click</td>
<td>Graph Properties dialog box/Plots tab</td>
</tr>
<tr>
<td>Plots</td>
<td>Double-click</td>
<td>Graph Properties dialog box/Plots tab</td>
</tr>
<tr>
<td>Axes</td>
<td>Double-click</td>
<td>Graph Properties dialog box/Axes tab</td>
</tr>
<tr>
<td>Tick marks</td>
<td>Double-click</td>
<td>Graph Properties dialog box/Axes tab</td>
</tr>
<tr>
<td>Tick labels</td>
<td>Double-click</td>
<td>Graph Properties dialog box/Axes tab</td>
</tr>
<tr>
<td>Axis titles</td>
<td>Double-click</td>
<td>Edit manually</td>
</tr>
<tr>
<td>Legends</td>
<td>Double-click</td>
<td>Edit manually</td>
</tr>
<tr>
<td>Fills or Lines</td>
<td>Right-click</td>
<td>Graph Properties dialog box/Plots tab</td>
</tr>
</tbody>
</table>

**Selecting Objects That Overlay One Another**

To select objects that overlay one another, press either the Alt-Click or Alt-Arrow keys.
To use Alt-Click:

- Click the object that you want to select, which may be covered by another object, and then press the Alt key.

- While holding down the Alt key, repeatedly click the object until it is selected under the position that you initially clicked.

  As you repeatedly click you will cycle through all objects that overlay one another.

To use Alt-Arrow:

- Click the object that you want to select and then press the Alt key.

- While holding down the Alt key, repeatedly press one of the arrow keys (up, down, right, or left) to select the object of interest. Use of different arrow keys will cycle through the objects in a different order.

  Note: It is important that you click on top of the object that you eventually wish to select. For example, selecting the intersection of the horizontal and vertical grid lines slightly below the symbol will result in a different sequence of selectable objects, i.e. vertical grid line, right y-axis, horizontal grid line and plot error bars. It is not possible in this case to select the symbol.

  The figure below shows a graph with multiple overlaid objects. The symbol has been clicked and the vertical grid line has been selected. To select the symbol, for example, click the center of the symbol as shown in the figure. In this case the top object is the vertical grid line so it is selected. Repeated Alt-clicking will cycle through the four overlaid objects: vertical grid line, plot symbol, right y-axis and plot error bars. With the plot symbol selected, you might use the color panel on the Graph Toolbar to change the plot symbol color.
**Real Time Mouse-Over Feedback**

You can obtain numeric data values from your plots by placing the mouse cursor over the data points. To do this click on the particular plot to select it. Then move the mouse cursor over the data points. When the cursor is over a data point the cursor background color is cyan and you can read the numeric value from the cursor window. When the cursor is not over a data point you can read the position of the cursor using the $x$ and $y$ scales for that plot.
Figure 5-5
The plot with the blue circular symbols has been selected. The cursor shows the y-axis value (price) to be 37.07 for the last data point. Select other plots (red, green) to obtain their values.

Turning Off Mouse Over Feedback

If you would like to disable this feature, from the menus select:

Tools
Options

► Click the Page tab.
► Clear the option Show data values.

Adding Another Graph to a Page

You can add additional graphs to the current graph page by:

► Creating a new graph onto the current page (see page 233).
► Copying a graph to the same page (see page 233).
► Copying and pasting a graph from another page (see page 233).
Creating a New Graph for the Current Page

If you want to add a graph to a page by creating a new graph:

- Add the data for the new graph in the worksheet associated with the current graph page.
- View the active graph page.
- From the menus select:
  - Graph
    - Create Graph

  or

  Select a graph from one of the Graph toolbars,
  or
  Click the Graph Wizard button.

Copying a Graph on the Same Page

One of the quickest and the easiest ways to add a second graph is to copy the one you have already created, then modify it.

Copying and Pasting a Graph from One Page to Another

You can copy a graph from a graph page within the current notebook section, or from a different notebook section.

To copy a graph from one page to another:

- Select the graph you want to copy.
- Press Ctrl+C.
Make the destination page the current page either by opening it, or if it is already open, select the graph page name from the Window menu. A check mark next to the page name indicates that it is the active window.

*Note:* If the destination page is in a different notebook than the source page, you must close the source page, and any other open work in the source notebook.

Press Ctrl+V to paste the graph.

The graph appears on the current page, and the graph data appears in the worksheet associated with the current page. Another method is dragging and dropping. For more information, see “Dragging and Dropping Graphs” on page 256.

**Zooming In and Out**

Use View menu commands to control display of the worksheet window. You can view the page at several different levels of magnification, magnify the page centering on a specified page location, or choose a completely unobstructed view of the page.

**Viewing the Full Page**

To view the full page without toolbars, title bars, scroll bars, or the status bar:

- From the menus select:
  
  View
  
  Full Screen

  The page appears without any obstructions.

- **To return to normal view of the page,** press any key on the keyboard. The screen returns to its normal appearance.

**Magnifying the Page**

There are three ways to change the magnification of the entire graph page:

- Select a zoom level from the toolbar drop-down list. You can also enter a custom zoom anywhere between 10 to 2500.
Click the Custom Zoom button on the Standard toolbar to zoom in on a specific region of the page. The pointer changes to a magnifying glass; select a region on the page by dragging the mouse, then release the mouse button. The region is zoomed to the selected area.

Figure 5-6
Using the Zoom Pointer to Select a Region on the Page

Use keyboard shortcuts while viewing the page window. The zoom keyboard shortcuts to view the page are:

- At 50% actual size, press Ctrl+5.
- At 100% actual size, press Ctrl+1.
- At 200% actual size, press Ctrl+2.
- At 400% actual size, press Ctrl+4
- Entire page, press Ctrl+F
- Magnified for a specific region, press Ctrl+U.

Using the Zoom Dialog Box

Use the Zoom dialog box to change the zoom level to fixed or custom levels.
To change the zoom:

- From the menus select:
  
  View
  Zoom

The Zoom dialog box appears.

Figure 5-7
The Zoom Dialog Box

- Choose the desired zoom level to fit the page to the window, or to zoom to a full screen view. Select Custom and move the slider or enter a specific zoom level to set a percentage of magnification.

Figure 5-8
Graph Page Zomed to 200%
Using Graph Pages as Templates

*Graph page templates* simplify graph and graph page creation and modification. You can use templates to create pages and graphs with preset properties. For example, if you need to create a set of slides, you can open pages that are already set to attributes for slides.

*Note:* Never use templates to add a graph to a page.

*Template pages* are ordinary graph pages. Any graph page can act as a template page if it is copied to a section or used from the File menu New command to create a new page. All attributes from the page - size, color, margins, and *orientation* - are retained. Any graphs and other objects on the page are also duplicated.

*Template graphs* automatically plot the worksheet column data that was selected when the graph was created.

When applying a page to a worksheet, make sure your data is already arranged as required, or re-pick the data for the graph after applying the template.

You can determine which columns are plotted by either looking at the worksheet footers, or you can open the *Graph Properties* dialog box for the template graph, and click the *Plots* tab, and then under *Settings for*, click *Data*.

*Note:* Graphs created by templates can be modified like any other graph. For more information, see “Modifying Graphs” on page 163.

Applying Templates

There are three methods for using pages as templates:

- **Using a template from the New Page command.** Creates a new page with attributes from the template applied. For more information, see “Creating a New Page with Attributes from a Template” on page 238.

- **Copying a graph page from one notebook section to another.** Creates a new page in a section, using the data in the existing worksheet for graphs. For more information, see “Copying a Graph Page to use as a Template” on page 238.

- **Overwriting an existing page.** Replaces the existing page. For more information, see “Overwriting an Existing Page” on page 239.
Creating a New Page with Attributes from a Template

- From the menus select:
  
  File
  New

  The New dialog box appears.

  Figure 5-9
  Graph Page Zomed to 200%

- Select Graph Page from the New drop-down list.

- Select the type of graph page you want to open from the Type scroll-down list.

- Click OK.

Copying a Graph Page to use as a Template

The best method of applying a page template to a worksheet is to use an existing graph page as a template. The copied page acts as a template using the worksheet in the new section. For more information, see “Copying and Pasting Items in the Notebook Manager” on page 41.

If you plan to copy a page, set up your worksheet so that the data is in the appropriate columns before applying the template. You can also change the columns to plot after applying a template by selecting the plot, opening the Graph Properties
dialog box, and clicking the Graph Wizard button. For more information, see “Picking Different Data for the Current Plot” on page 167.

**Overwriting an Existing Page**

When you apply a template to an existing graph page, all features of the existing page are lost.

*To apply a template to an existing page:*

- Make the graph page the active window.
- From the menus select:
  
  File
  
  Templates

The Templates dialog box appears.

Figure 5-10
The Templates Dialog Box

- Select a template from the Templates list.
- Click Apply.
To apply a template from a different notebook template file:

- Make the graph page the active window.
- From the menus select:
  
  File
  Templates

  The Templates dialog box appears.
- Click Browse.
- Select the path and file name of the desired SigmaPlot Notebook or template file.
- Click Open.
- Select a template from the Templates list in the Templates dialog box.
- Click Apply.

Templates and Notebooks

Store templates as pages in notebook files with the extension .jnt. You can open and edit template notebooks like any other notebook file; the different extension is only provided for organizational purposes.

A sample template notebook, Template.jnt, is provided with SigmaPlot, and is set as the initial template source notebook. For more information, see “About SigmaPlot’s User and Program Files” on page 8.
Template.jnt is the default source for new pages. It contains both pages with no graphs and pages with graphs.

You can modify existing pages or add your own graphs or graph pages to Template.jnt. Open the file, open the page you want to modify, then save your changes. You can add files by creating new pages or by copying pages from your notebooks to Template.jnt. For more information, see “Adding Another Graph to a Page” on page 232.

You can also create your own template notebook containing your own customized graph pages. Save template notebooks as SigmaPlot Template (.jnt) files, then specify that file to be your Template File.
Changing the Page Created with the New Page Button

The New Page toolbar button automatically uses whichever page is titled Normal as the source for new pages. If you want to modify the attributes of your new page, open and modify the Normal page, or replace it with the desired page.

If there is no page named Normal in your template file, the page is formatted according to settings found in the spw.ini file. For more information, see “About SigmaPlot’s User and Program Files” on page 8.

Changing the Template File Used for New Pages

SigmaPlot automatically uses the template notebook when you open a graph or graph page. Set the file name in the General tab of the Options dialog box.

To change the source file template:

- From the menus select:
  - Tools
    - Options

- On the Options dialog box, click the General tab.
Figure 5-12
Options Dialog Box General Tab

Type the path and file name of the desired template file in the Template File field.

Click OK. The notebook becomes the default template source.

Note: If a valid default template source file is not specified, a default page is created instead. This page is a letter-sized, white portrait page by default.
Adding New Pages to Template.jnt

You can add a previously created page to the Template.jnt notebook.

**To add a page to Template.jnt:**

- From the menus select:
  
  File
  
  Open

  The Open dialog box appears.

- Select Template Notebook from the Files of type drop-down list.

- Select Template.jnt from the SPW9 folder.

- Click Open.

- Open or view the notebook file containing the page you want to add to Template.jnt.

- Select the page you want to copy.

- Press Ctrl+C.

- Select the section of Template.jnt where you want to add the new page.

- Press Ctrl+V. The page is added to Template.jnt.

- Save and close Template.jnt.

- From the menus select:
  
  File
  
  New

  The New dialog box appears.

- Under New, select Graph page. The page you copied appears on the list.
Cutting, Copying and Pasting Graphs and other Page Objects

Cut and copy selected page objects to the Clipboard using the toolbar, or by using Edit menu commands.

Cutting and Copying Graphs

The easiest way to cut or copy a graph or other page object select the graph or object to cut or copy by clicking it. To cut the item, click the Cut button on the Standard toolbar, choose the Edit menu Cut command, or press Ctrl+X.

To copy the item, click the Copy button on the Standard toolbar, choose the Edit menu Copy command, or press Ctrl+C. A copy of the selected graph or object or is placed in the Clipboard. Since copied items remain in the Clipboard until replaced, you can paste as many copies as you want without having to cut or copy the object each time.

Pasting Objects

You can paste Clipboard contents to any open page, report, or into any other Windows application that supports Windows Metafiles or OLE (Object Linking and Embedding).

To paste an object to a page, click where you want the object to appear, then press Ctrl+V. You can also click the Paste button on the Standard toolbar, or choose the Edit menu Paste command. For more information, see “Using OLE to Paste, Link and Embed Objects” on page 245.

Note: The Clipboard is a Microsoft Windows feature. To learn more about how the Clipboard works, refer to your Windows User’s Guide.

Using OLE to Paste, Link and Embed Objects

There are various ways to paste SigmaPlot objects into other applications, and vice versa. One method is using OLE (Object Linking and Embedding), which is fully supported by the SigmaPlot page. OLE provides the ability to move or copy information among supporting applications, and to use the applications interchangeably to modify the data.
SigmaPlot and OLE

SigmaPlot can place and receive OLE and other types of objects, such as scanned images, clip art, or text from a word processor. For example, you can place an equation created with the Microsoft Word Equation Editor into a SigmaPlot report, and edit it with the Word Equation Editor when it changes.

Figure 5-13
Example of an Microsoft Excel Equation Embedded into a SigmaPlot Report

Methods Of Placing Objects

You can copy, cut, and paste graphs among applications without using OLE. The method of placing objects depends on each application’s implementation. The following list shows how objects can be placed:

- **OLE object.** Can be placed if application supports OLE.
- **Windows Metafile.** Can be placed if application doesn’t support OLE, but supports pictures.
- **Enhanced Metafile.** Can be placed in Windows applications only.
- **Bitmap.** Can be pasted in applications that support **bitmaps** only (for example, Microsoft Paint).

*Note:* SigmaPlot always pastes an OLE object if it is available. The SigmaPlot graph and report pages support OLE. Graphs (not graph pages) pasted into SigmaPlot reports are always pasted as Windows metafiles.
Commands to Place Objects

SigmaPlot provides the following commands and functions to place, link, and embed objects on a graph or report page:

- **Paste Command.** Embeds an OLE object, if there is one in the Clipboard. Connects to data in the originating application but not directly to a file. If there is no OLE object in the Clipboard, a non-editable picture or text is placed.

- **Paste Special Command.** Allows you to choose Clipboard file types and to also embed objects and links.

- **Insert New Object Command.** Directly creates and places an OLE object without using the Clipboard. Allows embedding the object or linking to a file.

- **Drag and Drop.** Moves, or copies any Clipboard object (usually OLE).

Linking or Embedding Objects

Use Paste Special, Insert Object, and Ctrl+Drag to either link or embed the object in the page or report.

Linking appears to place a copy of the object in the destination application, but actually only places a reference to it. Therefore, the object is modified every time the original file is modified.

You can only link to a file if you create an object using the Paste Special or Insert New Object commands, or if you drag and drop an object with the Ctrl key held down.

Linking is useful when you need to update an embedded object when the file is updated. The disadvantage of linking objects is that you cannot open a referenced file if the locations of either the SigmaPlot file and the source file change.

Embedding places a copy of the object in the destination application, and then you can edit it by activating its source application when you double-click it. Embedding does not use a reference file; the "file" is actually embedded completely in the SigmaPlot file. For example, if a Microsoft Word embedded object has been placed in a SigmaPlot report, and you double-click it, Microsoft Word opens. Word temporarily runs under SigmaPlot. When you are finished editing the item and close Word, SigmaPlot remains open.

Embedding an object has the advantage of keeping all the associated data in one place, but can create large files.
To embed an object:

- With a graph page in view, from the menus select:
  Insert
  New Object

The New Object dialog box appears.

- Select the type of object to insert from the Object Type list. A description of the object type appears below.

- Click OK to insert the object.

**Placing SigmaPlot Objects into Other Applications**

You can paste SigmaPlot graphs and reports into other applications, and link or **embed** them for future editing with SigmaPlot. For example, you can paste a SigmaPlot graph into a Microsoft Word document (as an OLE object), and use the SigmaPlot Graph Properties dialog box to edit it by double-clicking the graph.

When you link to SigmaPlot and double-click the graph or report, the notebook file containing the graph or report opens.

You can change the source of any linked object, with the Change Source command. For more information, see “Viewing and Modifying Object Links” on page 255.

**View as Icon**

With OLE, the View as Icon allows you to place an icon representing the application that created the file in your data. For example, if you have a description of a graph written in a Microsoft Word document, you can **embed** it, and display it as an icon that shows on the graph page. If you want the object displayed as an icon, select the Display As Icon option. Click the icon to view and edit the object in its source application.
To embed the object and view as an icon:

- With a graph view, from the menus select:
  - Insert
  - Insert Object

  The Insert Object dialog box appears.

- Select the type of object to insert from the Object drop-down list, and click OK.

- Select Display as Icon.

- Click OK to insert the object as an icon.

**Identifying Objects on the Graph Page**

You can determine the type of object on the graph or report page with the Edit menu Object command. Select the object, then on the Edit menu click Object. The Object command changes to reflect the file type of the selected object. For example, if you select a bitmap object, the Object command displays *Bitmap Image Object*. 
Placing SigmaPlot Graphs into Other Applications

You can copy or cut SigmaPlot graphs to the Windows Clipboard, then paste the graph directly into another document, like a word processing or desktop publishing page, without having to do any file exporting or importing.

You can also drag and drop graphs directly from SigmaPlot into any other Windows program that supports OLE. For more information, see “Dragging and Dropping Graphs” on page 256.

To paste a graph to another application:

► Select the graph to cut or copy.

► Press Ctrl+X or Ctrl+C. The graph is cut or copied.

► Open or switch to the other application, and click where you want the graph to appear.

► Paste the graph, typically using the Edit menu Paste command. If the graph isn’t an OLE object, try the Paste Special command, and select SigmaPlot Graph or SigmaPlot Graph Object.

► To create a link between SigmaPlot and the other application, click the Paste Link button. To insure you are pasting an OLE object, use the Paste Special command. If a Paste Special command doesn’t exist, the application probably doesn’t support OLE.

Figure 5-15
Using the Paste Special Dialog Box to Paste a Graph from SigmaPlot to another program
The SigmaPlot graph appears in the other application.

- You can now in-place activate the graph by double-clicking it, or open it in SigmaPlot, by choosing the Edit menu Object command. If the application does not support OLE, the SigmaPlot graph is pasted as a metafile or bitmap graphic.

SigmaPlot graphs pasted with the Edit menu Paste command take their plotted data with them in the form of the plotted graph (the worksheet is not shown). If you want to view or edit the data, you must open the graph rather than simply editing it.

Figure 5-16
Example of a SigmaPlot Graph Pasted into Microsoft Word.

Pasting Objects onto a Graph Page or Report

You can paste contents, including OLE objects, into both page and report documents.

To paste artwork, text from a word processing application, or other objects onto a graph or report page:

- Open the application and file containing the desired artwork or text, and cut or copy the object.
Switch to SigmaPlot and view the graph or report page.

Click the location where you want the object to appear, then press Ctrl+V. The graphic is pasted to the page. If the object can be an OLE object, SigmaPlot always defaults to the OLE object.

To paste the object as a specified file type, choose the Edit menu Paste Special command. The Paste Special dialog box appears.

Figure 5-17
Using the Paste Special Dialog Box to Paste an Object from Microsoft Word to SigmaPlot

Note: The options available in the Paste Special dialog box depend on the type of file being pasted.

If you want the object displayed as an icon, click Display As Icon. Click the icon to view and edit the object in its source application.

You can also specify a different icon to display the pasted object. Click Change Icon and select a different icon.

Click Paste to paste the object as a specified file type. Select Paste Link to paste the object as a linked file that can be updated in another application.

The options in the As list change depending on your selection of either Paste or Paste Link, and the explanation in the Result box changes depending on your selection in the As list.
Select the type of object to paste from the As box, then click OK. The object appears at the selected location.

**Placing Objects without the Clipboard**

You can select objects from applications that are installed on your system and to place them into a SigmaPlot graph or report with the Insert New Object command. The object types available on your system depend on the applications installed, and appear in the Object Type drop-down list of the Insert New Object dialog box.

*To insert an object using the Insert Object command:*

- View the report or graph page, and click where you want the insertion point.

- From the menus select:
  Insert
  New Object

  The Insert Object dialog box appears.

- If you want to display the new object as an icon, select Display As Icon.

  You can also specify a different icon to display the inserted object. Click the Icon button to open the Change Icon dialog box. Choose a different icon from the available options, or click the Browse button to search for alternative icons on your system.

- **To create a new object to place on the report or graph page**, select Create New, then choose the type of object from the Object Type list. Click OK to open the application associated with the selected object. Create the desired object, then use the application’s appropriate Exit command to close the application and return to SigmaPlot. The created object is displayed on the graph or report page as an embedded object.
To insert an object from an existing file on the report or graph page, select Create from File, then type the path and file name of the desired file in the File edit box, or click the Browse button to open the Browse dialog box, from which you can select the appropriate path and file name of the object you want to place.

Select the Link option to place the object on the page as a linked object. When a file is linked, it is modified in your graph or report page when it is modified in the original application. If you did not select the Link option, the object is pasted as an embedded object.
Viewing and Modifying Object Links

You can view and modify links with the Links dialog box. The Links dialog box displays all links associated with the current graph or report page.

To view and modify links:

- View the graph or report page by selecting it.
- On the Edit menu, click Links. The Links dialog box appears displaying the path, file name, type of file, and if it is a manually updated or automatically updated link, of all links on the page.

Figure 5-20
The Links Dialog Box

If you do not have any linked objects on the page, the Links box is empty.

- To change the updating to either Automatic or Manual, select the unselected option. If Automatic updating is selected, the object changes automatically when the source file is changed. If Manual updating is selected, you must click Update Now to update the linked object with any changes made to the source file.
To edit a linked object, select the object name in the Links dialog box, then click **Open Source**. The source file opens in the appropriate application where you can make changes, then exit the application and return to SigmaPlot.

If **Automatic updating** is selected, the object reflects the changes; if **Manual updating** is selected, you must click the **Update Now** button to apply changes to the linked object.

To change the source file for a linked object, click **Change Source**. Choose the new path and file name, then click **OK**. The link appears in the Links dialog box with the new path and file name. You may need to click the **Update Now** button to view this change in your document.

![Change Source Dialog Box](image)

To end the link between an object and its source file, click **Break Link**. The object is no longer treated as a linked object.

Click **OK** to close the Links dialog box.

---

**Dragging and Dropping Graphs**

Using OLE you can drag objects between compatible applications within Windows. Additionally, you can drag and drop graphs from one graph page to another.

To drag a graph into another application, you must be operating within Windows or Windows NT 4, and the other application must support OLE.
Make sure the other application is open and visible from the desktop, with the location where you want to drop the graph also visible.

Select the SigmaPlot graph you want placed in the other program, then drag the graph from the SigmaPlot page. If you want to drop a copy of the graph, press the Ctrl key while dragging.

Move the mouse to the location you want the SigmaPlot graph to appear.

Release the mouse; the graph appears at the drop location. You can now edit the graph with SigmaPlot in the future by double-clicking.

**Note:** You can also drag and drop graphs onto your Windows desktop. Dropping a graph onto the desktop creates a scrap file that can be dragged into another document at a later date.

### Dragging and Dropping Graphs Between Pages

You can drag a graph from one graph page to another. If you drag a graph from a different notebook section, it will insert its data into the destination section worksheet.

**To copy or move a graph from one graph page to another:**

- Open the source and destination pages. The pages must still be within the same notebook, but can be in different sections.

- Select the graph and drag it from the original page to the new page. If you want to copy rather than move the graph, press the Ctrl key while dragging.

- Release the mouse where you want the graph to appear. The graph is placed on the new page. If the page is in a different section, the data plotted by the graph is copied to the current worksheet.

### Hiding and Deleting Objects from the Page

You can delete drawn and pasted page objects from the page, and graphs, automatic legends, automatically created graph titles, plots, and axes can be deleted and/or hidden.
from view. For more information, see “Hiding, Displaying, and Deleting Axes” on page 419.

**Hiding and Viewing Graphs on a Page**

The quickest way to hide a graph on page is to select the graph page, then right-click the graph you want to hide, and on the shortcut menu, click Hide.

*To control which graphs are displayed on the page:*

- From the menus select:
  
  File
  
  Page Setup

The Page Setup dialog box appears.

**Figure 5-22**

*Graph Layout Tab of the Page Setup Dialog Box*

- Click the Page Layout tab. The graphs on the current page are listed in the Sh?wn box.

- **To hide a graph**, select it from the list and click Hide. The selected graph is moved to the Hidden list. (To select multiple graphs, hold down the Shift or Ctrl key while making selections.)

- **To view a hidden graph**, select it from the Hidden list and click Show.
Click OK to apply your selections and close the Page Setup dialog box.

Note that hidden graphs do not print.

**Hiding Graph Titles and Legends**

You can hide automatically generated graph and axis titles and legends from view without being permanently removed from the graph page.

*To hide an automatic legend or automatically created graph title:*

- Right-click the legend or title and on the shortcut menu, click Hide. The title or legend is not deleted, only hidden.

- You can also hide graph titles, axis title, and legends using the Graph Properties dialog box. Open the Graph Properties dialog box by double-clicking the graph. You can also right-click the graph, and on the shortcut menu, click Graph Properties.

- Click the Graph tab.

- Under Settings for, select Legends.

- **To hide the graph title**, clear Show Title.

- **To hide the automatic legend**, under Legend properties, clear Show Legend.

- **To hide axis titles**, select the Axes tab, under Settings for click Labels, and clear the Show Axis Title option(s).

- Click OK to apply the changes and to close the Graph Properties dialog box.

The titles and automatic legend no longer appear on the graph page. Restore the title and legend by returning to the Graph Properties dialog box and checking the Show Title and Show Legend options.
Removing Graphs, Plots, Titles, Legends, and Other Page Objects

Anything on the graph page can be removed from the page by selecting the object, then pressing the Delete key, or choosing the Edit menu Clear command.

Deleting removes curves, plots and graphs entirely. You can use undo (Ctrl+Z) to retrieve these items. When a graph or plot is removed, worksheet data remains intact. Delete also completely removes drawn and pasted objects. Note that delete only hides titles and legends, and does not remove them permanently.

Drawing Objects on the Page

Use the Tools menu Draw Box, Draw Ellipse, Draw Line, and Draw Arrow commands to draw rectangles, ellipses, lines, and arrows, or use the Page toolbar.

Any drawn object or text is not attached to the graph until they are grouped with the graph.

For more information, see “Grouping and Ungrouping Objects” on page 271.

The Page Toolbar

Use the Page toolbar to quickly and easily access Tools menu commands.
The drawing tools on the Page toolbar buttons are:

- **Select Object.** Use the Select Object button to select objects on the graph page.
- **Draw Line.** Click this button to draw a line on the graph page.
- **Draw Arrow.** Click this button to draw an arrow on the graph page.
- **Draw Box.** Use the Draw Box button to draw a box on the graph page.
- **Draw Ellipse.** Click this button to draw an ellipse on the graph page.
- **Text.** Click this button to add text, labels, or manually created legends to the graph page.

**Drawing an Object**

To draw an object:

- Click a drawing tool on the **Page** toolbar, or choose a drawing command from the **Tools** menu.

- The pointer has a crosshair appearance when over the graph page. Place the pointer over the page where you want the object to begin, press and hold down the left mouse button, then drag the pointer to draw the object.
Release the mouse button to finish drawing the object.

**Modifying Object Colors and Lines**

Use Format menu commands or double-click selected objects to modify line type, thickness, color, line end appearance (arrow heads, etc.), object fill color, pattern, and pattern color. You can make these modifications using the **Object Properties** dialog box.

You can also use the **Graph Properties** dialog box to change fill patterns and colors. For more information, see “Changing Object Fills” below.

**Changing Object Fills**

Change fill patterns and colors of drawn rectangles and ellipses, and of graph symbols, bars, and boxes using the **Object Properties** dialog box.

*Note:* When you select multiple objects, fill options apply to all selected objects that can be filled, including lines. For more information, see “Using Custom Colors” on page 295.

**To change the background color of an object fill:**

1. Select the object(s) to modify on the graph page.
2. From the menus select:
   - **Format**
   - **Fill**

   The **Object Properties** dialog box appears.
Click the Fills tab.

From the Background Color drop-down list, choose a color.

Click OK to apply your changes and to close the dialog box.

**Changing Lines**

For drawn lines and graph lines, you can change line type, color, and thickness. You can also use the Object Properties dialog box to add arrowheads and other line endings to lines.

For more information, see “Using Custom Colors” on page 295.

*To change line color:*

Select the object(s) to modify:

From the menus select:

- Format
- Line
The Object Properties dialog box appears.

Figure 5-25
Object Properties Dialog Box Line Tab

- Under Line, select a color from the Color drop-down list. Choose None to create a transparent line.
- Click OK to apply your changes and to close the dialog box.

**To change line type and thickness:**

- Select the object(s) to modify:
- On the Format menu, click Line. The Object Properties dialog box appears.
- Click the Line tab.
- **To set the line type**, under Line, select a type from the Type drop-down list.
- **To set the line thickness**, use the Thickness slider. Clicking the slider causes the slider to move incrementally, while dragging it moves it more precisely.
- **To change the range of control of the slider**, move the slider to one end of the selectable range, select the text in the corresponding edit box, and type a new numeric value.
Graph Page Basics

[Image: The Line End tab of the Object Properties Dialog Box]

- Click OK to apply your changes and to close the dialog box.

**Changing Line Ending Attributes**

Edit line ending attributes for existing lines and arrows, or set the default line endings for drawn arrows. Line ending attributes affect only plain lines and arrows, not graph lines.

*To change line ending attributes:*

- Select the line(s) to modify:

- From the menus select:
  - Format
  - Line

The Object Properties dialog box appears.

*Figure 5-26*
*The Line End tab of the Object Properties Dialog Box*
Chapter 5

Click the Line End tab.

Add or edit line ends at both the start and end of a line. The Start options add or modify the beginning end of the line (where you start drawing the line). The End options add or modify the line end at the end of the drawn line (where you stop drawing the line by releasing the mouse button).

To change the type of line used, select a style from the Style drop-down list.

To change the arrowhead length and angle, move the Angle and Length slider. The angle is the angle between the arrowhead line and the main line. The Angle option is unavailable if the line Style is dotted or plain.

Note: Clicking the slider causes the slider to move incrementally, while dragging it moves it more precisely. To change the range of control of the slider, move the slider to one end of the selectable range, select the text in the corresponding edit box, and type a new numeric value.

Click OK to apply your changes and to close the dialog box.

Changing Multiple Page Objects

When making changes to multiple objects with different properties, the Object Properties dialog box options are blank. Only options that are changed are applied to selected objects. For more information, see “Selecting Page Objects” on page 227.

Moving and Sizing Graphs and Objects

You can modify graph or object size and position either by using your mouse on the page, or by setting specific position, size, and scaling options in the Size and Position tab of the Object Properties dialog box.
Using Your Mouse to Move Graphs and Objects

When you use your mouse to move graphs, graph titles, axis labels, and automatic legends are automatically grouped with a graph and move with it. You can move graphs and objects to other page windows.

Figure 5-27  
Moving a Graph

To move a graph or object with your mouse:

► Select the desired graph.

► Drag it to the desired position. A dotted outline of the graph follows the pointer indicating the location of the moved graph.

► Release the mouse button. The graph moves to the new position.

Using Your Mouse to Change Graph and Object Size

The easiest way to adjust the size and shape of a graph is to resize the graph using the mouse. You can also specify proportional scaling of graphs and objects so that the height and width ratios are maintained, and choose to rescale graph and axis titles and tick marks accordingly.
To adjust graph or object size with the mouse:

- View the page window.

- Click the graph or desired objects to select them. Selected page objects are surrounded with small square handles. Place the pointer over a handle.

- Press and hold down the left mouse button to drag the handle to a new location. The shape of the pointer changes when you move it over a handle, indicating the direction you can stretch the graph or object.

Drag a side handle to stretch or shrink an object horizontally, drag a top or bottom handle to stretch or shrink an object vertically, or drag a corner handle to stretch an object two-dimensionally. A dotted outline of the resized graph or object follows the pointer position.

Figure 5-28
Resizing a Graph

Dragging a corner handle preserves the aspect ratio (relative height and width) of objects by default. Also, graph text, symbols and tick marks are rescaled along with the graph. To disable these features, use the Tools menu Options command and change these Page option settings. For more information, see “Setting Page Options” on page 224.

- Release the mouse button when finished. The graph or object resizes to the indicated size.
Note: Unlike graphs and drawn objects, you cannot stretch or shrink text labels manually. To resize text, change the font size. For more information, see “Formatting Text” on page 281.

Setting a Specific Size and Location

To move a graph or object to a specific location on the page, or to scale the graph or object to a specific size, use the Object Properties dialog box Size and Position tab.

To set graph size and location with the Object Properties dialog box:

► Select the graph or object on the page by clicking it.

► Right-click the selected item, and on the shortcut menu, click Object Properties. The Object Properties dialog box appears.

Figure 5-29
Object Properties Dialog Box Size and Position Tab

► Click the Size and Position tab.

► To set the distance of the selected object from the top and the left of the page, under Position, move the Top and Left sliders or type new values in the Top and Left boxes.
To change the size of the selected object, under Size, move the Height and Width sliders to set the size to specific measurements, or scale the object to a new size by typing a percentage in the Height and Width boxes.

Click OK.

**Nudging Graphs and Objects**

You can use your keyboard arrow keys to move graphs and objects on a graph page. Select the object using your mouse, and then move the object by using the arrow keys. You can also select objects by pressing the Tab key. Press Shift+Tab to scroll back. Press Shift+Arrow to select multiple objects.

Pressing an arrow key moves the graph or object one one point, or .014in. You can change this default setting in the spw.ini file. If you have activated Snap-to grids, nudge will not work unless you set the nudge value to be greater than or equal to the Snap-to value.

You cannot nudge computable objects, such as plots and all parts of plots, tick marks, and regression, reference, and grid lines.

**Moving Objects to the Front or Back**

You can move selected objects so that they appear in front of or behind other page objects.

*To move an object to the front or back:*

Select the object to move by clicking it.

To move the selected object to the foreground, on the Page toolbar, click Bring to Front. The selected object is drawn in front of all other objects.

To move the selected object to the background, on the Page toolbar, click Send to Back. The selected object is drawn behind all other objects.

*Note:* If you select more than one object, the selected objects remain in their relative front to back positions. Grouped objects, including titles and legends with graphs, move as a single object.
Grouping and Ungrouping Objects

You can move and modify selected items on the page by grouping multiple objects as one object. To individually modify grouped objects, you must ungroup them first. Objects and text must be grouped with the graph for them to stay in place, and move with the graph if you shift the graph’s location.

To group and ungroup objects:

- From the menus select:
  - Page
  - Select Object

- Select the graph, by clicking it, if you wish to attach the graph to the objects or text.

- Select the objects and text to group by holding down the Shift key while selecting individual objects. Handles appear around the graph and each selected object.

- On the Page toolbar, click Group. The Group command and button are available only when more than one object is selected.

All selected objects are grouped and can be selected, moved, sized, aligned, and positioned as a single object.

To ungroup objects on a graph page:

- Select the group.

- From the menus select:
  - Page
  - Ungroup

If you have grouped a group, you may need to ungroup the objects as many times as they have been grouped.
Chapter 5

Arranging Graphs on a Page

Use the Arrange Graph dialog box to quickly arrange, resize, and set positions of multiple graphs on a page.

To arrange graphs on a page:

- Select the graph page.
- From the menus select:
  - Format
  - Arrange Graphs

The Arrange Graphs dialog box appears.

Figure 5-30
Arrange Graph Dialog Box

- From the Layouts list, select a layout for the page. A preview of the layout appears in the Preview window.

Layouts are stored in a template file called Layouts.jnt. For more information, see “Adding New Pages to Layout.jnt” on page 273.
Graph Page Basics

Note: You must apply a layout to a page that has the same or fewer number of graphs.

► Click Apply. The graphs on the page match the layout you selected, and the Layout dialog box remains open.

► To arrange the graphs again, you can select another layout from the Layouts list, then click Apply, or click Close to close the dialog box.

Adding New Pages to Layout.jnt

Layouts, like templates, use a .jnt extension and are stored in notebooks. A sample layout notebook, layout.jnt, is provided with SigmaPlot and is set as the default layout source notebook. You can add a your own graph page to this file to use the next time you arrange graphs on the page. For more information, see “Applying Templates” on page 237.

To add a page:

► From the menus select:

File
Open

The Open dialog box appears.
Select Template Notebook (*.jnt) from the Files of type drop-down list.

Select Layout.jnt from the SPW_10 folder.

Click Open. The Layout.jnt notebook appears in the Notebook Manager.
Open or view the notebook file containing the page you want to add to Layout.jnt.

Select the page you want to copy.

Press Ctrl+C.

Select the section of Layout.jnt where you want to add the new page.

Press Ctrl+V. The page appears in Layout.jnt and also at the bottom of the section.

On the File menu, click Save to save the notebook.

**Creating a Custom Layout Template File**

You can create and save your own custom layouts by saving a graph page as a .jnt file.
To create your own layout template file:

- Create a graph page and position the graphs as desired.

- From the menus select:
  
  File
  
  Save

The Save As dialog box appears.

Figure 5-33
Save As Dialog Box

- Type the name of the new layout template notebook in File name box.

- Select SigmaPlot Template File from the Save as type drop-down list.

- Click Save. Now you can add future layouts to their own separate layout notebook.

Changing the Default Layout Template File

Set the default layout template file using the Options dialog box General tab.
To change the source template file:

- From the menus select:
  
  Tools
  Options

The Options dialog box appears.

Figure 5-34
The Options Dialog Box

- Click the General tab.

- Type the path and file name of the desired layout file in the Layout file field.

- Click OK. The notebook becomes the default layout source.
Aligning Page Objects

You can align labels and objects with each other as well as with graphs and axes.

To align page objects:

- Select the labels, graphs or other object(s) you want to align by holding down the Shift key while selecting individual objects. (You must select more than one object to use the Align command.)
- From the menus select:
  - Page
  - Align

The Align dialog box appears.

- Under Horizontal and Vertical, choose the appropriate options to align the selected objects vertically, horizontally, or both. Graphical feedback for your selections appears in the lower right corner of the dialog box.

- To align selected objects relative to each other, select Each Other.

  You must have multiple objects selected if you want to align selected objects relative to each other. Each Other moves aligned objects with respect to the last selected object, which remains in a fixed position. The last selected object can be distinguished from other selected objects by solid rather than hollow selection handles.

- To align objects relative to the page margins rather than the page edge, select PageMargins.

  Note: If you select Page Margins, objects will not move with respect to each other. You can select Page Margins to place single objects. To set margins for each page, on the File menu, click Page Setup.

- Click OK.
Working with Grids and Rulers

Use grids and rulers to quickly and easily align graphs and objects on the page. You can show or hide grids and rulers from the Options box, View menu, or you can right-click the graph page to open the shortcut menu. Although visible on the screen, they do not print with the page. Control the grid and ruler attributes using the Options dialog box.

Using Rulers

Rulers are optionally displayed at the top and left hand side of all graph pages. They display the current units set in the Tools menu Options dialog box. You can choose between inches, centimeters, or points.

Using Snap-to

You can use Snap-to if the grids are displayed or hidden. Select Snap-to in the Tools menu Options dialog box, or right-click the graph page and on the shortcut menu, click Snap-to. Graphs and objects snap to the nearest grid.

Using Crosshairs

Use Crosshairs as an object alignment tool. To turn on crosshairs, click the Crosshairs button on the upper left hand corner of the graph page window. Crosshair lines extend from the pointer tip to the rulers and to the right and bottom of the window, and follow the pointer.

To hide crosshairs, click the Crosshairs button again.

Editing Text

Use the Page toolbar to add and edit text labels and legends to the graph page, in addition to editing automatically created graph and axis titles. SigmaPlot automatically creates legends for every plot. You can modify the existing automatic legend by clicking the Text button on the Page toolbar, and then edit the text using the Formatting toolbar.
You can format tick and contour labels, but you cannot edit their content.

**Creating Text Labels**

You can add an unlimited number of text labels and legends to any graph page. SigmaPlot for Windows supports:
- All TrueType, PostScript, and other fonts installed on your system.
- Multiple lines of text aligned left, right, or centered, with adjustable line heights.
- Mixed fonts and other attributes within a single label.
- Multiple levels of superscripting and subscripting.
- Rotation of text in single degree increments.
- Color using up to 16.7 million different combinations of red, green, and blue.

**To create text labels or legends on a page:**

- Select and view the page window, then click the Text button on the Page toolbar. This places you into text mode until another mode or tool is selected.
- Click the page where you want the label to begin. A text box appears.
- Select the font, character size, and other starting character attributes from the Formatting toolbar.
  
  The Rotation, Alignment, and Line Spacing options affect the entire label, not just the selected text, and Line Spacing is a minimum spacing control, not fixed. If you change the height of characters by changing font sizes or by adding superscripts or subscripts, the line height adjusts automatically.

  *Note:* Using the Default Text Properties you can set default text label attributes by opening the Text Properties dialog box with no labels selected. For more information, see “Formatting Text” on page 281.

  *Note:* In addition to using the Greek Characters button to add a Greek symbol to text, you can also select pre-existing text and choose Symbol as the font type in the Text Properties dialog box. For more information, see “Formatting Text” on page 281.

- Type your label.
Graph Page Basics

To type additional lines, insert a line break by pressing Enter.

To change the attributes of text already typed in the Edit Text dialog box, drag the cursor over the text you want to change to highlight it, then click the appropriate button, such as normal font, bold, italics, underline, sub or superscript, or symbol.

To switch back to normal text from greek, superscript, or subscript text, click the Normal button.

To add legend symbols to your text, click Symbols. The Symbol palette appears.

Editing Text and Individual Characters

To edit existing text on a graph page, you can click the text if you are in text mode, or if you are in select mode, double-click the text. For more information, see “Selecting Page Objects” on page 227.

Formatting Text

If you want only to change the attributes (the formatting) of selected text on a graph page, use the Formatting toolbar. The Text Properties dialog box sets properties for all selected labels, and applies changes to all characters within selected labels.

Note: If you have complex font and character changes within a label, take care not to overwrite these formats with Text Properties dialog box settings.

Global Text Changes. The Text Properties dialog box is useful for formatting multiple labels as well as all text on a graph. Select the graph and choose Text Properties, then select the attributes you want applied to all graph labels and titles.

Default Text Properties. The Text Properties dialog box is used to set the default character and paragraph properties for new labels. Open the Text Properties dialog box with nothing selected, and set the options you want applied to new text labels.

To format text using the Text Properties dialog box:

Select the text object you want to modify.
If you want to modify several text objects, hold down the Shift key while clicking the objects, or drag a select window around all objects.

- From the menus select:
  - Format
  - Text Properties

The Text Properties dialog box appears.

Figure 5-35
*The Text Properties Dialog Box*

- To change the font, style, character size, or color of text, or to underline text, click the Font tab.

  *Note:* If you have multiple text objects with different text properties selected, the attributes that are not the same appear blank. Do not select an attribute for these options unless you want it to be applied to all selected objects.

- To change paragraph attributes, including line spacing, alignment, or rotation, click the Paragraph tab.
Figure 5-36
Text Properties Dialog Box Paragraph Tab

Click OK to apply the changes and close the dialog box.

Working with Automatic Legends

Legends work as a key for your graph. They label what the different graph symbols, lines, or fills represent. SigmaPlot automatically creates legends for all graphs, always placing them below the graph on the left side. Legend entries are labeled using the titles of the columns plotted; if there are no column titles, column numbers are used instead.

Move and modify legends as you would any other page object. They also have a special set of controls and features. This section describes how to modify and control these automatic legend features.

You can also add legend symbols to any text label or title. For more information, see “Creating Text Labels” on page 280.
Figure 5-37
A Graph Created with Automatic Legends

Editing Individual Legend Entries

For more information, see “Formatting Text” on page 281.

To edit legend entries:

- View the page.

  On the Page menu, click the Text button.

- Double-click the legend entry that you want to edit.

- Edit the text of the legend entry as desired using the Formatting toolbar. You can also change the legend symbol properties, including Symbol size, by clicking the Symbol button. For more information, see “Sizing Legend Symbols” on page 285.
**Increasing the Line Spacing for a Legend**

You can increase the spacing between legend symbols by increasing the height of the legend box. Click the box to select it, then drag the top or bottom handle to increase the height.

*Figure 5-38  
Increasing Spacing Between Legend Entries*

You cannot change the widths of automatic legends; these are determined automatically by the width of the text. You can edit individual labels and add multiple lines. You can also ungroup a legend and format it manually. For more information, see “Ungrouping a Legend” on page 289.

**Sizing Legend Symbols**

You can individually control legend symbol size using the Symbols dialog box.

*To resize legend symbols:*

- Double-click the legend.

- On the Formatting toolbar, click the Symbol button. The Symbol dialog box appears.
Figure 5-39
Using the Symbol Dialog Box to Resize Legend Symbols

► Under Symbol, select the symbol to use for the label. This list displays all symbols, lines and fills used by the selected graph source.

► Under Size, move the Width and Height sliders to increase symbol size, or enter a symbol size value. The Width value determines the space between symbols, while the Height value determines the actual symbol size. This means the larger the height, the larger the symbol size; the larger the width, the larger the space between the symbol and text. For line and scatter plots, the width can never be less than the height.

► Click OK to close the dialog box and save the changes.

Editing Automatic Legends

You can edit a legend as a single object.

To edit an automatic legend:

► Double-click the graph to open the Graph Properties dialog box.

► Click the Graph tab.
To show or hide an automatic legend, under Legend Properties, select or clear Show Legend. For more information, see “Hiding and Viewing Graphs on a Page” on page 258.

To enclose the legend in a box, under Legend properties, select Framed in box.

To hide a legend box, under Legend properties, clear Framed in box.

To modify the line thickness and fill of the legend box, under Legend Properties, click Box to open the Object Properties dialog box.

To halt all automatic updating of the legend text for the whole legend, select Lock legend. For more information, see “Locking Legend Text” on page 289.

To show or hide individual legend entries for a specific plot or curve, under Legend appearance, from the For legend symbol list, select or clear a legend entry.

To annotate from the For legend symbol drop-down list, enter the text for a legend symbol by selecting the symbol then select the Legend text box and type text. Do this for as many legend symbols as you want.
To move the legend symbols either to the right or to the left of text, select a position from the Symbol placement drop-down list. If you have no legend symbol selected, this operates on all legends. If you select a specific entry from the For legend symbol list, this option affects only that symbol.

To modify the appearance of the symbols for the current legend, select a symbol style from the Style drop-down list. The Style drop-down list only affects scatter and line plots. If you have no legend symbol selected, this operates on all symbols. If you select a specific entry from the For symbol list, this option affects only that symbol.

To change the text size or style, under Legend properties, click Font. The Text Properties dialog box appears. For more information, see “Formatting Text” on page 281.

To restore all legend text and symbols to the default settings, under Legend properties, click Reset.

Note: The Reset button also unlocks the legend, if locked. When you click Reset defaults, a Novice prompt appears which you can disable.

Click OK to apply the changes and close the Graph Properties dialog box. The legend is updated as specified.

Permanently Displaying and Hiding Automatic Legends

You can control the display of automatic legends either for all subsequently created graphs.

To view or hide automatic legends for all subsequently created plots:

From the menus select:
  Tools
  Options

The Options dialog box appears.

Click the General tab.
Select Automatic legends to display the legend, or clear it to hide the legend.

Click OK to close the dialog box and save the changes.

**Ungrouping a Legend**

You can ungroup the legend entries and box by selecting the legend, then choosing the Format menu Ungroup command, or clicking the Page toolbar Ungroup button. You can then edit each object like an ordinary graphic object or label. You can also use your mouse to move any of the legend items to a new location, and the Format menu Align command.

*Note:* Ungrouping a legend removes automatic legend features.

**Locking Legend Text**

Locking legends halts all automatic updating of the legend text for the whole legend. For example, if you lock the legend, you can change column titles and column data without resetting the legend label. The legend will automatically update, however, if you remove or add a curve.

You can also lock a legend by editing it.

If you do not lock the legend, either from the Graph Properties dialog box, or by editing the legend, the legend automatically updates itself when you change column titles and data. Locking the legend affects the entire legend, not just individual entries.

*To lock legend text:*

Double-click the graph to open the Graph Properties dialog box.
Figure 5-41
Use the Graph tab on the Graph Properties dialog box to lock legend text.

- Click the Graph tab.
- Under Settings for, click Legends.
- Under Legend properties, click Lock legend.
- Click OK to close the dialog box.

**Changing Graph Page Format**

You can change graph page margins and size use the Page Setup dialog box, by clicking Page Setup on the File menu. This dialog box also controls which graphs on a page are displayed or hidden from view, and the color of the page. For more information, see “Hiding and Deleting Objects from the Page” on page 257.
Figure 5-42
The Margins Tab of the Page Setup Dialog Box

Note: The options in the Page Setup dialog box affect both the view of the page on-screen, and the printer settings for the page you are printing. For more information, see “Printing Graph Pages” on page 226.

Changing and Displaying Graph Page Margins

To change page margins, and to view or hide margins on the current page:

► From the menus select:

    File
    Page Setup

The Page Setup dialog box appears.

► Click the Margins tab.

► Use the Top, Bottom, Left, and Right options to specify the width or height of the corresponding page margin. You can type values in the edit boxes using any of the available units of measurement; the value is converted to the current measurement units specified in the Options dialog box. Type in for inches, mm for millimeters, and pts for points.

Margins do not affect printing, they are only a guide. The Align dialog box uses margins when aligning the page.
Clear or check the Show Margins option by selecting it. If this option is checked, margins are displayed on the page. To hide page margins, clear Show Margins.

Click OK. For more information, see “Changing Page Units of Measurement” on page 292.

Graph Page Size and Orientation

To change the size or orientation of the graph page:

- From the menus select:
  
  File
  Page Setup

  The Page Setup dialog box appears.

- Click the Page Size tab.

- From the Paper Size drop-down list choose the appropriate size for the page, or select unique page sizes from the Width and Height drop-down lists.
  
  Note: SigmaPlot does not support heights or widths greater than 32 inches.

- To switch between portrait (normal) and landscape (sideways) orientation, select either the Portrait or Landscape option.

- Click OK to accept your changes and close the dialog box.
  
  Note: If you change the page size and/or orientation, the page changes on the screen, but your graphs remain in the same relative position. You may have to move the graphs back into position.

Changing Page Units of Measurement

Use the Page Options dialog box to change the units of measurement used on the page. Page units of measurement are important when specifying margins and object size and position. These settings apply to all pages and graph and object properties dialog boxes.
To change the unit of measurement used:

► From the menus select:
  - Tools
  - Options

The Options dialog box appears.

Figure 5-43
Options Dialog Box Page Tab

► Click the Page tab.

► From the Units box, select the unit of measurement to use on the page. You can choose to use inches, millimeters, or points.

► Click OK to accept the changes and close the dialog box.

Changing Page Color

You can change the color of a page using the Page Setup dialog box. This is especially useful when creating output for slides or for overhead projectors.
To change the color of a page:

- Make the page active by selecting it, or by choosing its name from the Window menu. A check mark next to the name of the page indicates that the page is active.

- From the menus select:
  
  File
  Page Setup

The Page Setup dialog box appears.

Figure 5-44
The Graph Layout Tab of the Page Setup Dialog Box

- Click the Graph Layout tab.

- From the Color drop-down list, select the color to use for the page. Select (Custom) to use or create a custom color. For more information, see “Using Custom Colors” on page 295.

- Click OK.

Note: If you want no background color to show up for pasted graphs (e.g., pasting a graph into PowerPoint), set the page color to None.
Page Color Default Setting

You can set the default color for a new page by opening the template file and change the attributes for the Normal page using the Page Setup dialog box for that page.

If there is no template file or Normal page present, page settings are derived from the settings stored in the spw.ini file. For more information, see “About SigmaPlot’s User and Program Files” on page 8.

Templates

You can overwrite the current page entirely by applying a template to it. This is not recommended as a means of reformatting the page unless you intend to discard all changes made to the page up to this point. For more information, see “Using Graph Pages as Templates” on page 237.

Using Custom Colors

Color drop-down lists have a (Custom) option that opens the Color dialog box, from which you can select a custom color from over 16.7 million possible combinations of red, green, and blue (24-bit color). These color controls are available in the Graph Properties, Object Properties, Options, and Page Setup dialog boxes.

Configuring Your Display for Color

If you want the truest representation of what your colors will appear like when printed, you should always set you display to the highest color level possible. Most Windows systems support Hi Color (16-bit) or True Color (24-bit) modes. Right-click your desktop, choose Properties, select Settings, then set your Color palette to the highest possible level.

To select a custom color:

- Open the dialog box that has the color option in it, and from the Color drop-down list, select (Custom).
Figure 5-45
Selecting the Custom Color option from the Text Properties Dialog Box.

You have not already selected a custom color, the Color dialog box appears.

Figure 5-46
The Color Dialog Box

If a custom color has already been defined for this option, the custom color is selected.

- From the Basic Colors list, select a color, or click Define Custom Colors to define your own color. The dialog box expands to show a color palette.
Click the large color field, or drag your mouse across it to indicate the approximate color you want to use. If you know the numeric RGB (red, green, blue) values of the desired color, you can select each of the Red, Green, and Blue edit boxes and type the correct values. The selected color box appears.

Move the slider next to the vertical color bar along the right of the dialog box to fine-tune the range of the Hue, Saturation, and Luminosity of the selected color, or type new values in the edit boxes. The current custom color appears in the Color|Solid box as a gradational color and a solid.

To change the color assigned to a Custom Color box, select the box in the list, then specify the new color from the large color field.

To select the gradational color, click Add to Custom Colors. The color appears in the first available box of the Custom Colors list.

To select the solid version of the color, double-click the solid in the Color|Solid box, then click Add to Custom Colors. The color appears in the first available box of the Custom Colors list.

Select the color to use from the Custom Color list, then click OK.
The Color dialog box closes, and you are returned to the dialog box from which you opened the Color dialog box.

The color drop-down list that you are using now has the color you created as an option with the word (Custom) next to it. If the custom color you created is a duplicate of a pre-existing system color, the system color is selected instead of the (Custom) option in the drop-down list.

**Re-defining Custom Colors**

If you want to change a custom color, right-click the Color drop-down list (without opening it). On the shortcut menu, click Custom Color; the Colors dialog box appears. Select a new custom color to use as described above.

Figure 5-48
Working with 2D Plots

You can create 2D Cartesian (XY) plots from many worksheet columns or column pairs. Each column is represented as a separate curve, set of bars, or box, depending on the plot type. 2D graphs must have at least one plot, but you also can display many more plots, each with a different type and style.

You can draw linear or polynomial regressions with confidence and prediction intervals. For more information, see “Plotting and Modifying Regression Lines” on page 487. You can also draw reference lines for each curve. For more information, see “Drawing Reference Lines” on page 494.

This chapter covers:

- Creating 2D plots (see page 302).
- Creating 2D scatter plots with error bars (see page 308).
- Creating 2D scatter plots with asymmetric error bars (see page 313).
- Modifying error bars. For more information, see page 317).
- Creating grouped bar charts (see page 325).
- Creating box plots (see page 331).
- Creating area plots (see page 336).
- Creating bubble plots (see page 354).

Scatter, Line, and Line/Scatter Plots

Scatter, line, and line/scatter plots graph data as symbols, as lines only with no symbols, or as symbols and lines. Line shapes can be straight segments, splines, or steps. You can add drop lines to either axis to any of these plot types, and add error bars to plots with symbols, and you can draw linear or polynomial regressions with confidence and prediction intervals for each curve. For more information, see “Creating 2D Plots with Asymmetric Error Bars” on page 313.
Using area plots, you can fill an area under a curve with a color making the curve easier to see. You can orient the fill up, down, left, or right. If your curve is a closed polygon, you can also fill the polygon. You can have multiple curves (plots) on a page, so you can stack Area Plots. For more information, see “Creating Area Plots” on page 336.

Figure 6-2
Examples of Area Plots
Bar Charts

Bar charts plot data either as vertical or horizontal bars. They originate from zero in either a positive or negative direction. Simple bar charts plot each row of data as a separate bar, and grouped bar charts plot multiple columns of data by grouping data in the same rows. Stacked bar charts plot data as segments of a bar; each data point is drawn as a bar segment starting where the previous data point ended.

Use the Graph Properties dialog box to modify bar width, bar fill colors, and bar fill patterns and to add error bars to simple and grouped bar charts. For more information, see “Creating Grouped Bar Charts” on page 326.

Figure 6-3
Examples of a Simple Bar Chart, a Grouped Bar Chart, and a Stacked Bar Chart

Box Plots

Box plots graph data as a box representing statistical values. The boundary of the box closest to zero indicates the 25th percentile, a line within the box marks the median, and the boundary of the box farthest from zero indicates the 75th percentile. Whiskers (error bars) above and below the box indicate the 90th and 10th percentiles. In addition, you can graph the mean and outlying points. For more information, see “Creating Box Plots” on page 331.

You need a minimum number of data points to compute each set of percentiles. At least three points are required to compute the 25th and 75th percentiles, and at least nine points are required for the 5th, 10th, 90th, and 95th percentiles. If SigmaPlot is unable to compute a percentile point, the related graph element is not drawn.
Creating 2D Plots

To create a 2D plot:

- Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.

- Select the desired graph type and style from the Graph toolbar. The Graph Wizard appears.

Figure 6-5
Using the Graph Wizard to Specify the Data Format
From the Data Format list, choose the appropriate data format, and click Next.

Specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box and you can click Finish to create the graph.

*Note:* If you have not already picked columns, note that a single data type is highlighted in the Selected Columns list. This shows the data type you are picking a column for. Begin picking data either by clicking the corresponding column directly in the worksheet, or choosing the appropriate column from the Data Columns list. Repeat this process for every column you are using to create your graph.

If you make a mistake while picking data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the list.

When you have finished picking data, click Finish to create the plot and close the Graph Wizard.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information, see “Creating Graphs” on page 151.

**Creating 2D Plots with Multiple Curves**

You do not have to create multiple plots to obtain multiple curves. To plot more than one curve, choose any of the plot styles described as Multiple and add additional columns, or column pairs to the list of curves in the Graph Wizard. Both the Graph Wizard and the graph style tool bars list all types of multiple plot graph styles.

The order of the curves is determined by the order of the column pairs in the Graph Wizard. To change the curve order, repick columns by selecting them in the Graph Wizard or by clicking the column in the worksheet.
Plotting Category and Grouped Data

Use the Category Data formats (indexed data) if your data is organized row-wise by categories with corresponding data. For more information, see “Arranging Category Data” on page 138.

Figure 6-7
The data in this worksheet is arranged as category (or indexed) data. The data is organized row-wise by categories.

To plot category (grouped) data:

- On the Graph menu, click Create Graph. The Type panel of the Graph Wizard appears.
Select one of the following graph types:
- Line Plot
- Scatter Plot
- Line and Scatter Plot

Click Next. The Style panel of the Graph Wizard appears.

**If you selected Line Plot as the graph type,** then select any one of the following graph styles:
- Multiple Scatter
- Multiple Regression
- Multiple Spline Curves
- Multiple Vertical Step Plot
- Multiple Horizontal Step Plot
- Multiple Vertical Midpoint Step Plot
- Multiple Horizontal Midpoint Step Plot

**If you select either Scatter Plot or Scatter and Line Plot as the Graph Type,** then select any one of these graph styles:
- Multiple Straight Lines
- Multiple Spline Curves
- Multiple Vertical Step Plot
- Multiple Horizontal Step Plot
- Multiple Vertical Midpoint Step Plot
- Multiple Horizontal Midpoint Step Plot

Click Next. The Data Format panel of the Graph Wizard appears.
Select one of the following category data formats:

- **XY Category.** Uses one worksheet column to graph the categories, and a pair of XY columns.
- **X Category.** Uses one X column, and a column for categories, indexes, or levels to group the data in corresponding rows.
- **Y Category.** Uses one Y column, and a column for categories, indexes, or levels to group the data in corresponding rows.

Click Next. The Select Data panel of the Graph Wizard appears.

Select which data columns will correspond to which axis or category. For example, if you are using an XY Category Data format, first select the column to use for the X data from the Data for drop-down list. This selection appears in the Selected columns list. Then select the column to use for the Y data from the drop-down list. Lastly, select the column to use as the Categories from the drop-down list.
If you make a mistake while picking data, select another entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the list.

When you have finished picking data, click Finish to create the plot and close the Graph Wizard.
Legends for category data plots include the title of the two columns containing the observation data and also text describing which category group each symbol pertains to.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information, see “Creating Graphs” on page 151.

**Creating 2D Scatter Plots with Error Bars**

In a Line and Scatter Plot with **Error Bars**, plot the means of each column as the Y value, and represent the standard deviations with error bars.

Use the Graph Wizard to create 2D plots with error bars. Scatter plots, line/scatter plots, or simple bar charts can be created with error bars. For more information, see “SigmaPlot Graph Styles” on page 114.
To add error bars to an existing plot, first change the plot type. For more information, see “Changing Graph Type and Style” on page 169.

To create a scatter plot with error bars:

- Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.
- On the 2D Graph toolbar, click Scatter Plot, and then click Simple Scatter Error Bars. The Graph Wizard appears.
- From the Symbol Value drop-down list, select the error bar source.

Symbol Value. Choose either Column Means to use the column means as the error bar source, Replicate Row Means to use the row means as the error bar source, Worksheet Columns to use values you’ve entered in the worksheet, or 2 Worksheet Columns to read error bar end values from sets of two adjacent columns. You are prompted during data picking to specify the column to use as error bar source data.
Error Calculation. If you choose any option besides Worksheet Columns as the symbol value, specify the error calculation method to use for upper and lower error bars.

From the Error Calculation - Upper and Error Calculation - Lower drop-down lists, specify the error calculation for the error bars. Error Calculations are not applicable if you select Worksheet Columns or Asymmetrical Error Bars from the Symbol Value list.

Click Next.
From the Data Format list, select the appropriate data format. X column averaged plots require a constant Y column value, and Y column averaged plots require a constant X column value.

Click Next.

Specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box, and you can click Finish to create the graph.
To create a single plot graph, choose data for every column you are using to make the graph. To create a graph of multiple plots, choose data for the first plot, then click Next to pick data for the next plot. Repeat this process for as many plots as necessary.

To make a graph with simple error bars or a graph with multiple error bars using worksheet columns as the Symbol Value for error bar data, you are prompted to choose columns for error bar data. Repeat the data picking process for every column you are using to create your plot. For more information, see “Computing Percentile Methods” on page 335.

To make a graph using any of the other sources for error bar data (i.e. Column Means, Column Median, Standard Error, etc.) with multiple error bars, you can create a graph using a single plot, or a graph with multiple plots. Use multiple plots if you want to use different symbols to distinguish between data sets.

Note: If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list. Click Back to access previous Graph Wizard panels.

Click Finish when you have finished picking the data to create the plot.

Creating a Range Plot

A range plot is an error plot that plots the highest and lowest values in a column or row of data as the range of the error bar, using the mean or median value as the data point.

To create a range plot from columns of data:

Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.

On the 2D Graph toolbar click Scatter Plot and then Simple Scatter - Error Bars. The Graph Wizard - Create Graph dialog box appears.

Select Column Means or Column Median from the Symbol Value drop-down list.

Select Maximum from the Error Calculation - Upper drop-down list.
313

Working with 2D Plots

► Select Minimum from the Error Calculation - Lower drop-down list.

► Click Next. The Graph Wizard prompts you to select a data format.

► Select X Many Y from the Data Format list, and click Next. Since you’ve already selected the data columns to plot, the appropriate column titles appear in the Selected Columns list.

► Click Finish. A range plot appears.

Creating 2D Plots with Asymmetric Error Bars

Create 2D scatter plots with error bars using two adjacent worksheet columns as the error bar source to independently control the error bar values. SigmaPlot computes the asymmetrical error bars by using the column value as the absolute value.

The column to the right of the plotted data is the source for the bottom or left error bar; the next column is the source for the top or right error bar. For more information, see “Computing Percentile Methods” on page 335.

Figure 6-16
2D Plots with Asymmetrical Error Bars

To create a plot with asymmetric error bars:

► Drag the pointer over your worksheet data to select the data.

► On the 2D Graph toolbar, click Scatter Plot, and then click either Simple Scatter - Vertical Asymmetrical Error Bars or Simple Scatter - Horizontal Asymmetrical Error Bars.
The Graph Wizard appears.

- From the Data Format list, select a data format, and click Next.

- Specify which worksheet columns correspond to the data for your plot. For more information, see “Picking Different Data for the Current Plot” on page 167.

  Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.

- Click Finish to create the graph. For more information, see “Modifying Error Bars” on page 317.

**Creating Quartile Plots**

A quartile plot is an asymmetrical error bar plot that divides the total sample of a frequency distribution into four quarters. The median of the data is the data point, while the 75th and 25th percentiles of the data represent the upper and lower error bars.

By default, SigmaPlot uses the **Standard method** to calculate percentile values for box and quartile plots. You can change this setting to the Cleveland method on the General tab of the Options dialog box. For more information, see “Computing Percentile Methods” on page 335.
To create a quartile plot:

- Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.
- On the 2D Graph toolbar click Scatter Plot and then Multiple Scatter - Error Bars. The Graph Wizard - Create Graph dialog box appears.
- Select Column Median from the Symbol Value drop-down list.
- Select 75th Percentile from the Error Calculation - Upper drop-down list.
- Select 25th Percentile from the Error Calculation - Lower drop-down list.
- Click Next. The Graph Wizard prompts you to select a data format.
Select X Many Y from the Data Format list, and click Next. Since you’ve already selected the data columns to plot, the appropriate column titles appear in the Selected Columns list.

Click Finish.

Creating Error Bar Plots Using Category Data

You can create SigmaPlot error bar plots using category data either entered into a SigmaPlot worksheet or imported from SPSS. For more information, see “Arranging Category Data” on page 138. You can also create graphs as embedded objects in SPSS. You can also create scatter plots and bar charts using category data.

To create a SigmaPlot error bar plot using category data:

Open or import a worksheet using a category data format. For more information, see “Importing Files from Other Applications” on page 53.

On the Graph menu, click Create Graph. The Graph Wizard - Create Graph - Type dialog box appears.

Select a graph type from Graph types list, and click Next. The Graph Wizard - Create Graph - Style dialog box appears.

Select a graph style that uses error bars from the Graph styles list, and click Next. The Create Graph - Error BarsGraph Wizard - dialog box appears.

Select either Category Mean or Category Median from the drop-down list.

Select error calculations from the Error calculation - upper and Error calculation - lower drop-down lists, and click Next. The Graph Wizard - Create Graph - Data Format dialog box appears.

From the Data for Categories drop-down list, select a column that corresponds to the categorical data you wish to plot.
From the Data for Y drop-down list, select the column that corresponds to the Y data you wish to plot, and click Finish. An error bar plot appears.

**Modifying Error Bars**

Compute **error bars** for scatter, line/scatter, and bar charts. Select error bar values when you pick the data for a plot and compute using values in a worksheet column or using column means. For more information, see “Computing Percentile Methods” on page 335.

**Note:** You cannot add error bars to existing plots. However, you can select the desired plot on the page and change its plot type and style so that it includes error bars. For more information, see “Changing Graph Type and Style” on page 169.

**Figure 6-18**

*Examples of Graphs with Error Bars*

**Changing Error Bar Appearance**

Use the Graph Properties dialog box to change error bar color, cap width, line thickness, mean computation method, and direction.

Note that you cannot select error bar values from this dialog box; the Graph Properties dialog box only affects the appearance of error bars. Determine error bar values when you pick data to plot.

**To change error bar appearance:**

- Double-click the plot. The Graph Properties dialog box appears.
- From the Settings for list, select Error Bars.
To change the color of the error bars, from the Line Color list, select a line color.

To change line thickness and error bar cap width, move the Thickness and Cap Width sliders.

Click OK.

**Changing Error Bar Directions**

Specify error bar direction using two different methods: absolute and relative. You can specify absolute error bars to point in either a positive or negative direction; specify relative error bars to point either towards or away from zero.

**To change error bar direction**

Double-click the plot. The Graph Properties dialog box appears.
Figure 6-20
You can change the direction of the error bars by selecting a direction from the Error Bar Direction drop-down list on the Plots tab of the Graph Properties dialog box.

- Click the Plots tab.
- From the Plot drop-down list, select the plot with error bars to modify.
- From the Settings for drop-down list, select Error Bars.
- Under Error Bars, from the Direction drop-down list, select the direction of Y.
- Select either X or Y Positive or Negative.

Note: An X positive absolute direction always points right; a Y positive direction always point up. An X negative absolute direction always points left; a Y negative absolute direction always points down.
Double-click the plot. The Graph Properties dialog box appears.

Click the Plots tab.

From the Settings for list, select Error Bars.

From the Error Bars Direction drop-down list, select X or Y From Zero or To Zero.

Note: A relative to zero direction always points toward or away from zero. This option is useful for bar charts that have negative values.

Figure 6-22
The bar chart on the left uses X error bars with an absolute negative direction. The bar chart on the right uses a relative direction towards zero.

Click OK.
Customizing Error Bar Directions

Control the error bar direction used for each data point by entering error bar directions into a worksheet column.

Figure 6-23
Error Bars Using Custom Directions from Worksheet Columns

To use custom error bar directions:

► Select the first cell in an empty worksheet column.

► Enter the codes for the error bar directions. The codes for the directions are:

<table>
<thead>
<tr>
<th>Direction</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Positive</td>
<td>Positive or P</td>
</tr>
<tr>
<td>Absolute Negative</td>
<td>Negative or N</td>
</tr>
<tr>
<td>Relative From Zero</td>
<td>From Zero or F</td>
</tr>
<tr>
<td>Relative To Zero</td>
<td>To Zero or T</td>
</tr>
<tr>
<td>Absolute or Relative, Both Directions</td>
<td>Both, PN or FT</td>
</tr>
</tbody>
</table>

*Note:* Codes you type in the worksheet can be either upper or lower case.

► Double-click the plot. The Graph Properties dialog box appears.
Click the Plots tab.

From the Settings for list, select Error Bars.

Under Error bars, from the Direction list, choose the name of the first column which contains the error bar direction codes.

*Note:* SigmaPlot assumes that it is the next column that contains the second column of error bar codes.

Click OK to apply the changes and close the dialog box.
Changing the Mean Computation Method

If your graph uses a log axis scale, you can choose between calculating the column means arithmetically (the default) or geometrically on a log scale. This option is only available for log axis scales.

To change the mean computation method:

► Double-click the plot with a log axis scale to open the Graph Properties dialog box.
► Click the Plots tab.
► From the Settings for list, select Error Bars.
► From the Mean Computation drop-down list, select Arithmetic or Geometric.

Figure 6-25
Selecting Arithmetic or Geometric from the Mean Computation list

► Click OK.
Changing Error Bar Source

Use this method to change the error bar source after you have created a graph. You can:

- Plot the means of worksheet columns as single data points and compute the error bars values from column statistics (column averaging). For more information, see “Grouping Column Averaged Bars” on page 328.
- Use data in worksheet rows and columns as error bar values. For more information, see “Creating 2D Scatter Plots with Error Bars” on page 308.
- Use data in two adjacent worksheet columns as the absolute error bar values. For more information, see “Creating 2D Plots with Asymmetric Error Bars” on page 313.

To change the error bar source after you have created the graph:

- Select the plot to modify by clicking it.
  Small, square, black handles surround the selected plot.

- On the Standard toolbar, click the Graph Wizard button.
  The Graph Wizard appears.

  Figure 6-26
  Graph Wizard - Modify Plot

- Click Next.

- From the Data for Error drop-down list, select a column as a new error bar source.
Working with 2D Plots

Figure 6-27
Choosing the New Error Bar Source from the Data for Error drop-down list.

- Click Finish. The graph appears with the new error bars.

**Grouped Bar Charts**

Create grouped bars charts by picking multiple columns for a single plot. Data points within the same row appear within the same group, and each additional column adds another bar to each group. There are as many groups as there are rows of data.

The order of the column pairs in the list determines the order of the bars for each group. To change the bar orders within groups, change the order the column pairs appear in the list by using the Graph Wizard to repick column data. For more information, see “Picking Different Data for the Current Plot” on page 167.

Use the Graph Wizard to create grouped bar charts with or without error bars. If creating a grouped bar chart with error bars, error bar values must be from worksheet column values entered prior to creating the plot. You are prompted during graph creation for error bar worksheet columns.

Figure 6-28
Examples of Grouped Bar Charts with and without Error Bars
Creating Grouped Bar Charts

To create a grouped bar chart:

- Select the worksheet columns to plot before creating your graph by dragging the pointer over your data. For more information, see “Picking Different Data for the Current Plot” on page 167.

- On the 2D Graph toolbar, click Horizontal or Vertical Bar Chart, and then click either Grouped Bar Chart, or Grouped Error Bars. The Graph Wizard appears.

Figure 6-29
Using the Graph Wizard to Specify the Data Format

- From the Data Format list, choose the appropriate data format to specify how your data is formatted. The data formats available depend on the graph type and style.

- Click Next.

Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the the Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list.
Figure 6-30
Using the Create Graph Dialog to Pick Columns to Plot.

► Click Finish. For more information, see “Modifying Error Bars” on page 317.

**Spacing Bars from Different Plots**

If you need to create a bar chart with two or more different axes scales, or a chart with overlapping bars, use multiple plots.

SigmaPlot does not automatically space bars from different plots. However, you can manually space bars by grouping your data column(s) with column(s) containing missing or empty data. This creates bar groups with null values and leaves room for other bars. When picking columns to plot, pick the missing columns in a different order for each plot, so that the bars do not overlap.

To overlap bars, plot your bar values versus a column of evenly incremented values rather than by row numbers.
Figure 6-31
Bars graphed with different plots that both overlap and are spaced differently by using different x increments.

**Grouping Column Averaged Bars**

You cannot create a grouped bar chart with error bars using *column averaging*; the bars do not group or space correctly. However, you can copy the worksheet means and standard deviations from the statistics window, then plot this data as a grouped bar chart with error bars.

*To create a bar chart with grouped column averaged bars:*

- From the menus select:
  - View
  - Statistics

The statistics window for the worksheet appears.
Select the block of data in the statistics window that consists of the means and standard deviations of the first set of bars.

Right-click, and on the shortcut menu click Copy.

Select the first row of an empty column in the worksheet.

From the menus select:
Edit
Transpose Paste

The first pasted column of data is the mean, and the next column is the standard deviations. For more information, see “Switching Rows to Columns” on page 88.
Figure 6-33
The data in columns 13 and 14 of the worksheet are transposed from the selected data in rows 1 and 2 of the Column Statistics window. Column 13 contains the means of the column data and column 14 contains the standard deviations of the data.

- Repeat the copy and transpose paste procedure for the remaining sets of bars. Each pair of mean and standard deviation columns you create adds an additional bar to each group.

- **To plot the results,** on the 2D Graph toolbar, select a vertical or horizontal bar chart graph type with grouped error bars, then select the desired data format. If you already have a graph, repick the plotted data by selecting the plot to modify, then clicking the toolbar button.

- If you select X Many Y as the data format, pick your constant value column (either a row number or a single column), then pick the first column of means as your data column, and the first column of standard deviations as the associated error bar column.

- Continue picking the mean columns and error bars for each set.

- Click Finish when done.
Creating Box Plots

A box plot is a summary plot that plots graph data as a box representing statistical values. The boundary of the box closest to zero indicates the 25th percentile, a line within the box marks the median, and the boundary of the box farthest from zero indicates the 75th percentile. Whiskers (error bars) above and below the box indicate the 90th and 10th percentiles. In addition, you can graph the mean and outlying points.

By default, SigmaPlot uses the Standard method to calculate percentile values for box and quartile plots. You can change this setting to the Cleveland method on the General tab of the Options dialog box. For more information, see “Computing Percentile Methods” on page 335.

To create a box plot:

► Select the worksheet columns to plot by dragging the pointer over your data.

► On the 2D Graph toolbar, click Box Plot and then click Horizontal Box or Vertical Box. The Graph Wizard appears.
From the Data Format list, choose the appropriate data format, and click Next.

Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.

**Note:** You need a minimum number of data points to compute each set of percentiles. At least three points are required to compute the 25th and 75th percentiles, and at least nine points are required for the 5th, 10th, 90th and 95th percentiles. If SigmaPlot is unable to compute a percentile point, that set of points is not drawn.

Click Finish to create the graph.
Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph.

**Changing Other Box Plot Attributes**

*To add a mean line, change which outliers are displayed, and change the 10th and 90th percentile whisker cap widths:*

- Double-click the plot to open the Graph Properties dialog box.

![Graph Properties Plots Tab](image)

- Click the Plots tab.
- From the Settings for list, select Box Options.
- **To display a mean line in addition to the median line**, under Box Plot Mean Line, select Display Mean Line. If the check box is clear, the mean line is not displayed.
- **To modify the mean line**, under Box Plot Mean Line, from the Line Type drop-down list, select a mean line type.
Select a line thickness and color using the Thickness and Color options.

Selecting (none) from the Line Type or Color lists creates a transparent mean line. Selecting (Custom) from the color list enables you to use a custom mean line color, or to create a new color.

To change how outliers are handled, from the Handling Outliers drop-down list, select either Show Each Outlier (to plot outside the 10th and 90th percentiles), or Show 5th/10th Percentiles (to plot only the 5th and 95th percentiles as symbols).

Note: At least nine data points are required to compute the 5th, 10th, 90th and 95th percentiles. Also, there may be no data points beyond the 10th and 90th percentiles.

To modify whisker cap width, under Whisker Caps, move the Width slider, or type a new value in the Width box.

Click OK.

Modifying Box Plots

The fill, width, and symbol settings for the boxes can be modified using the appropriate Graph Properties Plot tab settings.

You can change:

- Symbols used to display extreme data points. For more information, see “Changing Symbol Type, Size, and Color” on page 180.

- Box fill color and patterns (including edge and whisker color). For more information, see “Changing Plot Fill Patterns and Colors” on page 195.

- Box widths. For more information, see “Changing Bar and Box Widths and Spacing” on page 203.
Computing Percentile Methods

When graphing error bars and creating box plots, you can select the method of computing percentiles.

To compute the percentile method:

- From the menus select:
  
  Tools
  
  Options

  The Options dialog box appears.

- Click the General tab.

- From the Percentile Method drop-down list, select either:
  
  - Cleveland
  
  - Standard

  Both the Cleveland method and the Standard method use linear interpolation to determine the percentile value, but each uses a different method of rounding when determining the smallest data index used for the interpolation. The two methods give the same result when computing the 50th percentile (median).

  If the data in increasing order is $x_1, x_2, \ldots, x_N$ and the percentile is $p$, then the two methods compute the data percentile value $v$ using the following formulas:

  - Cleveland: Let $k$ be the nearest integer to $N \cdot p / 100$, and let $f = N \cdot p / 100 + .5 - k$.
  
  - Standard: Let $k$ be the largest integer less than or equal to $(N+1) \cdot p / 100$, and let $f = (N+1) \cdot p / 100 - k$.

- To compute the percentile value, each of the above methods uses the formula:
  
  $v = f \cdot x_k + 1 + (1-f) \cdot x_k$.

- Click OK.
Creating Area Plots

Area plots are 2D line plots with regions below or between curves filled with a color or pattern. Most commonly, an area plot is a line plot with shading that descends to the axis. You can add shade below a curve and shade in different directions, and you can uniquely fill and identify intersecting regions.

Figure 6-38
This example is actually four plots: a simple straight line, simple scatter, vertical area, and multiple area. You can find this example in Samples.jnb.

Creating Simple and Vertical Area Plots

Simple Area Plots plot a single line plot with a downward fill. Vertical Plots plot single YX line plots with a left direction fill.
Figure 6-39
In this example, there are see two vertical area plots, a simple area plot, and a simple scatter plot.

To create a simple straight line area plot:

► Select the worksheet columns to plot by dragging the pointer over your data.

► On the 2D Graph toolbar, click Area Plot and then click Simple Area Plot. The Graph Wizard appears.
From the Data Format list, choose the appropriate data format, and click Next.

**Figure 6-41**
*Graph Wizard - Select Data*

Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.

*Note:* You can plot no more than 2500 data points per curve.

Click Finish to create the graph.

**Figure 6-42**
*Example of a Vertical Area Plot*
Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph.

**Creating Multiple Area and Multiple Vertical Area Plots**

Multiple Area Plots plot multiple line plots with downward fills. Multiple Vertical Area Plots plot single YX line plots with left downward fills.

*To create a multiple area plot:*

- Select the worksheet columns to plot by dragging the pointer over your data.
- On the 2D Graph toolbar, click Area Plot, and then click Multiple Area plot. The Graph Wizard appears.

**Figure 6-43**

*Graph Wizard - Data Format*

- From the Data Format list, choose the appropriate data format, and click Next.

Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list.
Figure 6-44
Graph Wizard - Select Data

Note: You can plot no more than 2500 data points per curve.

- Click Finish to create the graph.

Figure 6-45
Example of a Multiple Area Plot using a Y Many X data format.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph.

You can identify intersections either by using the Graph Properties dialog box or by creating a complex area plot. For more information, see “Creating Complex Area Plots” below.
Creating Complex Area Plots

Complex Area Plots plot multiple line plots with downward fills and intersections.

To create a complex area plot:

- Select the worksheet columns to plot by dragging the pointer over your data.

- On the 2D Graph toolbar, click Area Plot, and then click Complex Area Plot. The Graph Wizard appears.

Figure 6-46
Graph Wizard - Data Format

- From the Data Format list, choose the appropriate data format, and click Next.

Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list. To change the selected data, select the wrong entry in the Graph Wizard, then choose the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list.
Figure 6-47
Graph Wizard - Select Data

Note: You can plot no more than 2500 data points per curve, and you cannot plot more than four curves.

- Click Finish to create the graph.

Figure 6-48
Intersections only appear for two or more curves, and a legend appears for each intersection.
Converting a Multiple Area Plot to a Complex Area Plot

You can uniquely identify intersecting areas of all curves of a multiple area plot with a separate fill by using the Graph Properties dialog box. Each possible intersection appears on the area plot, and each identifiable set of intersections uses the next color or pattern in the selected scheme.

You can display intersections for a minimum of two curves and a maximum of four. Plots with two curves will have up to three different regions, one region for each tuple, and one region for the intersection. Three curves yield up to seven regions, and four curves up to fifteen.

To change a multiple area plot to a complex area plot:

► Double-click the multiple area plot. The Graph Properties dialog box appears.

Figure 6-49
Using the Graph Properties Dialog Box to Identify Intersections

► Click the Plots tab.

► Select Area Fills from the Settings for list.

► Select Identify Intersections.
Click OK to close the dialog box and accept the changes.

**Shading in Different Directions**

Use the Graph Properties dialog box to change the direction of fill colors in an area plot.

*To change the area fill direction:*

- Create an area plot.
- Double-click the graph. The Graph Properties dialog box appears.

![Graph Properties dialog box](image)

- Click the Plots tab.
- From the Settings for list, select Area Fills.
- From the Direction drop-down list, select Up, Down, Left, or Right.
Click OK.

**Changing Area Plot Fill Colors**

Use the Graph Properties dialog box to change area plot fill colors.

*Note:* SigmaPlot only supports system patterns. If you enter patterns into the worksheet, you should only use system patterns.

**To change the area plot fill color:**

1. Click OK.

2. Double-click the area plot. The Graph Properties dialog box appears.

   ![Graph Properties Dialog Box](image)

   *Using the Graph Properties Dialog Box to change the area fill color and pattern*

3. Click the Plots tab.

4. From the Settings for list, select Area Fills.

5. From the Color drop-down list, select (none) to create a transparent fill color, (Custom) to create a custom color, or an incremental color scheme to use a color array, or any one of many available colors.
From the Pattern drop-down list, select a pattern.

Click OK. For more information, see “Changing Patterns and Fill Colors” on page 195.

**Shading Between Two Curves**

You can emphasize the difference between two curves by filling in the area. This is useful when creating a climograph, for example, where two lines could show high and low temperatures throughout the year. Shading between the curves aids in visualizing the range in temperatures which would otherwise be lost in a sea of data points.

**Figure 6-52**
An example of two plots, a bar chart and an area plot. In the area plot (in red), the area between the two curves is shaded.

**Average Daily Temperature Range and Precipitation, Oakland CA**


You can shade the area between two curves by:
Using the Object Properties dialog box to change the background color of the graph to match the lower shade.

Using the Insert Graphic Cells dialog box to insert colors in to the worksheet, and then applying those to the plot.

To shade the area using the Object Properties dialog box:

- Create an area plot that uses either X Many Y or XY Pairs data formats. Make sure, when in the Graph Wizard, that you first select to plot the column with the largest Y values for the upper curve. Then use the column with the smallest Y values for the lower curve.

Figure 6-53
To shade between the curves, first create an area plot that uses the larger values for the upper curve.

Once you’ve created the graph, right-click. On the shortcut menu, click Object Properties. The Object Properties dialog box appears.

Click the Fill tab.
Under Fill Color, from the Color drop-down list, select a color that matches the color of the lower curve.

Figure 6-54
Shading the Area Using the Object Properties Dialog Box

Click Close. The graph appears with the area between the two curves shaded.
Working with 2D Plots

Figure 6-55
The area between the two curves appears shaded, while the area under the lower curve matches the background.

To insert graphic cells to shade between two curves:

For more flexibility you can define the area colors by inserting colors into a column in the worksheet and then use the front area color as the graph background color.

- As above, create an area plot.
- View the worksheet, and select a cell in the first row of an empty column.
- From the menus select:
  - Insert
  - Graphic Cells

The Insert Graphic Cells dialog box appears.
► Click the Colors tab.

► Double-click to select two colors. In the first cell (row 1), select the color that you want the area to be and in the second cell (row 2), select the color you want the background to be.

**Figure 6-56**
*Insert Graphic Cells Dialog Box*

► Click Close to close the dialog box.

► **To assign the area plot colors to those in the worksheet**, double-click the graph. The Graph Properties dialog box appears.

► Click the Plots tab.

► Select Area Fills.

► Under Fill Color, scroll to the bottom of the Color drop-down list and select the column that contains the colors you selected in the Insert Graphic Cells dialog box.
Figure 6-57
Select the column that contains the graphic cells that you inserted into the worksheet.

*Click OK to apply the changes and close the dialog box. The graph now appears with the two shaded areas filled with the colors you inserted in worksheet; however, the background of the graph is still white.*
Figure 6-58
Once you’ve selected the color for the lower curve, you still must match a color for the background.

Right-click the graph, and select Object Properties. The Object Properties dialog box appears.
Click the Fills tab.

Under Fills color, from the Color drop-down list, select the color that matches the lower shaded area on the graph.

Click OK to apply the changes and close the dialog box. The graph appears with one shaded area between the two curves.
Figure 6-60
As in the example above, the graph appears with the background color matching the color of the lower shaded region.

**Bubble Plots**

Bubble plots are XY scatter plots that use symbols to represent not only XY locations, but also a third dimension represented by the size of the symbol. Use bubble plots to plot population density, epidemiological data, or other similar data sets where a third variable can be clearly illustrated by the size of the symbols.

**Creating a Bubble Plot**

To create a bubble plot:

- Select the worksheet columns to plot before creating your graph by dragging the pointer over your data.
On the Standard tool bar, click the Graph Wizard button. The Graph Wizard appears.

Figure 6-61
Graph Wizard Dialog Box

- From the Graph Types scroll-down list, select Bubble Plot, and click Next.
- From the Data Format list, select the appropriate format, and click Next.
- When you have selected all the columns to plot, including the Bubble Size column, click Finish.

**About Axes and Plots**

You can only create new pairs of X or Y axes if you have more than one plot on a graph and you want to scale these plots differently. For more information, see “Modifying Axes, Tick Marks, and Grids” on page 407.

**Creating Additional Axes for Multiple Plots**

If you have more than one plot on a graph and want to use multiple axes, use the following steps to add additional axes. For more information, see “Modifying Axes, Tick Marks, and Grids” on page 407.

**To create an additional axis:**

- Right-click the plot, and on the shortcut menu, click Add New Axis. The Graph Wizard appears.
Figure 6-62
Using the Graph Wizard - Add Axis Dialog Box to Select the Plot for the New Axis

- Select to create either a new X axis or Y axis for the specified plot.
- Click Next.

Figure 6-63
Selecting to Create a New Y Axis for the Selected Plot

- Select which side of the graph to add the new axis. You can add the new axis to the left, right, top, or bottom of the graph. Selecting an Offset location moves the new axis slightly to the side, top, or bottom of the original axis.
Click Finish to add the new axis according to the specified settings. The New axis appears on the graph, and the plot re-scales to reflect the new axis.

Figure 6-65
*Example of a Second Y Axis Added to the Graph for a Line Plot*
Creating Multiple Axes for a Single Plot

If you want to use two or more X or Y axes for a single plot (for example, to show two different units of measurement), first create a plot which graphs empty columns, then add an axis to the empty plot.

To add an axis to the second plot:

- Right-click the graph, and on the shortcut menu, click Add New Plot.
  The plot type does not matter, so long as it is a 2D Cartesian plot.
- Pick any data format.
- Pick empty columns when prompted to select the data to plot.
- Create an axis for this "dummy" plot at the desired location
- Select the new axis, then use manual scaling to set the appropriate range and tick interval for the new axis. This scale is often a linear transformation of the opposite axis scale, for example, a Celsius scale to a Fahrenheit scale.

Figure 6-66
The second temperature axis for the single plot was created by first creating a "dummy" plot, creating a Y axis for the dummy plot, then manually scaling the axis range.

For more information, see “Modifying Axes, Tick Marks, and Grids” on page 407.
Working with 3D and Contour Graphs

Create 3D (XYZ) plots from many worksheet columns or column triplets. XYZ plots must have at least one plot, but can display many more plots, each with a different type and style. Graphs can be rotated and shaded added to enhance the height and depth of mesh and bar charts.

This chapter covers:

- An overview of 3D plots (see page 359).
- Creating 3D scatter plots and 3D bar charts (see page 363).
- Creating trajectory plots (see page 364).
- Creating waterfall plots (see page 365).
- Creating mesh plots (see page 367).
- Changing graph perspective, rotation, and shading (see page 371).
- 3D axis placement (see page 375).
- Creating contour plot (see page 378).
- Modifying contour plot (see page 380).

3D Scatter and Line Plots

3D scatter and line plots graph data as symbols, as lines only with no symbols, or as symbols and lines. Use the Graph Properties dialog box Plots tab Symbols settings to add symbols to a 3D line plot, or the Lines settings to add lines to a scatter plot. You can add drop lines to any back plane of either of these plot types.
Mesh Plots

Mesh plots graph 3D data as a continuous surface with a mesh. Use the Graph Properties dialog box to modify mesh lines, color, transparency, and to enable the light source for shading. For more information, see “Modifying Mesh Lines and Fill Color” on page 368.
Create bar charts in 3D space using 3D data. Modify 3D bar charts by changing fill color and pattern. For more information, see “Changing Patterns and Fill Colors” on page 195. You can also adjust bar width and spacing. For more information, see “Changing Bar and Box Widths and Spacing” on page 203.
**Waterfall Plots**

Waterfall plots graph 3D data as stacked line plots along the Y axis. Use the Graph Properties dialog box to modify plot lines, color, and transparency.

Figure 7-4
*Waterfall Plots*
Creating 3D Scatter Plots and 3D Bar Charts

3D scatter plots can use any data format; however, 3D bar charts are limited to XY Many Z or Many Z only.

Creating a 3D Scatter Plot or 3D Bar Chart:

- Select the worksheet columns to plot by dragging the pointer over your data.
- On the 3D Graph toolbar, click 3D Scatter Plot or 3D Bar Chart. The Graph Wizard appears.

Figure 7-5
Specifying the Data Format

- From the Data Format list, specify how your data is formatted. The data formats available depend on the graph type you are making.
- Click Next.
Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box.

Click Finish.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information, see “Modifying Graphs” on page 163.

**Creating Trajectory Plots**

Trajectory plots use an XYZ **coordinate system** to create a 3D line plot.

**Creating a Trajectory Plot**

- Select the worksheet columns to plot by dragging the pointer over your data.
- On the 3D Graph toolbar, click 3D Line Plot and then 3D Trajectory.
  
The Graph Wizard appears. Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.
Click Finish.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph.

**Creating Waterfall Plots**

3D waterfall plots are stacked line plots along the Y axis. Because hidden lines are eliminated, waterfall plots are useful for showing trends of line plots.

3D waterfall plots are limited to Many Z and XY Many Z data formats.
Creating a Waterfall Plot

- Select the worksheet columns to plot by dragging the pointer over your data.

- On the 3D Graph toolbar, click 3D Line Plot and then click 3D Waterfall. The Graph Wizard appears.

Figure 7-9
Graph Wizard Data Format Panel

- From the Data Format list, choose the appropriate data format.

- Click Next.

Figure 7-10
Graph Wizard Select Columns Panel

Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.

- Click Finish.
Use the Graph Properties dialog box to modify plot lines, color, and transparency. For more information, see “Modifying Mesh Lines and Fill Color” on page 368.

**Creating Mesh Plots**

When you create a mesh plot you can choose between solid and transparent mesh with discrete or gradient shading. Use a transparent mesh to highlight the relationship of one mesh plot to another on the same graph.

3D mesh plots use an XYZ coordinate system; the data points are graphed as intersections of a mesh grid. If you select Many Z as the data format, SigmaPlot uses column numbers as the X values, and row numbers as the Y values. If you are using XYZ triplet data, you need to reformat the data.

**Creating a 3D Mesh Plot**

- Select the columns to plot by dragging the pointer over your data.

- On the 3D Graph toolbar, click 3D Mesh Plot. The Graph Wizard appears.

![Figure 7-11: Specifying the Data Format](image)

- From the Data Format list, choose the appropriate data format, and click Next.
Since you already selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box.

- Click Finish.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot, or to add another plot to your graph. For more information, see “Modifying Mesh Lines and Fill Color” on page 368.

**Modifying Mesh Lines and Fill Color**

To modify mesh lines and fill color:

- Double-click the plot. The Graph Properties dialog box appears.
Click the Plots tab.

From the Settings For list, select Mesh.

To change the color of the mesh, under Fill Colors, from the Color drop-down list, select a color. Select (none) to create a transparent mesh, select (Custom) to create a custom color, and select one of the color schemes or color columns to increment the mesh from bottom to top using a color array. For more information, see “Using Custom Symbol, Fill, Line, and Color Increments” on page 199.

To make your mesh translucent, under Fill Colors, select Transparent. Objects behind it will be visible. Use this option to more clearly show the intersections between two or more 3D meshes.

Tip: Set your display to High Color (16 bit) or True Color (24 bit) for this feature to work properly. Check your system’s color capabilities under the Windows Display Properties Settings.

If you are using a color scheme, under Fill Colors, from the Transition drop-down list, specify how the colors flow across the grid. Select Discrete to use an increment with a clear shift between colors, or select Gradient to use an increment with a gradual shift between colors.

Note: The Transition drop-down list is available only when using a fill color scheme.
To change mesh lines, from the Settings For list, select Lines. Use the Color dropdown list to change line color. Selecting (none) creates transparent mesh lines, and selecting (Custom) enables you to use or create a custom color. For more information, see “Using Custom Colors” on page 295.

To change line thickness, move the Thickness slider, or type a new value in the Thickness box.

Click OK.

Adding Contours to 3D Mesh Plots

You can add contours to the top and bottom backplanes in the XY plane of 3D Mesh Plots.

Double-click a 3D Mesh Plot to open the Graph Properties dialog box.

Click the Graph tab.

Under Settings For, select Backplanes.

Under Show Contours, select in which Backplanes you would like the contour plot(s) to appear.

To edit the contour plots, click the Plots tab.

Select the plot to edit from the drop-down list.

Click OK to save changes and close the Graph Properties dialog box.
Changing Graph Perspective, Rotation, and Shading

Modify the view of the 3D graph by changing perspective and rotation of the graph, and by enabling a light source to add shading.

Changing the View of a 3D Graph

To change the perspective of a 3D graph, rotate a graph, and enable the light source:

- Double-click the plot. The Graph Properties dialog box appears.

Figure 7-14
Graph Properties Dialog Box 3D View Tab Rotation Settings

- Click the Graph tab.

- From the Settings for list, select Rotation. This tab displays a Preview that shows how the current settings affect the selected graph.

- To rotate the graph, move the Horizontal View and Vertical View sliders, or type horizontal or vertical values into the boxes.
Note: Horizontal and vertical values are in degrees. Rotate the graph horizontally from 0° to 360°, or vertically from -90° to +90°. The recommended Horizontal View is 205°, and the Vertical View is 25°. The three solid red axes displayed in the Preview box of the 3D View tab are the origin axes for the rotation, and are used as reference when determining the angles of rotation. The rotation is displayed in the axes degrees from 0°. The origin used to determine the degree from the horizontal or vertical is the intersection of the three axes.

When both rotation angles are set to 0°, the origin as you see the graph, is the left bottom rear corner.

Note: The origin axes are not related to the axes marked with ticks and tick labels, but act as the zero point for tick labels and data.

Figure 7-15
A 3D graph with a horizontal rotation of 0, a vertical rotation of 0°, and a perspective of 20.

To change the perspective of the graph, move the Perspective slider, or type a new value into Perspective box.

Figure 7-16
A 3D graph with a horizontal rotation of 0°, a vertical rotation of 45°, and a perspective of 20.
Working with 3D and Contour Graphs

Figure 7-17
A 3D graph with a horizontal rotation of 45°, a vertical rotation of 45°, and a perspective of 20°.

Figure 7-18
A 3D graph with a perspective of 0°.

Note: The Perspective value is based on the "depth" of the graph. A perspective of 0% means that the graph has no depth; 100% means that the graph has maximum depth. The recommended perspective is 20%.
To enable the light source and create shading on your graph, select Enable Light Source. If the check box is cleared, the light source is not applied to the graph.

*Note:* Set your display to High Color (16 bit) or True Color (24 bit) for this feature to work properly. You may check your system’s color capabilities under the Windows Display Properties Settings.
3D line and scatter plots are not affected by the light source option.

- To return to the 3D View settings you had before applying any changes, click Revert to original settings.

- Click OK.

3D Graph Axis Placement

3D axes are always at the following positions (unless you rotate the graph horizontally):

- X: bottom right front
- Y: bottom left front
- Z: left front

Axis Placement During Graph Rotation

When you rotate the view of a 3D graph, SigmaPlot automatically repositions the visible axes to the front of the graph so that the axes do not become positioned behind the graph.
For more information, see “Changing Graph Perspective, Rotation, and Shading” on page 371.

**Drawing, Modifying, and Hiding Frame Lines**

Drawing a 3D graph frame completes the cube surrounding the plotted data. Normally, these lines are hidden. You can use a frame to mark the **origin axes**, or to mark the 3D extent of the graph.

**Frame lines** are unrelated to the lines used to draw axes and planes, and are controlled independently of those lines. Frame lines are drawn over the axes.

**To add frame lines, modify frame lines, or hide frame lines from view:**

1. Double-click the plot. The **Graph Properties** dialog box appears.

   ![Graph Properties Dialog Box](image)

   **Figure 7-22**
   **Graph Properties Dialog Box 3D View Tab Frame Lines Settings**

   - Click the **Graph** tab.
   - From the **Settings for** list, select **Frame Lines**.
   - Click the **Graph** tab.
   - From the **Settings for** list, select **Frame Lines**.
From the Frame Lines drop-down list, select either:

- **Relative to Viewer**: If the frame is oriented from your perspective, one set of lines is composed of the three cube edges closest to you, and the other lines are the remaining sides of the cube. The position of these lines is independent of the graph’s rotation. This is the default position.

- **Relative to Graph Origin**: If the frame is drawn according to the origin, one set of the lines is drawn over the origin axes, and the other lines draw the remainder of the cube. The position of these lines is dependent on the graph’s rotation.

**Figure 7-23**
These graphs use the Viewer as the point of reference. The graph on the left draws only the front lines, and the right graph draws only the back lines.

**Figure 7-24**
These graphs use the Origin as the point of reference. The graph on the left draws only the origin lines, and the right graph draws only the non-origin lines.
Chapter 7

- Hide frame lines, or add frame lines to your graph by selecting or clearing the appropriate Show check box. Selected frame lines are drawn.

  A graph cannot display frame lines for both the Relative To Viewer and Relative To Graph Origin perspectives. If Relative To Graph Origin is selected from the Frame Lines drop-down list, the Show check boxes for Relative To Viewer are cleared automatically, and vice versa.

- To change the frame line type, under Front lines, from the Line Type drop-down list, select a line type.

- To change a frame line color, under Front Lines, from the Color drop-down list, select a frame line color.

- Select (None) from either list to create transparent frame lines. Choose (Custom) from the Color drop-down list to use or create a custom color. For more information, see “Using Custom Colors” on page 295.

- To the modify frame line thickness, move the Thickness slider, or type a new thickness value into the thickness field.

- Click OK.

Creating Contour Plots

Contour graphs and filled contour graphs plot 3D data on an XYZ coordinate system with the Z data (vertical) indicated with lines at specified Z intervals. If you select Many Z as the data format, SigmaPlot uses column numbers as the X values, and row numbers as the Y values. If you are using XYZ triplet data, it needs to be reformatted as mesh data. For more information, see “Smoothing 3D Data” on page 577.
Creating a Contour Plot

- Select the worksheet columns to plot by dragging the pointer over your data.

- On the 3D Graph toolbar, click Contour Plot and then Contour. The Graph Wizard appears.

- From the Data Format list, select the appropriate data format, and click Next. The Graph Wizard prompts you to specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the

Figure 7-26
Graph Wizard Select Columns Panel
Selected Columns list.
Note: If you made a mistake picking data, click the wrong entry in the Selected Columns list, then select the correct column from the worksheet. You can also clear a column assignment by double-clicking it in the Selected Columns list.

- Click Finish.

**Creating a Filled Contour Plot:**

- Select the worksheet columns to plot by dragging the pointer over your data.
- On the 3D Graph toolbar, click Contour Plot and then Filled Contour. The Graph Wizard appears.
- From the Data Format list, select the appropriate data format and click Next. The Graph Wizard prompts you to specify which worksheet columns correspond to the data for your plot. Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the Selected Columns list.
- Click Finish.

**Modifying Contour Plots**

Use the Graph Properties dialog box to modify a contour plot. You can:

- Pick new data for the plot. For more information, see “Picking Different Data for the Current Plot” on page 167.
- Change contour line attributes, and hide or display lines. For more information, see “Displaying and Changing Contour Lines” on page 381.
- Modify back plane color and grid lines. For more information, see “Modifying Backplanes” on page 450.
- Change the vertical (Z data) range and scale. For more information, see “Changing Contour Vertical (Z Data) Range and Scale” on page 384.
- Change X and Y axis and tick attributes. For more information, see “Changing Tick Mark Line Attributes” on page 438.
- Add colors to contour fills. For more information, see “Adding Fills to Contour Plots” on page 382.
- Turn on or off interpolated fills. For more information, see “Modifying Interpolated Filled Contours” on page 383.
- Change and display contour labels. For more information, see “Displaying and Modifying Contour Labels” on page 387.

**Displaying and Changing Contour Lines**

To hide, display, and modify contour plot lines:

- Double-click the plot. The *Graph Properties* dialog box appears.

  ![Graph Properties Dialog Box](image)

  **Figure 7-27**
  *Graph Properties Dialog Box Plots Tab Contours Settings*

  - Click the *Plots* tab.
  - From the *Settings For* list, select *Contours*.
  - **To modify contour lines**, from the *Contours* drop-down list, select *Major* or *Minor*. The Line Styles reflect the contour you select in the Contour drop-down list. Select *Major* to change the Line Styles for major contours. Select *Minor* to change the Line Styles for minor contours.
To specify the line type of major and minor contour lines, from the Type drop-down list, select a line type. Select one of the incrementing schemes to increment contour line types, or select (none) to create transparent lines.

To select the color of the contour lines, from the Line Style Color drop-down list, select a color. You can choose from several predefined color schemes, or select (none) to create transparent lines. Select the (Custom) option to create a custom color.

To set the thickness of the contour lines, move the Thickness slider, or type a new value in the Thickness box.

Click OK.

Adding Fills to Contour Plots

To fill intervals between contour lines with colors:

Double-click the plot. The Graph Properties dialog box appears.

Figure 7-28
Graph Properties Dialog Box Plots Tab Contours Settings
Click the Plots tab.

From the Settings for list, select Contours.

From the Contours drop-down list, select Major.

From the Color drop-down list, select from several predefined color schemes.

From the Fill Start drop-down list, set the direction of the contour fills. The default direction is bottom. That is, the fill starts from the lowest z value.

You can also create filled contour plots automatically when you first create the graph. You can either select the Filled Contour Plot style from the 3D Graph toolbar, or choose Filled Contours from the Graph Wizard.

**Modifying Interpolated Filled Contours**

When you create a filled contour plot from the toolbar, its fill colors are automatically interpolated and stretched to fit the number of z-intervals.

**To turn off interpolated fills:**

Double-click the graph. The Graph Properties dialog box appears.
Click the Plots tab.

- From the Settings for list, select Contours.

- From the Contours drop-down list, select Minor.

- Under Fills, from the Color drop-down list, select (none).

- Click OK.

**Changing Contour Vertical (Z Data) Range and Scale**

Use the Graph Properties Range settings to select the scale type and set the vertical range used by the contour lines.

To set the scale and range used by contour lines:

- Double-click the plot. The Graph Properties dialog box appears.
Click the Plots tab.

From the Settings for list, select Scale.

From the Scale Type list, select Linear or Log (Common) scale. The linear scale uses a standard base 10 numeric scale, and the log scale uses a base 10 logarithmic scale.

To manually set the Z axis range, in the Start and End boxes, enter beginning and ending range values.

To automatically set the Z axis range, from the Calculation drop-down lists, select Data Range. SigmaPlot automatically determines the vertical range based on the Z data plotted.

To add padding to both ends of the axis, select Pad 5%.

To extend the range to the nearest major tick mark, select Nearest Tick.

Click OK.
Changing Contour Line Intervals

Use the Graph Properties Line Interval settings to select line intervals for Major and Minor contours.

To set line intervals:

► Double-click the plot. The Graph Properties dialog box appears.

Figure 7-31
Graph Properties Plots Tab Scale Settings

► Click the Plots tab.

► From the Settings for list, select Scale.

► From the Apply to drop-down list, select the Major or Minor lines to modify.

► Under Line intervals, from the Lines drop-down list, select one of the following intervals:
Working with 3D and Contour Graphs

- **Automatic**: SigmaPlot automatically determines the interval at which contour lines are drawn.
- **Manually**: Manually set the number of contour lines are drawn. Enter the z interval in the Every field, and the value at which the first interval is drawn in the From field.
- **Columns**: Select the column used to determine major contour line z values.

*Note*: When major contour lines are plotted from a column, no minor lines are drawn.

> Click OK.

**Displaying and Modifying Contour Labels**

Use the Graph Properties dialog box Label settings to switch contour line labels on and off, add prefixes or suffixes to labels, and rotate labels relative to the contour line.

*To add, hide or modify contour line labels:*

> Double-click the contour plot. The Graph Properties dialog box appears.

Figure 7-32
Graph Properties Dialog Box Plots Tab Labels Settings
Click the Plots tab.

From the Settings for list, select Labels.

To display or hide contour labels, under Contour Labels, select or clear Major Contour Labels and Minor Contour Labels. Selected options display labels, and cleared options hide labels.

To align contour labels parallel to the contour line, under Label Appearance, select Align With Contour Line. Clear the option to align the contour labels parallel to the X axis.

To control how many labels appear for the contour lines, move the Label Frequency slider. Move the slider toward Fewer to reduce the number of contour labels, or move the slider toward More to increase the number of contour labels.

To add to the contour labels, under Add to Major Labels and Add to Minor Labels, in the Prefix and Suffix boxes, type the prefix or suffix.

To separate a suffix or prefix from the tick label, type a space before a suffix or after a prefix.

Click OK.

Changing Contour Label Settings

Using the Graph Properties dialog box Detail settings you can:

- Use a numeric type of contour label. For more information, see “Setting a Numeric Type of Contour Label” on page 389.
- Use a series type of contour label. For more information, see “Setting a Series Type of Contour Label” on page 390.
- Use values or text from a worksheet column for contour labels. For more information, see “Using Values or Text from a Worksheet Column for Contour Labels” on page 391.
- Change the font size, style or color of contour text labels. For more information, see “Changing the Font Size, Style or Color of Contour Text Labels” on page 392.
Setting a Numeric Type of Contour Label

- Double-click the plot. The Graph Properties dialog box appears.

Figure 7-33
The Numeric Labels Settings for Contour Labels

- Click the Plots tab.

- From the Settings for list, select Details.

- From the Type drop-down list, select Numeric, then use the Contour label appearance options.

- From the use drop-down list, specify which type of numeric display to use.

  The Scientific Notation and Engineering Notation options always use scientific notation or engineering notation to display numbers.

  - For large numbers options, use scientific or engineering notation only when numbers exceed a specified range. Use the Above and Below lists to specify the range beyond which scientific notation or engineering notation is used.
For linear scale, you can always use scientific notation, or only when needed. If you use scientific notation only when needed, set the range to by typing values in the Lower and Upper ranges in the edit boxes. These values are expressed in log units.

- Use the Precision options to specify the number of places used to display numeric tick labels. Select Automatic to let SigmaPlot automatically determine precision, or select Manual, then select the number of decimal places to use from the Places drop-down list.

**Setting a Series Type of Contour Label**

- Double-click the plot. The Graph Properties dialog box appears.

![Figure 7-34](image)

*The Series Labels Settings for Contour Labels*

- Click the Plots tab.
- From the Settings for list, select Details.
- From the Type drop-down list, select Series.
- From the Series list, select one of the following series:
■ Months
■ Days of the week
■ Years
■ Alpha Series
■ Numeric

► From the Length drop-down list, select the number of characters to use for the labels.

► From the Start At drop-down list, select the series item to begin labeling tick marks with, then from the Step By drop-down list, select the frequency or increment for the series.

► To restart tick labeling from a specified point, use the After and Repeat From drop-down lists.

► Click OK to close the dialog box and make the changes.

Using Values or Text from a Worksheet Column for Contour Labels

► Enter the values or text in a worksheet column.

► Double-click the plot. The Graph Properties dialog box appears.
Chapter 7

Figure 7-35
The Series Labels Settings for Contour Labels

Click the Plots tab.

From the Settings for list, select Details.

From the Type drop-down list, select the column containing tick labels.

Click OK to close the dialog box and make the changes.

Changing the Font Size, Style or Color of Contour Text Labels

Changing the text attributes for both major and minor contour labels involves changing the font, style, size and color of the text.

Double-click the plot. The Graph Properties dialog box appears.

Click the Plots tab.

From the Settings for list, select Details.
Click Contour label font to open the Text Properties dialog box. For more information, see “Formatting Text” on page 281.
Chapter 7
Working with Pie, Polar, and Ternary Plots

This chapter describes basic procedures specific to pie charts, polar plots, and ternary plots, including:

- Creating pie charts (see page 395).
- Changing pie chart slice settings (see page 397).
- Creating polar plots (see page 401).
- Modifying polar plots (see page 403).
- Creating ternary graphs (see page 404).
- Changing basic ternary graphs attributes (see page 405).

Pie Charts

Pie charts plot a single worksheet column by representing each data point in the column as a pie slice. Each data point in the column is graphed as a slice size equivalent to the data point’s percent of the sum of all the data.

Figure 8-1
Examples of Pie Charts
The first pie slice starts at 0 degrees (3 o’clock) by default. Additional slices are added counterclockwise, in the order the data points occur in the column.

**Creating Pie Chart**

- Select worksheet data before creating the graph.

- On the 2D Graph Toolbar, click Pie Chart. The Graph Wizard appears.

![](image)

**Figure 8-2**
*Using the Create Graph Dialog Box to Pick Columns to Plot*

- Specify which worksheet column corresponds to data for your plot. Since you selected a column prior to opening the Graph Wizard, your choice automatically appears in the dialog box and you can click Finish to create the pie chart.

- If you selected the incorrect columns to plot, select a column either by clicking the corresponding column directly in the worksheet, or selecting the appropriate column from the Data for Pie list.

  *Note:* If you make a mistake while picking data, click the wrong entry in the Graph Wizard, then select the correct column from the worksheet.

- Click OK.

  Use the Graph Properties dialog box to modify the pie chart, or reopen the Graph Wizard to pick a different data column for your plot.

  *Note:* You cannot add plots or axes to pie charts.
Modifying Pie Charts

Modifying pie charts includes:

- Changing fill color and patterns of pie chart slices. For more information, see “Changing Patterns and Fill Colors” on page 195.
- Rotating the pie chart. For more information, see “Rotating the Pie” on page 397.
- Adding exploded pie slices to the pie chart. For more information, see “Adding Exploding Slices” on page 398.
- Picking new data for the graph. For more information, see “Picking Different Data for the Current Plot” on page 167.

To modify a pie chart, select the graph and open the Graph Properties dialog box. For more information, see “Modifying Graphs” on page 163.

Rotating the Pie

Use the Graph Properties dialog box to rotate pie charts or add single or multiple exploding slices.

To rotate the pie:

1. Double-click the pie chart. The Graph Properties dialog box appears.

Figure 8-3
Graph Properties Dialog Box Plots Tab Pie Slices Settings
Chapter 8

► Click the Plots tab.

► Select Pie Slices from the Settings For list.

► Move the Counterclockwise from slider to change the starting angle. Increasing the starting angle for the first slice moves the starting slice counterclockwise. The default is 0 degrees (3 o’clock).

► Click OK.

Adding Exploding Slices

► Use the Graph Properties dialog box to add single or multiple exploding slices.

To explode one slice:

► Double-click the pie chart. The Graph Properties dialog box appears.

Figure 8-4
Graph Properties Dialog Box Plots Tab Pie Slices Settings

► Click the Plots tab.
Select Pie Slices from the Settings For list.

Select Single Slice from the Exploded Slices drop-down list.

Select the number of the slice to explode from the Slice drop-down list.

By default, the first slice begins at 0° and proceeds counterclockwise. If you have not rotated the pie chart, the slice number corresponds to the worksheet row number.

Click OK.

Note: Choosing No Exploded Slices from the Exploded Slices drop-down lists replaces any exploded pie slices.

To explode multiple slices:

Select an empty column.

Type a 1 in the same row as the data point for each row you want to emphasize with an exploding slice.

Double-click the pie chart. The Graph Properties dialog box appears.
Click the Plots tab.

Select Pie Slices from the Settings For list.

Select the column containing exploding slice data from the Exploded Slices drop-down list.

Click OK.
**Polar Plots**

Polar plots display data in the coordinate system format where \( r \) is the distance from the origin of the graph, and \( \theta \) is the angle between the positive horizontal axis and the radius vector extending from the origin to the plotted data point.

Use polar plots to show data where one value \( \theta \) is periodic in nature, like a clock. An example of this is a graph that shows average temperatures of differing geographical regions during the days of a month, or months of a year.

Figure 8-6
Polar Plots

---

**Creating a Polar Plot**

- Select the worksheet columns to plot by dragging the pointer over your data.

  On the 2D Graph Toolbar, click Polar Plot, and then click the style of polar plot you want to create. The Graph Wizard appears.

- Choose a unit type from the Angular Axis Unit list.
  
  The Range Lower Bound and Range Upper Bound options change depending on your selection from the list.

  *Tip:* If you don’t see the axis units you want to use for your polar plot listed in the list, you can type the desired values in the Range Lower Bound and Range Upper Bound fields.
If you want to create a polar plot with its angles increased in a clockwise direction, select Clockwise. This creates a plot where the Range Lower Bound starts at the top of the graph. On polar plot set to use a counter clockwise direction, Range Lower Bound starts at the 3 o’clock position.

Figure 8-7
An example of a polar plot with its angular units set to use a clockwise direction.

Click Next.

Select the appropriate data format from the Data Format list.

Click Next.

Click Finish.

Use the Graph Properties dialog box to modify the plot, or reopen the Graph Wizard to pick different data columns for your plot. For more information, see “Modifying Graphs” on page 163.
Modifying a Polar Plot

Modifying polar plots involves:

- Modifying angular and radial axes. For more information, see “Modifying Polar Axes” on page 453.
- Picking new data for the plot. For more information, see “Picking Different Data for the Current Plot” on page 167.
- Changing symbol type, size, and color. For more information, see “Changing Symbol Type and Other Symbol Options” on page 180.
- Changing line type, size, and color. For more information, see “Changing Line Type and Other Line Options” on page 191.
- Modifying back plane color and grid lines. For more information, see “Modifying Backplanes” on page 450.

To modify a polar plot, select the graph and open the Graph Properties dialog box. For more information, see “Modifying Graphs” on page 163.

Ternary Graphs

Ternary graphs plot data on an XYZ coordinate system in the form of three variables that add up to 100% or 1. These variables are typically the normalized proportions of three substances and are plotted on three axes generally arranged as an equilateral triangle. These graphs are also commonly referred to as triangle plots.

Figure 8-8
Examples of a Ternary Line Plot, Scatter Plot and Scatter and Line Plot
Ternary Plot Styles

You can create ternary scatter, line, and scatter and line plots. These graph data as symbols, as lines only with no symbols, or as symbols and lines, respectively. Line shapes can be straight segments or spline.

Creating a Ternary Plot

Ternary plot data set (triplet or pair) must be based on a percentage or unitary scale with the sum of all values being 100% or 1. If your data does not add up to 100% or 1, you must first normalize the data. For more information, see “Normalizing Ternary Data” on page 569.

Drag the pointer over your data to select the worksheet columns to plot.

On the 2D Graph Toolbar, click Ternary Plot, and then click the style of ternary plot you want to create. The Graph Wizard appears. For more information, see “Creating Graphs” on page 151.

Figure 8-9
Selecting a Ternary Graph Data Format from the Graph Wizard

Select the appropriate format, and click Next.
Since you selected columns prior to opening the Graph Wizard, your choices automatically appear in the dialog box.

*Tip:* If you made a mistake picking columns, highlight the wrong entry in the Graph Wizard, then choose the correct column either in the worksheet or from the column list.

- Click Finish.

Use the Graph Properties dialog box to modify the plot or to open the Graph Wizard to pick different data columns to plot or to add another plot to your graph. For more information, see “Modifying Ternary Axes” on page 463.

### Modifying Ternary Graphs

Modifying ternary graphs involves:

- Changing axis properties. For more information, see “Modifying Ternary Axes” on page 463.
- Picking new data for the plot. For more information, see “Picking Different Data for the Current Plot” on page 167.
- Changing line and symbol type, size, and color. For more information, see “Changing Line Type and Other Line Options” on page 191.
- Modifying backplane color and grid lines. For more information, see “Modifying Backplanes” on page 450.

To modify a ternary graph, select the graph and open the Graph Properties dialog box. For more information, see “Modifying Graphs” on page 163.
Modifying Axes, Tick Marks, and Grids

Axes are the scales or rulers along which data is plotted. 2D Cartesian graphs have an X (horizontal) axis, and a Y (vertical) axis. For 3D graphs, the X and Y axes form the base of the graph, and the Z axis is the vertical axis. Polar plots use an angular axis to draw the circumference of the plot and the radial axes to draw the radius of the plot. An axis is always associated with at least one plot on a graph, and determines the scaling of the plot.

Each axis consists of pairs of lines that you can move and modify independently. Tick marks are short lines along the axis that represent scale intervals. You can display and modify tick marks for each axis. Grid lines are attached to the graph planes, and can be drawn at tick intervals for all axes. Make most axis modifications using the Axes tab of the Graph Properties dialog box.

This chapter covers:

- Axis scale types (see page 408).
- Changing axis scales and ranges (see page 413).
- Changing scale type (see page 415).
- Hiding, displaying, and deleting axes (see page 419).
- Setting axis breaks (see page 424).
- Working with axis titles and tick labels (see page 426).
- Changing tick mark intervals (see page 429).
- Changing tick mark appearance (see page 437).
- Changing tick labels (see page 440).
- Displaying grid lines and backplanes (see page 450).
- Modifying polar axes (see page 453).
- Modifying ternary axes (see page 463).
Chapter 9

Axis Scale Types

Scale types appear on the Axes tab of the Graph Properties dialog box. To open:

- Select an axis on a graph.
- From the menus select:
  - Graph
  - Graph Properties

*Tip:* You can also double-click the axis on the graph.

The Graph Properties dialog box appears.

- If necessary, click the Axis tab, and then select Scaling from the Settings for list.

The available scale types appear under the Scale type list. They include:
- Linear (see page 408).
- Common Log (see page 408).
- Natural Log (see page 409).
- Probability (see page 409).
- Probit (see page 409).
- Logit (see page 410).
- Category (see page 410).
- Date/time (see page 411).

**Linear**

A linear scale is a standard base 10 numeric scale. (This scale is recommended for a date axis when an exact representation of spacing depicted by dates is not required. Otherwise, use the date/time scale.)

**Common Log**

A common log scale is a base 10 logarithmic scale.
Natural Log

A base $e$ logarithmic scale.

Figure 9-1
Graphs of the Same Data Using Linear, Common Log, and Natural Log Scales

Probability

A probability scale is the inverse of the Gaussian cumulative distribution function. The graph of the sigmoidally shaped Gaussian cumulative distribution function on a probability scale is a straight line. Probabilities are expressed as percentages with the minimum range value set at 0.001 and the maximum range value set at 99.999. The default range depends on the range of the actual data.

Probit

A probit scale is similar to the probability scale; the Gaussian cumulative distribution function plots as a straight line on a probit scale. The scale is linear, however, with major tick marks at each Normal Equivalent Deviation (N.E.D. = $(X - \mu) / \sigma$) plus 5.0. At the mean ($X = \mu$) the probit = 5.0; at the mean plus one standard deviation ($X = \mu + \sigma$) the probit = 6.0, etc. The default range is from 3 to 7. The range limit for a probit axis scale is 1 to 9.
Logit

A *logit scale* uses the transformation $\logit = \ln(y / a - y)$
where $a = 100$ and $0 \leq y \leq 100$

Category

A *category scale* uses numerical values or text from a worksheet column used to
generate a plot. Each distinct entry in the column is a separate category against which
the corresponding data values are plotted. This scale is commonly used for bar charts
or other plots used to graph different categories of data.
Any plot generated by plotting a column containing any text versus a column containing data will use a category axis automatically. For more information, see “Using a Category Scale” on page 416.

You can select a category scale for numeric data, and each unique value will be treated as its own category.

Note: If a column contains more than one instance of the same category, the category appears only once, and all corresponding data is plotted within that category.

Date/Time

Date and time formatted data are automatically plotted using a Date/Time axis scale. This scale is specifically designed to handle true calendar date and time units, labeling and spacing. You can:

- Plot date and time data. For more information, see “Entering Dates and Times” in Chapter 3.
- Change date and time labels. For more information, see “Changing Date and Time Tick Labels” on page 446.
- Change data and time intervals. For more information, see “Tick Intervals for Date/Time Axes” on page 434.

Although you can plot numeric data as date and time, you should first view these numbers as dates and times in the worksheet to make sure they are sensible values.

If a worksheet cell is a label, it won’t plot as a date and time value. In this case, you may want to reenter the label as a date and time value.

Reciprocal

A reciprocal axis scale graphs inverse of a number, where \( x \) is the number which, when multiplied by \( 1/x \), yields 1. Its equation is \( 1/x \) or \( x^{-1} \).
Researchers often use a reciprocal scale when creating graphs for reliability studies. For example, there is a theory that aging accelerates as temperature rises. The plot in this case would use a reciprocal temperature \((1/T (1/mK))\) x-axis and a log \((\ln k)\) y-axis. The slope of the line fitted through the plot is the activation rate of the studied chemical reaction, that is, the reaction causing the failure.

**Weibull**

The Weibull axis displays the Cumulative Percent Failure (CPF) using the Weibull distribution using the formula:

\[
y = \ln(\ln(1/(1-CPF/100)))
\]

This scale is frequently used for life data analysis. The Failure Time, typically a log scale on the x-axis, is plotted against the Cumulative Percent Failure, typically on the y-axis.
Changing Axis Scales and Range

You can control the axis units and increments used in representing your data. Axis scale and range are modified with the Scaling settings of the Graph Properties dialog box Axes tab.

You can also use transforms and tick labels and intervals from worksheet columns to create your own custom axis scales.

Changing Axis Range

Axis range includes the values of the starting and ending points of an axis. You can choose to set axis range automatically or manually.

To change the axis range:

- Double-click the axis to modify. The Graph Properties dialog box appears.
Click the Axes tab.

From the Axis drop-down list, select the axis you wish to modify.

From the Settings for list, select Scaling.

To automatically set the axis range, select Data Range from the Calculation list. SigmaPlot automatically determines the axis range based on the data plotted.

For log axes, or axes that forbid zero or negative numbers, the minimum is set to the nearest major tick mark beyond the smallest value.

To manually set the axis range, select Constant then type beginning and ending axis range values in the Start and End edit boxes.

Note: Date/Time axes display the ranges in date and time units.

Select Pad 5% to add padding to both ends of the axis.

Select Nearest Tick to extend the range to the nearest major tick mark.
Click OK.

**Changing Scale Type**

To change an axis scale type:

- Select the axis to modify.

- On the Properties toolbar, click the Axis Scale button. The Graph Properties dialog box appears.

**Figure 9-7**
*Using the Scale Type list from the Axes Tab of the Graph Properties Dialog Box*

- From the Settings for list, select Scaling.

- From the Scale Type list, select the desired axis scale type. The default axis scale is Linear for all numeric data, Category for text data, and Date/Time for date and time data.

- Click OK.
Using a Category Scale

Use the **category scale** type by plotting a column containing categories against other columns of data values, or modify an already existing plot to use a category scale by changing the axis scale type to Category, then using the Graph Wizard to repick the data and assign your category column as the X or Y coordinate values.

**Figure 9-8**
Plotting Category Data Using a Category Scale

To plot a column of text as a category scale:

- Enter your category data (text) into a worksheet column, and corresponding data into adjacent worksheet columns.
- On the Graph toolbar, click the graph type and style you want to create. The **Graph Wizard** appears.
- Select the data format, and click **Next**.
- Since you have not already selected your data from the worksheet, click the worksheet columns to assign them under **Selected Columns**. Plot your category column as the category axis data type, and pick your other column(s) as the corresponding data type.
Modifying Axes, Tick Marks, and Grids

Click Finish to create the graph.

To modify a plot to use a category scale:

- Double-click the axis you want to modify. The Graph Properties dialog box Axes tab appears.
- Select Scaling from the Settings for list.
- Select Category from the Scale Type drop-down list.
- Click Apply to change the scale type without closing the dialog box.
- Click the Plots tab, and then click Graph Wizard. The Graph Wizard - Modify Plot dialog box appears.
- Under Data Format, select the data format you want to use, and click Next.
- Click the columns in the worksheet to choose the worksheet columns to assign to plotted data under Selected Columns. Plot your category column as the data type you want to use as the category axis, and pick your other columns(s) as the corresponding data type.
- Click Finish to create the graph with the newly assigned worksheet data and modified axis.

Using a Date and Time Scale

SigmaPlot graphs date and time data from worksheet columns as specific calendar dates and times against which corresponding data values in other columns are plotted.

To create a plot using a date/time scale:

- Enter dates or times into a column of a worksheet. For example, enter 1/1, 2/1, 3/1, etc., indicating months and days.
- Enter corresponding data into a separate worksheet column or columns.
Drag the pointer over both the date and data columns.

Create the graph using the Graph toolbar or the Graph Wizard.

Plot your date and time column as the date/time axis.

Pick your other column(s) as the corresponding axis.

Click Finish to create the graph.

Using a Custom Axis Scale

Use the transform language to transform your data for a new axis scale, then use tick intervals from a column to the place correct ticks marks and labels.

For example, to use an Extreme Value Distribution scale, apply the transform:

\[ f(y) = \ln(\ln(100/(100-y))) \]

and for the Arrhenius scale, use the transform:

\[ f(y) = \frac{1-273}{T+273} \]

Apply the transform to both your original interval values and data, then plot the transformed data using the transformed intervals as the tick mark values, and the original interval data as tick labels.
Modifying Axes, Tick Marks, and Grids

Figure 9-9
This graph uses the Arrhenius scale. You can skip labeling tick intervals by using empty cells in the tick label column.

For more information, see “Using Transforms in SigmaPlot” in Chapter 14.

Hiding, Displaying, andDeleting Axes

The easiest way to hide an axis is to select it, then press Delete. The axis is hidden rather than deleted. You can also hide an axis by right-clicking the axis, then choosing Hide.

Control the display of axes using the Lines settings of the Graph Properties dialog box Axes tab.

To view, hide or modify the display of an axis:

- Double-click the axis (you can double-click hidden axes as well). The Graph Properties dialog box appears.
Click the Axes tab.

From the Settings for list, select Lines.

Under Show/Place Axes, select an axis to display that axis, or clear an axis to hide it. Hidden axes hide all ticks and labels associated with that axis.

*Note:* You can hide 3D axes, but if frame lines are active, a line will remain present. For more information, see “Drawing, Modifying, and Hiding Frame Lines” in Chapter 7. Also, if the graph has grid lines, a line will remain present. For more information, see “Displaying Grid Lines and Backplanes” on page 450.

Click OK.
Changing Axis Line, Color, and Thickness

Use the Axes tab of the Graph Properties dialog box to change axis color and thickness.

To change the color and thickness of an axis:

- Double-click the axis. The Graph Properties dialog box appears.
- Click the Axes tab.
- Select Lines from the Settings for list.
- Select the axis you want to modify from the Axis drop-down list.
- To change the color of the axis, under Line Properties, select a color from the Color drop-down list. Choose (None) to make the axis transparent, and choose (Custom) to open the Custom Color dialog box.
- To change the thickness of the axis, under Line Properties, move the Thickness slider or type a thickness in the Thickness box.
- Click OK to apply the changes and close the dialog box.

Note: 3D graph frame lines are drawn over axes lines and may obscure 3D axes modifications.

Using the Object Properties Dialog Box to Change Line Attributes

You can change axis line attributes by right-clicking the axis and choosing Line Properties. You can also select the axis, and then on the Format menu, click Line.
Moving Axes

You can move 2D axes with your mouse, or to a precise location with the Graph properties dialog box. You cannot move 3D axes, but you can hide them from view. For more information, see “Hiding, Displaying, and Deleting Axes” on page 419.

Moving 2D Axes Manually

To move a 2D axis with the mouse, select the axis and drag it to a new position. Y axes move only horizontally and X axes only vertically. Moving ternary graph axes changes the axis range and scale, along with the size and shape of the graph. Axis titles move with the axis.
Modifying Axes, Tick Marks, and Grids

Figure 9-12
Moving an Axis by Dragging

Moving Axes to a Precise Location

Use the Lines settings in the Graph Properties dialog box Axes tab to position axes a precise distance from the graph origin. For more information, see “Modifying Ternary Axes” on page 463.

To move an axis:

- Double-click the axis you want to move. The Graph Properties dialog box appears.
Click the Axes tab.

From the Settings for list, select Lines.

Under Show/Place Axes, move the sliders to change the percentage in the Top and Bottom boxes for X axes or Y axes, or type the value in the fields.

Locations are described as the percentage of the graph dimension the axes lie from the original position. To move an axis up or right, enter a percent greater than 0% (positive). To move an axis down or left, enter a percent less than 0% (negative). The defaults are 0.0%, and Normal.

Click OK.

Setting Axis Breaks

You can set axis breaks for 2D Cartesian graphs over specific ranges, at a specific location along the axis, and you can change the major tick intervals that occur after the break. You can also use several different break symbols.

Note: You can’t create axis breaks on a graph that uses a date and time axis scale.
Creating an Axis Break

To create an axis break:

- Double-click the axis where you want to add the break. The Graph Properties dialog box appears.

![Graph Properties Dialog Box Axes Tab Breaks Settings](image)
▶ Click the Axes tab.
▶ From the Settings for list, select Breaks.
▶ From the Break Range group box, select Show Break.
▶ In the Omit boxes, enter the Break to omit.
▶ **To specify the break position,** move the Position slider.

The location of the break is determined as a percent of the total axis length, from the origin.

▶ **To set the width of the space between break lines,** move the Gap Width slider.
▶ **To set a post break interval,** type a value in the Post Break Interval box.

The default value is the interval specified for the axis range.

*Note:* Tick values from a column are not applied to the post break interval.

To set axis break properties, under Break Properties, from the Symbol drop-down list, select a break symbol type then use the Length, Color, and Thickness options.

▶ Click OK.

### Working with Axis Titles and Tick Labels

SigmaPlot automatically labels graph axes with titles and tick labels. Axis titles can be modified like any other text label.

#### Editing an Axis Title

To edit an axis title:

▶ On the graph page, double-click the axis title. The title appears highlighted.
Modifying Axes, Tick Marks, and Grids

- Make your changes to the title.

*Note:* You can also rename an axis title from within the Axis tab of the Graph Properties dialog box. Double-click the axis, then click Rename. The Edit Text dialog box opens.

**Rotating Axis Titles**

To rotate an axis title:

- Right-click the axis title. On the shortcut menu, click *Edit*.

  Edit Text dialog box appears.

- Select a degree of rotation for the selected label from the *Rotation* drop-down list.

**Viewing and Hiding Axis Titles and Tick Labels**

The easiest way to hide a graph axis title or tick label is to click it and press delete. You can also use the Graph Properties dialog box.

*To view or hide axis titles:*

- Double-click the desired axis. The Graph Properties dialog box appears.
Select Labels from the Settings for list.

- **To view or hide the axis title**, under Show Axis Title select or clear Bottom or Top to specify the position of the axis label.

- **To view or hide Major Tick labels**, from the Apply to list, select Major Ticks, then under Major Tick Labels, then select or clear Bottom or Top to specify the position of the tick label.

- **To view or hide Minor Tick labels**, from the Apply to list, select Minor Ticks, then under Minor Tick Labels select or clear Bottom or Top to specify the position of the tick label.

- Click OK.
Modifying Axes, Tick Marks, and Grids

Moving an Axis Title

To move an axis title, drag it with the mouse, just like any other text label, or on the Format menu, click Size and Position. For more information, see “Using Your Mouse to Move Graphs and Objects” in Chapter 5.

*Note:* Axis title position, relative to the axis, remains constant when the axis or graph is moved.

Changing Tick Mark Intervals

Use the Graph Properties dialog box to modify tick intervals. For more information, see “Displaying and Changing Radial Axis Ticks and Labels” on page 460. You can also change tick marks for ternary graphs. For more information, see “Changing Ternary Axis Range, Scale, and Direction” on page 465.

*Note:* Tick Intervals options vary depending upon the axis scale used. For example, there are no tick interval options for category axes.

Changing Linear and Probit Scale Tick Mark Intervals

To change the tick intervals for linear and probit axis scales:

- Double-click the tick marks you want to change. The Graph Properties dialog box appears.
Click the Axes tab.

From the Settings for list, select Ticks.

To change tick intervals, select from the Ticks and Every drop-down lists in the Tick Intervals group box.

If you select Manual, enter interval values by typing into the Every and From fields. The value in the Every field specifies how often major tick marks appear, and the From value specifies and origin point on the axes from which major tick marks start appearing.

For example, if you type 0 into the From field and the 2 into the Every field, the major tick marks appear at even numbers on the axis. If you type 1 into the From field, the major tick marks appear at odd numbers on the axis.

Custom Tick Intervals: You can also choose major tick interval values from the worksheet from the Major Tick Intervals list. Custom tick intervals are not available for minor ticks. For more information, see “Customizing Tick Intervals” on page 435.
Click OK.

**Tick Intervals for Log Axes**

You can only specify log axis major tick marks automatically or from a column. However, you can select specific intervals for log scale minor ticks.

Figure 9-18
A View of a Graph with Log Y Axis Minor Ticks

To change log scale minor tick intervals:

- Change the axis scale to a log axis. For more information, see “Changing Axis Scales and Range” on page 413.

- Double-click the tick marks. The Graph Properties dialog box appears.
Figure 9-19
The Axes Minor Tick Intervals Options for a Log Axis

- Click the Axes tab.
- From the Settings for list, select Ticks.
- From the Apply to drop-down list, select Minor Ticks.
- Select all minor tick intervals you want to appear, and clear those you want hidden.
- Click OK.

Natural Log and Logit Scales

Natural log and logit scales have only Automatic and from column Tick Intervals.

Natural log intervals occur at every factor of e. Logit ticks occur at 7, 10, then every ten until 90, then 95 and 97.
Figure 9-20
Tick Intervals for Natural Log and Logit Scales

Tick Intervals for Probability Scales

Probability scale axes have no minor ticks, but have three different settings for major tick intervals, coarse, medium, and fine, as well as the option to set tick intervals from a worksheet column.

Figure 9-21
Coarse, Medium and Fine Tick Intervals for Probability Scales

To specify the tick mark density for probability scales:

- Double-click the tick marks. The Graph Properties dialog box appears.
Chapter 9

Figure 9-22
Axes Tick Intervals Options for a Probability Axis

► Click the Axes tab.
► From the Settings for list, select Ticks.
► Under Tick Intervals, from the Density drop-down list, select a tick mark density.
► Click OK.

Tick Intervals for Date/Time Axes

SigmaPlot automatically sets both major and minor tick intervals that are computed from the data range. You can also manually set Major Ticks and Minor Ticks.

To set tick intervals for a date/time axis:
► Double-click the tick marks. The Graph Properties dialog box appears.
Click the Axis tab.

From the Settings for drop-down list, select Ticks.

Under Tick Intervals, from the Type drop-down list, select a tick interval type. Tick intervals are defined by the unit Type used and the selected Count. Dates fall at 12:00 AM of the first day for that period. The major tick interval options available are limited by the data range. You are prevented from selecting time units that would create too many tick marks.

To increase the period between tick occurrences, change the Count. For example, set ticks to occur every other Type date by changing the Count to 2, or every fifth by changing the count to 5.

Counts must be positive integers.

To set minor tick intervals, from the Apply to drop-down list, select Minor Ticks.

Select the minor tick Type and Count. Any time unit equal to or smaller than the Major interval type can be used as the Minor interval type.

Note: Do not select a minor interval that creates hundreds or even many thousands of minor tick marks.

Customizing Tick Intervals

You can specify major tick locations by entering major tick values into a worksheet column, then selecting that column from the Graph Properties dialog box.

Custom tick intervals are not available for minor ticks.

To use worksheet columns to customize tick intervals:

Enter the desired tick marks into an empty worksheet column.

Double-click the tick marks. The Graph Properties dialog box appears.
Chapter 9

Figure 9-23
Selecting a Column for Tick Label Intervals

- Click the Axes tab.
- From the Settings for drop-down list, select Ticks.
- From the Apply To drop-down list, select Major Tick Intervals.
- Under Major Tick Intervals, from the Ticks drop-down list, select the column number or title of the column you want to use for major tick marks.
- Click OK. The numeric values of the intervals are automatically used for tick labels, that you can modify them like any other tick labels.
**Changing Tick Mark Appearance**

Use the Graph Properties dialog box to modify tick appearance including tick length and color. You can also specify tick mark direction, or hide tick marks altogether. You can change:

- Tick marks for polar plots. For more information, see “Displaying and Changing Radial Axis Ticks and Labels” on page 460.
- Tick marks for ternary graphs. For more information, see “Changing Ternary Axis Range, Scale, and Direction” on page 465.

**Tick Mark Direction**

To turn tick drawing on and off and to select tick directions for both sides of an axis:

- Double-click the tick marks. The Graph Properties dialog box appears.

![Figure 9-24: The Axes Tick Direction Options](image)

- Click the Axes tab.
- From the Settings for list, select Ticks.
From the Direction list for either axis:

- Select **Outward** to point tick marks away from the graph.
- Select **Inward** to point tick marks toward the inside of the graph.
- Select **Both** to point tick marks in both directions.
- Select **(none)** to hide tick marks.

*Note:* The options that appear under Direction are dependent upon what type of graph you are modifying. If you are modifying a 3D plot, then the options are **Front** and **Rear**. If you are modifying a polar plot with a radial axis, then the options are **Outer** and **Inner**. In a polar plot with a radial axis, you change the direction of the spokes.

Directions for tick marks are independent for either side of the axis.

**Hiding Tick Marks**

To hide tick marks:

- Click the tick marks on the page.
- Press Delete, or right-click and from the shortcut menu, click **Hide**.

**Changing Tick Mark Line Attributes**

To change tick mark length, color, and thickness:

- Double-click the tick mark. The **Graph Properties** dialog box appears.
From the Settings for list, select Ticks.

From the Apply to drop-down list, select Major Ticks or Minor Ticks.

To change tick length and thickness, under Tick Line, move the Length and Thickness sliders.

Select a color from the Color drop-down list. Choose from any of the listed colors, or select (Custom) to use a pre-defined custom color or create your own color. For more information, see “Using Custom Colors” in Chapter 5. Select (none) to create transparent tick marks.

Click OK.


**Changing Tick Labels**

SigmaPlot can display tick labels for:
- Both major and minor tick marks.
- Standard numeric labels.
- Time and series labels.

You can also add a suffix or prefix to all major or minor tick labels on a selected axis, and modify the calculation and precision of numeric labels, view different dates and times, select among many different series labels, and change the font and other text attributes.

**Changing Tick Label Font and Other Text Attributes**

To change the font size, style, or color of tick labels:

- Right-click the tick labels, and from the shortcut menu, click **Text Properties**.

![Figure 9-26](image)

*Selecting a Column for Tick Label Intervals*

The **Text Properties** dialog box appears.

- Click the **Font** tab.
Change text attributes for tick labels the same way you would for any text label.

You can also use the Rotation drop-down list on the Paragraph tab to rotate tick labels, but no other Paragraph settings are applied to tick labels.

For more information, see “Formatting Text” in Chapter 5.

**Changing Tick Label Type**

You can change the type of tick label used for all axis types except for category axes.

*To change all other tick label types for all other axes:*

- Double-click the tick labels you want to change. The Graph Properties dialog box appears.

**Figure 9-27**
*Changing the Tick Label Type*

- Click the Axes tab.
- From the Settings for list, select Tick Labels.
From the Apply to drop-down list, select either Major Ticks or Minor Ticks.

To use a numeric type of tick label, from the Type list, select Numeric, then use the Label Notation options.

To use a series type of tick label, from the Type list, select Series.

Click OK.

Note: If you want to plot data versus true calendar dates, you should have entered date and time data in the worksheet, and use a date/time axis scale.

**Formatting Numeric Tick Labels**

To format numeric tick labels:

Double-click the tick labels of the axis you want to change. The Graph Properties dialog box appears.

Figure 9-28
Selecting Numeric Tick Label Notation

Click the Axes tab.
From the Settings for list, select Tick Labels.

From the Apply to drop-down list, select either Major Ticks or Minor Ticks.

Under Label appearance, from the use drop-down list, select the type of label notation to use.

*Scientific Notation* or *Engineering Notation* for large numbers use scientific or engineering notation only when numbers exceed a specified range. Use the When below and or above drop-down lists to specify the range beyond which scientific notation or engineering notation is used. Once a label exceeds the range, then all the labels will use the specified notation.

For log axes, you can select to display the number, only the Exponent, or both the Base and exponent.

For linear axes, you can select *Scientific notation* or *Engineering notation* to use always, or you can select *Scientific notation, for large numbers* or *Engineering notation, for large numbers* to use only when needed for large numbers. To specify when scientific notation is needed, enter the lower and upper ranges in the When below and or above.

**Figure 9-29**  
*Log Scale Y Axes Using Numbers, Exponent Only, and Base and Exponent*

To divide numeric tick label values by a specific number, enter a divisor in the Factor Out drop-down list. A value of 2 divides label values in half, a factor of 0.5 doubles the tick label values, etc.

To specify the number of places used to display numeric tick labels, under Precision, select Automatic to let SigmaPlot automatically determine precision, or select Manual, then select the number of decimal places to use from the Places drop-down list.

Click OK.
**Formatting Series Tick Labels**

To format series tick labels:

- Double-click the tick labels of the axis you want to change. The Graph Properties dialog box appears.

**Figure 9-30**  
*Selecting Series Tick Label Format*

- From the Settings for list, select **Tick Label**.

- From the Apply to drop-down list, select either **Major Ticks** or **Minor Ticks**.

- From the Type drop-down list, select **Series**.

- From the Series drop-down list, select a series.

- From the Length drop-down list, set the number of characters to use for the tick label.

- From the Start At drop-down list, specify which series item to begin labeling tick marks with.
From the Step By list, set the frequency, or increment, of series items to use.

For example, if you are using a Days of the Week series, you might choose to start with Monday, and to step labeling by 2 days at a time. Tick labels appear as Monday, Wednesday, Friday, Sunday, Tuesday, etc.

To re-start tick labeling from a specified point, use the After and Repeat From drop-down lists.

For example, if you were using a Days of the Week series, and were stepping by 2 days at a time, you might use the After and Repeat From lists to specify that after Friday, repeat the series from Monday. Tick labels appear as Monday, Wednesday, Friday, Monday, Wednesday, Friday, etc.

Click OK.

**Adding a Prefix or Suffix to Tick Labels**

To add a suffix or prefix to the major or minor tick labels on a selected axis:

- Double-click the axis you want to change. The **Graph Properties** dialog box appears.
- Click the **Axes** tab.
- From the Settings for list, select **Labels**.
- From the Apply to drop-down list, select either **Major Ticks** or **Minor Ticks**.
- To add a prefix or suffix to the major or minor tick labels, type the prefix or suffix into the appropriate **Add to Tick Labels Prefix** or **Suffix** boxes. All labels on the selected axis appear with the specified suffix or prefix.

You can use any keyboard or extended characters. Use the **Windows Character** map accessory program, or Alt+Numeric keypad combinations to enter extended characters like degrees symbols (Alt+0176).

Click OK.
Changing Date and Time Tick Labels

To change the format of date/time tick labels, use the Graph Properties dialog box. Entering values in these boxes is similar to entering date/time values in the worksheet.

To change date and time tick label format:

- Double-click the tick labels of the axis you want to change. The Graph Properties dialog box appears.

Figure 9-31
Changing Date/Time Tick Labels

- From the Settings For list, select Tick Label.

- From the Apply to drop-down list, select either Major Ticks or Minor Ticks.

- To change the display Date format, select a format from the list, or use the following table to enter a new label, using any additional characters as delimiters (i.e., slashes,
commas, spaces, etc.). As you enter a different format, the Sample window shows an example of the label.

<table>
<thead>
<tr>
<th>Typing:</th>
<th>Displays:</th>
</tr>
</thead>
<tbody>
<tr>
<td>M/d/yy</td>
<td>No leading 0 for single digit month, day or year</td>
</tr>
<tr>
<td>MM/dd/yy</td>
<td>Leading 0 for single digit month, day or year</td>
</tr>
<tr>
<td>MMMM</td>
<td>Complete month</td>
</tr>
<tr>
<td>dddd</td>
<td>Complete day</td>
</tr>
<tr>
<td>yyy or yyyy</td>
<td>Complete year</td>
</tr>
<tr>
<td>MMM</td>
<td>Three-letter month</td>
</tr>
<tr>
<td>ddd</td>
<td>Three-letter day</td>
</tr>
<tr>
<td>gg</td>
<td>Era (AD or BC)</td>
</tr>
</tbody>
</table>

To change the display Time format, select a format from the list, or use the following table to enter a new label, using any additional characters as delimiters (i.e., colons, spaces, etc.). As you enter a different format, the Sample window shows an example of the label.

<table>
<thead>
<tr>
<th>Typing:</th>
<th>Displays:</th>
</tr>
</thead>
<tbody>
<tr>
<td>hh or h</td>
<td>12 hour clock</td>
</tr>
<tr>
<td>HH or H</td>
<td>Military hours</td>
</tr>
<tr>
<td>mm or m</td>
<td>Minutes</td>
</tr>
<tr>
<td>ss or s</td>
<td>Seconds</td>
</tr>
<tr>
<td>uu or u</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>H: h: m: s: or u</td>
<td>No leading zeroes for single digits</td>
</tr>
<tr>
<td>HH: hh: mm: ss: uu</td>
<td>Leading zero for single digits</td>
</tr>
<tr>
<td>tt</td>
<td>Double letter AM or PM</td>
</tr>
<tr>
<td>t</td>
<td>Single letter AM or PM</td>
</tr>
</tbody>
</table>

Click OK.
Using Custom Tick Labels

You can enter text and numbers into worksheet columns and use them as major tick labels.

To customize tick labels using worksheet columns:

- Enter the labels you want to use in a worksheet column in the order you want them to appear. Enter minor labels in the right adjacent column.

Figure 9-32
Tick Labels from a Column using the Symbol Font

Note: To skip specific labels, leave an empty cell for that tick mark when entering the labels into the worksheet column.

- Double-click the axis tick labels you want to modify. The Graph Properties dialog box appears.
Modifying Axes, Tick Marks, and Grids

Figure 9-33
Selecting a Columns as the Source for the Tick Labels

Click the Axes tab.

From the Settings for list, select Tick Labels.

From the Type drop-down list, select the column to use for major labels. Labels for minor ticks are automatically taken from the column to the right of the major tick labels.

To change the font used for the tick labels, click Font.

The Text Properties dialog box appears. You can use the Symbols font for Greek characters, and the Wingdings and other symbol fonts for iconic labels.

Click OK.
Displaying Grid Lines and Backplanes

Display and modify grids for each graph plane using the Graph Properties dialog box. Grid lines are associated with both a backplane and one of the two axes which form the plane. If a graph has multiple axes, the axes used are the original pair.

You can choose to turn on and modify grid lines for both major and minor tick intervals. Tick intervals are controlled using the Graph Properties dialog box Axes tab Scaling settings.

Modifying Backplanes

To change back planes:

- Double-click the graph to modify. The Graph Properties dialog box appears.
- Click the Graph tab.
- Under Settings for, select Backplanes.
- If your graph is a 3D graph, from the Plane list, select the plane to modify.

Note: When modifying a 2D graph, only one plane is available.

- **To select a background color for the selected plane,** under Background, select a color from the Color drop-down list.

- Select any of the listed colors, or select (Custom) to use or create a custom color. For more information, see “Using Custom Colors” in Chapter 5.

- Select (none) to create a transparent plane. Transparent planes are especially useful when superimposing graphs over one another. The grid lines available for Cartesian plots are X, Y, and Z for 3D plots. The grid lines for polar plots are for the Angular and Radial axes. Ternary plots have X, Y and Z direction grid lines.

- Click OK.
Modifying Grid Lines

To change major or minor grid lines:

► Double-click the graph to modify. The Graph Properties dialog box appears.

► Click the Graph tab.

► Under Settings for, select Grid Lines.

Figure 9-34
Selecting the Grid Lines

► **To change grid line thickness**, under Gridlines, move the Thickness slider type a thickness value in the Thickness box.

► **To change grid line style**, under Line properties, from the Style drop-down list, select a style.

► **To change grid line color**, under Line properties, from the Color drop-down list, select a color. Choose any of the listed colors, or choose (Custom) to use or create a custom color. Choose (none) to turn off grid lines. For more information, see "Hiding and Viewing Grid Lines" on page 452.
To move the grid behind or in front of the plot, from the Layering drop-down list, select to move either the plot or grid to the front. This feature is especially useful for bar charts, and is not available for 3D plots.

Click OK.

Figure 9-35
A Bar Chart with a White Backplane and White Grid Lines Placed in Front of the Plot

Hiding and Viewing Grid Lines

To view hidden grid lines, or hide visible grid lines:

- Open the Graph Properties dialog box.
- Click the Graph tab.
- Select Grid Lines from the Settings for list.
- To hide grid lines, under Style, select (none) from the Style drop-down list.
- To display grid lines, change the style to a style other than (none).
- Click OK.
Modifying Polar Axes

Polar plots have a radial axis and an **angular axis**. The angular axis describes a circle and can use radians, degrees, or other units as the scale. There are both outer and inner **angular axes**.

The **radial axes** are spokes of the circle and scale the distance from the center of the circle (the radius, or R). There are four radial axes, referred to as spokes 1-4.

*Figure 9-36*
A Diagram of the Axes of a Polar Plot

*Note:* **Axis breaks** cannot be created for either radial or angular axes.

Angular Axes

You can draw angular axes along the inner and outer circumferences of the graph. By default, the inner axis is not displayed. You can modify angular axes by:

- Changing axis titles. For more information, see “Working with Axis Titles and Tick Labels” on page 426.
- Displaying or hiding either axis. For more information, see “Hiding, Displaying, and Deleting Axes” on page 419.
Changing axis lines. For more information, see “Changing Axis Line, Color, and Thickness” on page 421.

Changing axis scaling, range, and rotation. For more information, see “Changing Angular Axis Scaling and Position” on page 454.

Changing tick marks. For more information, see “Changing Tick Mark Intervals” on page 429.

Changing axis tick labels. For more information, see “Changing Tick Labels” on page 440.

Changing Angular Axis Scaling and Position

Polar plot angular axis scale and range settings control the axis units and increments used to plot data. You can modify axis scale, range, units, and rotation using the Scaling settings of the Graph Properties dialog box Axes tab.

To change an axis scale, range, units, and rotation:

1. Double-click the plot. The Graph Properties dialog box appears.

Figure 9-37
Graph Properties Dialog Box Axes Tab Scaling Settings
Click the Axes tab.

Select Scaling from the Settings for list.

To change the axis scale used, choose the desired axis scale type from the Scale Type list. For more information, see “Axis Scale Types” on page 408.

To change the measurement units of the angular axis, select measurement units from the Angular Axis Units drop-down list. If you don’t see the axis units you want to use for your polar plot listed in the list, select Other, then type new axis range values in the Range Lower Bound and Range Upper Bound fields. If using a predefined measurement unit, the Range Lower Bound and Range Upper Bound box values are entered automatically. For more information, see “Using a Custom Axis Scale” on page 418.

Note: The only effect of changing units is to change the pre-defined axis range. This range can be manually changed regardless of the current units.

To change the size of the displayed arc of the polar plot, move the Arc slider. A setting of 360 degrees displays the entire circle, 270 degrees displays three-quarters of the circle, and 90 degrees displays half of the circle.

Note: If you change the arc of the angular axis, the axis range remains the same. The current axis range appears along the new distance of the arc.

To change the start angle for the displayed arc, move the Start Angle slider. The default is 0 degrees (3 o’clock). Rotation is counterclockwise.

Figure 9-38
Polar plots with: Starting angle of 315° and arc of 270°; start angle of 0° and arc of 180°; and start angle of 135° and arc of 22.5°.

Click OK.
**Moving Angular Axis Positions**

You can drag both inner and outer **angular axes** closer or further from the center of the graph. Select the axis, and move it using the mouse.

**To set exact locations for angular axes:**

- Double-click an **angular axis**. The Graph Properties dialog box appears.

  ![Graph Properties Dialog Box Axes Tab Lines Settings](image)

  - Click the **Axes** tab.
  - Select **Lines** from the Settings for list.
  - **To change the percentage in the Outer and Inner axes**, under Show/Place Axes, move the Outer and Inner slider controls.

Locations are described as the percentage of the distance the axes lie from the center of the graph. To move an axis out, increase the percent. To move an axis in, decrease the percent.
Modifying Axes, Tick Marks, and Grids

Click OK.

Radial Axes

The radial axes are drawn along the radius of the graph, and by default are displayed as four axes extending from the center of the graph to the outer edge of the graph. Each of the radial axes is a representation of the same data, so the range and scale must be the same for each radial axis; however, you can modify the color, tick marks, labels, location, and display of each radial axis independently.

Modify radial axes by:

- Displaying or hiding any axis. For more information, see “Hiding, Displaying, and Deleting Axes” on page 419.
- Changing display of axis and tick label titles. For more information, see “Displaying and Changing Radial Axis Ticks and Labels” on page 460.
- Changing axis lines. For more information, see “Modifying Radial Axes Lines and Position” on page 457.
- Changing axis scaling. For more information, see “Changing Axis Scales and Range” on page 413.
- Changing tick marks. For more information, see “Changing Tick Mark Intervals” on page 429.
- Changing axis tick label type. For more information, see “Changing Tick Labels” on page 440.

Modifying Radial Axes Lines and Position

To control polar plot radial axes line settings:

- Double-click the graph to open the Graph Properties dialog box.
- Click the Axes tab.
- Select Lines. Moving a Radial Axis

To move a radial axis:

- Select the axis on the page.
Use the mouse to drag it to a new location. Radial axes rotate about the center of the graph like the spokes of a wheel. Setting Radial Axis Positions to Exact Degree Positions

To set radial axis positions to exact degree positions

Double-click a radial axis. The Graph Properties dialog box appears.

Figure 9-40
Graph Properties Dialog Box Axes Tab Lines Settings

Click the Axes tab.

Select Lines from the Settings for list.

To move a radial axis, under Show/Place Axes, move the sliders to set a new location. The axis location is in degrees from 0 degrees (3 o’clock). The defaults are 0 degrees, 90 degrees, 180 degrees, and 270 degrees.

To offset an axis from the center of the graph, move the Axes Start slider to change the length of the radial axes.
Setting the slider to 0% draws the axis from the center of the graph outward, 25% draws the axis beginning a quarter of the distance from the center, 50% draws it half the distance from the center, and so on.

Figure 9-41
*Radial Axes in the Default Positions, and Offset by 45 degrees with an Axes Start of 30%.*

Click OK. Displaying and Modifying Radial Axes Lines

To display and modify radial axes lines:

Double-click a radial axis. The Graph Properties dialog box appears.

Figure 9-42
*Graph Properties Dialog Box Axes Tab Lines Settings*
Click the Axes tab.

Select Lines from the Settings for list.

To view or hide a radial axis, select Spoke 1, 2, 3, or 4.

Select or clear the Show/Place Axes boxes to show or hide the axis.

To change line color and thickness, under Line Properties, select a color and thickness from the Color and Thickness drop-down lists.

Click OK.

Displaying and Changing Radial Axis Ticks and Labels

Use the Graph Properties dialog box Axes tab Labels settings to display polar radial axis labels, and modify tick labels. Angular axes labels are analogous to standard Cartesian graph titles and labels. However, radial tick marks and labels have additional positioning options.

Other than display and position, polar plot tick marks and labels have the same options as Cartesian graph tick marks and labels.

Viewing, Hiding, or Moving Titles and Tick Labels on the Radial Axes

To view, hide, or move titles and tick labels on the radial axes:

Double-click a radial axis. The Graph Properties dialog box appears.
Click the Axes tab.

Select Labels from the Settings for list.

Select either Minor Ticks or Major Ticks from the Apply to drop-down list.

To move or hide the major or minor tick labels on the radial axes, use the Major (or Minor) Tick Labels options.

Select (none) to hide the labels.

Select clockwise or counterclockwise to move the label from one side of the axis to the other.

Click OK.
Hiding Tick Marks

Hide tick marks by clicking the ticks and pressing the Delete key. You can also right-click the labels and click Hide.

Specifying the Direction for Radial Axis Tick Marks for Each Pair of Radial Axes

To specify the direction for radial axis tick marks for each pair of radial axes:

- Double-click any radial axis tick mark. The Graph Properties dialog box appears.

Figure 9-44
Graph Properties Dialog Box Axes Tab Ticks Settings

- Click the Axes tab.
- Select Ticks from the Settings for list.
- Select either Minor Ticks or Major Ticks from the Apply to drop-down list.
- Use Direction options to change the tick directions on the radial axes. You can only change the directions for Spokes 1 and 3 together, and for 2 and 4 together.
Modifying Axes, Tick Marks, and Grids

Note: Selecting Inward orients the ticks clockwise, and Outward points the ticks counterclockwise.

Figure 9-45
Polar Plots with All Ticks Pointing Inward, Spokes 1, 3 Inward and 2, 4 Outward, and All Ticks Pointing in Both Directions

► Selecting Both directions draws ticks both clockwise and counterclockwise, and selecting (none) hides the tick marks.

► Click OK.

Modifying Ternary Axes

Ternary axes are drawn to represent increases in data value in a counterclockwise direction by default. You can reverse the axis direction, which is indicated by a reversal of tick labels. The tick direction changes accordingly.

Because ternary axes are interdependent, any modification in the scale type or range of one of the axes is reflected in the other axes, and may alter the shape and size of the graph. You can modify the color and thickness of axis lines, the appearance of tick marks and tick labels, location and rotation of axis titles, and display of each ternary axis independently.

Ternary axes can be modified similarly to other graph axes.

Note: You cannot create axis breaks for ternary axes.

Modifying Ternary Axis Title Location

You can position axis titles of ternary graphs either at the apex or along the length of the axis. You can also rotate them to a position parallel to the axis.
To reposition a ternary graph axis title:

- Double-click the axis. The Graph Properties dialog box appears.
- Click the Axes tab.
- Select Labels from the Settings for list.

*Tip:* To identify which axis is associated with an axis title, keep in mind that the title at the apex is always at the 100% point or maximum for that axis.

- Under Show Axis Title, select the desired Axis title location from the At drop-down list.
- Select Axis Title in the Rotate with Axis group box to rotate the axis title parallel to the axis.
- Click Apply.
- Continue to modify the titles of the other axes. Specify the axis title you want to change using the Axis list, then make the desired changes.
- When you have finished click OK.

Figure 9-46
*The titles along the axes are also rotated with the axes.*
Modifying Axes, Tick Marks, and Grids

Changing Ternary Axis Range, Scale, and Direction

Ternary axis scale type and range settings control the units and increments used to plot the data. Axis scale, range, and direction are modified using the Scaling settings displayed in the Graph Properties dialog box Axes tab. Axis range can also be modified by dragging a selected axis. Modifying a ternary axis range can alter the size and even the shape of the graph.

Modifying Axis Range by Dragging

You can modify axis range by dragging a selected axis or apex. Because ternary axes are interdependent, dragging an axis to modify its range can change the ranges of the other axes.

Dragging an apex modifies the ranges of the two axes which form the apex; reducing the maximum of an axis range introduces a fourth axis, creating a trapezoid graph. Dragging a selected axis toward or away from the center of the graph modifies all three axis ranges by the same increment, maintaining the original shape of the graph.

To modify ternary axis ranges:

► View the ternary graph.

► Select either an apex or an axis to modify.

A selected apex displays a black, square selection handle and is surrounded by a dotted line; a selected axis displays a selection handle at the center point of its range and is surrounded by a dotted line.
Drag either the apex or the axis toward or away from the center of the graph. The axis ranges adjust accordingly.

*Note:* Modifying axis ranges of ternary graphs often introduces additional axes. These axes are the second axes of each "pair" of axis lines. An axis which appears as a result of moving an apex is paired with the axis opposite the apex which moved. Additional axes can be modified and are controlled in the same way as the three original ternary axes using the Axes tab of the Graph Properties dialog box.

*Figure 9-48*  
The left graph Y axis was dragged to 50%. The right graph Y apex was dragged to 50%.
Modifying Ternary Axis Range

Modify ternary graph ranges using the Graph Properties dialog box:

- Double-click the axis. The Graph Properties dialog box appears.

Figure 9-49
Graph Properties Dialog Box Axes Tab Scaling Settings

- Click the Axes tab.

- Select Scaling from the Settings for list.

- Use the slider controls for X Range, Y Range, and Z Range to change individual axis ranges.

  Note: When you change the Minimum for any axis, the maximums for the other axes adjust automatically. The Maximum value must be greater than the Minimum value.

- Click OK.
Note: Increasing an axis range minimum reduces the size of the ternary graph because it is always reduces the other axis range maximums. Reducing the maximum of a ternary axis range changes the graph shape.

Ternary Scale Type

All ternary axes on a single graph use either the default Percentage (0-100) scale or the Unitary (0-1.0) scale. Data used by each scale should be within the required ranges for each scale.

The type of graph you create determines the graph scale. There should be no need to change the scale unless a mistake was made while creating the graph. Changing the scaling from Percentage to Unitary can also hide out-of-range data.

Figure 9-50
The data range used for Percentage is 0-100; the data range for Unitary data is 0-1.

To change ternary axis scale type:

- Double-click the angular axis. The Graph Properties dialog box appears.
Click the Axes tab.

Select Scaling from the Settings for list.

Select the new axis scale type from the Scale Type drop-down list.

Click OK.

When you change the axis scale type for one axis, it is changed for all axes.

Changing Ternary Axis Direction

Ternary graph axes show data increasing in either a clockwise or counterclockwise direction. Each axis line can represent either or both of two values in the graph. Changing the direction changes which values are shown on the axis by default. Modifying axis direction changes all three axes; ternary axes are interdependent.

Ternary graph axes have interdependent axis ranges from 0 to 100, where 0 to 100 is the default setting or 0-1.0 where 0-1.0 is the default setting. For more information, see “Ternary Scale Type” on page 468.
The axis range and scale control the axis units and increments used to plot data.

To modify the axis direction:

- Double-click the plot. The Graph Properties dialog box appears.

Figure 9-52
Graph Properties Dialog Box Axes Tab Scaling Settings

- Click the Axes tab.
- Select Scaling from the Settings for list.
- Select the axis you wish to modify from the Axis drop-down list.
- Select the axis direction from the Direction drop-down list.
- Click OK.

The tick directions change on all three axes and the axis ranges reverse.
Changing the axis directions inverts the 0-100 direction of the labels and changes the direction of the tick marks. However, axis titles only move if they are positioned
along an axis, not at an **apex**. Apex position for each variable remain constant regardless of axis direction.

**Figure 9-53**
*Ternary Graphs Displaying Counterclockwise (Left) and Clockwise (Right) Axis Directions*

---

**Changing Ternary Axis Tick Marks and Tick Labels**

Ternary axes tick marks indicate the precise location of each value at specific intervals determined by the axis range. Tick marks and tick labels along ternary axes have both direction and origin. Every tick location can have tick marks and labels pointing in clockwise, counterclockwise, both clockwise and counterclockwise, and perpendicular directions, independent of the actual direction of the data.

**Tick and Tick Label Directions and Ownership**

Tick marks and labels indicate which values correspond to the plotted data points by the direction they lean in. The direction also indicates which axis the tick is actually controlled by. This can be a different axis than the tick mark is actually drawn on.

For example, the default ticks for the X axis are drawn leaning in a clockwise direction on the bottom axis. These tick marks also correspond to the counterclockwise tick marks on the Y axis. If you change the tick mark attributes for X axis ticks, you can affect tick marks that are actually drawn on a different axis.

The following figure best illustrates tick mark and label ownership.
Figure 9-54
The X Axis ticks and labels are drawn in light gray, the Y Axis ticks and labels are drawn in black, and the Z Axis ticks and labels are drawn in dark gray.

Figure 9-54

**Modifying Ternary Tick Marks Direction and Intervals**

Use the Graph Properties dialog box to modify tick appearance including tick length and color. You can also specify to view or hide tick marks, which side of the axis they extend from, and the tick interval.

**To modify tick marks:**

- Double-click the tick marks. The Graph Properties dialog box appears.
Click the Axes tab.

Select Ticks from the Settings for list.

Select either Major Ticks or Minor Ticks from the Apply to drop-down list.

To turn tick drawing on and off and to select tick directions for both sides of an axis line, use the Direction lists. The second list is only available if a ternary plot range change has created a secondary axis.

Select Out, In, or In and Out to display tick marks on the selected axis out from the center of the graph, in toward the center of the graph, or both outward and inward. Select a clockwise, counterclockwise, both, or 90 Degree option to select the tick mark direction along the axis. Select (none) to hide tick marks.
To change major tick intervals, move the Major Tick Intervals slider.

To change minor tick intervals, under Tick Intervals, select a new value from the Minor Tick Intervals drop-down list.

Click Apply.

Use the Axis drop-down list to modify tick marks on a different axis, or use the Apply to drop-down list to switch to modifying major or minor tick marks.

Click OK.

**Modifying Ternary Tick Mark Line Appearance**

To change tick mark display, length, color, and interval:
Double-click the tick marks you want to change. The Graph Properties dialog box appears.

Figure 9-58
Graph Properties Dialog Box Axes Tab Ticks Settings

- Click the Axes tab.
- Select Ticks from the Settings for list.
- Select either Major Ticks or Minor Ticks from the Apply to drop-down list.
  
  - **To change tick length and thickness**, under Tick Line, move the Length and Thickness sliders. Drag the slider control with the mouse or set the tick length and thickness to specific values by typing directly in the Length and Thickness boxes.
  
  - **To change tick color**, under Tick Line, select a color from the Color drop-down list. Choose from any of the listed colors, or select (Custom) to use a pre-defined custom color or create your own color. Select (none) to create transparent tick marks.
  
- Click Apply.
Use the Axis drop-down list to modify tick marks on a different axis, or use the Apply to drop-down list to switch to modifying major or minor tick marks.

Click OK.

**Modifying Ternary Tick Label Display**

Tick labels are drawn using directions clockwise, counterclockwise, and both clockwise and counterclockwise. Tick label direction is controlled independently of the data direction. Tick labels can also be turned off, have a prefix or suffix added, and be rotated along the angle of the axis line.

You can also modify the tick label. For more information, see “Formatting Numeric Tick Labels” on page 442.

**To modify tick label display along an axis:**

1. Double-click the axis you want to change. The Graph Properties dialog box appears.

![Graph Properties Dialog Box Axes Tab Labels Settings](image)

2. Click the Axes tab.

3. Select Labels from the Settings for list.
Select the Major (or Minor) Tick Labels check boxes. Depending on the selected axis, the check boxes are Top, Bottom, Left, or Right.

To change the direction of the axis tick labels, select the Clockwise and counterclockwise (CCW) check boxes. You can draw in both directions at once.

To draw tick labels at the 90 degrees tick position, clear both direction options.

Figure 9-60
Ternary Graph Axes with Tick Labels counterclockwise, Both Clockwise and CounterClockwise, and Neither (90 Degrees)

To add a suffix or prefix to the major or minor tick labels on ternary axes, select either Major Ticks or Minor Ticks from the Apply to drop-down list, then use the Add To Major (or Minor) Tick Labels options to type a prefix or suffix to the major or minor tick labels.

To rotate major or minor tick labels parallel to their axis, select either Major Ticks or Minor Ticks from the Apply to drop-down list, then under Rotate with Axis, select Tick Labels.

Click Apply.

Use the Axis list to modify tick labels on a different axis, or use the Apply To drop-down list to switch to modifying major or minor tick labels.

Click OK.

Note: Tick labels and tick marks are controlled by their axis of origin, but may be drawn on axes other than their own.
This chapter covers many of the features available on the Statistics menu, including:

- Running t-tests (see page 479).
- Computing a histogram (see page 481).
- Plotting and modifying linear regression lines (see page 487).
- Adding and modifying reference lines (see page 487).

**Running Paired and Independent t-Tests**

A t-test determines if the mean values of two data columns are significantly different by testing the hypothesis that the means of the two columns are equal. SigmaPlot can perform both paired and unpaired t-tests.

A paired t-test requires columns of equal length, since the data is assumed to be before and after data on the same subjects. An independent t-test can be performed on differently sized columns, since no relationship is assumed between the groups.

*To perform a t-test:*

- From the menus select:
  Statistics
  t-test

  or

  Statistics
  Paired t-test

  Thet-test Column Picker dialog box appears.
Select the columns from the Selected Columns list or click the columns in the worksheet to pick the columns you want to compare. Selected columns are assigned to the highlighted group in the Selected Columns list.

Click Finish. SigmaPlot displays results for the t-test.

To save the t-test results, copy and paste the data to the worksheet, page, or another application.

For each test these values are displayed:

- T, the Student’s t statistic
- P, the probability that you are incorrect in stating that the two means are different
- The Degrees of Freedom, a measure of the sample size
**Calculation of t**

When performing \( t \)-tests, \( t \) is defined differently for paired \( t \)-tests than for unpaired tests.

**Paired Test.** For a paired \( t \)-test on data sets \( \{x_1, x_2, \ldots, x_n\} \) and \( \{y_1, y_2, \ldots, y_n\} \)

\[
t = \frac{\bar{D}}{S_D} \text{ where } \bar{D} = \bar{x} - \bar{y} \text{ and } S_D = \sqrt{\frac{\sum D_i^2 - (\sum D_i)^2}{n(n-1)}} \text{ where } D_i = x_i - y_i
\]

**Unpaired Test.** For an independent \( t \)-test on data sets \( \{x_1, x_2, \ldots, x_{n_1}\} \) and \( \{y_1, y_2, \ldots, y_{n_2}\} \)

\[
t = \frac{\bar{D}}{S_D} \text{ where } S_D = \left[ \frac{1}{n_1} + \frac{1}{n_2} \right]^{1/2} \sqrt{\frac{\sum x_i^2 - n_1 \bar{x}^2 + \sum y_i^2 - n_2 \bar{y}^2}{n_1 + n_2 - 2}} \text{ where } \begin{align*}
x &= \frac{1}{n_1} \sum x_i \\
y &= \frac{1}{n_2} \sum y_i
\end{align*}
\]

**Creating Histograms**

Histograms are step, needle, or bar charts that represent counts of the data points that fall within specified ranges. The Histogram Wizard guides you through the steps in creating a histogram: generating frequency data, specifying the number of buckets or intervals, and selecting a graph style.

The Histogram Wizard allows you to specify the number of bins into which to partition the source data. The range of each interval is identical; the total range is the data minimum to the data maximum. The number of bars, steps, or needles displayed is generally equal to the number of bins.
You can also create a histogram with an uneven bucket size. For more information, see “The Histogram Transform Function” on page 485.

**Using the Histogram Wizard**

*To use the Histogram Wizard:*

- Enter the data you want to analyze in an empty column of the active worksheet.

- From the menus select:
  
  - Graph
  - Histogram

  The Histogram Wizard appears.

- Select the data for the histogram by choosing the appropriate column from the Source data for histogram drop-down list.

**Figure 10-3**
*Histogram Wizard - Select Data Panel*

- Select the column for the Output for histogram either from the drop-down list, or by clicking the column.
Figure 10-4
Selecting the Output for Bin Centers in the Histogram Wizard

Select the column for the Output for bin counts either from the drop-down list, or by clicking the column.

Figure 10-5
Selecting the Output for Bin Counts in the Histogram Wizard.

Click Next.

The Histogram - Bin Options panel appears, with Automatic binning already selected. The algorithm calculates the number of bins for representation, based upon the number of data points.

Approximate Bins = 3 + log10(N) * log10(N)/log10(2)

where N = number of non-missing points.
To specify a different number of bins, clear Automatic binning and select a number from the Number of bins list. You can enter values from 1 to 100.

Click Next.

Select a graph style from the Graph Styles list. A preview of the graph appears.

Click Finish.

The graph appears on the active graph page, or a new page if the worksheet has no associated graph pages. The X axis representing the buckets is titled Raw Data. The Y
axis representing the frequency or the number of data points in each bin, is titled Bin Count. Both use a linear scale.

*Note:* If you choose None, SigmaPlot displays the worksheet with the output column containing the histogram frequency data.

**Figure 10-8**
*Example of a Histogram Created Using the Histogram Wizard*

---

**The Histogram Transform Function**

If you need to use uneven bucket sizes for a histogram, use SigmaPlot’s built-in histogram transform function.

**To use the histogram transform function:**

- Enter the data to analyze in column 1 the bin values in column 2 of the worksheet.

  Bin values are used as the upper bounds (inclusive) of the histogram interval ranges. The number of data points that fall within each specified range is counted. The number of histogram bars is equal to the number of interval upper bounds entered. The number of values that fall beyond the largest upper bound is also counted.
From the menus select:
Transforms
User-Define

The User-Defined Transform dialog box appears.

Enter the following transform into the Edit Transform box:

\[ \text{col}(3) = \text{histogram}(\text{col}(1), \text{col}(2)) \]

Figure 10-9
Graphing the results of the HISTOGRM.XFM transform as a bar chart

Click Run. The histogram data appears in column 3.

To graph the data, plot column 3 as a bar chart. For more information, see “Creating 2D Plots” in Chapter 6.
Plotting and Modifying Regression Lines

You can automatically compute and draw linear and polynomial regressions with confidence and prediction intervals. The regression equation can be computed using all the data in a plot, or individually for each curve in a multiple-curve plot. Polynomial curves can be fitted up to the 10th order.

Regressions for column averaged data are computed using all the data from the columns, not just from the mean value. Regressions are computed and drawn linearly on nonlinear (e.g., log, probability, etc.) axis scales.

Regression equation coefficients, R² values, and predicted values can be viewed and copied to the Clipboard.

To perform nonlinear regressions and curve fits, such as sigmoidal, exponential, and peak functions use SigmaPlot’s Regression Wizard. The Regression Wizard provides an extensive set of equations for curve fitting.

Modifying and Adding Linear Regression Lines

Add a first order regression to a graph by selecting one of the graph styles that has a regression. These styles include:

- Simple Regression
- Multiple Regression
- Simple Error Bars and Regression
- Multiple Error Bars and Regression

To modify or add a regression to a plot:

- Click the plot to select it.
- From the menus select:
  Graph
  Linear Regression

The Linear Regression dialog box appears.
Chapter 10

Figure 10-10
Regression Line Tab

Click the Regression Line tab.

Under Regressions, select either Each Curve to draw a regression for the data in each curve of the selected plot, or All data in plot to draw a single regression for all of the data in the selected plot from the Regressions group box.

If neither box is selected, a regression is not drawn. If both boxes are selected, regressions are drawn for each curve and for all data in the plot.

Under Line, select the desired regression order from the Order drop-down list.

Select the regression line type from Type drop-down list.

Select line color from the Color drop-down list.

To change line thickness, move the Thickness slider.

To set the extent of regression line(s) all the way across the graph, under Options, select Extend to Axes.

Click OK.
Viewing and Saving Regression Equation Results

If you want to view and save the coefficients of the regression(s), select the Results tab of the Linear Regression dialog box. The Results tab appears displaying regression equation results.

The regression equation coefficients, correlation coefficient $R^2$, and function results are displayed for each regression curve computed. If you computed confidence and prediction intervals, these values are also displayed.

Figure 10-11
The Linear Regression Dialog Box Results Tab

Click Copy to copy the results and paste them into the worksheet, a report, or any other Windows application.

For more information, see “Linear Regression, Confidence, and Prediction Calculation” on page 491.

Adding Confidence and Prediction Intervals

SigmaPlot can draw lines which describe either the 95% or 99% confidence and prediction intervals around a regression line.

Confidence intervals (or confidence line), also called the confidence interval for a regression, describe the range where the regression line values will fall a percentage of the time for repeated measurements.
Prediction intervals, also called the confidence interval for the population, describe the range where the data values will fall a percentage of the time for repeated measurements.

*Note:* You must compute a regression in order to compute confidence and prediction lines.

**To add prediction and confidence lines:**

- From the menus select:
  - Graph
  - Linear Regression

The Linear Regression dialog box appears.

**Figure 10-12**

*The Confidence Intervals Panel of the Linear Regression Dialog Box*

- Click the Confidence Intervals tab.

- Choose the method of prediction to use from the Method drop-down list. Select either 95% or 99% for confidence and prediction intervals.

- Select the Confidence Interval or Prediction Interval option and select a line type and color, then move the Thickness slider or enter a value in the Thickness box to set line
thickness. Line color, type, and thickness options work identically to the regression line type, color, and thickness options.

- Click OK.

**Linear Regression, Confidence, and Prediction Calculation**

**Regression Calculation.** SigmaPlot linear regression uses the least squares method to construct a fit a set of data points \((x_i, y_i)\) \(i = 1, ..., n\) by a polynomial of degree \(p\) where:

\[
y = \beta_0 + \beta_1 x + \beta_2 x^2 + ... + \beta_p x^p
\]

In vector-matrix notation this problem is formulated as:

\[
Y = X \beta + \varepsilon
\]

where the \(n \times 1\) vector containing the \(y\) data is:

\[
Y = \begin{bmatrix} y_1 & y_2 & \cdots & y_n \end{bmatrix}
\]

and the \(n \times (p + 1)\) design matrix is:

\[
X = \begin{bmatrix}
1 & x_1 & x_1^2 & \cdots & x_1^p \\
1 & x_2 & x_2^2 & \cdots & x_2^p \\
\vdots & \vdots & \vdots & \ddots & \vdots \\
1 & x_n & x_n^2 & \cdots & x_n^p
\end{bmatrix}
\]

\(\beta\) is a \((p + 1) \times 1\) vector of parameters to be estimated:

\[
\beta = \begin{bmatrix} \beta_0 & \beta_1 & \cdots & \beta_p \end{bmatrix}
\]

\(\varepsilon\) is an \(n \times 1\) vector of residuals.

The solution for the least squares estimates of the parameters \(\hat{\beta}\) is:

\[
h = (X'X)^{-1} X'Y
\]

where \(X'\) denotes the transpose of \(X\).
SigmaPlot uses the Cholesky decomposition to invert the $X_{1Y}$ matrix. (see Dongarra, J.J., Bunch, J.R., Moler, C.B., and Stewart, G.W., *Linpack User’s Guide*, SIAM, Philadelphia, 1979). This produces the regression curve:

$$\hat{y} = b_0 + b_1 x_0 + b_2 x_0^2 + ... + b_p x_0^p$$


**Confidence Interval Calculation.** Given a set of $n$ data points $(x_i, y_i)$ from two columns in the worksheet, SigmaPlot computes the $p^{th}$ order polynomial regression:

$$\hat{y}_0 = b_0 + b_1 x_0 + b_2 x_0^2 + ... + b_p x_0^p$$

where $(b_0, b_1, ..., b_p)$ are the $p + 1$ estimated parameters and $\hat{y}_0$ is the $Y$ value predicted for any $x_0$.

The confidence interval for this calculated regression is defined by the two confidence limits:

$$\hat{y}_0 \pm t(n - p - 1) s \sqrt{X'_0 (X'X)^{-1} X_0}$$

where $X_0$ is the $(p + 1) \times 1$ vector defined by

$$X_0 = \begin{bmatrix} 1 & x_0 & x_0^2 & \ldots & x_0^p \end{bmatrix}^T$$

$X$ is the $n \times (p + 1)$ design matrix:

$$X = \begin{bmatrix} 1 & x_1 & x_1^2 & \ldots & x_1^p \\ 1 & x_2 & x_2^2 & \ldots & x_2^p \\ \vdots & \vdots & \vdots & \ddots & \vdots \\ 1 & x_n & x_n^2 & \ldots & x_n^p \end{bmatrix}$$

$s$ is obtained from the variance about the regression

$$s^2 = \frac{\sum_{i=1}^{n} (y_i - \hat{y}_2)^2}{n - 2}$$
and the $t$ value for $n$, $p=1$ degrees of freedom and the standard normal percentile equivalent $z$ ($z = 1.96$ or $2.576$ for 95% and 99% confidence intervals respectively) is computed from a six term rational polynomial approximation taken from Sahai, H. and Thompson, W., “Comparisons of Approximation to the Percentile of $t$”, and “$F$ Distributions”, Journal of Statistical Computation and Simulation, 1974, Vol. 3, pp. 81-93.

**Prediction Interval Calculation.** The prediction interval is calculated using the following equation:

$$
\hat{y}_0 \pm (n - p - 1)s\sqrt{1 + X'_0 (X' X)^{-1} X_0}
$$

**Adding Reference Lines**

You can add horizontal or vertical lines at specific locations using the Graph Properties Plots tab Reference settings. Reference lines can be used to draw lines at specific values, to set quality control limits, and specify other reference values.

*Note:* Bar and stacked bar charts automatically place a reference line at the zero value.

You can add up to five reference lines. All lines can be drawn only horizontally or vertically as a set. The Reference settings display the current calculation, line type, label, and color for each line.

One set of five reference lines, either horizontal or vertical, can be drawn for each plot. If you need more than five lines or need both horizontal and vertical lines, you must create an additional plot. For more information, see “Adding New Plots” in Chapter 4.

**Figure 10-13**

*Graphs Using References Lines*
**Chapter 10**

**Drawing Reference Lines**

*To draw reference lines:*

- Double-click the plot to open the Graph Properties dialog box.

  **Figure 10-14**
  *Graph Properties Dialog Plots Tab*

  ![Graph Properties Dialog Plots Tab](image)

- Click the Plots tab.

- Select Reference from the Settings for list.

- Select a reference line to draw by selecting its check box. You can add up to five lines for each plot. The default names and calculations are the names commonly used when employing reference lines for quality control charts.

- **To change the reference line name,** select the line from the list, then edit the Label box for that line.

- **To display the label next to the reference line,** select Left or Right for horizontal reference lines, or Top or Bottom for vertical reference lines.
▶ To change the value or statistic used for the line, select an option from the Calc drop-down list.

If you are not using a mean as the calculation, type a value to multiply the statistic by, or a value to use as a constant, in the box next to the Calc drop-down list. The calculation options apply only to the reference line highlighted in the Graph Properties dialog box list of reference lines.

To set the reference line value to a specific value, select the Constant Calc option, and enter the value to the right.

Automatically calculated statistics are derived from the plot data. All data points graphed, including multiple columns of data, are used for reference line calculations.

▶ Use the Appearance options to set a line type, thickness, and color for the highlighted reference line. Each reference line can have separate line attributes.

▶ Use the Direction drop-down list to draw reference lines horizontally or vertically.

▶ Use the Layering drop-down list to draw reference lines either Behind or In Front of the selected plot.

▶ Click Apply when finished modifying the current reference line, then highlight another reference line to continue modifying reference lines, or click OK.
Chapter 10
Using the Report Editor

Use the Report Editor to annotate and document your graphs and data. The Report Editor features a complete text editor and OLE2 insertion and editing. It is also used by the Regression Wizard to report regression results.

This chapter covers:
- Setting report options (see page 497).
- Creating reports (see page 499).
- Exporting reports (see page 500).
- Printing reports (see page 501).
- Using the Report Editor ruler (see page 502).
- Formatting text and paragraphs (see page 505).
- Inserting the current date and time into a report (see page 506).

Setting Report Options

Use the Reports tab on the Options dialog box to:
- Set the number of decimals displayed in the report.
- Enable or disable scientific notation.
- Enable or disable explanatory text for report results.
- Set whether or not you want to report only flagged values.
- Hide or display the report ruler.

To set report options:

- From the menus select:
  Tools
  Options
The Options dialog box appears.

- Click the Report tab.

- To set the number of significant digits used for the values in the report, select Number of Significant Digits. The default is three digits. The maximum number of digits is sixteen.

- To use scientific notation for the appropriate values in the report tables, select Always Use Scientific Notation. If this option is disabled, scientific notation is only used when the value is too long to fit in the table cell. This option is disabled by default.

- To explain explanatory text for test results in the report, select Explain Test Results. This option is enabled by default. Clear this option to keep explanatory text out of the report.

- To specify a significant P value, select P Value for Significance. This option determines whether there is a statistically significant difference in the mean values of the groups being tested. The value you specify is compared to the P values computed by all tests.

   Note: This P value does not affect the actual test results. It only affects the text that explains if the difference in the mean values of the groups is due to chance or due to random sampling variation.

   If the P computed by the test is smaller than the P set here, the text reads, "The difference in the mean values of the two groups is greater than would be expected by chance; there is a statistically significant difference between the input groups."

   If the P value computed by the test is greater than the P set here, the text reads, "The difference in the mean values of the two groups is not great enough to reject the possibility that the difference is due to random sampling variability. There is not a statistically significant difference between the input groups."

   One of the above explanation text strings appears for each P value computed by the test. ANOVAs and some regressions produce multiple P values.

   Note: If the Explain Test Results option is cleared, the results of this P value do not appear in the report.

- To display the ruler at the top margin of the report page, select Show Ruler. This option is enabled by default. Clear this option to hide the report ruler.
Creating Reports

Create reports using the New command, or the Regression Wizard.

To create a new report:

- Right-click the section in the notebook where you want to create the report, and on the shortcut menu click New, and then click Report.

A report window opens and a new report is added to the selected section.

Setting Report Page Size and Margins

Use the report Page Setup dialog box to set report margins, paper orientation, paper size, and paper source.

Note: These settings apply to the current report, but not to other open reports. To have these settings apply to subsequently opened or created reports, make your changes, then close the page. Newly opened or created reports will use all of these settings.

To open the Page Setup dialog box:

- Select the report window.

- From the menus select:
  File
  Page Setup

The Page Setup dialog box appears.
The page sample at the top of the dialog box reflects changes.

- Select the paper size and source from the Size and Source drop-down lists.

- **To select the printer**, click Printer. The Page Setup dialog box appears on which you can select and setup any printer configured for your system.

- **To change the paper orientation**, under Orientation, select either Portrait or Landscape.

- **To change the margins**, under Margins (inches), type the desired values into the four boxes. The current ruler units appear in the Margins title.

**Exporting Reports**

You can only export the entire report. If you want to export a portion of the report, delete the portion you don’t want to export, then export the remainder as the file.
To export a report:

- Select and view the report window you want to export.

- From the menus select:
  File
  Export

  The Export File dialog box appears.

- From the Files of type drop-down list, select a file format.

- Enter the file name, directory, and drive for the exported file.

- Click Export to create the file.

Printing Reports

You can print any report in a SigmaPlot notebook.

To display a report as it will look when printed:

- From the menus select:
  File
  Print Preview

A preview of the report appears.

To print a report:

- Select and view the report window.

- Click the Print button to print the report using all the default settings.
To set printing options before printing the report:

- From the menus select:
  - File
  - Print

    The Print dialog box appears.

- Click Properties. The printer Properties dialog box appears.

- Click OK when you are satisfied with the printer properties settings. The Properties dialog box closes.
  
  Note: The Properties dialog box options vary from printer to printer.

- Click OK to print the report.

Using the Report Editor Ruler

Use the Report Editor ruler to view margins and to both view and modify report page tabs and paragraph indents.

Figure 11-2
The Report Editor Ruler

The ruler indicates:
- Usable page column width
- Default tabs
- User-defined tabs
- Left and right paragraph indents
- First line indent
Setting Tabs

All tab stops appear on the report ruler. The default tab stop is 0.25" regardless of the current units. Tab stops are made for individual and selected paragraphs, and are saved with reports.

To set a tab:

- Select the paragraph(s) to change the tab stops.
- Click the ruler where you want to place a tab. A tab marker appears at the clicked location.
- To move a tab, drag the tab marker to another location on the ruler. To delete a tab, drag the tab marker off the ruler.

You can also set tabs from the Tabs dialog box:

- From the menus select:
  - Format
  - Tabs

Note: This command is only available while viewing a report window.

The Set Tab dialog box appears.

Figure 11-3
Set Tab Dialog Box
Enter tab stops in the Tab stop position (in) box. Enter Tab locations using the current ruler units.

Click OK to add the tab setting to the list.

**Setting Paragraph Indents**

You can set left, right, and first line indents for individual paragraphs. These settings are saved with the report.

*To set paragraph indents:*

- Select the paragraph(s) to change the indents.

Figure 11-4
*Report Editor Ruler*

- **To change the first line indent**, drag the marker at the top left of the ruler.

- **To change the left indent**, drag the marker on the bottom left of the ruler.

- **To move both the left and first line indents**, drag each marker separately.
To change the right indent, drag the marker on the bottom right side of the ruler.

*Note:* To create an indented line, drag the top left marker to the right of the left indent. To create a hanging indent, drag top left marker to the left of the bottom left indent marker.

Figure 11-5
Paragraph Indent Formatting

---

**Formatting Text and Paragraphs**

The Formatting toolbar appears at the top of the Report Editor. Using it, you can change report text attributes such as font, font size, color, and style of selected text.

Figure 11-6
Formatting Toolbar

---

To modify text with the Formatting Toolbar:

- Select the text you want to modify. You can select individual characters, words, paragraphs, or the entire report.
To format character font, size, weight, underlining, or color, use the formatting toolbar buttons. For more information, see “Formatting Text” in Chapter 5.

To set paragraph alignment, use the Formatting Toolbar Align Left, Align Center, and Align Right and Justify.

To add bullets or numbers a to selected paragraph, click the Bullet Style or Number Style button. To remove bullets, click the Bullet Style or Number Style button again. You can also right-click the report page and on the shortcut menu click Bullet or Number.

Bullets are applied to the selected text.

Inserting the Current Date and Time into a Report

To insert the current date and time into reports:

Select the report and click where you want to insert the Date or Time.

From the menus select:

Insert
Date and Time

Select the date and time format from the Available formats list.

Click OK.

The current date and time appear as text at the specified location.

Note: The list of available date and time formats depends on your Regional Settings. You can view or modify the Regional Settings directly from your Windows Control Panel.
Publishing Graphs

You can use SigmaPlot 10.0 to publish graphs on the World Wide Web, and to create publication quality graphs for submission to journals and other printed forms.

This chapter covers:

- Publishing graphs on the World Wide Web (see page 507).
- Submitting graphs for publication (see page 511).

Publishing Graphs on the World Wide Web

You can save your graphs in high resolution and then later publish them on the Internet using the SigmaPlot WebViewer. For more information, see “About the SigmaPlot WebViewer” below.

Saving your graphs as a web page creates HTML code that you can later import into any HTML editor. For more information, see “Exporting Graphs into HTML Format” on page 508.

About the SigmaPlot WebViewer

The SigmaPlot WebViewer is an ActiveX control freely distributed from the Systat Web site. If this control is not installed the first time a SigmaPlot graph is viewed on a web page, the WebViewer is automatically installed. Then you can view the graphs in high resolution on the Intranet or Internet.

Using the SigmaPlot WebViewer, you can:

- View the graphs in high resolution.
- Pan and zoom the graph without losing resolution.
- Print in high resolution (printer resolution) as opposed to typical Web graphics (GIFs, JPEGs, etc.) that are printed in low resolution.
- View the data used to create the graph.
Chapter 12

Exporting Graphs into HTML Format

When you export a graph to the Web, SigmaPlot automatically creates three files:

- A notebook .JNB file which contains the SigmaPlot graph and data worksheet.
- A .JPG of the graph, viewable by those who do not have the SigmaPlot WebViewer.
- An .HTM file which references a .JPG of the graph and the .JNB file.

You can export an entire graph page or other pasted objects.

To export a SigmaPlot graph into HTML format:

- Open a graph page.
- Select the page objects you want to publish.
- On the File menu, click Save As Web Page. The Export File dialog box appears.
- Enter a name of the file in the File name box. HTML (SigmaPlot Web Graph) already appears in the Save as type box.
- Click Export.

The Export Web Graph dialog box appears.

Figure 12-1
Export Web Graph Dialog Box

- To set the size of the figure, select desired measurements from the Height and Width drop-down lists.
Note: One inch is 96 pixels, and the Export Web Graph dialog box uses a fixed aspect ratio.

► To export the currently selected graph or objects, select Export Selected Only.

► To export the entire graph page, clear Export Selected Only.

► To password protect the file, click Set Password.

► To password protect the file, click Set Password. For more information, see “Password Protecting Data on the World Wide Web” below.

► Click OK.

Three files are created: an .HTM file which references a saved .JPG file and a .JNB file. You can later insert this .HTM file into any HTML editor.

Password Protecting Data on the World Wide Web

You can secure your data for a graph you export to an HTML file by setting a password for viewers to enter when viewing this graph on the Internet. Setting a password also prevents the opening and downloading of this file.

To set a password:

► On the Export Web Graph dialog box, click Set Password. The Set Password dialog box appears.

Figure 12-2
Set Password Dialog Box
Exporting Data Associated with the Graph

When you export a graph to a web page, you not only export the data for the graph but the entire worksheet as well. This can be useful if you want to associate or display additional data for the graph. However, it can also increase the size of the .JNB file, which can slow viewing.

To export just the data associated with the graph:

► Select the graph on the page, and copy it.

► On the Standard toolbar, click the New Page button. The Graph Page dialog box appears asking if you would like to create a graph.

► Click No.

► Paste the graph to the new page.

Now when you export this graph, you will also only export the data associated with the graph.

Inserting a Graph into FrontPage

After you’ve exported a graph into HTML format, you can import the graph into most HTML editors. The following example describes importing a SigmaPlot graph into FrontPage.

To insert the graph into FrontPage:

► Export a graph into HTML format.

► In FrontPage, place the cursor on the page where you want to insert the WebViewer graph. On the Insert menu, click File. The Select File dialog box appears.

► Select the HTML file you created in SigmaPlot to import into your FrontPage project, and click Open.
A Javascript object containing WebViewer graph information appears at the insertion point on the page. The graph is not visible on the page until viewed using Internet Explorer.

**Submitting Graphs for Publication**

The following are some guidelines for preparing graphs for submission to journals or other printed form. This process is not necessarily simple, and requires understanding both the figure requirements of the publication as well as graphic file formats and terminology.

**Figure Submission Requirements**

The ultimate destination for most SigmaPlot graphs is a publication, and most publishers are now equipped for digital pre-press. This requires graphic files with specific formats and properties. Keep in mind the requirements of the different journals and other publications. These tend to vary, but are usually available at the web site for the journal submission requirements.

**Creating Files for Figure Submission**

The steps to producing a file for publication can vary from publisher to publisher. For more information, see “Figure Submission Requirements” on page 511.

When preparing a figure for file export, first determine:

- The final size of the figure, including the size of text (usually inches or millimeters).
- The required line weights.
- Acceptable typefaces (especially important for EPS - Encapsulated Postscript - files).
- The desired final dpi (the dots-per-inch resolution), if necessary.
**To produce a file for publication:**

- Determine the final size of the figure, the heights of text and thicknesses of lines and whether the figure will be color, grayscale, or black and white.

- Determine what file formats are acceptable, and choose the best one. The ranking in which you should choose your format is:
  - SigmaPlot
  - EPS
  - TIFF

- Printed hardcopy (not really a file, but some publications actually still prefer this). These formats are regardless of whether the graph is color or not.

  Some publishers will directly accept SigmaPlot files. Most others accept EPS, TIFF, or both.

- Determine how much the figure is going to be scaled using the size of your current figure. For example, if your graph is 5 inches wide, but the figures are printed at 3.25 inches wide, then scale your graph by a factor of 3.25/5, or .65.

- Increase text labels and line widths accordingly on your SigmaPlot graph.

  For example, if you reduce your graph to .65 of the original size, and text must be 10pt in height, increase your labels to at least 15.5pt.

  Alternately, you can reduce the graph itself to the final publication size.

- Make any other changes to your graph to meet the publisher’s requirements, such as typeface, labeling, and so on.

- Once you have your graph formatted, produce the selected file. Make sure that you select the figure (click it) before choosing export-this will automatically crop your figure for you.

  If you are producing an EPS file, you don’t need to pay attention to dpi at all.

  If you must use TIFF format, make sure you use the CMYK-compressed TIFF format. Uncompressed TIFF files are too big to easily handle. Also, you will now have to do some dpi calculations.
For example, if you are producing a file that requires a final printed dpi of 600, and the graph is being reduced by a .65 ratio, do not set the file dpi to 600. Instead, use a dpi of 390 (600*.65). When this file shrinks to the final printed size, the final dpi will also be 600.

**Why Use EPS?**

Most publishers request either **EPS** or TIFF formats. When given a choice, choose EPS. Why? Because EPS is known as a vector format. This means that the image is not made up of pixels, but instead graphic descriptions of lines, fills, text, and so on. A vector format has no “size.” It is dimensionless. This means you can shrink it as small as you want, or grow it as big as you want, with no change in resolution. dpi has no meaning for a vector file.

This format is ideal for a graph figure since there is no degradation of the quality of the figure as it re-scales. It is also means that when you place a vector format file in a document, it often first appears at an arbitrary size, and then you can scale it to the final desired size. This can often startle, annoy or confuse someone not familiar with the behavior of vector files.

The other vector format supported by SigmaPlot is the Windows Metafile format.

**Post-Processing TIFF Files**

If you must use TIFF files and you have access to Photoshop, use it to optimize the file. SigmaPlot does not have access to the expensive, proprietary compression formats available in Photoshop. This means that SigmaPlot files will always be much larger than Photoshop files saved with the LZW compression algorithm. Also, SigmaPlot does not support Monochrome or Grayscale TIFF, which are also proprietary export formats.

Opening and re-saving a SigmaPlot file using LZW compression and the correct color mode can create dramatic differences in file size. A 100-fold reduction in size is typical.

- For color figures, leave the figure as a CMYK TIFF, but save it using LZW compression.
- For grayscale figures, change the Image Mode to Grayscale.
- For black and white figures, change the Image Mode to **Bitmap**.
About dpi

dpi (dots per inch) is a printer term, and is often misleading. dpi determines how many pixels are used to create the figure. A more accurate term would be resolution. You can increase the final dpi of a raster figure by shrinking it. This creates more pixels within a smaller space, increasing the dpi.

Most printed figures do not require a dpi higher than 600 for grayscale figures, and 300 dpi for color figures. The 1200 dpi number is for black and white figures only that have no half toning. If you must produce a 1200 dpi figure, you will have to do some post-processing on your file in order make it palatable to the printer. This can be beneficial if you must use TIFF file and have Photoshop.

Publication Tips and Tricks

Making Global Changes

Use the Line and Text Properties dialog boxes to make global changes to your graphs before publishing.

To make global changes to text and lines:

- Select the graph.
- From the menus select:
  
  Format  
  Line

  or

  Format  
  Text Properties

Resizing Graphs

If you need to resize you graph for publication, set your fonts and line widths first, then turn the automatic re-scaling of these objects off before resizing your graph.
To resize your graph for publication:

- From the menus select:
  - Tools
  - Options

  The Options dialog box appears.

- Click the Page tab.

- Clear Graph objects resize with graph.

To re-scale the graph precisely:

- From the menus select:
  - Format
    - Size and Position

Before You Export

Select the graph before you export; otherwise, you will export the entire page including unnecessary white space surrounding the graph.

Disk Space and Memory

Make sure you have enough disk space and memory before trying to export a large graphic file.

For a large file, you need at least 200 megabytes or more free on both your system drive (for swap and temp file space) as well as the same on your destination drive. You can also increase your Virtual Memory to a very large size, but this isn’t necessary if you have sufficient hard drive space available. Note that it can take awhile to generate these files, depending on your system’s speed and available RAM.
The Submission Assistant

The Submission Assistant walks you through the sometimes arduous process of creating graphs suitable for publication. Choose from a list of journal profiles that correspond to specific journal submission requirements, or create and edit your own profiles. If you run into any problems along the way, the Submission Assistant offers suggestions to get your graph publication-ready.

This section explains how to:
- Submit a graph using the Submission Assistant. For more information, see “Using the Submission Assistant” below.
- Editing a submission profile. For more information, see “Editing a Submission Profile” on page 517.

Using the Submission Assistant

To start the Submission Assistant, from the menus select:

File
  Export
    Submission Assistant

The Submission Assistant dialog box appears.

- Pick a journal profile from the Submission Profile drop-down list.
  
  Note: Profile data is stored in individual profile files in your User’s Folder. For more information, see “About SigmaPlot’s User and Program Files” on page 8

- Enter the final figure size into the Height and Width fields. This is either set by default or you enter this information manually.

- Select the file name and path to save the scaled figure. If you don’t change the path name the page name is used for the file name.

- Select Save scaled figure to new page to review the scaled figure in SigmaPlot.

- Clear Export selection only, if available, to export all graphs on the page.

- Click Next.
The Submission Assistant - Summary dialog box appears with a list of Submission Criteria and a result of either Pass, Fail or Warning in the Pass/Fail column.

Select any item in the Submission Criteria list. If the graph failed, the Details section offers suggestions on how to repair the graph to meet the submission standards.

Once the graph has met the Submission Criteria, click Export.

**Editing a Submission Profile**

Use the Submission Assistant - Edit profile dialog box to modify the file type, figure size and minimum sizes for fonts and lines.

*To edit a profile:*

On the Submission Assistant - Pick profile dialog box, click Edit. The Submission Assistant - Edit profile dialog box appears.

Once you’ve edited the profile, click OK to save it.
Automating Routine Tasks

SigmaPlot uses a VBA®-like macro language to access automation internally. However, whether you have never programmed, or are an expert programmer, you can take advantage of this technology by using the Macro Recorder. This chapter describes how to use SigmaPlot’s Macro Recorder and integrated development environment (IDE). It also contains descriptions of related features accessible in the Macro window, including the Sax Basic programming language, debugging tool, dialog box editor, and user-defined functions.

Record a macro any time that you find yourself regularly typing the same keystrokes, choosing the same commands, or going through the same sequence of operations.

Before you Record a Macro

Before you record the macro:

- Analyze the task you want to automate. If the macro has more than a few steps, write down an outline of the steps.
- Rehearse the sequence to make sure you have included every single action.
- Decide what to call the macro, where to assign it, and where to save it. For more information, see “Creating Macros as Menu Commands” on page 534.

Recording Macros

To record a macro:

On the menus click:

Tools
Macro
Record New Macro
Chapter 13

Chapter 13

REC appears in the status area of SigmaPlot’s main window, indicating that the macro is recording your menu selections and keystrokes.

► Complete the activity you want to include in this macro.

Note: The Macro Recorder does not record cursor movements.

► When you are finished recording the macro, on the menus click:

Tools
Macro
Stop Recording

The Macro Recorder stops recording and the Macro Options dialog box appears.

► Type a name for the macro in the Name text box.

Give the macro a descriptive name. You can use a combination of upper- and lowercase letters, numbers, and underscores. For example a macro that formats all of your graph legends to match a certain report might be called "Report1AddFormatToLegend".

► Enter a more detailed description in the Description text box.

► Click OK.

After you have finished recording the macro, save it globally (for use in all of SigmaPlot) or locally (for use in a particular notebook file).

Your macro appears in the Notebook Manager.

Creating Macros Using the Macro Language

You can record a macro using the Macro Recorder, or you can create a macro manually using a VBA®-like macro language in the Macro Window.

To create a macro using the Macro Window:

► On the menus click:

File
New
The **New** dialog box appears. For more information, see “Creating New Items in the Notebook Manager” in Chapter 2.

Figure 13-1
*Select Macro in the New dialog box to create a new macro from scratch.*

- From the New drop-down list, select **Macro**.
- Click **OK**. The Macro Window appears.
Figure 13-2
A new Macro Window. You can create SigmaPlot macros from scratch using SigmaPlot’s VBA-like macro language.

For more information, see “Editing Macros” below.

Editing Macros

When you record a macro, SigmaPlot generates a series of program statements that are equivalent to the actions that you perform. These statements are in a form of SigmaPlot language that has custom extensions specifically for SigmaPlot automation and appear in the Macro Window. You can edit these statements to modify the actions of the macro. You can also add comments to describe code.
To edit a macro:

- On the menus click:
  
  Tools
  Macro
  Macros.

  The Macros dialog box appears.

- Select a macro from the Macro list.

- Click Edit. The Macro Window appears.

  For more information, see “Creating Macros Using the Macro Language” on page 520.

**Getting Help for Sax Basic in SigmaPlot**

To get help for Sax Basic, in the Macro Window, click on an item you want to learn more about, and press F1.

**Using the Macro Window Toolbar**

The Macro Window toolbar appears at the top of the Macro Window. It contains buttons grouped by function.

The following describes the functions of the toolbar buttons in the Macro Window.

- **New Procedure.** Opens the Add Procedure dialog box that lets you name the procedure and paste procedure code into your macro file.
- **Start.** Runs the active macro and opens the Debug Window.
- **Pause/Continue.** Pauses and restarts a running macro. This button also pauses and restarts recording of SigmaPlot commands while using the Macro Recorder.
- **Stop.** Terminates recording of SigmaPlot commands in the Macro Recorder. Also, stops a running macro.
- **Find.** Opens the Find dialog where you can define a search for text strings in the Macro Window.
- **Step in.** Executes the current line. If the current line is a subroutine or function call, execution will stop on the first line of that subroutine or call.
- **Step Over.** Executes to the next line. If the current line is a subroutine or a function call, execution of that subroutine or function call will complete.
- **Step Out.** Steps execution out of the current line the cursor is on.
- **Step to Cursor.** Steps execution out to the current subroutine or function call.
- **Toggle Breakpoint.** Toggles the breakpoint on the current line. The breakpoint stops program execution.
- **Quick View.** Shows the value of the expression under the cursor in the Immediate Window.
- **Macros.** Opens the Macros dialog box.
- **Dialog Box Editor.** Opens the Dialog Box Editor.
- **Object Browser.** Object Browser
- **Reference.** Editing Macros Opens the Reference dialog box which contains a list of all programs that are extensions of the SigmaPlot Basic language.

**Color-Coded Display**

The color-coding of text in the Macro Window indicates what type of code you are viewing. The following describes the default text colors used in the script text:

- **Blue.** Identifies reserved words in Visual Basic (for example, Sub End Sub, and Dim).
- **Magenta.** Identifies SigmaPlot macro commands and functions.
- **Green.** Identifies comments in your macro code. Separates program documentation from the code as you read through your macros.

**Object and Procedure Lists**

The Object and Procedure lists show SigmaPlot objects and procedures for the current macro. These lists are useful when your macros become longer and more complex.

- The object identified as (General) groups all of the procedures that are not part of any specific object.
- The Procedure list shows all of the procedures for the currently selected object.
**Setting Macro Window Options**

You can set appearance options for the Macro window in the Macros tab of the Options dialog box.

*To set the options of the Macro Window:*

- With a Macro window open, on the menus click:
  - Tools
    - Options

  The Options dialog box appears.

- Click the Macros tab.

- Set text colors for different types of macro code and Debug Window output.

- Change font characteristics.

- Set the location for the macro library.

**Parts of the Macro Programming Language**

The following topics list the parts of the macro programming language:

- **Statements** are instructions to SigmaPlot to perform an action(s). Statements can consist of keywords, operators, variables, and procedure calls.

- **Keywords** are terms that have special meaning in SigmaPlot. For example, the Sub and End Sub keywords mark the beginning and end of a macro. By default, keywords appear as blue text on color monitors. To find out more about a specific keyword in a macro, select the keyword and press F1. When you do this, a topic in the SigmaPlot on-line reference appears and presents information about the term.

- You can add optional comments to describe a macro command or function, and how it interacts in the script. When the macro is running, comment lines are ignored. Indicate a comment by beginning a line with an apostrophe. Comments always must end the line they’re on. The next program line must go on a new line. By default, comment lines appear as green text.
Scrolling and Moving the Insertion Point

When you use the scroll bars the insertion point does not change. To edit the macro code that you are viewing in the macro window, you must move the insertion point manually.

To edit macro code manually:

- In the Macro Window, click where you want to edit.
- You can also use arrows and key combinations to move the insertion point; when you do this the window scrolls automatically.

Editing Macro Code

You can edit macro code in the same way you edit text in most word-processing and text editing programs. You add select and delete text, type over code, or insert text by moving the insertion point and then typing in new text. As with other programming languages, you can also add comments to code.

To edit macro code:

- Open the macro code window and select the text to edit.

Adding Comments to Code

Add comments to code to identify the purpose of the various parts of a macro and to map locations as you edit a complex macro. Insert comments to fully document how to use and how to understand the macro code.

Deleting Unnecessary Code

The Macro Recorder creates code corresponding exactly to the actions that you make in SigmaPlot while the recorder was turned on. You may need to edit out unwanted steps.
**Moving and Copying Code**

You can cut, copy, and paste selected text.

**Finding and Replacing Code**

When you need to find and change text in a macro that you have written, use the Find commands. For example, if you change the name of a file that is referenced in your macro, you need to change every instance of the file name in your macro. Use Find to locate the instances of the filename in the macro and replace using cut and paste edit commands.

**Adding Existing Macros to a Macro**

If you have another macro that already does what you want, you can just paste it into your new macro. Copy and paste the macro into your new macro, test it in the new code and run it.

**Creating Custom Dialog Boxes**

Design and customize your own dialog boxes using the UserDialog Editor. When you are designing and creating SigmaPlot macros, you can automatically create the necessary dialog box code and dialog monitor function code. Like the other automated coding features in SigmaPlot, the code may require further customizing.

**To create a custom dialog box:**

- In the Macro Window, place the insertion point where you want to put the code for the dialog box. For more information, see “Editing Macros” on page 522.

- On the Macro Window toolbar click the User Dialog button. The blank grid in the UserDialog Editor appears.

- On the left hand side of the UserDialog Editor there is a Toolbox. You can select a tool, such as a button or check boxes, from the Toolbox. The cursor changes to a cross when you move it over the grid.
Chapter 13

To place a tool on the dialog box, click a position on the grid. A default tool will be added to the dialog grid.

Resize the dialog box by dragging the handles on the sides and the corners.

Right-click any of the controls that you have placed on the dialog surface (after selecting the control) and enter a name for the control.

Right-click the dialog form (with no control selected) and enter a name for the dialog monitor function in the DialogFunc field.

To finish, click OK. The code for the dialog box with controls will be written to the Macro Window.

Finally, and in most cases, you must edit the code for dialog box monitor function to define the specific behavior of the elements in your dialog box. For more information, see “SigmaPlot Automation Reference” in Appendix A.

Using the Object Browser

The Object Browser displays all SigmaPlot object classes. The methods and properties associated with each SigmaPlot macro object class are listed. A short description of each object appears in the dialog box as you select them from the list.

To view the Object Browser, the Macro Window must first be in view. For more information, see “Creating Macros Using the Macro Language” on page 520.

To open the Object Browser:

On the Macro Window toolbar, click the Object Browser button.

Use Paste to insert generic code based on your selection into a macro.

Tip: Press F1 at any time for full details on using the Object Browser.

Using the Add Procedure Dialog Box

Organizing your code in procedures makes it easier to manage and reuse. SigmaPlot macros, like Visual Basic programs, must have at least one procedure (the main
subroutine) and often they have several. The main procedure may contain only a few statements, aside from calling subroutines that do the work. You add procedures using the Add Procedure dialog box.

**To add a procedure:**

- On the Macro Window toolbar, click the New Procedure button.

  The Add Procedure dialog box appears.

- Define a sub, function, or property using the Name, Type, and Scope boxes.

- Click OK to paste the code for a new procedure. The new procedure appears at the bottom of the macro.

**Tip:** For full details on using the Add Procedure dialog box, press F1 from anywhere in the Macro Window.

### About User-Defined Functions

A user-defined function is a combination of math expressions and Basic code. The function always requires input data values and always returns a value. You supply the function with a value; it performs calculations on the values and returns a new value as the answer. Functions can work with text, dates, and codes, not just numbers. A user-defined function is similar to a macro but there are differences. Some of the differences are listed in the following table.

<table>
<thead>
<tr>
<th><strong>Recorded Macro</strong></th>
<th><strong>User-Defined Functions</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Performs a SigmaPlot action, such as creating a new chart. Macros change the state of the program. Can be recorded. Are enclosed in the Sub and End Sub keywords.</td>
<td>Returns a value; cannot perform actions. Functions return answers based on input values. Must be created in Macro code. Are enclosed in the keywords Function and End Function.</td>
</tr>
</tbody>
</table>

**For more information.** Press F1 from anywhere in the Macro window to view user-defined function on-line Help.
Creating User-Defined Functions

A user-defined function is like any of the built-in SigmaPlot function. Because you create the user-defined function, however, you have control over exactly what it does. A single user-defined function can replace database and spreadsheet data manipulation with a single program that you call from inside SigmaPlot. It is a lot easier to remember a single program than it is to remember several spreadsheet macros. For more information, see “SigmaPlot Automation Reference” in Appendix A.

Using the Debug Window

The Debug Window contains a group of features that are helpful when you are trying to locate and resolve errors in your macro code. The debugging tools in SigmaPlot will be familiar if you have used one of the modern visual programming languages or Microsoft Visual Basic for Applications. Essentially, the Debug Window gives you incremental control over the execution of your program so that you can sleuth errors in your programs. The Debug Window also gives you a precise way to determine the contents of your variables. Again, a series of buttons is used to select the operation mode of the Debug Window.

Debug Toolbar Buttons

The debugging features of the Debug Window are controlled by buttons on the Macro Window toolbar. To review:

- The four Step buttons provide methods for controlling the execution of commands. They offer various ways of responding to subroutines and functions.
- The Breakpoint button lets you set a point and execute the program until it reaches that point.
- The Quick View button displays the value of the expression in the immediate window. The inclusion of these features for controlling program execution are a standard but powerful combination of tools for writing and editing macros.
Debug Window Tabs

The output from the Debug Window is organized in four tabs that allow you to type in statements, observe program execution responses, and iteratively modify your code using this feedback. If you have never used a debugging tool and are new to programming, it would be a good idea to supplement the following description with further study.

Immediate Tab

The Immediate Tab lets you evaluate an expression, assign a specific value to a variable or call a subroutine and evaluate the results. Trace mode prints the code in the tab when the macro is running.

- Type "?expr" and press Enter to show the value of "expr".
- Type "var = expr" and press Enter to change the value of "var".
- Type "set var = expr" and press Enter to change the reference of "var" for object vars.
- Type "subname args" and press Enter to call a subroutine or built-in expression "subname" with arguments "args".
- Type "trace" and press Enter to toggle trace mode. Trace mode prints each statement in the Immediate Tab when a macro is running.

Watch Tab

The Watch Tab lists variables, functions, and expressions that are calculated during execution of the program.

- Each time program execution pauses, the value of each line in the window is updated.
- The expression to the left of the "->" may be edited.
- Pressing Enter updates all the values immediately.
- Pressing Ctrl+Y deletes the line.
**Stack Tab**

The output from the Stack Tab lists the program lines that called the current statement. This is a macro command audit and is helpful to determine the order of statements in your program.

- The first line is the current statement. The second line is the one that called the first, and so on.
- Clicking a line brings that macro into a sheet and highlights the line in the edit window.

**Things You Can Do with Macros**

Use SigmaPlot macros to help streamline your workflow. For example, you can create macros in Microsoft Word or Excel that allow you to open SigmaPlot from within either application. You can place macros that you create yourself on the main menu. You can even run a SigmaPlot macro by specifying its path in your command prompt without ever having to open SigmaPlot. Examples of these macro applications appear in the following topics. For more information, see “Using SigmaPlot’s Macros” on page 535.

**Opening SigmaPlot from Microsoft Word or Excel**

You can create a macro in either Microsoft Word or Microsoft Excel that can open SigmaPlot directly from either application.

**To create this macro:**

- In either Microsoft Word or Excel, on the menus click:
  Tools
  Macro
  Visual Basic Editor

  Microsoft Visual Basic appears.
From the menus select:
   Insert
      Module

Type (or copy and paste):

Sub SigmaPlot()
   ' SigmaPlot Objects and Collections
   ' SigmaPlot Macro
   
   Dim SPApp as Object
   Set SPApp = CreateObject("SigmaPlot.Application.1")
   SPApp.Visible = True
   End Sub

To run the macro, from the menus select:
   Run
      Run Sub/User Form

SigmaPlot appears with an empty worksheet and notebook window.

The next time you want to run SigmaPlot:

From the menus select:
   Tools
      Macro
         Macros.

The Macros dialog box appears.

Select SigmaPlot.

Click Run.
Running SigmaPlot Macros from the Command Prompt

You can run SigmaPlot macros directly from your command prompt, saving you valuable time. Suppose you need to produce the same graph report of a data set week after week. Rather than going through the trouble of starting up SigmaPlot, opening a file, and then running a macro, you can run the entire macro from a run command on the Start menu instead.

In your command prompt type: `c:\spw "filename" /runmacro:"macroname"`.

For example, if you want to run a macro you created called "ErrorBars", and it is stored in a notebook file called "MyNotebook.jnb", you would type `c:\spw MyNotebook.jnb\runmacro:ErrorBar`.

Tip: You can also create a batch file or script that runs SigmaPlot from the DOS command prompt as part of the batch file’s set of operations.

Creating Macros as Menu Commands

You can place your macro as a menu command on the main menu that you specify. For example, your new macro could appear on the main menu under the macro command "My Macros".

To create a new menu command:

From the menus select:

Tools
Macro
Macros

The Macros dialog box appears.

Select a macro from the Macro Name scroll-down list.

Click Options. The Macro Options dialog box appears.

Select Command Name.
Automating Routine Tasks

- Enter the name of the macro in the Command Name field. If the Command Name is cleared, the macro doesn’t appear on a menu.
- Enter the name of the menu under which you want the macro to appear in the Menu Name field.
- Click OK.

Your new macro appears under the menu command you have just created.

- Enter the same menu command name in the Menu Name field of future macros if you want them to appear on your new macro command menu. By default, if the Menu Name field is left empty, the macro name appears on the Tools menu. You can also create your own menu by entering the menu name in the Menu Name field.

Using SigmaPlot’s Macros

SigmaPlot comes with an extensive library of Macros. The macros, along with their corresponding sample data, can be found in: ProgramFiles\SigmaPlot\SPW10\SigmaPlot Macro Library.jnb. For more information, see “SigmaPlot’s Macros” below.

You can double-click the macro in the Notebook Manager to run it. If the macro does not have any errors or run into difficulties with your data, it will run to completion. For more information, see “How to Run a Macro” on page 549.

Note: You can also run a macro from the Macro script window. This is useful for debugging the macro script.

SigmaPlot’s Macros

SigmaPlot’s available macros are:

- **Area Below Curves.** Integrates under curves using the trapezoidal rule. For more information, see “Area Below Curves” on page 537.

- **Batch Process Excel Files.** Imports data from multiple Excel Files into individual SigmaPlot worksheets, then plots and curve fits the imported data automatically. For more information, see “Batch Process Excel Files” on page 537.
- **Border Plots.** Draws a histogram or box plot along the top and right axes of a scatter plot. For more information, see “Border Plots” on page 539.

- **By Group Data Split.** Splits data contained in one column into groups of data sorted into multiple data columns within one SigmaPlot worksheet. For more information, see “By Group Data Split” on page 539.

- **Color Transition Values.** Creates a column of colors changing smoothly in intensity as the data changes from its minimum value to its maximum value. For more information, see “Color Transition Values” on page 540.

- **Compute 1st Derivative.** Computes a numerical first derivative of a pair of data columns. For more information, see “Compute 1st Derivative” on page 540.

- **Frequency Plot.** Creates frequency plots with mean bars for multiple data columns. For more information, see “Frequency Plot” on page 541.

- **Gaussian Cumulative Distribution.** Returns the results of a Gaussian Cumulative Distribution function (CDF) for a single column of data, and optionally plots the results with a probability Y axis scale. For more information, see “Gaussian Cumulative Distribution” on page 541.

- **Insert Graphs into Microsoft Word.** Inserts a SigmaPlot graph into an open Microsoft Word document. For more information, see “Insert Graphs into Microsoft Word” on page 541.

- **Label Symbols.** Labels a plot with symbols or text from a specified column. For more information, see “Label Symbols” on page 542.

- **Merge Columns.** Merges two separate worksheet columns into one single text column. For more information, see “Merge Columns” on page 543.

- **Paste to PowerPoint Slide.** Creates PowerPoint slides from selected SigmaPlot graphs. For more information, see “Paste to PowerPoint Slide” on page 543.

- **Piper Plots.** Creates a Piper Plot. For more information, see “Piper Plots” on page 544.

- **Plotting Polar and Parametric Equations.** Creates curves in either Cartesian or polar coordinate systems. For more information, see “Plotting Polar and Parametric Equations” on page 546.

- **Power Spectral Density.** Computes the power spectral density (psd) for a data column. For more information, see “Power Spectral Density” on page 547.

- **Quick Re-Plot.** Re-assigns the columns that are plotted for the current curve in the current two- or three-dimensional plot. For more information, see “Quick Re-Plot” on page 547.
- **Rank and Percentile.** Computes ranks and cumulative percentages for a specified data column. For more information, see “Rank and Percentile” on page 547.
- **Survival Curve.** Computes and graphs a Kaplan-Meier survival curve using the SurvMod transform. For more information, see “Survival Curve” on page 548.
- **Vector Plot.** Uses the vector transform to plot X,Y, angle and magnitude data as vectors with arrowheads. For more information, see “Vector Plot” on page 549.

**Area Below Curves**

This macro integrates under curves using the trapezoidal rule. This can be used for equal or unequally spaced x values. The algorithm is:

\[
\sum_{i=0}^{n-1} \text{or} \\
\{y_i(x_{i+1} - x_i) + \frac{1}{2}(y_{i+1} - y_i)(x_{i+1} - x_i)\}
\]

Specify the column number for the results. Click Compute to calculate the area under the curve. The results are in the Results Column.

**Restrictions**
- This macro only works using a SigmaPlot worksheet.
- This macro only works with plots with both X and Y data.
- A graph window containing a scatter or line plot must be open and in focus when running the macro.

**Batch Process Excel Files**

Use this macro to import data from multiple Excel Files into individual SigmaPlot worksheets, then plot and curve fit the imported data automatically. The macro plots the first two columns of data for each file as a Simple Scatter Plot, curve fits the data using a Logistic, 4 parameter equation, and generates a statistical report. You are then prompted to save the results in a "BatchFile.jnb" SigmaPlot notebook.

The following options are available:


- **Single-step mode.** Displays a dialog box after each step within the macro. For instance, after the Excel data is imported a dialog box appears that states, “The data is imported from the Excel Worksheet...” You must click OK to continue running the macro. By default, this mode is disabled so that the macro runs without stopping at each step.

- **Add File button.** Opens the Select Excel File dialog box. Double-click the Excel file to add it to the Excel files list.

- **Excel Files.** Select the Excel file in the Excel files list to activate this button. Click to delete the file from the Excel files list.

- **Import Range.** Enter the starting and ending ranges to import from the first worksheet in the Excel files. Only the first two columns of imported data are plotted and/or fit.

- **Process.** Plot data as a Simple Scatter Plot or a Simple Bar Chart. Curve fit data using an equation from the drop-down list.

- **Save notebook to.** Shows the path where the BatchFile.jnb notebook is saved.

- **Browse.** Select to save the BatchFile.jnb notebook file to a folder other than the default.

You may edit the macro to change:

- To a different fit library.
- The default location of the source data block.
- Whether the data are plotted or fit.
- The file extension to import different file types.

**Restrictions**

- Only data from the first Excel worksheet from each file is imported.
- You cannot specify a different Excel worksheet.
- You must select an Excel file.
- You must select a curve in order to plot curve fit.
- You may change the default equation Only simple scatter and bar charts are available.
**Border Plots**

This macro draws a histogram or box plot along the top and right axes of a scatter plot. The border plots are located .5 inches from each *axis*. When using histogram border plots, specify the number of bins displayed.

**Restrictions**

- A graph window containing a scatter plot must be open and in focus when running the macro. If the current plot is not a scatter plot, the macro can convert the plot to the required form.
- If the plot is an X only or Y only plot, the macro creates one border plot corresponding to the X or Y axis.

**By Group Data Split**

This macro splits data contained in one column into groups of data sorted into multiple data columns within one SigmaPlot worksheet.

The following options are available:

- **Data Column.** Define the column to begin the data grouping, and to use as column headings.
- **Group Column.** Define the column data to group. This column should not have empty cells.
- **Output Column.** Define the column to begin placing the group results. The default is the First Empty column found in the worksheet. Change the output column location by entering the number of the worksheet column. The Output column must be greater than the last data column.
- **Sort Data.** within the Group Arranges the data within each group into ascending order.

**Restrictions**

- To run the macro, a worksheet must be open and in focus.
- The worksheet must have at least two columns of data.
- Can accept empty cells. Puts "--" into grouped cell to indicate an empty cell or missing data.
Group Column should not have empty cells.

Grouped Data Column Heading Titles correspond to the Group Column contents.

Output column entry must be numeric and greater than the last data column.

**Color Transition Values**

This macro creates a column of colors changing smoothly in intensity as the data changes from its minimum value to its maximum value and employs this gradient to color the symbols in a scatter plot. Define X and Y columns, as well as the column for displaying the color gradient. The Y column generates the gradient. The scatter plot plots the Y column against the X column with the color column determining the symbol color.

**Restrictions**

To run the macro, a worksheet must be open and in focus.

**Compute 1st Derivative**

This macro computes a numerical first derivative of a pair of data columns. It computes the running average of specified adjacent first order derivatives. Both the original data and resulting derivative values can be plotted automatically.

The SigmaPlot transform language 'diff' function is used to compute the first order differences in x and y required for the numerical derivative. The data need not be sorted by x. Replicate x values and the associated y values are row-wise deleted to eliminate zero divides.

To run the macro, choose the first data column and results column. You can also change the length used to determine the running average. Use even values for the length of the running average to place each derivative at the midpoint of the derivatives used in the average. Use odd values to place it at the first point to the left of midpoint.

For even running average length values, there will be avg len/2 cells will be empty at the beginning and end of the derivative values.
Finally, you can also automatically generate graphs of the original data and the derivatives.

**Frequency Plot**

Creates frequency plots with mean bars for multiple data columns. The following options are available:

- **Column Selection.** Specify the number of data columns. The analysis includes all columns between the first and the specified column, inclusive. Each column corresponds to a group. In addition, define the column in which to begin placing the macro results.

- **Graph Dimensions.** Set the height and width of the frequency plot in inches.

- **Bins.** The Vertical Interval indicates the range into which data points will be grouped. The Start Value defines the smallest vertical interval value. A value of 0 corresponds to a vertical range from 0 to 100.

- **Mean/Median Lines.** Add a line (of the specified width) corresponding to the mean or median for each group. Symbols Size defines the diameter of the plotting symbols. Gap represents the horizontal distance between symbols as a percentage of the symbol diameter.

**Restrictions**

- To run the macro, a worksheet must be open and in focus.
- Data must begin in column 1.

**Gaussian Cumulative Distribution**

This macro returns the results of a Gaussian Cumulative Distribution function (CDF) for a single column of data, and optionally plots the results with a probability Y axis scale. The error function is approximated with a polynomial approximation.

**Insert Graphs into Microsoft Word**

Use this macro to insert a SigmaPlot graph into an open Microsoft Word document.
In your Word Document, place your cursor at the position where you want to insert the graph.

The macro lists all graph pages in your currently active notebook. Select the page containing the graph(s) you want to insert.

Adjust the size and positioning of the figure as desired, then click Insert. All graphs on the selected page are placed into the specified frame. The next version of this macro will also allow selection of a specific graph on a page.

To insert additional graphs from this notebook, move to where you want to place the graph in Word, then switch back to SigmaPlot, click the desired page, and click Insert.

**Restrictions**

You must have both a Word Document and a SigmaPlot notebook open in order to use this macro.

**Label Symbols**

This macro labels a scatter or simple bar plot with text from a specified column. Select an offset percentage and one of eight locations for the labels. The offset percentage is a percent of each axis range - 3 to 5 percent is a good starting value. If you have more than one plot in your graph then select the plot you want to label by clicking on a symbol or bar of the particular plot.

Rerun the macro to obtain the best position for the labels and then use Graph, Delete Plot to remove the unwanted label plots.

You can label the plot with numbers by placing the numbers in a column and using Format, Cells to change the numbers to text. Then format each text-number for a pleasing appearance by removing places to the right of the decimal point, and so on.

If the label column contains fewer entries than the plot contains symbols or bars, labeling continues by returning to the first case of the label column. For example, in a scatterplot containing six points, if the label column contains three entries (A,B,C), the points are labeled (A,B,C,A,B,C).
Restrictions

- A graph window must be open and in focus when running the macro.
- The macro is restricted to scatter and simple bar charts and is not applicable to stacked or grouped bar charts.

Merge Columns

This macro merges two separate worksheet columns into one single text column. This is useful if you have two text fields that need to be combined into one, or if you have imported data that contains dates in one column and time in another.

To run the macro, simply select the first and second columns to merge, then click OK.

Restrictions

At least two columns of data must present on your worksheet. The results are automatically placed into the first empty column after the last data column.

Paste to PowerPoint Slide

This macro creates PowerPoint slides from selected SigmaPlot graphs.

To create a PowerPoint slide:

- Select New Presentation or Existing Presentation. If you select Existing Presentation, the Select Presentation button becomes active.
- Click Select Presentation. The Select Presentation dialog box appears.
- Navigate to your existing presentation, and double-click the presentation. The macro returns to the Insert Graph into PowerPoint dialog box.
- Select the PowerPoint Slide Layout you want to insert the graph into from the Slide Layout drop-down list.
Select the PowerPoint Slide Background you want from the Slide Background drop-down list.

Select the SigmaPlot Graph Scheme from the drop-down list.

Select the Transparent Graph Plane check box if you want a transparent background for the graph.

Click OK. PowerPoint opens, and the graph object appears centered in a new PowerPoint slide.

To edit the graph object in PowerPoint:

Open SigmaPlot.

Open the PowerPoint presentation with the inserted SigmaPlot graph.

Double-click the graph in PowerPoint. The graph color changes, and the handles around the graph turn black.

Right-click over the graph. The SigmaPlot right-click menu appears.

Select Object Properties to edit graph Lines, and Size and Position.

Select Graph Properties to edit graph Plots, Axes, Grids and Planes, and Title and Legend.

Click OK to apply changes.

Piper Plots

PIPER plot showing the variations in groundwater chemistry in different sandstone aquifers of England courtesy Dr Paul Shand, British Geological Survey
http://www.bgs.ac.uk/hydro/index.htm
Using the Piper Plot Macro

To create a Piper plot:

► Make sure the values of your four cations and three anions are entered into seven columns.

► Pick the units the data use. If the units used do not match any of the options (percentages, mg/l, or mmol/l) then you will need to transform your data to one of these units.

► Assign the column for each cation/anion as desired by selecting a worksheet column from the Worksheet columns list, the cation/anion from the Assign to list, and clicking the Assign button. Your column assignments are listed under Assigned columns.

► When finished, click OK.

About the Piper Diagram

The PIPER diagram (Piper, 1944) is a plot commonly used by hydrogeologists and hydrologists to display water chemistry data. It has the advantage that many different water samples can be plotted on one graph. The major dissolved ionic species in most natural waters are Ca\(^{2+}\), Mg\(^{2+}\), Na\(^{+}\), K\(^{+}\), Cl\(^{-}\), HCO\(_{3}^{-}\) and SO\(_{4}^{2-}\). The PIPER diagram displays the relative proportions of the major cations (positively charged ions) and anions (negatively charged ions) on two adjacent triangular plots (Figure 1). For plotting purposes, Na and K are grouped together. Each apex of the triangle represents 100\% of that component and mixtures of components plot either along the axes (for 2 components) or within the triangle (for 3 components).

Figure 1. PIPER diagram showing how the relative proportions of cations and anions are plotted. The diamond shaped graph is used to represent the composition of water with respect to both cations and anions. This graph has the advantage that mixing between two waters plots as a straight line. The cation and anion points for each sample are projected onto the diamond shaped field along a line parallel to the outer axes of each triangular plot as shown on Figure 1 and the intersection of these points is plotted. The PIPER diagram can be used to classify "hydrochemical facies" or "water-types" based on the dominant ions (Figure 2).
Chapter 13

Figure 2. The classification of water types displayed on a PIPER diagrams. The proportions of different elements provide information on the chemical history of groundwaters and indicate the dominant chemical reactions that occur between groundwater and the rocks through which it passes. Some data from a sandstone aquifer in Yorkshire are shown on Figure 3 where it can be seen that the groundwaters generally vary from a Ca-HCO₃ type to a CaSO₄ type due to the dissolution of the minerals calcite (CaCO₃) and gypsum (CaSO₄). Some samples also trend towards the Na and Cl apex of the plots due to mixing with an old seawater component (dominated by Na and Cl). Piper, A.M. 1944 A graphic procedure in the geochemical interpretation of water analysis. Transactions, American Geophysical Union, 25, 914-923.

Figure 3. The distribution of water types from a sandstone aquifer in the Vale of York displayed on a PIPER diagram.

**Plotting Polar and Parametric Equations**

This macro creates curves in either Cartesian or polar coordinate systems.

- Select Rectangular or Polar as the Coordinate System.

- Select Single Equation or Parametric as the Curve Description.

  A curve description can be:
  - A single equation relating the two coordinate variables (such as \( y=x^2 \) or \( r = \cos(2*\theta) \)).
  - A pair of equations that define the coordinate values of points on the curve in terms of a third parameter variable (such as \( x = \cos(t) \), \( y = \sin(t) \), or \( r = t^*\sin(2*t) \), \( \theta = t^* \)).

- Set the range of the independent variable and the number of sampled intervals within that range.

- Click Plot. A new graph page appears with a rendering of the curve.

- Render subsequent curves on a new graph page or on the last created graph by selecting Create Graph or Add to Current Graph in under Graphing Options.

- Click Close to close the dialog box.
**Power Spectral Density**

Computes the power spectral density (psd) for a data column. Specify two columns: the data column and the results column. In addition, define the sampling frequency and whether the macro should employ a Hanning window.

The macro creates two plots:
- Amplitude versus Time
- PSD versus Frequency

**Restrictions**

To run the macro, a worksheet must be open and in focus.

**Quick Re-Plot**

This macro quickly re-assigns the columns that are plotted for the current curve in the current two- or three-dimensional plot. Click Next Curve to change the plotted columns for several curves simultaneously.

**Restrictions**

To run the macro, a graph must be open and in focus.

**Rank and Percentile**

Computes ranks and cumulative percentages for a specified data column. Specify the following:
- **Data Column.** The data to be ranked. SigmaPlot also computes cumulative percentages for this column.
- **Percentile Column.** A column containing percentiles. SigmaPlot returns the raw value corresponding to these percentiles.
- **Results Column.** The worksheet column at which the results should begin.
- **Percentile Type.** One of two methods of computing percentiles must be selected.
- **Numeric.** No adjustment made to the values.
Graphing. The Cleveland definition of percentiles described in The Elements of Graphing Data by William S. Cleveland (1985), in which .5 is subtracted from the positions before computing percentages.

The macro returns the sorted data, an index of the original positions, the ranks, and the cumulative percentages. Specifying a column of percentiles yields the values corresponding to those percentiles.

Restrictions

To run the macro, a worksheet must be open and in focus.

Survival Curve

This macro computes and graphs a Kaplan-Meier survival curve using the Surv1Mod transform. Specify the column containing the survival data, as well as the column indicating censoring of cases. A value of 0 in the censoring column indicates that the case is censored, whereas a value of 1 indicates an uncensored case.

Use the Graph Titles section of the Survival Curve dialog box to customize the graph title, the X axis title and the Y axis title. Further customize the plot by selecting between a built-in symbol and a half-line symbol for censored observations.

The macro writes the data underlying the plot in seven worksheet columns, beginning in the specified location. The first three result columns contain the time, cumulative probability, and standard error of the cumulative probability. The next two columns hold the coordinates of the censored observations. The final two columns contain the coordinates of the half-lines used to depict the censored observations.

Restrictions

- To run the macro, a worksheet must be open and in focus.
- The worksheet must be sorted by survival times.
- If identical survival times occur for both censored and uncensored cases, place the censored cases after the uncensored within the tied time value.
**Vector Plot**

This macro uses the vector transform to plot X, Y, angle and magnitude data as vectors with arrowheads. The arrowheads have a user-specified length and angle. The vector plot consists of three line plots. The data underlying these plots appears in the first six empty columns of the worksheet as three XY pairs.

**Restrictions**

- To run the macro, a worksheet must be open and in focus.
- The four columns to be plotted must be contiguous and in the following order: X, Y, Angle, and Magnitude (Length). Due to this restriction, only the first data column (X) must be specified.
- Angle data must be in radians.

**How to Run a Macro**

- On the menus, click:
  - Tools
  - Macro
  - Macros

  The Macros dialog box appears with a list of available macros.

- Select the macro to run from the Macro name list.

- Click Run.
Chapter 13
Transforms are sets of equations that manipulate and calculate data. Math transforms apply math functions to existing data and also generate serial and random data. To perform a transform, you enter variables and standard arithmetic and logic operators into a transform dialog. Your equations can specify that a transform access data from a worksheet as well as save equation results to a worksheet.

You can save transforms as independent .xfm files for later opening or modification. Because transforms are saved as plain text (ASCII) files, you can create and edit them using any word processor that can edit and save text files.

This chapter covers:
- User-defined transforms (see page 551).
- Transform operators (see page 561).
- Performing quick transforms (see page 565).
- Sorting data (see page 568).
- Normalizing ternary data (see page 569).
- Smoothing 2D and 3D data (see page 571).

**User-Defined Transforms**

Modify and manipulate worksheet data by entering SigmaPlot’s extensive mathematical transformation language into the User-Defined Transform dialog box. Use transforms to create new data by performing functions on existing data, or generate calculated or random data, which can then be placed in worksheet columns. For more information, see “Transform Operators” on page 561.

The first step to transform worksheet data is to enter the desired equations in the edit box of the User-Defined Transform dialog box. If no previously entered transform equations exist, the edit box is empty; otherwise, the last transform entered appears.

Select the edit box to begin entering transform instructions. As you enter text into the transform edit box, the box scrolls down to accommodate additional lines.
You can enter up to 100 lines of equations, either on separate lines or on the same line.

**How to Create a User-Defined Transform**

- View the worksheet.

- From the menus select:
  
  Transforms
  User-Defined

The User-Defined Transform dialog box appears.

*Figure 14-1*
*User-Defined Transform Dialog Box*

- Type transform instructions into the Edit Transform field. You can enter up to 32,000 characters.

- Click Run.

You can save the contents of the transform window to a file. Since this is a text file, you can view or print these files using any word processor. You can open previously saved transforms in the transform window for execution or modification.
All transform files have the extension of .xfm in the Transforms folder. To view these files, click the Open button in the User-Defined Transforms dialog box and open a transform file. A library of transform results is named Xfms.jnb in the Transform folder. These transform examples also include a sample SigmaPlot graph file displaying the results of the transform. For more information, see “About SigmaPlot’s User and Program Files” in Chapter 1.

**Transform Syntax and Structure**

Use standard syntax and equations when defining user-defined transforms in SigmaPlot or SigmaStat. This section discusses the basics and the details for entering transform equations.

**Transform Syntax**

Enter transforms as equations with the results placed to the left of the equal sign (=) and the calculation placed to the right of the equal sign. Results can be defined as either variables (which can be used in other equations), or as the worksheet column or cells where results are to be placed.

**Entering Transforms**

To type an equation in the transform edit box, click in the edit box and begin typing. When you complete a line, press Enter to move the cursor to the first position on the next line.

You can leave spaces between equation elements: \( x = a + b \) is the same as \( x = a + b \). However, you may find it necessary to conserve space by omitting spaces. Blank lines are ignored so that you can use them to separate or group equations for easier reading.
Figure 14-2
Typing Equations into the Edit Window

If the equation requires more than one line, you may want to begin the second and any subsequent lines indented a couple of spaces (press the space bar before typing the line). Although this is not necessary, indenting helps distinguish a continuing equation from a new one.

*Note:* You can resize the transform dialog box to enlarge the edit box. You can press Ctrl+X, Ctrl+C, and Ctrl+V to cut, copy, and paste text in the edit window.

Transforms are limited to a maximum of 100 lines. Note that you can enter more than one transform statement on a line; however, this is only recommended if space is a premium.

*Note:* Use only parentheses to enclose expressions. Curly brackets and square brackets are reserved for other uses.

**Commenting on Equations**

To enter a comment, type an apostrophe (’) or a semicolon (;), then type the comment to the right of the apostrophe or semicolon. If the comment requires more than one line, repeat the apostrophe or semicolon on each line before continuing the comment.
Sequence of Expression

SigmaPlot and SigmaStat generally solve equations regardless of their sequence in the transform edit box. However, the col function (which returns the values in a worksheet column) depends on the sequence of the equations, as shown in the following example.

Example

The sequence of the equations:

\[
\begin{align*}
\text{col}(1) &= \text{col}(4)^\alpha \\
\text{col}(2) &= \text{col}(1)\theta
\end{align*}
\]

must occur as shown. The second equation depends on the data produced by the first. Reversing the order produces different results. To avoid this sequence problem, assign variables to the results of the computation, then equate the variables to columns:

\[
\begin{align*}
x &= \text{col}(4) \\
y &= x^\alpha \\
z &= y\theta \\
\text{col}(1) &= y \\
\text{col}(2) &= z
\end{align*}
\]

The sequence of the equations is now unimportant.

Transform Components

Transform equations consist of variables and functions. Operators are used to define variables or apply functions to scalars and ranges. A scalar is a single worksheet cell, number, missing value, or text string. A range is a worksheet column or group of scalars.
Variables

You can define variables for use in other equations within a transform. Variable definition uses the following form:

\[
\text{variable} = \text{expression}
\]

Variable names must begin with a letter. After that, they can include any letter or number, or the underscore character (_). Variable names are case sensitive—an "A" is not the equivalent of an "a." Once a variable has been defined by means of an expression, that variable cannot be redefined within the same transform.

Functions

A function is similar to a variable, except that it refers to a general expression, not a specific one, and thus requires arguments. The syntax for a function declaration is

\[
\text{function(\text{argument 1, argument 2, ...})} = \text{expression}
\]
Using Transforms in SigmaPlot

where function is the name of the function, and one or more argument names are enclosed in parentheses. Function and argument names must follow the same rules as variable names.

User-Defined Functions. Frequently used functions can be copied to the Clipboard and pasted into the transform window.

Constructs

Transform constructs are special structures that allow more complex procedures than functions. Constructs begin with an opening condition statement, followed by one or more transform equations, and end with a closing statement. The available constructs are for loops and if...then...else statements.

Operators

A complete set of arithmetic, relational, and logic operators are provided. Arithmetic operators perform simple math between numbers. Relational operators define limits and conditions between numbers, variables, and equations. Logic operators set simple conditions for if statements. For more information, see “Transform Operators” on page 561.

Numbers

You can enter numbers as integers, in floating point style, or in scientific notation. All numbers are stored with 15 figures of significance. Use a minus sign in front of the number to signify a negative value.

Missing values, represented in the worksheet as a pair of dashes, are considered non-numeric. All arithmetic operations which include a missing value result in another missing value.

To generate a missing value, divide zero by zero.

Example

If you define:

missing = 0/0
the operation:

size({1,2,3,missing})

returns a value of 4.0. (The size function returns the number of elements in a range, including labels and missing values.)

The transform language does not recognize two successive dashes; for example, the string {1,2,3,--} is not recognized as a valid range. Dashes are used to represent missing values in the worksheet only.

Strings, such as text labels placed in worksheet cells, are also non-numeric information. To define a text string in a transform, enclose it with double quotation marks.

As with missing values, strings may not be operated upon, but are propagated through an operation. The exception is for relational operators, which make a lexical comparison of the strings, and return true or false results accordingly.

**Scalars and Ranges**

The transform language recognizes two kinds of elements: *scalars* and *ranges*. A scalar is any single number, string, or missing value. Anything that can be placed in a single worksheet cell is a scalar.

A range (sometimes called a vector or list) is a one-dimensional array of one or more scalars. Columns in the worksheet are considered ranges.

Ranges can also be defined using curly bracket ({} ) notation. The range elements are listed in sequence inside the brackets, separated by commas. Most functions which accept scalars also accept ranges, unless specifically restricted. Typically, whatever a function does with a scalar, it does repeatedly for each entry in a range. A single function can operate on either a cell or an entire column.

**Example 1**

The entry:

{1,2,3,4,5}

produces a range of five values, from 1 through 5.
**Example 2**

The operation:

\{\text{col}(1), \text{col}(2)\}

concatenates columns 1 and 2 into a single range. Note that elements constituting a range need not be of the same type, i.e., numbers, labels and missing values.

**Example 3**

The entry:

\{x, \text{col}(4)*3, 1, \sin(\text{col}(3))\}

also produces a range.

**Array References**

Individual scalars can be accessed within a range by means of the square bracket ([ ]) constructor notation. If the bracket notation encloses a range, each entry in the enclosed range is used to access a scalar, resulting in a new range with the elements rearranged.

**Example**

For the range:

\[x = \{1.4, 3.7, 3.3, 4.8\}\]

the notation:

\[x[3]\]

returns 3.3, the third element in the range. The notation:

\[x[4,1,2]\]

produces the range \{4.8, 1.4, 3.7\}. The constructor notation is not restricted to variables: any expression that produces a range can use this notation.
Example

The operation:

\[
\text{col}(3)[2]
\]

produces the same result as \(\text{col}(3,2)\), or \(\text{cell}(3,2)\). The notation:

\[
\{2,4,6,8\}[3]
\]

produces 6. If the value enclosed in the square brackets is also a range, a range consisting of the specified values is produced.

Example

The operation:

\[
\text{col}(1)[\{1,3,5\}]
\]

produces the first, third, and fifth elements of column 1.

Figure 14-4
Range and Array Reference Operations Typed into the User Defined Transform Window
Transform Operators

Transforms use operators to define variables and apply functions. A complete set of arithmetic, relational, and logical operators are provided.

Order of Operation

The order of precedence is consistent with P.E.M.A. (Parentheses, Exponentiation, Multiplication, and Addition) and proceeds as follows, except that parentheses override any other rule:

- Exponentiation, associating from right to left.
- Unary minus.
- Multiplication and division, associating from left to right.
- Addition and subtraction, associating from left to right.
- Relational operators.
- Logical negation.
- Logical and, associating from left to right.
- Logical or, associating from left to right.

This list permits complicated expressions to be written without requiring too many parentheses.
Chapter 14

Figure 14-5
Examples of Transform Operators

```
Example

The statement:

a<10 and b<5

groups to (a<10) and (b<5), not to (a<(10 and b))<5.

Note: Only parentheses can group terms for processing. Curly and square brackets are reserved for other uses.

Operations on Ranges

The standard arithmetic operators—addition, subtraction, multiplication, division, and exponentiation—follow basic rules when used with scalars. For operations involving two ranges corresponding entries are added, subtracted, etc., resulting in a range representing the sums, differences, etc., of the two ranges.

If one range is shorter than the other, the operation continues to the length of the longer range, and missing value symbols are used where the shorter range ends.
For operations involving a range and a scalar, the scalar is used against each entry in the range.

*Example:* The operation:

```
col(4)*2
```

produces a range of values, with each entry twice the value of the corresponding value in column 4.

**Arithmetic Operators**

Arithmetic operators perform arithmetic between a scalar or range and return the result.

+ Add
- Subtract (also signifies unary minus)
* Multiply
/ Divide
^ or ** Exponentiate

Multiplication must be explicitly noted with the asterisk. Adjacent parenthetical terms such as (a+b) (c-4) are not automatically multiplied.
Relational Operators

Relational operators specify the relation between variables and scalars, ranges or equations, or between user-defined functions and equations, establishing definitions, limits and/or conditions.

= or .EQ.Equal to
> or .GT.Greater than
>= or .GE.Greater than or equal to
< or .LT.Less than
<= or .LE.Less than or equal to
<> or .NE.Not equal to

The alphabetic characters can be entered in upper or lower case.
Logical Operators

Logical operators are used to set the conditions for if function statements.

and, \&Intersection
or, |Union
not, \neg Negation

Performing Quick Transforms

Using the Quick Transform dialog box and the Functions palette, you can execute simple, one-line mathematical functions to modify one or more columns of data. No knowledge of complex programming is required.
Chapter 14

Figure 14-8
The transform in this example applies the sine function to each entry in Column 2 and then adds the results row-wise to the entries of Column 1. The final results will appear in Column 3.

There are two editable drop-down lists on the Quick Transform dialog box. The list on the left is where you select the output cell, column, or block on the worksheet. This is where you want the results of the transform to appear. The drop-down list on the right is where you specify the input cells, columns, or blocks of data or any one-line transform.

You can run Quick Transforms on an individual cell, an entire column, or a block of data.

Note: You cannot run transforms on date and time columns. To use date and time data, you must first convert the data to numeric data, run the transform, and then convert the column back to date and time data. For more information, see “Switching Between Date and Time and Numeric Display” in Chapter 3.

How to Perform a Quick Transform

> With the worksheet in view, from the menus select:
  
  Transforms
  Quick Transforms

The Quick Transform dialog box appears with the Functions palette below, which provides immediate access to frequently used transforms. Using your mouse, you can select cells, blocks of data or columns in the worksheet, and then select different
functions on the Functions palette. You can open and close it by clicking the \( f(x) \) button. It

You can also manually type the equation into the Quick Transform dialog box. For example, if you click Col on the Functions palette, \( \text{col}(?) \) appears in the Quick Transforms dialog box.

Figure 14-9
Selecting an output column in the Quick Transforms dialog box

Now you can a column number to replace the ?.

Or you can first place the cursor in a field in the Quick Transform dialog box, and then select a cell, block of data, or column. This selection then appears in the Quick Transform dialog box.

Figure 14-10
Selecting Column 1 to begin entering transform. The results of the transform will appear in Column 4.

To set trigonometric units, click Options. The Options dialog box appears.
Select the appropriate trigonometric units if calculating trigonometric functions.

- **To use the transform as the title of the column**, in the Options dialog box, select Use transform as the title of the output column. For example:
  - Using a Quick Transform of \( \text{col}(3) = \text{col}(1)+\text{col}(2) \), results in the column title for column 3 of: \( \text{col}(1)+\text{col}(2) \).
  - Using a Quick Transform of \( \text{col}(4) = \text{col}(2)+\text{col}(3) \), results in the column title for column 4 of: \( \text{col}(2)+\text{col}(3) \).

- Click OK to accept these options and close the dialog box.

- Click Run to run the transform. Results appear in the cell, block of data, or column specified in the left drop-down list.

### Sorting Data

You can use SigmaPlot’s built-in Sort Selection transform to move selected blocks of data in ascending or descending order according to the order in a key column.

*Note:* Because the sort command sorts data in place, if you want the original data to remain intact, copy the data to a new location and sort the copied data.

### How to Sort Selected Data

- Use the mouse or keyboard to select the data you want to sort. Only the selected columns and rows are sorted; unselected values within a column are ignored.
From the menus select:

Transforms
Sort selection

The Sort Selection dialog box appears.

Select the key column by choosing the appropriate column title or column number from the Key Column drop-down list, or by typing the column title or column number in the Key Column box.

Select either Ascending or Descending to sort your data in order of increasing or decreasing values.

Click OK to sort the data in place and close the Sort Selection dialog box.

**Normalizing Ternary Data**

To create a ternary graph using data whose sum is not 100% or 1, you need to convert the raw XYZ data into normalized ternary triplet data by using the Normalize Ternary Data transform.
How to Normalize Ternary Data

- From the menus select:
  Transforms
  Normalize Ternary Data

The Normalize Ternary Data Column Picker dialog box appears.

Figure 14-13
Selecting the Data Columns to Normalize from the Normalize Ternary Data Column Picker Dialog Box

- Select the column with the original X data from the worksheet or the Data Source list. The selected column is assigned as the X Source in the Selected Columns list.

- Select the Y data source.

- Select the columns from the worksheet data.

- Select the X, Y, and Z data destination columns in the worksheet.

- Click Next.

- Select the type of scale from the Scale Type drop-down list.
Smoothing 2D and 3D Data

SigmaPlot smoothers are algorithms for smoothing sharp variations in dependent variable values within 2D and 3D data sets. You can also use smoothers to resample data to a rectangular grid of independent variable values.

You control the locations of the computed smoothed values. You can choose the raw data values of the independent variable(s) as the smoothing locations. You can also specify uniformly-spaced smoothing locations over the extent of the independent variable data.

Each smoothing method weights the data contained in a window surrounding the smoothing location. The radius of this window is called the bandwidth radius. A linear or non-linear technique is then applied to the weighted data to compute each smoothed value.

The weight assigned to each data value in the window is determined by its normalized distance (u) from the smoothing location.

Choose one of the following smoothing methods:

- **Loess.** Applies the tricube weight function to weight the data. The smoother is polynomial of degree 1, 2, or 3. Use with 2D or 3D data.

- **Running Average.** Computes the average of the dependent values. Use with 2D or 3D data.

- **Running Median.** Computes the median of the dependent variable. Use with 2D or 3D data.
Negative Exponential. Applies a Gaussian weight function to weight the data and a quadratic fit. Use with 2D or 3D data.

Bisquare. Applies a bisquare weight function. Use with 2D or 3D data.

Inverse Square. Applies a Cauchy weight function. Use with 2D or 3D data.

Inverse Distance. Applies the weight function to the (x,y) data. Use with 3D data only.

You can find smoother method guidelines in the 2D and 3D Smoothers sections of Samples.jnb. For more information, see “About SigmaPlot’s User and Program Files” in Chapter 1.

Smoothing 2D Data

Use the Smooth 2D Data dialog box to remove undesired high-frequency data components, such as data contamination.

Figure 14-15
An example of noisy data and then its conversion. Note that the original noisy data points appear on the graph.

To select the data source:

- Select the worksheet columns by dragging the pointer over your data.

- From the menus select:
  Transforms
  Smooth 2D Data
The Smoother 2D - Select Data dialog box appears.

Figure 14-16
Selecting the Data Columns to Smooth from the Smoother 2D Dialog Box

▲ Click *Next*.

*To select columns for results:*

▲ Select *Predicted: First Empty* from the Results list to compute a smoothed value for each data point.

Figure 14-17
Selecting the Results Columns for the Smoothed Data

▲ Select *Residuals: First Empty* to differentiate between the smoothed value and the original Y value.

▲ Accept *First Next Empty* as the standard default column in the Columns drop-down list.
Select Plot Results to create a grid of the computed smoothed values on the worksheet.

Click Next.

**To select columns to graph:**

Accept First Empty as the default in the Curve Data Column list.

Figure 14-18
*>Selecting columns to display a grid of smoothed data on the worksheet.*

Select Create a new graph to create a line plot using the grid of data which appears on the worksheet.

**To create another plot type and style,** clear Create new graph, and create the plot manually. For more information, see “Creating 2D Plots” in Chapter 6.

Click Finish. The Smooth 2D Data dialog box appears.
Using Transforms in SigmaPlot

Figure 14-19
Selecting Smoothers from the Smooth 3D Data drop-down list

- **To define smoothing parameters**, select a smoother type from the Smoothers drop-down list.

- Set the **Sampling Proportion** to determine a fraction of the total number of data points used to compute each smoothed value.

  *Note:* The interpretation of the **Sampling Proportion** depends on the Bandwidth Method.

- Set the polynomial degree from the **Polynomial Degree** list, if applicable.

- Select **Reject Outliers** to reduce the effects of outlier points on the smoothed values.

- **To preview and create the graph**, click **Preview** to see a preview of the graph.

  If the preview is not satisfactory, adjust the **Smoothers** settings and options and click **Preview** again. Each time you preview, the settings are stored for subsequent review by clicking the right and left arrows.

- Click **OK** to accept the preview.

  The graph appears with a line graph representing the smoothed data points. The original noisy data points also remain. The worksheet now contains the results of all selected computations.

  *Note:* You can click the **Stop** button at the bottom of the **Smooth 2D Data** dialog box if you want to stop the process.
**Setting Smoothed Curve Options**

Use the Smoothed Curve Options dialog box to set the options for smoothing a 2D Curve.

Figure 14-20
*The Smooth Curve Options Dialog Box*

- Change the Minimum and Maximum for the X values to new beginning and ending values for the X ranges. For 2D smoothing, the Y values are the smoothed values, and therefore unavailable in the Smoothed Curve Options dialog box.

- Set the Bandwidth method to either Fixed or Nearest Neighbors.
  - **Fixed.** Sets the same bandwidth radius the same at every smoothing location. The radius is computed by multiplying the Sampling Proportion value times half of the difference between the set Minimum and Maximum independent variables (X values).

  Select Fixed if the density of the observed data is relatively constant over the extent of its defined region.

  - **Nearest Neighbors.** Here the bandwidth radius depends on the smoothing location. The radius is equal to the maximum distance between the smoothing location and its nearest neighbors, as determined by the Sampling Proportion value.

  Select Nearest Neighbors for data that is clustered in some areas and sparse in others.

For example, if there are 100 data points, enter .1 as the Sampling Proportion value to choose ten data points nearest the smoothing location.
Click OK to close the dialog box and return to the Smooth 2D Data dialog box.

**Smoothing 3D Data**

Use the Smoother 3D dialog box to smooth variations in 3D data. You can also re-sample 3D data to rectangular grid locations to create mesh plots and 3D contour plots from irregularly spaced data.

- Select the worksheet columns by dragging the pointer over your data.
- From the menus select:
  - Transforms
  - Smooth 3D Data

The Smoother 3D - Select Data dialog box appears.

**Figure 14-21**

*Selecting the Data Columns to Smooth from the Smoother 3D Dialog Box*

- Click Next.
To select worksheet columns for your results, select Predicted: First Empty from the Results list to compute a smoothed value at each data point.

Select Residuals: First Empty to differentiate between the smoothed value and the original Y value.

Accept First Empty as the standard default column in the Columns drop-down list.

Select Plot Results to create a grid of the computed data on the worksheet.

Click Next.

To select columns to graph, accept First Empty as the default in the Columns drop-down list.
Select Create a new graph to create a mesh plot using the grid of data which appears on the worksheet. If you are creating a contour plot, clear Create new graph, and create the contour plot manually. For more information, see “Creating Contour Plots” in Chapter 7.

Select a smoother type from the Smoother drop-down list.

Figure 14-24
Selecting Smoothers from the Smooth 3D Data drop-down list

Set the Sampling Proportion, a fraction of a total number of data points used to compute each smoothed value.

*Note:* The Sampling Proportion depends on the Bandwidth Method. For more information, see page 576.

Set the Polynomial Degree from the Polynomial Degree list, if applicable.

Select Reject Outliers to reduce the effects of outlier points on the smoothed values.

To set the smoothed surface options, click Options. The Smoothed Surface Options dialog box appears. For more information, see “Setting Smoothed Curve Options” on page 576.

To preview and then create the graph, click Preview to see a preview of the graph.

If the preview is not satisfactory, adjust the Smoother settings and options, and click Preview again. Each time you preview, the settings are stored for subsequent review by clicking the right and left arrows.
Click OK to accept the preview.

The graph appears, and the worksheet now contains the results of all selected computations.

*Note:* You can click the red Stop button at the bottom of the Smooth 3D Data dialog box to stop the process.

**Setting Smoothed Surface Options**

Use the Smoothed Surface Options dialog box to set the options for smoothing a 3D Curve.

**Figure 14-25**
The Smooth Curve Options Dialog Box

- Change the Minimum and Maximum for the X and Y values to new beginning and ending values for the X and Y ranges.

- Set the bandwidth method to either Fixed or Nearest Neighbors.
  - **Fixed.** The bandwidth radius is the same at every smoothing location. The radius is computed by multiplying the Sampling Proportion value times half of the difference between the set Minimum and Maximum independent variables (X and Y values).
    Select Fixed if the density of the observed data is relatively constant over the extent of its defined region.
  - **Nearest Neighbors.** Here the bandwidth radius depends on the smoothing location. The radius is equal to the maximum distance between the smoothing location and its nearest neighbors, as determined by the Sampling Proportion value.
Select **Nearest Neighbors** for data that is clustered in some areas and sparse in others.

- Click **OK** to close the dialog box and return to the **Smooth 3D Data** dialog box.
Chapter 14
Transform Examples

Many mathematical transform examples, along with appropriate graphs and worksheets are included with SigmaPlot. This chapter describes the data transform examples and the graphing transform examples provided. Each description contains the text of the transform and, where applicable, a graph displaying the possible results of the transform. You can find these sample transforms in the Transforms folder. For more information, see “About SigmaPlot’s User and Program Files” in Chapter 1.

Data Transform Examples

The data transform examples are provided to show you how transform equations can manipulate and calculate data.

One Way Analysis of Variance (ANOVA)

A One Way Analysis of Variance (ANOVA) table can be created from the results of a regression or nonlinear regression. The original Y values, the Y data from the fitted curve, and the parameters are used to generate the table. The transform assumes you have placed the original Y data in column 2, the fitted Y data in column 3, and the regression coefficients or function parameters in column 4. You can either place this data in these columns, or change the column numbers used by the transform.

The One Way ANOVA transform contains examples of the following transform functions:

- Count
- If
- Total
- Mean
- {...} (constructor notation)
To use the One Way ANOVA transform:

- Make sure your original Y data is in column 2. Perform the desired regression using the Regression Wizard, and save your Predicted values (fitted Y data) in column 3, and Parameters (the regression coefficients) in column 4.

  For more information, see “What is Regression?” in Chapter 16.

- Press F10 to open the User-Defined Transform dialog box, then click the Open button and open the ANOVA.XFM transform file in the XFMS directory. The ANOVA transform appears in the edit window.

- Click Run. The ANOVA results are placed in columns 5 through 9, or beginning at the column specified with the anova variable.

Area Beneath a Curve Using Trapezoidal Rule

This transform computes the area beneath a curve from X and Y data columns using the trapezoidal rule for unequally spaced X values. The algorithm applies equally well to equally spaced X values.

  This transform uses an example of the diff function.

To use the Area Under Curve transform:

- Place your X data in column 1 and your Y data in column 2. If your data has been placed in other columns, you can specify these columns after you open the AREA.XFM file. You can use an existing or new worksheet.

- Press F10 to open the User-Defined Transform dialog box, then click the Open button and open the AREA.XFM transform file in the XFMS directory. The Area transform appears in the edit window.

- Click Run. The area is placed in column 3 or in the column specified with the res variable.
Bivariate Statistics

This transform takes two data columns of equal length and computes their means, standard deviations, covariance, and correlation coefficient. The columns must be of equal length.

The Bivariate transform uses examples of these transform functions:

- mean
- stddev
- total

To use the Bivariate transform:

- Place your X data in column 1 and your Y data in column 2. If your data has been placed in other columns, you can specify these columns after you open the BIVARIAT.XFM transform file. You can enter data into an existing worksheet or a new worksheet.

- Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the BIVARIAT.XFM transform file in the XFMS directory. The Bivariate Statistics transform appears in the edit window.

- Click Run. The results are placed in columns 3 and 4, or beginning in the column specified with the res variable.

Differential Equation Solving

This transform can be used to solve user-defined differential equations. You can define up to four first order equations, named fp1(x1,y1,y2,y3,y4) through fp4(x1,y1,y2,y3,y4). Set any unused equations = 0.

To solve a first order differential equation:

- Begin a new worksheet by choosing the File menu New command, then choosing Worksheet; this transform requires a clean worksheet to work correctly.
Open the User-Defined Transforms dialog box by selecting the Transforms menu User Defined command, then clicking the Open button, and opening the DIFFEQN.XFM transform file in the XFMS directory. The Differential Equation Solving transform appears in the edit window.

Scroll to the Number of Equations section and enter a value for the neqn variable. This is the number of equations you want to solve, up to four.

Scroll down to the Differential Equations section, and set the fp1 through fp4 functions to the desired functions. Set any unused equations = 0. If only one first order differential equation is used, then only the fp1 transform equation is used and fp2, fp3, and fp4 are set to 0. For example, if you only wanted to solve the differential equation:

\[ \frac{dy_1}{dt} = ay_1 \]

you would enter:

\[
\begin{align*}
fp1(x,y1,y2,y3,y4) &= -a*y1 \\
fp2(x,y1,y2,y3,y4) &= 0 \\
fp3(x,y1,y2,y3,y4) &= 0 \\
fp4(x,y1,y2,y3,y4) &= 0
\end{align*}
\]

Scroll down to the Initial Values heading and set the nstep variable to the number of integration (X variable) steps you want to use. The more steps you set, the longer the transform takes.

Set the initial X value x0, final X value x1, and the Y1 through Y4 values (placed in cells (2,1) through (5,1)). If you are not using a y1 value, set that value to zero (0). For example, for the single equation example above, you could enter:

\[
\begin{align*}
x0 &= 0; initial x \\
x1 &= 1; final x \\
cell(2,1) &= 1; y1 initial value \\
cell(3,1) &= 0; y2 initial value \\
cell(4,1) &= 0; y3 initial value \\
cell(5,1) &= 0; y4 initial value
\end{align*}
\]

Click Run. The results output is placed in columns 1 through neqn+1.
To graph your results, create a Line Plot graphing column 1 as your X data and columns 2 through 5 as your Y data.

Figure 15-1
Differential Equation Graph

F-test to Determine Statistical Improvement in Regressions

This transform compares two equations from the same family to determine if the higher order provides a statistical improvement in fit.

Often it is unclear whether a higher order model fits the data better than a lower order. Equations where higher orders may produce better fits include: simple polynomials of different order, the sums of exponentials for transient response data, and the sums of hyperbolic functions for saturation ligand binding data.

F_TEST.XFM uses the residuals from two regressions to compute the sums of squares of the residuals, then creates the F statistic and computes an approximate P value for the significance level.

You can try this transform out on the provided sample graph, or run it on the residuals produced by your own regression sessions. Residuals are saved to the worksheet by the Regression Wizard.
To use the provided sample data and graph, open the F-test worksheet and graph in the XFMS.JNB notebook. The worksheet contains raw data in columns 1 and 2, and curve fit results for the two competitive binding models in columns 3-5 and 6-8. The graph plots the raw data and the two curve fits.

To use your own data, enter the XY data to be curve fit in columns 1 and 2, respectively. Select the first curve fit equation and use it to fit the data, place the parameters, fit results and residuals in the first empty columns (3-5). Run the second curve fit and place the results in columns 6-8 (the default). If desired, create graphs of these results using the wizard.

Press F10 to open the User-Defined Transform dialog box, then open the F_TEST.XFM transform file. Specify n1 and n2, the number of parameters in the lower and higher order functions. In the example provided, these are 3 and 5, respectively.

If necessary, specify cs1 and cs2, the column locations for the residuals of each curve fit, and cres, the first column for the two column output.

Click Run. The F-test value and corresponding P value are placed into the worksheet. If P < 0.05, you can predict that the higher order equation provides a statistically better fit.
You can use this transform to compute the coefficient of determination ($R^2$) for the results of a nonlinear regression. The original Y values and the Y data from the fitted curve are used to calculate $R^2$.

To save the fitted Y values of the nonlinear regression to the worksheet, use the Regression Wizard to save the Function results to the appropriate column (for this transform, column 3).

- Place your original Y data in column 2 of the worksheet and the fitted Y data in column 3. If your data has been placed in other columns, you can specify these columns after you open the R2.XFM transform file. You can enter data into an existing or a new worksheet.

- Press F10 to open the User-Defined Transform dialog box, then click the Open button and open the R2.XFM transform file in the XFMS directory. The $R^2$ transform appears in the edit window.

- Click Run. The $R^2$ value is placed in column 4 of the worksheet, or in the column specified with the res variable.
**Standard Deviation of Linear Regression Parameters**

This transform computes linear 1st-order regression parameter values (slope and intercept) and their standard deviations using X and Y data sets of equal length.

*To calculate 1st-order regression parameters and their standard deviations for XY data points:*

- Place the X data in column 1 of the worksheet and the Y data in column 2. If your data is in other columns, you can specify these columns after you open the STDV_REG.XFM transform file. You can enter data into an existing worksheet or a new worksheet.

- Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the STDV_REG.XFM transform file in the XFMS directory. If necessary, change the x_col, y_col, and res variables to the correct column numbers.

- Click Run. The results are placed in columns 3 and 4, or in the columns specified by the res variable.

**Graphing Transform Examples**

The graph transform examples are provided to show you how transform equations can manipulate and calculate data to create complex graphs.

Each of the following descriptions provide instructions on how to use SigmaPlot to create graphs. Most of these graphs, however, are already set up as sample graphs. If you use the provided worksheet and graphs with the corresponding transform files, SigmaPlot will automatically create the graphs after you run the transform.

**Control Chart for Fractional Defectives with Unequal Sample Sizes**

This example computes the fraction of defectives p for a set of unequally sized samples using their corresponding numbers of defects, the control limits for p, and data for the upper and lower control lines. This transform contains examples of the following transform functions:

- stddev
To calculate and graph the fraction of defectives and control lines for given sample sizes and number of defects per sample, you can either use the provided sample data and graph or begin a new notebook, enter your own data and create your own graph using the data.

To use the provided sample data and graph, open the Control Chart worksheet and graph in the Control Chart section of the Transform Examples notebook. The worksheet appears with data in columns 1, 2, and 3. The graph page appears with an empty graph.

To use your own data, place the sample sizes in column 1 and the corresponding number of defects data in column 2 of a new worksheet. If your data is in other columns, you can specify these columns after you open the CONTCHRT.XFM transform file. You can enter your data in an existing or a new worksheet.

Press F10 to open the User-Defined Transform dialog box, then click the Open button and open the CONTCHRT.XFM transform file in the XFMS directory. The Control Chart transform appears in the edit window.

Click Run. The results are placed in columns 4 through 5 of the worksheet.

If you opened the Control Chart graph, view the graph page. The graph plots the fraction of defectives using a Line and Scatter plot with a Simple Straight Line style graphing column 3 as Y data versus the row numbers. The control lines are plotted as a Simple Horizontal Step Plot using columns 4 and 5 versus their row numbers. The mean line for the fractional defectives is drawn with a reference line.

To create your own graph, create a Line and Scatter Plot, with a Simple Line style, then plot column 3 as Y data against the row numbers. Add an additional Line Plot using the Multiple Horizontal Step Plot style, plotting columns 4 and 5 versus their two numbers, then add a reference line to plot the mean line for the fractional device.
Cubic Spline Interpolation and Computation of First and Second Derivatives

This example takes data with irregularly spaced X values and generates a cubic spline interpolant. The CBESPLN1.XFM transform takes X data which may be irregularly spaced and generates the coefficients for a cubic spline interpolant. The CBESPLN2.XFM transform takes the coefficients and generates the spline interpolant and its two derivatives.

The values for the interpolant start at a specified minimum X which may be less than, equal to, or greater than the X value of the original first data point. The interpolant has equally spaced X values that end at a specified maximum which may be less than, equal to, or greater than the largest X value of the original data.

Note that this is not the same algorithm that SigmaPlot uses; this algorithm does not handle multiple valued functions, whereas SigmaPlot does.

To use the transform to generate and graph a cubic spline interpolant, you can either use the provided sample data and graph, or begin a new notebook, enter your own data and create your own graph using the data.

To use the provided sample data and graph, open the Cubic Spline worksheet and graph by double-clicking the graph page icon in the Cubic Spline section of the Transform Examples notebook. The worksheet appears with data in columns 1 and 2 and the graph page appears with two graphs. The first graph plots the original XY data as a scatter plot. The second graph appears empty.
To use your own data, enter the irregularly spaced XY data into the worksheet. The X values must be sorted in strictly increasing values. The default X and Y data columns used by the transform are columns 1 and 2, respectively.

Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the CBESPLN1.XFM transform file in the XFMS directory. The first Cubic Spline transform appears in the edit window.

Move to the Input Variables heading. Set the X data column variable cx, the Y data column cy, the beginning interpolated X value xbegin, the ending interpolated X value xend, and the X increments for the interpolated points xstep. A larger X step results in a smoother curve but takes longer to compute. Enter the end condition setting iend for the interpolation.

Enter the end condition setting iend for the interpolation.

You can use first, second, or third order conditions. If you have only a few data points, you should try different orders to see which one you like the most. See the example for the effect of too low an order on the first and second derivatives.

1 end spline segments approach straight lines asymptotically
2 end spline segments approach parabolas asymptotically
3 end spline segments approach cubics asymptotically

Move to the RESULTS heading and enter the first column number for the results cr. This column for the beginning of the results block is specified in both transforms.

Click Run to run the transform. When it finishes, press F10 then open the CBESPLN2.XFM transform file in the XFMS directory. Make sure that the cr variable is identical to the previous value, then click Run.

If you opened the Cubic Spline graph, view the page. The first graph plots the original XY data as a scatter plot and the interpolated data as a second line plot by picking the cr column as the X column and cr+1 as the Y column. The second graph plots the derivatives as line plots using the cr column versus the cr+2 column and the cr column versus the cr+3 column.
To create your own graphs using SigmaPlot, create a Scatter Plot using a Simple Scatter style which plots the original data in columns 1 and 2 as XY pairs. Add an additional Line Plot using a Simple Spline Curve, then plot the cr column as the X column against the cr+1 column as the Y column.

Fast Fourier Transform

The Fast Fourier Transform converts data from the time domain to the frequency domain. It can be used to remove noise from, or smooth data using frequency-based filtering. Use the fft function to find the frequency domain representation of your data, then edit the results to remove any frequency which may adversely affect the original data.

The Fast Fourier Transform uses the following transform functions:

- fft
- invfft
- real
- img
- complex
- mulcpx
- invcpx

The Fast Fourier Transform operates on a range of real values or a block of complex values. For complex values there are two columns of data. The first column contains...
the real values and the second column represents the imaginary values. The worksheet format of a block of complex numbers is:

\[
\begin{array}{cc}
 r_1 & i_1 \\
r_2 & i_2 \\
... & ...
\end{array}
\]

where \( r \) values are real elements, and \( i \) values are imaginary elements. In transform language syntax, the two columns \([ r_1, r_2, ..., r_n ], [ i_1, i_2, ..., i_n ]\) are written as:

\[
\text{block}(\{ r_1, r_2, ..., r_n \}, \{ i_1, i_2, ..., i_n \})
\]

This function works on data sizes of size \( 2^n \) numbers. If your data set is not \( 2^n \) in length, the \texttt{fft} function pads 0 at the beginning and end of the data range to make the length \( 2^n \).

The \texttt{fft} function returns a range of complex numbers. The Fast Fourier Transform is usually graphed with respect to frequency. To produce a frequency scale, use the relationship:

\[
f = f_s \times (\text{data}(0,n/2)-1)/n
\]

where \( f_s \) is the sampling frequency. The example transform \texttt{POWSPEC.XFM} includes the automatic generation of a frequency scale.

The Fast Fourier Transform operates on data which is assumed to be periodic over the interval being analyzed. If the data is not periodic, then unwanted high frequency components are introduced. To prevent these high frequency components from occurring, windows can be applied to the data before using the \texttt{fft} transform. The Hanning window is a cosine function that drops to zero at each end of the data. The example transform \texttt{POWSPEC.XFM} includes the option to implement the Hanning window. For more information, see “Computing Power Spectral Density” on page 596.

**Using the Block Function**

To return the full \texttt{fft} data to the worksheet:

- First assign the data you want to filter to column 1 of the worksheet. You can generate the data using a transform, or use your own measurements.
Press F10 to open the User-Defined Transforms dialog box, then click the New button to start a new transform.

Type the following transform in the edit window:

\[ x = \text{col}(1) \quad \text{real data} \]
\[ tx = \text{fft}(x) \quad \text{compute the fft} \]
\[ \text{block}(2) = tx \quad \text{place real fft data back in col}(2) \]
\[ \text{place imaginary fft data in col}(3) \]

Click Run. The results are placed starting one column over from the original data.

**Computing Power Spectral Density**

The example transform POWSPEC.XFM uses the Fast Fourier Transform function, then computes the power spectral density, a frequency axis, and makes optional use of a Hanning window.

To calculate and graph the power spectral density of a set of data, you can either use the provided sample data and graph, or begin a new notebook, enter your own data and create your own graph using the data.

To use the sample worksheet and graph, open the Power Spectral Density worksheet and graph by double-clicking the graph page icon in the Power Spectral Density section of the Transform Examples notebook. Data appears in column 1 of the worksheet, and two graphs appear on the graph page. The top graph shows data generated by the sum of two sine waves plus *Gaussian* random noise. The data is represented by:

\[ f(t) = \sin(2\pi f_1 t) + 0.3 \sin(2\pi f_2 t) + g(t) \]

where \( f_1 = 10 \text{ cycles/sec (cps),} \ f_2 = 100 \text{cps,} \) and the Gaussian random noise has mean 0 and standard deviation of 0.2. The lower graph is empty.

To use your own data, place your data in column 1. If your data is in a different column, specify the new column after you open the POWSPEC.XFM transform file.

Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open POWSPEC.XFM transform file in the XFMS directory. The Power Spectral Density transform appears in the edit window.
Note: To use this transform, the Trigonometric Units must be set to Radians.

- Click Run. Since the frequency sampling value (fs) is nonzero, a frequency axis is generated in column 2 and the power spectral density data in column 3.

- If you opened the Power Spectral Density graph, view the graph page. Two graphs appear on the page. The top graph plots the data generated by the sum of two sine waves plus Gaussian random noise using a Line Plot with Simple Straight Line style graphing column 1 versus row numbers. The lower graph plots the power spectral density using a Line Plot with a Simple Straight Line style, graphing column 2 as the X data (frequency), and column 3 as the Y data.

- To plot your own data using SigmaPlot, choose the Graph menu Create Graph command, or select the Graph Wizard from the toolbar. Create a Line Plot with a Simple Straight Line style plotting your original data versus row numbers by choosing Single Y data format. If you set the frequency sampling value (fs) to nonzero, create a Line Plot with a Simple Straight Line style, graphing columns 2 and 3 using XY Pair data format. Otherwise, create a Line Plot with a Simple Straight Line style plotting column 3 (power spectral density) versus row numbers by choosing Single Y data format.

The power spectral density plot of the signal f(t) shows two major peaks at the two frequencies of the sine waves (10cps and 100cps), and a more or less constant noise level in between.

For more information, see “Creating and Modifying Graphs” in Chapter 4.
Kernel Smoothing

The example transform SMOOTH.XFM smooths data by convolving the Fast Fourier Transform of a triangular smoothing kernel together with the fft of the data. Smoothing data using this transform is computationally very fast; the number of operations is greatly reduced over traditional methods, and the results are comparable. To increase the smoothing, increase the width of the triangular smoothing kernel.

To calculate and graph the smoothed data, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data.

> To use the sample worksheet and graph, open the Kernel Smoothing worksheet and graph by double-clicking the graph page icon in the Kernel Smoothing section of the Transform Examples notebook. Data appears in columns 1 through 4, 6, and 7 of the worksheet, and two graphs appear on the graph page. The first graph has two plots, the signal, and the signal with noise distortion. Column 1 contains the X data, column 2 contains the Y data for the signal, and column 3 contains the Y data for the signal and the noise distortion. The lower graph is empty.
To use your own data, place your data in columns 1 through 2. If your data is in other columns, specify the new columns after you open the SMOOTH.XFM transform file. If necessary, specify a new column for the results.

Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open SMOOTH.XFM transform file in the XFMS directory. The Kernel Smoothing transform appears in the edit window.

*Note:* To use this transform, make sure the Insert mode is turned off.

Click Run. The results are placed in column 5 unless you specified a different column in the transform.

If you opened the Kernel Smoothing graph, view the graph page. Two graphs appear on the page. The first graph has two plots, the signal, and the signal with noise distortion. The Line Plot with a Multiple Straight Line style graphs column 1 as the X data, column 2 as the Y data for the signal, and column 3 as the Y data for the signal and the noise distortion. The lower Line Plot with a Simple Straight Line style plots column 1 as the X data, and column 5 as the Y data using XY Pairs data format.

To plot your own data using SigmaPlot, choose the Graph menu Create Graph command, or select the Graph Wizard from the toolbar. Create a Line Plot with a Multiple Straight Line style using X Many Y data format, plotting column 1 as the X data, column 2 as the Y data for the signal, and column 3 as the Y data for the signal and the noise distortion. Create a second Line Plot graph with a Simple Straight Line style using the data in columns 1 and 5, graphing column 1 as the X data and column 5 as the Y data using XY Pairs data format.

For more information, see “Creating and Modifying Graphs” in Chapter 4.
Smoothing with a Low Pass Filter

The Low Pass Filter transform smooths data by eliminating high frequencies. Use this transform in contrast to the Kernel Smoothing transform which smooths data by augmenting some frequencies while minimizing others. The transform statements describing how the low pass filter works are:

\[
\begin{align*}
x &= \text{col}(1) \quad \text{"the data to smooth"} \\
f &= 5 \quad \text{"number of channels to eliminate"} \\
\text{tx} &= \text{fft}(x) \quad \text{"fft of data"} \\
r &= \text{data}(1, \text{size(tx)/2}) \quad \text{"total number of channels"} \\
\text{mp} &= \text{size(tx)/4} \quad \text{"get the midpoint"} \\
\text{td} &= \text{if}(r<\text{mp}-f \text{ or } r>\text{mp}+1+f, \text{tx}, 0) \quad \text{"remove the frequencies"} \\
\text{sd} &= \text{invfft}(\text{td}) \quad \text{"convert back to time domain"} \\
\text{col}(2) &= \text{real}(\text{sd}) \quad \text{"save smoothed data to worksheet"}
\end{align*}
\]
The LOWPASS.XFM transform expresses $f$ as a percentage for ease of use. As the value of $f$ increases, more high frequency channels are removed. Note that this is a digital transform which cuts data at a discrete boundary. In addition, this transform does not alter the phase of the data, which makes it more accurate than analog filtering. A high pass or band pass filter can be constructed in the same manner.

To calculate and graph the smoothing of a set of data using a low pass filter, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data.

- To use the sample worksheet and graph, open the Low Pass Smoothing worksheet and graph by double-clicking the graph page icon in the Low Pass Smoothing section of the Transform Examples notebook. Data appears in columns 1 through 4 of the worksheet, and two graphs showing plots appear on the graph page. Column 1 contains the X data, column 2 contains the Y data for the signal and the noise distortion, column 3 contains the X data, and column 4 contains the Y data for the original signal. The top graph plots the signal plus the noise distortion; the bottom graph plots the signal.

- To use your own data, place your data in columns 1 through 2. If your data is in other columns, specify the new columns after you open the LOWPASS.XFM transform file. If necessary, specify a new column for the results.

- Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open LOWPASS.XFM transform file in the XFMS directory. The Low Pass Filter transform appears in the edit window.

  Note: To use this transform, make sure Insert mode is turned off.

- Click Run. The results are placed starting in column 5, unless you specified a different column in the transform.

- If you opened the Low Pass Smoothing graph, view the graph page. Two graphs appear. The top graph plots the signal plus the noise distortion, using a Line Plot with a Simple Straight Line style and XY Pairs data format graphing column 1 as the X data, column 2 as the Y data for the signal and the noise distortion. The bottom graph displays two plots. A Scatter Plot with a Simple Scatter Style and XY Pairs data format, plots column 3 as the X data, and column 4 as the Y data for the original signal. A second Line Plot with a Simple Straight Line style using data in columns 1 and 5, plots column 1 as the X data and column 5 as the Y data using XY Pairs data format.
To plot your own data using SigmaPlot, choose the Graph menu Create Graph command, or select the Graph Wizard from the toolbar. Create two graphs. Graph the signal plus the noise distortion, using a Line Plot with a Simple Straight Line style and XY Pairs data format graphing column 1 as the X data, column 2 as the Y data for the signal and the noise distortion. Create a second graph with two plots. Plot the original signal using a Scatter Plot with a Simple Scatter Style and XY Pairs data format, plotting column 3 as the X data, and column 4 as the Y data for the original signal. Add a second Line Plot with a Simple Straight Line style using data in columns 1 and 5, plotting column 1 as the X data and column 5 as the Y data using XY Pairs data format.

**Figure 15-6**

*Low Pass Filter Smoothing Graph*
Gain Filter Smoothing

The GAINFILT.XFM transform example demonstrates gain filter smoothing. This method eliminates all frequencies with power spectral density levels below a specified threshold. The transform statements describing how gain filter smoothing works are:

\[ P = 4000 \quad \text{psd threshold} \]
\[ x = \text{col}(1) \quad \text{data} \]
\[ tx = \text{fft}(x) \quad \text{compute fft of data} \]
\[ md = \text{real}(tx)^2 + \text{img}(tx)^2 \quad \text{compute sd} \]
\[ kc = \text{if}(md > P, 1, 0) \quad \text{remove frequencies with } \text{psd} < P \]
\[ sd = \text{mulcpx} (\text{complex}(kc), tx) \quad \text{remove frequency components from x} \]
\[ td = \text{real} (\text{invfft}(sd)) \quad \text{convert back to time domain} \]
\[ \text{col}(2) = td \quad \text{place results in worksheet} \]

To calculate and graph the smoothing of a set of data using a gain filter, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data.

To use the sample worksheet and graph, open the Gain Filter Smoothing worksheet and graph by double-clicking the graph page icon in the Gain Filter Smoothing section of the Transform Examples notebook. Data appears in columns 1 through 3 of the worksheet, and two graphs showing plots, and one blank graph appear on the graph page. Column 1 contains the Y data for the signal plus noise, column 2 contains the X data and column 3 contains the Y data for the power spectral density graph. The top graph plots the signal plus the noise distortion; the middle graph plots the power spectral density.

To use your own data, place your data in column 1. If your data is in a different column, specify the new column after you open the GAINFILT.XFM transform file. If necessary, specify a new column for the results.

Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open GAINFILT.XFM transform file in the XFMS directory. The Gain Filter transform appears in the edit window.
Note: To use this transform, make sure Insert mode is turned off. For more information, see “Insertion and Overwrite Modes” in Chapter 3.

- Click Run. The results are placed in column 5 unless you specified a different column in the transform.

- If you opened the Gain Filter Smoothing graph, view the graph page. Three graphs appear. The top graph plots the signal plus the noise distortion using a Line Plot with a Simple Straight line style and Single Y data format, plotting column 1 as the Y data for the signal plus noise. The middle graph plots the power spectral density using a Line Plot with a Simple Straight Line style and XY Pairs data format, plotting column 2 as the X data and column 3 as the Y data for the power spectral density graph. The lower graph is a plot of the gain filtered signal, using a Line Plot with a Simple Straight Line style, and single Y data format from column 5.

- To plot your own data using SigmaPlot, choose the Graph menu Create Graph command, or select the Graph Wizard from the toolbar. Create two graphs. Plot the signal plus the noise distortion using a Line Plot with a Simple Straight line style and Single Y data format, plotting column 1 as the Y data for the signal plus noise. Plot the gain filtered signal using a Line Plot with a Simple Straight Line style, and single Y data format from column 5.
Figure 15-7
Gain Filter Smoothing Graph

Frequency Plot

This transform example creates a frequency plot showing the frequency of the occurrence of data in the Y direction. Data is grouped in specified intervals, then horizontally plotted for a specific Y value. Parameters can be set to display symbols that are displaced a specific distance from each other or that touch or overlap. You can also plot the mean value of each data interval. This transform example shows overlapping symbols which give the impression of data mass.

To calculate and graph the frequency of the occurrence of a set of data, you can either use the provided sample data and graph, or begin a new notebook, enter your own data and create your own graph using the data.
To use the sample worksheet and graph, open the Frequency Plot worksheet and graph by double-clicking the graph page icon in the Frequency Plot section of the Transform Examples notebook. Data appears in columns 1 through 3 of the worksheet, and an empty graph appears on the graph page.

To use your own data, place your data in columns 1 through 3. You can put data in as many or as few columns as desired, but if you use the sample transform you must change the X locations of the Y values in the second line under the Input heading in the transform file to reflect the number of data columns you are using. If your data is in other columns or more than three columns, specify the new columns after you open the FREQPLOT.XFM transform file.

Enter the tick labels for the X axis in a separate column, and specify tick labels from a column using the Tick Labels Type drop-down list in the Tick Labels panel in Graph Properties Axis tab.

Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the FREQPLOT.XFM transform file in the XFMS directory. The Frequency Plot transform appears in the edit window.

Click Run. The results are placed starting one column over from the original data.

If you opened the sample Frequency Plot graph, view the graph page. A Scatter Plot appears plotting columns 5 and 6, 7 and 8, and 9 and 10 as three separate XY Pair plots. The lines passing through each data interval is a fourth Line Plot with a Simple Straight Line style plotting columns 11 and 12 as an XY pair, representing the mean value of each data interval. The X axis tick marks are generated by the transform. The axis labels are taken from column 13.
To create your own graph using SigmaPlot, make a graph with three Scatter Plots with Simple Scatter styles. Plot each consecutive result column pair as XY pair scatter plots. If the mean line option is active in the transform, plot the last consecutive result column pair as a XY pair Line Plot with Simple Straight Line style. Use labels typed into a worksheet column as the X axis tick labels.

**Gaussian Cumulative Distribution from the Error Function**

Rational approximations can be used to compute many special functions. This transform demonstrates a polynomial approximation for the error function. The error function is then used to generate the Gaussian cumulative distribution function. The absolute maximum error for the error function approximation is less than 2.5 x 10⁻⁵ (M. Abramowitz and I.A. Stegun, Handbook of Mathematical Functions, p. 299).

To calculate and graph the Gaussian cumulative distribution for given X values, you can either use the provided sample data and graph or begin a new notebook, enter your own data and create your own graph using the data.

To use the sample worksheet and graph, open the Gaussian worksheet and graph by double-clicking the graph page icon in the Gaussian section of the Transform Examples notebook. Data appears in column 1 of the worksheet and two empty graphs appear on the graph page.
To use your own data, place the X data in column 1. If your data has been placed in another column, you can specify the column after you open the GAUSDIST.XFM transform file.

Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the GAUSDIST.XFM transform file in the XFMS directory. The Gaussian Cumulative transform appears in the edit window.

Click Run. The results are placed in column 2, or in the column specified by the res variable.

If you opened the sample Gaussian graph, view the graph page. A Line Plot appears with a spline curve in the first graph with column 1 as the X data versus column 2 as the distribution (Y) data.

To create your own graph using SigmaPlot, make a Line Plot graph with a Simple Spline Curve. The spline curve plots column 1 as the X data versus column 2 as the distribution (Y) data.

**Gaussian Cumulative Distribution on a Probability Scale**

The probability scale is the inverse of the Gaussian cumulative distribution function. When a Gaussian cumulative distribution function is graphed using the probability scale, the result is a straight line.

If you opened the sample Gaussian graph, view the graph page. A straight line plot appears in the second graph plotting the distribution data in column 3 along a probability scale.

To create your own graph using SigmaPlot, create a Line Plot with a Simple Straight Line using column 1 as your X data and column 3 as your Y data, and set the Y axis scale to Probability.
Histogram with Gaussian Distribution

This transform calculates histogram data for a normally distributed sample, then uses the sample mean and standard deviation of the histogram to compute and graph a Gaussian distribution for the histogram data.

The Histogram Gaussian transform uses examples of the following functions:

- gaussian
- histogram
- size
- [...] (array reference)

To calculate and graph a histogram and Gaussian curve for a normally distributed sample, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data.

To use the sample worksheet and graph:

- Open the Histogram Gaussian worksheet and graph by double-clicking the graph page icon in the Histogram Gaussian section of the Transform Examples notebook.
The Histogram worksheet with data in column 1 and an empty graph page appears. The data in the Histogram Gaussian worksheet was generated using the transform:

\[ \text{col(1) = gaussian(100,0,325,2)} \]

**To use your own data:**

- Place the sample in column 1 of the worksheet. If your data has been placed in another column, you can specify this column after you open the HISTGAUS.XFM transform file. You can enter the data into an existing or new worksheet.

- Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the HISTGAUS.XFM transform file in the XFMS directory. The Histogram with Gaussian Distribution transform appears in the edit window.

- Click Run. The results are placed in columns 2 through 5 of the worksheet, or in the columns specified by the res variable.

- If you opened the Histogram Gaussian graph, view the graph page. A histogram appears using column 2 as X data versus column 3 as the Y data. The curve plots the Gaussian distribution using column 4 as X data versus column 5 as the Y data.

- To create your own graph using SigmaPlot, create a simple vertical bar chart and set the bar widths as wide as possible. Add the Gaussian curve to the graph by creating another plot using the data in column 4 as the X data and the data in column 5 as the Y data.
Linear Regression with Confidence and Prediction Intervals

This transform computes the linear regression and upper and lower confidence and prediction limits for X and Y columns of equal length. A rational polynomial approximation is used to compute the t values used for these confidence limits.

The figure below displays the sample Linear Regression graph with the results of the LINREGR.XFM transform plotted.

The LINREGR.XFM transform contains examples of these two functions:

- min
- max

To calculate and graph a linear regression and confidence and prediction limits for XY data points, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data.

To use the provided sample data and graph, open the Linear Regression worksheet and graph by double-clicking the graph page icon in the Linear Regression section of the Transform Examples notebook. The worksheet appears with data in columns 1 and 2. The graph page appears with a scatter graph plotting the original data in columns 1 and 2.
To use your own data, place the X data in column 1 and the Y data in column 2. If your data has been placed in other columns, you can specify these columns after you open the LINREGR.XFM transform file. You can enter data into an existing or a new worksheet.

Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the LINREGR.XFM transform in the XFMS directory. The Linear Regression transform appears in the edit window. If necessary, change the x_col, y_col, and res variables to the correct column numbers (this is not necessary for the example Linear Regression worksheet data).

Change the Z variable to reflect the desired confidence level (this is not necessary for the example Linear Regression worksheet data).

Click Run. The results are placed in columns 3 through 8, or in the columns specified by the res variable.

If you opened the Linear Regression graph, view the graph page. The original data in columns 1 and 2 is plotted as a scatter plot. The regression is plotted as a solid line plot using column 3 as the X data versus column 4 as the Y data, the confidence limits are plotted as dashed lines using column 3 as a single X column versus columns 7 and 8 as many Y columns, and the prediction limits are plotted as dotted lines using column 3 as a single X column versus columns 7 and 8 as many Y columns.

To create your own graph in SigmaPlot, create a Scatter Plot with a Simple Regression, plotting column 1 against column 2 as the symbols and using column 3 plotted against column 4 as the regression. Add confidence and prediction intervals using column 3 as the X column and columns 7 and 8 as the Y columns.
Low Pass Filter

This transform is a smoothing filter which produces a data sequence with reduced high frequency components. The resulting data can be graphed using the original X data.

To calculate and graph a data sequence with reduced high frequency components, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data.

- To use the provided sample data and graph, double-click the Low Pass Filter graph page icon in the Low Pass Filter section of the Transform Examples notebook. The worksheet appears with data in columns 1 and 2. The graph page appears with two graphs. The first is a line graph plotting the raw data in columns 1 and 2. The second graph is empty.

- To use your own data, place your Y data (amplitude) in column 2 of the worksheet, and the X data (time) in column 1. If your data is in other columns, you can specify these columns after you open the LOWPFILT.XFM file. You can enter your data in an existing or new worksheet.
Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the LOWPFILT.XFM transform file in the XFMS directory. The Low Pass Filter transform appears in the edit window.

Set the sampling interval \( dt \) (the time interval between data points) and the half power point \( f_c \) values. The half power point is the frequency at which the squared magnitude of the frequency response is reduced by half of its magnitude at zero frequency.

If necessary, change the cy1 source column value and cy2 filtered data results to the correct column numbers.

Click Run to run the transform. Filtered data appears in column 3 in the worksheet, or in the worksheet column you specified in the transform.

If you opened the Low Pass Filter graph, view the graph page. The second graph appears as a line graph plotting the smoothed data in columns 1 and 3.

To create your own graphs in SigmaPlot, create the first graph as a Line Plot with a Simple Spline Curve using the raw data in columns 1 and 2 as the X and Y data. Make the second Line Plot graph with a Simple Spline Curve using the data in column1 as the X data and the smoothed data in column 3 as the Y data.

Figure 15-12
Low Pass Filter Graph Plotting Raw Data and Filtered Data
Transform Examples

Lowess Smoothing

Smoothing is used to elicit trends from noisy data. Lowess smoothing produces smooth curves under a variety of conditions. "Lowess" means locally weighted regression. Each point along the smooth curve is obtained from a regression of data points close to the curve point with the closest points more heavily weighted.

The y value of the data point is replaced by the y value on the regression line. The amount of smoothing, which affects the number of points in the regression, is specified by the user with the parameter f. This parameter is the fraction of the total number of points that is used in each regression. If there are 50 points along the smooth curve with \( f = 0.2 \), then 50 weighted regressions are performed and each regression is performed using 10 points.

An example of the use of lowess smoothing for the U.S. wheat production from 1872 to 1958 is shown in the figures below. The smoothing parameter f was chosen to be 0.2 since this produced a good tradeoff between noisy undersmoothing and oversmoothing which misses some of the peak-and-valley details in the data.

- To use the provided sample data and graph, open the Lowess Smoothing worksheet and graph in the Lowess Smoothing section of the Transform Examples notebook. The worksheet appears with data in columns 1, 2, and 3.
- To use your own data, enter the XY data for your curve in columns 1 and 2, respectively. If your data has been placed in other columns, you can specify these columns after you open the LOWESS.XFM transform file. Enter data into an existing or a new worksheet.
- Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the LOWESS.XFM transform file in the Transforms directory. The Lowess transform appears in the edit window.
- Click Run. The results are placed in column 3 of the worksheet, or in the column specified by the output variable.
- If you opened the Lowess Smoothing graph, view the graph page. The smoothed curve is plotted on the second graph and both the original and smoothed data are plotted on the third.
Figure 15-13
U.S. Wheat data and the lowess smoothed curve \( f = 0.2 \). Notice the definite decreased production during World War II.

If you want to plot your own results, create a line plot of column 1 versus column 3.

**Normalized Histogram**

This simple transform creates a histogram normalized to unit area. The resulting data can be graphed as a bar chart. Histogram bar locations are shifted to be placed over the histogram box locations. The resulting bar chart is an approximation to a probability density function.

To calculate and graph a normalized histogram sample, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data.

- To use the provided sample data and graph, open the Normalized Histogram worksheet and graph in the Normalized Histogram and Graph section of the Transform Examples
notebook. The worksheet appears with data in column 1. The data is made up of exponentially distributed random numbers generated with the transform:

\[ x = \text{random}(200, 1, 1.e-10, 1) \text{ col}(1) = -\ln(x) \]

The graph page appears with an empty graph.

To use your own data, place your data in column 1 of the worksheet. If your data has been placed in another column, you can specify this column after you open the NORMHIST.XFM transform file. You can enter data into an existing or new worksheet.

Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the NORMHIST.XFM transform file in the XFMS directory. The Normalized Histogram transform appears in the edit window.

Click Run. The results are placed in columns 2 and 3 of the worksheet, or in the columns specified by the res variable.

If you opened the Normalized Histogram graph, view the graph page. A histogram appears using column 2 as X data versus column 3 as the Y data.

To create your own graph in SigmaPlot, create a Vertical Bar chart with simple bars, then set the bar widths as wide as possible.
This transform example creates a smooth color transition corresponding to the changes across a range of values. The transform places color cells in a worksheet column that change from a specified start color to a specified end color, each color cell incrementing an equivalent shade for each data value in the range. This transform example shows how the color transform can be set to display a "cool" (blue) color that corresponds to small residuals, and a "hot" (red) color that corresponds to large residuals resulting from a nonlinear regression. Since residuals vary positively and negatively about zero, the absolute values for the residuals are used in the transform.

Note: It is unnecessary to sort the data before executing the smooth color transition transform.

To calculate and graph the smooth color transition of a set of data, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data.

To use the sample worksheet and graph, open the Smooth Color Transition worksheet and graph by double-clicking the graph page icon in the Smooth Color Transition section of the Transform Examples notebook. Data appears in columns 1 and 2 of the worksheet, and a scatter graph appears on the graph page.
To use your own data, place your data in columns 1 and 2. For the residuals example, column 2 is the absolute value of the residuals in column 1. To obtain absolute values of your data, use the abs transform function. For example, to obtain the absolute values of the data set in column 1, type the following transform in the User-Defined Transform dialog box:

\[ \text{col(2)} = \text{abs}(\text{col(1)}) \]

If your data is in a different column, specify the new column after you open the RGBCOLOR.XFM transform file.

If your data is in a different column, specify the new column after you open the RGBCOLOR.XFM transform file.

Click Run. The results are placed starting one column over from the original data, or in the column you specified in the transform.

If you opened the sample Smooth Color Transition graph, view the graph page. A Scatter Plot appears plotting column 2 as a Simple Scatter plot style using Single Y data format. The symbol colors are obtained by specifying column 3 in the Symbols, Fill Color drop-down list in the Plots panel of the Graph Properties dialog box. The Smooth Color Transition transform applies gradually changing colors to each of the data points. The smaller residual values are colored blue, which gradually changes to red for the larger residuals.

To create your own graph using SigmaPlot, make a Scatter Plot graph with a Scatter Plot with Simple Scatter style. Plot the data as Single Y data format. Use the color cells produced by the transform by selecting the corresponding worksheet column from the Symbol Fill Color drop-down list.
Survival (Kaplan-Meier) Curves with Censored Data

This transform creates Kaplan-Meier survival curves with or without censored data. The survival curve may be graphed alone or with the data.

To use the transform, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data.

1. To use the sample worksheet and graph, double-click the graph page icon in the Survival section of the Transforms Examples notebook. The Survival worksheet appears with data in columns 1 and 2. The graph page appears with an empty graph. If you open the sample worksheet and graph, skip to step 7.

2. To use your own data, enter survival times in column 1 of the worksheet. Ties (identical survival times) are allowed. You can enter data into an existing or a new worksheet.

3. Enter the censoring identifier in column 2. This identifier should be 1 if the corresponding data point in column 1 is a true response, and 0 if the data is censored.

4. If desired, save the unsorted data by copying the data to two other columns.

5. Select columns 1 and 2, then choose the Transforms menu Sort Selection command. Specify the key column in the Sort Selection dialog box as column 1, and the sort order option as Ascending.

6. Check for any ties between true response and censored data. If any exist, make sure that within the tied data, the censored data follows the true response data.

7. Click Run to run the file. The sorted time, cumulative survival probability, and the standard error are placed in columns res, res+1, and res+2, respectively. For graphical purposes a zero, one, and zero have been placed in the first rows of the sorted time, cumulative survival curve probability and standard error columns.

8. If you opened the sample Survival graph, view the page. The Simple Horizontal Step Plot graphs the survival curve data from columns res as the X data versus column res+1 as the Y data and a Scatter Plot graphs the data from the same columns. The first data point of the Scatter Plot at (0, 1) is not displayed by selecting rows 2 to end in the Portions of Columns Plotted area of the Data section in the Plots tab of the Graph.
Properties dialog box. As shown in the figure below, a tied censored data point has been incorrectly placed; it should follow uncensored data.

To graph a survival curve using SigmaPlot, create a Line graph with a Simple Horizontal Step Plot graphing column res as the X data versus column res+1 as the Y data. If desired, create an additional Scatter plot, superimposing the survival data using the same columns for X data and Y data. To turn off the symbol drawn at x = 0 and y = 1, select Plot 2 and set Only rows = 2 to end by 1 in the Plots tab and Data sections of the Graph Properties dialog box.

Figure 15-15
The Survival Graph

Survival Curve Example with Censored Data
User-Defined Axis Scale

The USERAXIS.XFM transform is a specific example how to transform data to fit the user-defined axis scale.

This transform:

- Transforms the data using the new axis scale
- Creates Y interval data for the new scale

To use this transform to graph data along a \((\log(\log(100/Y)))\) Y axis, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data.

- To use the sample worksheet and graph, double-click the graph page icon in the User Defined Axis Scale section of the Transforms Examples notebook. The User Defined Axis Scale worksheet appears with data in columns 1 through 3. The graph page appears with an empty graph with gridlines.

- To use your own data, place your original X data in column 1, Y data in column 2, and the Y axis tick interval values in column 3. If your data has been placed in other columns, you can specify these columns after you open the USERAXIS.XFM file.

- Press F10 to open the User-Defined Transform dialog box, then open the USERAXIS.XFM transform. If necessary, change the y_col, tick_col, and res variables to the correct column numbers.

- Click Run. The results are placed in columns 4 and 5, or the columns specified by the res variable.

- If you opened the User Defined Axis Scale graph, view the page. The graph is already set up to plot the data and grid lines.

- To plot the transformed Y data using SigmaPlot, plot column 1 as the X values versus column 4 as the Y values.

  To plot the Y axis tick marks, open the Ticks panel under the Axes tab of the Graph Properties dialog box. Select Column 5 from the Major Tick Intervals drop-down list.
To draw the tick labels, use the Y tick interval data as the tick label source by selecting Column 3 from the Tick Label Type drop-down list in the Tick Labels panel under the Axes tab of the Graph Properties dialog box.

Figure 15-16  
User-Defined Axis Scale Graph

![Graph Image]

**Vector Plot**

The VECTOR.XFM transform creates a field of vectors (lines with arrow heads) from data which specifies the X and Y position, length, and angle of each vector. The data is entered into four columns. Executing the transform produces six columns of three XY pairs, which describe the arrow body and the upper and lower components of the arrow head.

Other settings are:

- The length of the arrow head.
- The angle in degrees between the arrow head and the arrow body.
- The length of the vector (if you want to specify it as a constant).

To generate a vector plot, you can either use the provided sample data and graph or begin a new notebook, enter your own data, and create your own graph using the data.
To use the sample worksheet and graph, double-click the graph page icon in the Vector section of the Transform Examples notebook. The Vector worksheet appears with data in columns 1 through 4. The graph page appears with an empty graph.

To use your own data, enter the vector information into the worksheet. Data must be entered in four column format, with the XY position of the vector starting in the first column, the length of the vectors (which correspond to the axis units), and the angle of the vector, in degrees. The default starting column for this block is column one.

Press F10 to open the User-Defined Transforms dialog box, then click the Open button to open the VECTOR.XFM file in the XFMS directory.

If necessary, change the starting worksheet column for your vector data block xc.

If desired, change the default arrowhead length L (in axis units) and the Angle used by the arrowhead lines. This is the angle between the main line and each arrowhead line.

If you want to use vectors of constant length, set the l value to the desired length, then uncomment the remaining two lines under the Constant Vector Length heading.

Make sure that Radians are selected as the Trigonometric Units (they should be by default.

Click Run to run the transform. The transform produces six columns of three XY pairs, which describe the arrow body and the upper and lower components of the arrow head.

If you opened the Vector graph, view the page. The Line Plot with Multiple Straight Line appears plotting columns 5 through 10 as XY pairs.

To plot the vector data using SigmaPlot, create a Line Plot with Multiple Straight Line graph that plots columns 5 through 10 as three vector XY column pairs.
The ZPLANE.XFM transform is a specific example of the use of transforms to generate data for a unit circle and curves of constant damping ratio and natural frequency.

The root locus technique analyzes performance of a digital controller in the z plane using the unit circle as the stability boundary and the curves of constant damping ratio and frequency for a second order system to evaluate controller performance.

Root locus data is loaded from an external source and plotted in Cartesian coordinates along with the design curves in order to determine performance.

Refer to *Digital Control of Dynamic Systems*, Gene. F. Franklin and J. David Powell, Addison-Wesley, pp. 32 and 104 for the equations and graph.

To calculate the data for the design curves, you can either use the provided sample data and graph, or begin a new notebook, enter your own data, and create your own graph using the data.

To use the sample worksheet and graph, double-click the graph page icon in the Z Plane section of the Transform Examples notebook. The Z Plane worksheet appears with data in columns 1 through 10. The Z Plane graph page appears with the design curve data plotted over some sample root locus data. This plot uses columns 1 and 2 as the first curve and columns 3 and 4 as the second curve.
To use your own data, place your root locus, zero, and pole data in columns 1 through 10. If your locus data has been placed in other columns, you can change the location of the results columns after you open the ZPLANE.XFM file.

To plot the design curves of your data, create a Line Plot with Multiple Spline Curves, then plot column 1 as the X data against column 2 as the Y data for the first curve and column 3 as the X data against column 4 as the Y data as the second curve.

Press F10 to open the User-Defined Transform dialog box, then click the Open button, and open the ZPLANE.XFM transform in the XFMS directory. If necessary, change the res variable to the correct column number.

Click Run. The results are placed in columns 11 through 20, or the columns specified by the res variable.

If you opened the Z Plane graph, view the page. The circle, frequency trajectory, and damping trajectory data is automatically plotted with the design data.

To plot the circle data using SigmaPlot, create Multiple Line Plots with Simple Spline Curves. For the first plot use column 11 as the X values versus column 12 as the Y values.

To plot the frequency trajectory data (zeta) plot column 13 versus column 14 and column 15 versus column 16 as the XY pairs.

To plot the damping trajectory data (omega) plot column 17 versus column 18 and column 19 versus column 20 as the XY pairs.
Figure 15-18
Z Plane Graph

Root Locus for Compensated Antenna Design
What is Regression?

Regression is most often used by scientists and engineers to visualize and plot the curve that best describes the shape and behavior of their data.

Regression procedures find an association between independent and dependent variables that, when graphed on a Cartesian coordinate system, produces a straight line, plane or curve. This is also commonly known as curve fitting.

The independent variables are the known, or predictor, variables. These are most often your X-axis values. When the independent variables are varied, they result in corresponding values for the dependent, or response, variables, most often assigned to the Y-axis.

Regression finds the equation that most closely describes, or fits, the actual data, using the values of one or more independent variables to predict the value of a dependent variable. The resulting equation can then be plotted over the original data to produce a curve that fits the data.

About the Regression Wizard

SigmaPlot uses the Regression Wizard to perform regression and curve fitting. The Regression Wizard provides a step-by-step guide through the procedures that let you fit a known function to your data and then automatically plot the best-fit curve and produce statistical results.

The Regression Wizard simplifies curve fitting. There is no need to be familiar with programming or higher mathematics. The large library of built-in equations are graphically presented and organized by different categories, making selection of your models straightforward. Built-in shortcuts let you bypass all but the simplest
procedures; fitting a curve to your data can be as simple as picking the equation to use, then clicking a button.

Note: For more complicated curve fitting, try using the Dynamic Fit Wizard. For more information, see “Dynamic Curve Fitting” on page 691.

Use the Regression Wizard to:

- **Select the function describing the shape of your data.** SigmaPlot provides over 100 built-in equations. You can also create your own custom regression equations. For more information, see “Regression Equation Library” in Appendix C.

- **Select the variables to fit to the function.** You can select your variables from either a graph or a worksheet.

- **Evaluate and save your results.** You can automatically plot the resulting curves on a graph, and save statistical results to the worksheet and text reports.

The Regression Wizard is also compatible with older .FIT files. For more information, see “Opening .FIT Files” on page 632.

**Figure 16-1**

*Selecting an Equation from the Regression Wizard*
About SigmaPlot’s Curve Fitter

The SigmaPlot curve fitter works by varying the parameters (coefficients) of an equation, and finds the parameters which cause the equation to most closely fit your data. Both the equation and initial parameter values must be provided. All built-in equations have the curve equation and initial parameters predefined.

The curve fitter accepts up to 25 equation parameters and ten independent equation variables. You can also specify up to 25 parameter constraints, which limit the search area of the curve fitter when checking for parameter values.

The regression curve fitter can also use weighted least squares for greater accuracy.

Curve-fitting Algorithm

The SigmaPlot curve fitter uses the Marquardt-Levenberg algorithm to find the coefficients (parameters) of the independent variable(s) that give the best fit between the equation and the data.

This algorithm seeks the values of the parameters that minimize the sum of the squared differences between the values of the observed and predicted values of the dependent variable

\[ SS = \sum_{i=1}^{n} w_i \left( y_i - \hat{y}_2 \right)^2 \]

where \( y_i \) is the observed and \( \hat{y}_2 \)

is the predicted value of the dependent variable.

This process is iterative—the curve fitter begins with a guess at the parameters, checks to see how well the equation fits, then continues to make better guesses until the differences between the residual sum of squares no longer decreases significantly. This condition is known as convergence.

For more information, see “References for the Marquardt-Levenberg Algorithm” below.
References for the Marquardt-Levenberg Algorithm


Opening .FIT Files

Use the File menu Open command to open old curve fit (.FIT) files, selecting SigmaPlot Curve Fit as the file type. .FIT files are opened as a single equation in a notebook.

You can also open .FIT files from the Library panel of both the Regression Wizard and the Dynamic Fit Wizard. For more information, see “Dynamic Curve Fitting” on page 691.

Adding .FIT Files to a Library or Notebook

Add these equations to other notebooks by copying and pasting. To add them to your regression library, open the library notebook (Standard.jfl for SigmaPlot’s built-in library), then copy the equation and paste it into the desired section of the library notebook. For more information, see “About SigmaPlot’s User and Program Files” on page 8.

You can also create your own library by simply combining all your old .fit files into a single notebook, then setting this notebook to be your default equation library. For more information, see “Using a Different Library for the Regression Wizard” on page 681.
Note: Sections appear as categories in the library, so create a new section to create a new equation category.

.FIT files as well as new equations do not have graphic previews of the equation.

Using the Regression Wizard

Selecting the Data Source

- View the page or worksheet with the data you want to fit.

If you select a graph, right-click the curve you want fitted, and on the shortcut menu, click Fit Curve.

Note: If you are running a regression from the graph page, make sure you select the plot itself, not the graph, or Fit Curve will not appear on the shortcut menu.

If you are using a worksheet, select the variables in the worksheet you want to fit, then from the menus select:
   - Statistics
     - Regression Wizard

The Regression Wizard appears.

Selecting the Equation to Use

- Select an equation from the Equation Category and Equation Name drop-down lists. You can view different equations by selecting different categories and names. The equation’s mathematical expression and shape appear to the left. For more information, see “Regression Equation Library” in Appendix C.
If the equation you want to use isn’t on this list, you can create a new equation. For more information, see “Editing Code” in Chapter 17. You can also browse other notebooks and regression equation libraries for other equations. For more information, see “Regression Equation Library” in Appendix C.

Note: SigmaPlot remembers the equation for the next time you open the Regression Wizard.

If the Finish button is available, you can click it to complete your regression. If it is not available, or if you want to further specify your results, click Next.

**Selecting the Variables to Fit**

- Click Next to open the Variables panel. From here, you can select or re-select your variables. There are three ways to select variables:
  - Selecting a curve on a graph.
  - Selecting a column in a worksheet.
  - Selecting the variable from the Variable Columns drop-down list in the Regression Wizard. The equation picture to the left prompts you for which variable to select.
Using the Regression and Dynamic Fit Wizards

Figure 16-3
Selecting a plot as the data source for the Regression Wizard.

You can also modify other equation settings and options from this panel by clicking Options, which opens the Equations Options dialog box. These options include changing initial parameter estimates, parameter constraints, weighting, and other related settings. For more information, see “Equation Options” on page 650.

If you pick variables from a worksheet column, you can also set the data format. For more information, see “Variable Options” on page 648.

► When you have selected your variables, you can either click Finish, or click Next to view the Initial Results.
**Viewing Fit Results**

The fit results also appear if you receive a warning or error message about your fit.

**Figure 16-4**
The Fit Results for a Regression

![Regression Wizard - Fit Results](image)

For more information, see “Interpreting Fit Results” on page 657.

- If you wish to modify the remainder of the results that are automatically saved, click **Next**. Otherwise, click **Finish**.

The subsequent panels provide options for the output data.

**Setting Numeric Output Options**

Use the Regression Wizard - Numeric Output Options panel to:

- Decide which results are saved to the worksheet.
- Generate a text report of the regression. For more information, see “Setting Nonlinear Regression Report Options” on page 640.
- Save a copy of the regression equation to the notebook.
Select which results you want to keep from the Results list. These settings are remembered between regression sessions.

To set the options for the report, click Report. For more information, see “Setting Nonlinear Regression Report Options” on page 640.

Click Next to set the graph options.

**Setting Graph Options**

This panel is only available if your fit equation has at most two independent variables.

If you selected your variables from a graph, select Add curve to to automatically add the equation curve to that graph. You can also plot the equation on any other graph on that page by selecting one from the drop-down list.

Select Create new graph to create a new graph of the original data and fitted curve.
Figure 16-6
Selecting the results to graph. These settings are retained between sessions.

- **Select Add to graph** to create a plot of the regression equation for the graph specified by the drop-down list. This option on appears if you ran the regression using a graph curve as a data source.

- **Select Confidence and prediction bands** to display confidence and prediction bands on the graph. For more information, see “Confidence and Prediction Bands” on page 664.
  
  *Note:* This option only appears if you select either **Create new graph** or **Add to graph**.

- **Select Extend fit to axes** to extend the equation curve to intersect the Y-axis.

- **Select Add equation to graph title** to insert the equation of the curve fit under the title of the graph.

- After selecting the graphed results you want, click **Finish**.
  
  Click **Next** only if you want to select the specific columns used to contain the data for the fitted curve.
Selecting Columns for Graph Data

► To select the specific columns to use for the plotted results, click the columns in the worksheet where you want the results to always appear.

Tip: Remember, these settings are reused each time you perform a regression and overwrite data if it exists in these columns in subsequent worksheets. To avoid overwriting data, use First Empty to place the fitted curve results in empty columns.

► Click Finish.

Figure 16-7
Selecting the graph results columns. These settings are retained between sessions.

Finishing the Regression

After clicking Finish, all your results are displayed in the worksheet, report, and graph. The initial defaults are to save parameter and computed dependent variable values to the worksheet, to create a statistical report, and to graph the results.

► To change the results that are saved, click Next to go through the entire wizard, changing your settings as desired.
**Setting Nonlinear Regression Report Options**

Use the Report Options for Nonlinear Regression dialog box to:

- **Set assumption checking options.** For more information, see “Assumption Checking” on page 640.
- **Specify the residuals to display and save them to the worksheet.** For more information, see “Residuals” on page 642.
- **Display confidence and prediction intervals and save them to the worksheet.** For more information, see “More Statistics” on page 644.
- **Display the PRESS Prediction Factor.** For more information, see “More Statistics” on page 644.
- **Specify tests to identify outlying or influential data points.** For more information, see “Other Diagnostics” on page 645.
- **Display power.** For more information, see “Other Diagnostics” on page 645.

*Note:* To open the Report Options for Nonlinear Regression dialog box, click Report on the Regression Wizard - Numeric Output Options panel. For more information, see “Setting Numeric Output Options” on page 636.

**Assumption Checking**

Select the Assumption Checking tab from the Report Options for Nonlinear Regression to view the Normality, Constant Variance, and Durbin-Watson options. These options test your data for its suitability for regression analysis by checking three assumptions that a linear regression makes about the data. A nonlinear regression assumes:

- That the source population is normally distributed about the regression.
- The variance of the dependent variable in the source population is constant regardless of the value of the independent variable(s).
- That the residuals are independent of each other.

All assumption checking options are selected by default. Only disable these options if you are certain that the data was sampled from normal populations with constant variance and that the residuals are independent of each other.

**Normality Testing.** SigmaPlot uses the Kolmogorov-Smirnov test to test for a normally distributed population.
**Constant Variance Testing.** SigmaPlot tests for constant variance by computing the Spearman rank correlation between the absolute values of the residuals and the observed value of the dependent variable. When this correlation is significant, the constant variance assumption may be violated, and you should consider trying a different model (i.e., one that more closely follows the pattern of the data), or transforming one or more of the independent variables to stabilize the variance. For more information, see “User-Defined Transforms” on page 551.

**P Values for Normality and Constant Variance.** The P value determines the probability of being incorrect in concluding that the data is not normally distributed (P value is the risk of falsely rejecting the null hypothesis that the data is normally distributed). If the P computed by the test is greater than the P set here, the test passes.

To require a stricter adherence to normality and/or constant variance, increase the P value. Because the parametric statistical methods are relatively robust in terms of detecting violations of the assumptions, the suggested value in SigmaPlot is 0.05. Larger values of P (for example, 0.10) require less evidence to conclude that the residuals are not normally distributed or the constant variance assumption is violated.

To relax the requirement of normality and/or constant variance, decrease P. Requiring smaller values of P to reject the normality assumption means that you are willing to accept greater deviations from the theoretical normal distribution before you flag the data as non-normal. For example, a P value of 0.01 for the normality test requires greater deviations from normality to flag the data as non-normal than a value of 0.05.

*Note: Although the assumption tests are robust in detecting data from populations that are non-normal or with non-constant variances, there are extreme conditions of data distribution that these tests cannot detect. However, these conditions should be easily detected by visually examining the data without resorting to the automatic assumption tests.*

**Durbin-Watson Statistic.** SigmaPlot uses the Durbin-Watson statistic to test residuals for their independence of each other. The Durbin-Watson statistic is a measure of serial correlation between the residuals. The residuals are often correlated when the independent variable is time, and the deviation between the observation and the regression line at one time are related to the deviation at the previous time. If the residuals are not correlated, the Durbin-Watson statistic will be 2.

**Difference from 2 Value.** Enter the acceptable deviation from 2.0 that you consider as evidence of a serial correlation in the Difference for 2.0 box. If the computed Durbin-Watson statistic deviates from 2.0 more than the entered value, SigmaPlot warns you
that the residuals may not be independent. The suggested deviation value is 0.50, i.e., Durbin-Watson Statistic values greater than 2.5 or less than 1.5 flag the residuals as correlated.

**To require a stricter adherence to independence**, decrease the acceptable difference from 2.0.

**To relax the requirement of independence**, increase the acceptable difference from 2.0.

### Residuals

Click the Residuals tab in the Report Options for Nonlinear Regression dialog box to view the Predicted Values, Raw, Standardized, Studentized, Studentized Deleted, and Report Flagged Values Only options.

**Studentized Residuals.** Studentized residuals scale the standardized residuals by taking into account the greater precision of the regression line near the middle of the data versus the extremes. The Studentized residuals tend to be distributed according to the Student t distribution, so the t distribution can be used to define "large" values of the Studentized residuals. SigmaPlot automatically flags data points with "large" values of the Studentized residuals, i.e., outlying data points; the suggested data points flagged lie outside the 95% confidence interval for the regression population.

To include studentized residuals in the report, make sure this check box is selected. Click the selected check box if you do not want to include studentized residuals in the worksheet.

**Studentized Deleted Residuals.** Studentized deleted residuals are similar to the Studentized residual, except that the residual values are obtained by computing the regression equation without using the data point in question.

**To include Studentized deleted residuals in the report**, make sure this check box is selected. Click the selected check box if you do not want to include studentized deleted residuals in the worksheet.

SigmaPlot can automatically flag data points with "large" values of the studentized deleted residual, i.e., outlying data points; the suggested data points flagged lie outside the 95% confidence interval for the regression population.

**Note:** Both Studentized and Studentized deleted residuals use the same confidence interval setting to determine outlying points.
Raw Residuals. The raw residuals are the differences between the predicted and observed values of the dependent variables. To include raw residuals in the report, make sure this check box is selected. Click the selected check box if you do not want to include raw residuals in the worksheet.

To assign the raw residuals to a worksheet column, select the number of the desired column from the corresponding drop-down list. If you select none from the drop-down list and the Raw check box is selected, the values appear in the report but are not assigned to the worksheet.

Predicted Values. Use this option to calculate the predicted value of the dependent variable for each observed value of the independent variable(s), then save the results to the worksheet. Click the selected check box if you do not want to include raw residuals in the worksheet.

To assign predicted values to a worksheet column, select the worksheet column you want to save the predicted values to from the corresponding drop-down list. If you select none and the Predicted Values check box is selected, the values appear in the report but are not assigned to the worksheet.

Standardized Residuals. The standardized residual is the residual divided by the standard error of the estimate. The standard error of the residuals is essentially the standard deviation of the residuals, and is a measure of variability around the regression line. To include standardized residuals in the report, make sure this check box is selected. Click the selected check box if you do not want to include raw residuals in the worksheet.

Flag Values >. SigmaPlot automatically flags data points lying outside of the confidence interval specified in the corresponding box. These data points are considered to have "large" standardized residuals, i.e., outlying data points. You can change which data points are flagged by editing the value in the Flag Values > edit box. The suggested residual value is 2.5.

Report Flagged Values Only. To include only the flagged standardized and Studentized deleted residuals in the report, make sure the Report Flagged Values Only check box is selected. Clear this option to include all standardized and Studentized residuals in the report.
More Statistics

Click the More Statistics tab in the Report Options for Nonlinear Regression dialog box to view options for Confidence and Prediction Intervals and PRESS Prediction Error.

Confidence Intervals. You can set the confidence interval for the population, regression, or both and then save them to the worksheet.

- **Prediction Interval.** The confidence interval for the population gives the range of values that define the region that contains the population from which the observations were drawn. To include confidence intervals for the population in the report, make sure the Population check box is selected. Click the selected check box if you do not want to include the confidence intervals for the population in the report.

- **Confidence Interval.** The confidence interval for the regression line gives the range of values that defines the region containing the true mean relationship between the dependent and independent variables, with the specified level of confidence.

To include confidence intervals for the regression in the report, make sure the Regression check box is selected, then specify a confidence level by entering a value in the percentage box. The confidence level can be any value from 1 to 99. The suggested confidence level for all intervals is 95%.

Click the selected check box if you do not want to include the confidence intervals for the population in the report. Click the selected check box if you do not want to include the confidence intervals for the population in the report.

- **Saving Confidence Intervals to the Worksheet.** To save the confidence intervals to the worksheet, select the column number of the first column you want to save the intervals to from the Starting in Column drop-down list. The selected intervals are saved to the worksheet starting with the specified column and continuing with successive columns in the worksheet.

PRESS Prediction Error. The PRESS Prediction Error is a measure of how well the regression equation fits the data. Leave this check box selected to evaluate the fit of the equation using the PRESS statistic. Click the selected check box if you do not want to include the PRESS statistic in the report.
**Other Diagnostics**

Click the Other Diagnostics tab in the Report Options for Nonlinear Regression dialog box to view options Influence, DFFITS, leverage, Cook’s Distance and power.

**Influence.** Influence options automatically detect instances of influential data points. Most influential points are data points which are outliers, that is, they do not do not "line up" with the rest of the data points. These points can have a potentially disproportionately strong influence on the calculation of the regression line. You can use several influence tests to identify and quantify influential points.

- **DFFITS.** DFFITS is the number of estimated standard errors that the predicted value changes for the ith data point when it is removed from the data set. It is another measure of the influence of a data point on the prediction used to compute the regression coefficients.

Predicted values that change by more than two standard errors when the data point is removed are considered to be influential.

Select DFFITS to compute this value for all points and flag influential points, i.e. those with DFFITS greater than the value specified in the Flag Values > edit box. The suggested value is 2.0 standard errors, which indicates that the point has a strong influence on the data. To avoid flagging more influential points, increase this value; to flag less influential points, decrease this value.

- **Leverage.** Leverage is used to identify the potential influence of a point on the results of the regression equation. Leverage depends only on the value of the independent variable(s). Observations with high leverage tend to be at the extremes of the independent variables, where small changes in the independent variables can have large effects on the predicted values of the dependent variable.

Select Leverage to compute the leverage for each point and automatically flag potentially influential points, i.e., those points that could have leverages greater than the specified value times the expected leverage. The suggested value is 2.0 times the expected leverage for the regression. To avoid flagging more potentially influential points, increase this value; to flag points with less potential influence, lower this value.

- **Cook’s Distance.** Cook’s distance is a measure of how great an effect each point has on the estimates of the parameters in the regression equation. Cook’s distance assesses how much the values of the regression coefficients change if a point is deleted from the analysis. Cook’s distance depends on both the values of the independent and dependent variables.
Select Cook’s Distance to compute this value for all points and flag influential points, i.e., those with a Cook’s distance greater than the specified value. The suggested value is 4.0. Cook’s distances above 1 indicate that a point is possibly influential. Cook’s distances exceeding 4 indicate that the point has a major effect on the values of the parameter estimates. To avoid flagging more influential points, increase this value; to flag less influential points, lower this value.

Power. The power of a regression is the power to detect the observed relationship in the data. The alpha is the acceptable probability of incorrectly concluding there is a relationship.

Select Power to compute the power for the linear regression data. Change the alpha value by editing the number in the Alpha Value edit box. The suggested value is $\alpha = 0.05$. This indicates that a one in twenty chance of error is acceptable, or that you are willing to conclude there is a significant relationship when $P < 0.05$.

Report Flagged Values Only. To only include only the influential points flagged by the influential point tests in the report, select Report Flagged Values Only. Clear this option to include all influential points in the report.

Running a Regression From a Notebook

Because regression equations can be treated like any other notebook item, you can select and open regression equations directly from a notebook. This is particularly convenient if you have created or stored equations along with the rest of your graphs and data.

- In the Notebook Manager, view the notebook with the equation you want to use, and double-click the equation. The Regression Wizard appears with the equation selected.

- Select the variables as prompted by clicking a curve or worksheet columns. Note that at this point you can open and view any notebook, worksheet or page you would like, and pick your variables from that source.

- Click Finish to complete the regression, or click Next if you want to view initial results or change your results options.
Creating New Regression Equations

You can create new equations by using the Function dialog box. Here you can set the equations, variables, initial parameters, constraints and other options. You can create new regression equations two different ways:

- On either the Regression Wizard or the Dynamic Fit Wizard, click New or Edit Code, or
- Right-click in a notebook section, and on the shortcut menu, click Equation.

When you create a new equation, the Function dialog box appears with blank headings. For more information, see “Editing Code” in Chapter 17.

Viewing and Editing Code

To view the code for the current equation document, click Edit Code in the Regression Wizard or Dynamic Fit Wizard. For more information, see “Editing Code” in Chapter 17.

You can click the Edit Code button from the equation or variables panels. The Edit Code button opens the Function dialog box. All settings for the equation are displayed.

Figure 16-8
Viewing the code for a built-in equation in the Function dialog box.
Note: You cannot edit the Equations, Parameters, and Variables for built-in SigmaPlot equations; however, you can edit and save built-in equations as new equations. Click Add As, add the equation to the desired section, and then edit the Equations, Variables and Parameters as desired.

You can also copy and paste equations from notebook to notebook like any other notebook item. You can also edit pasted built-in equations. For more information, see “Editing Code” in Chapter 17.

Saving Regression Equation Changes

When you edit an equation using the Equation Options or Function dialog boxes, or when you add an equation, all changes are updated to the equation in the library or notebook. However, just like other notebook items, these changes are not saved to the file until the notebook is saved. Changes made to regression libraries are automatically saved when you close the Regression or Dynamic Fit Wizard.

You can also save changes to regression libraries using the Save or Save As buttons in the Regression Wizard. This saves the current regression library notebook to disk. Save As allows you to save the regression library to a new file.

If you have a regression library open as a notebook, you can also save changes by saving the notebook. To save the notebook, on the File menu, click Save or Save As.

Variable Options

Data Format Options. If you use data columns from the worksheet, you can specify the data format to use in the variables panel of the Regression Wizard. By default, the data format when assigning columns from the worksheet is XY Pair.
The data format options are:

- **XY pair.** Select an x and a y variable.
- **Y only.** Select only a y variable column.
- **XY column means.** Pick one x column, then multiple y columns; the y columns will be graphed as means.
- **Y column means only.** Pick multiple y columns; the columns will be graphed as means.
- **From Code.** Uses the current settings as shown when editing code.
- **XY Replicate.** Select X and multiple Y columns. Rows of the Y columns are replicate measurements.
- **Y Replicates.** Select multiple Y columns. Rows of the Y column are replicate measurements.

When you use an existing graph as your data source, the Regression Wizard displays a format reflecting the data format of the graph. You cannot change this format unless you switch to using the worksheet as your data source, or run the regression directly from editing the code.
Multiple Independent Variables

Although the Standard Regression Library only supports up to two independent variables, the curve fitter can accept up to ten. To use models that have more than two independent variables, simply create or open a model with the desired equation and variables. The Regression Wizard prompts to select columns for each defined variable.

Equation Options

If the curve fitter fails to find a good fit for the curve, you can try changing the equation options to see if you can improve the fit. To set options for a regression, click the Options button in the Variables panel of the Regression Wizard or the Dynamic Fit Wizard. The Equation Options dialog box appears.

Note: If you want to edit the settings in the equation document manually, click the Edit Code button. For more information, see “Editing Code” in Chapter 17.

Use the Equation Options dialog box to:

- Change initial parameter values.
- Add or change constraints.
- Change constant values.
- Use weighted fitting, if it is available.
- Change convergence options.

Parameters

The default setting for the initial parameter value is shown Automatic. The Automatic setting available with the built-in SigmaPlot equations uses algorithms that analyze your data to predict initial parameter estimates. These do not work in all cases, so you may need to enter a different value. Just click the parameter you want to change, and make the change in the edit box.

The values that appear in the Initial Parameters drop-down list were previously entered as parameter values. Any parameter values you enter will also be retained between sessions.
Parameters can be either a numeric value or a function. The value of the parameter should approximate the final result, in order to help the curve fitter reach a valid result, but this depends on the complexity and number of parameters of the equation. Often an initial parameter nowhere near the final result will still work. However, a good initial estimate helps guarantee better and faster results.

**Constraints**

Use *constraints* to set limits and conditions for parameter values, restricting the regression search range and improving curve fitter speed and accuracy. Constraints are often unnecessary, but should always be used whenever appropriate for your model.

Constraints are also useful to prevent the curve fitter from testing unrealistic parameter values. For example, if you know that a parameter should always be negative, you can enter a constraint defining the parameter to be always less than 0.

You can also use constraints if the regression produces parameter values that you know are inaccurate. Simply click **Back** from the initial results panel, click the **Options** button, and enter constraint(s) that prevent the wrong parameter results.

Note that a parameter equals a constraint value at the completion of the fit, the constraint is called *active*. You can view these constraints from the initial results panel by clicking **View Constraints**. For more information, see “Checking Use of Constraints” on page 660.
Entering Parameter Constraints

To enter constraints, click the Constraints edit box, and type the desired constraint(s), using the transform language operators.

A constraint must be a linear equation of the equation parameters, using an equal (=) or inequality (< or >) sign. For example, you could enter the following constraints for the parameters \( a, b, c, d, \) and \( e \):

\[
\begin{align*}
  a &< 1 \\
  10b + c/20 &> 2 \\
  d - e & = 15 \\
  a &> b + c + d + e
\end{align*}
\]

However, the constraint

\[ a*x < 1 \]

is illegal, since \( x \) is a variable, not a parameter, and the constraints

\[
\begin{align*}
  b + c^2 &> 4 \\
  d*e & = 1
\end{align*}
\]

are illegal because they are nonlinear. Inconsistent and conflicting constraints are automatically rejected by the curve fitter.

Figure 16-11
Entering parameter constraints
Defining Constants

Constants that appear in the Constants edit window have been previously defined as a constant, rather than a parameter to be determined by the regression. To edit a constant value, or define new constant values, click Edit Code on the Regression Wizard or Dynamic Fit Wizard dialog box.

Constants are defined when an equation is created. Currently, you can only define new constants by editing the regression equation code. However, you can redefine any existing constants.

Change only the value of the constant. Do not add new constant values; constant variables must exist in the equation and not be defined already under variables or parameters, so they can only be defined within the code of an equation.

Fit with Weight

You can select from any of the weights listed. Some built-in equations have some predefined values, although most do not. If no weighting options are available for your equation, only the None option will be available.

Weighting options appear in the Fit with Weight drop-down list. By default, the weighting applied to the fit is (none). To apply a different weighting setting, select a weighting option from the drop-down list.

Figure 16-12
Selecting a Predefined Weight Variable

Weight variables must be defined by editing the regression code.
**Iterations**

The **Iterations** option sets the maximum number of repeated fit attempts before failure. Each iteration of the curve fitter is an attempt to find the parameters that best fit the model. With each iteration, the curve fitter varies the parameter values incrementally, and tests the fit of that model to your data. When the improvement in the fit from one iteration to the next is smaller than the setting determined by the Tolerance option, the curve fitter stops and displays the results.

![Figure 16-13](image)

*Changing iterations*

Change the number of iterations to speed up or improve the regression process, especially if a complex fit requires more than the default of 100 iterations. You can also reduce the number of iterations if you want to end a fit to check on its interim progress before it takes too many iterations.

Setting **Iterations** to 0 will simply evaluate the dependent variable of the fit equation using the initial parameter values.

To change the maximum number of iterations, enter the number of iterations to use, or select a previously used number of iterations from the drop down list.

When the maximum number of iterations is reached, the regression stops and the current results are displayed in the initial parameters panel. If you want to continue with more iterations, you can click **More Iterations** on the Regression Wizard.
**Step Size**

*Step size*, or the limit of the initial change in parameter values used by the curve fitter as it tries, or iterates, different parameter values, is a setting that can be changed to speed up or improve the regression process.

Figure 16-14

*Changing Step Size*

A large step size can cause the curve fitter to wander too far away from the best parameter values, whereas a step size that is too small will result in slow convergence to the best parameters.

For most functions, the default step size value is 1. To change the *Step Size* value, type the desired step size in the *Step Size* edit box, or select a previously defined value from the drop-down list.

**Tolerance**

The *Tolerance* option controls the condition that must be met in order to end the regression process. When the absolute value of the difference between the sum of squares of the residuals (square root of the sum of squares of the residuals), from one iteration to the next, is less than the tolerance value, the iteration stops.
When the tolerance condition has been met, a minimum of the sum of squares has usually been found, which indicates a correct solution. However, local minima in the sum of squares can also cause the curve fitter to find an incorrect solution.

Decreasing the value of the tolerance makes the requirement for finding an acceptable solution more strict; increasing the tolerance relaxes this requirement.

The default tolerance setting is $1 \times 10^{-10}$. To change the tolerance value, type the desired value in the Tolerance edit box, or select a previously defined value from the drop-down list.

### Watching The Fit Progress

During the regression process, the Regression fit progress dialog box displays the number of iterations completed, the norm value for each iteration, and a progress bar indicating the percent complete of the maximum iterations.
Cancelling a Regression

To stop a regression while it is running, click Cancel. The initial results appear, displaying the most recent parameter values, and the sum of squares value. You can continue the regression process by clicking More Iterations on the Regression Wizard.

Interpreting Fit Results

When you click Next from the variables panel, the regression process completes by either converging, reaching the maximum number of iterations, or encountering an error. When any of these conditions are met, or whenever there is an error or warning, the initial results panel is displayed.
Completion Status Messages

A message displaying the condition under which the regression completed is displayed in the upper left corner of the Regression Wizard. If the regression completed with convergence, the message:

Converged, tolerance satisfied

is displayed.

Otherwise, another status or error message is displayed. For more information, see “Regression Results Messages” on page 688.

Rsqr

R² is the coefficient of determination, the most common measure of how well a regression model describes the data. The closer R² is to one, the better the independent variables predict the dependent variable.

R² equals 0 when the values of the independent variable does not allow any prediction of the dependent variables, and equals 1 when you can perfectly predict the dependent variables from the independent variables.
**Fit Results**

The initial results are displayed in the results window, in five columns.

- **Parameter.** The parameter names are shown in the first column. These parameters are derived from the original equation.

- **Value.** The calculated parameter values are shown in the second column.

- **StdErr.** The asymptotic standard errors of the parameters are displayed in column three. The standard errors and coefficients of variation can be used as a gauge of the fitted curve’s accuracy.

- **CV(%).** The parameter coefficients of variation, expressed as a percentage, are displayed in column four. This is the normalized version of the standard errors:

\[
CV = \frac{\text{standard error} \times 100}{\text{parameter value}}
\]

The coefficient of variation values and standard errors can be used as a gauge of the accuracy of the fitted curve.

- **Dependency.** The last column shows the parameter dependencies. The dependence of a parameter is defined to be

\[
\text{dependence} = 1 - \frac{\text{variance of the parameter, other parameters constant}}{\text{variance of the parameter, other parameters changing}}
\]

Parameters with dependencies near 1 are strongly dependent on one another. This may indicate that the equation(s) used are too complicated and over-parameterized—too many parameters are being used, and using a model with fewer parameters may be better.

**Changing the Regression Equation or Variables**

To go back to any of the previous panels, click **Back**. This is especially useful if you need to change the model (equation) used, or if you need to modify any of the equation options and try the curve fit again.

**More Iterations**

If the maximum number of iterations was reached before convergence, or if you canceled the regression, the **More Iterations** button is available. Click **More Iterations**
to continue for as many iterations as specified by the Iterations option, or until completion of the regression.

**Checking Use of Constraints**

If you used parameter constraints, you can determine if the regression results involved any constraints by clicking View Constraints. This button is dimmed if no constraints were entered.

Figure 16-18  
*The Constraints Dialog Box*

![Constraints Dialog Box](image)

The Constraints dialog box displays all constraints, and flags the ones encountered with the word (active). A constraint is flagged as active when the parameter values lie on the constraint boundary. For example, the constraint:

\[ a+b<1 \]

is active when the parameters satisfy the condition \( a+b=1 \), but if \( a+b<1 \), the constraint is inactive.

Note that an equality constraint is always active (unless there are constraint inconsistencies).

**Quitting the Regression**

If the regression results are unsatisfactory, you can click Back and change the equation or other options, or you can select Cancel to close the wizard.

If you want to keep your results, click Finish. You can also click Next to specify which results you want to keep.
Saving Regression Results

Regression reports and other data results are saved using the Regression Wizard - Numeric Options panel, which appears after the Fit Results panel. Settings made here are retained from session to session. The type of data results that can be saved to the current notebook for each regression procedure are:

- The function results, saved to the worksheet.
- A statistical report.
- A copy of the regression equation.

Saving the Results using Default Settings

To save the regression results using the default save setting, click Finish at any point the Finish button is active. If you want to see or modify the results that are produced, you can use the Next button to advance to the results options panel.

Saving Results to the Worksheet

You can save function results to the current worksheet. These are:

- Equation parameter values.
- Predicted values of the dependent variable for each independent variable value.
- Residuals, or the difference between the predicted and observed dependent variable values.

To place any of these values in a column in the worksheet, simply check the results you want to keep. If you want to set a specific column in which to always place these values, you can click a column on a worksheet for each result.
Create Report. Select to save regression reports to the current notebook section.

Adding Equation to Notebook. To add the current regression equation to the current notebook, select Add Equation to Notebook. If this option is selected, a copy of the equation is added to the current section of your notebook.
Graphing Regression Equations

SigmaPlot graphs the results of a regression as a fitted curve and creates a curve or graph by default. If you want to disable graphed results, you can change the options in the Regression Wizard - Graph Options panel. Note that SigmaPlot retains these settings from session to session.

From the graph panel, you can choose to plot the results either by:

- Adding a plot to an existing graph. This option is only available if the fitted variables were assigned by selecting them from a graph.
- Creating a new graph of the original data and fitted curve.

To add a plot to an existing graph, select Add Curve to, then select the graph to which you want to add a plot from the drop-down list. The drop-down list includes all the graphs on the current page. If there is no existing graph, this option is dimmed.

If you want to specify the columns used to plot the fitted curve, click Next. Otherwise, the data is placed in the first available columns.

Figure 16-20
A Fitted Curve Added to the Graph

To create a new graph, select Create New Graph. Click Finish to create a new notebook section containing a worksheet of the plotted data and graph page.
**Data Plotted for Regression Curves**

You can specify the worksheet columns used to add a fitted curve to an existing graph, or to create a new graph, by clicking Next from the graph panel.

Figure 16-21  
*The Regression Wizard Pick Output Dialog Box*

From this panel you can select worksheet columns for X, Y, (and Z data for 3D graphs) by clicking worksheet columns. The default of First Empty places the results in the first available column after the last filled cell.

**Confidence and Prediction Bands**

The term confidence band refers to the region of uncertainties in the predicted values over a range of values for the independent variable. The term prediction band refers to the region of uncertainties in predicting the response for a single additional observation at each point within a range of independent variable values. Prediction bands are always wider than confidence bands. Each band appears on the graph as a multiple line plot with two curves. One represents the upper limits of the confidence intervals and the other represents the lower limits of the confidence intervals. The independent variable values used to compute the confidence bands are the same values used to create the fit curve.
**Confidence and Prediction Band Computational Formulas**

Calculation of the limits of both bands is based upon a quantity that generalizes the notion of leverage at a data point. At a given value \( x \) of the independent variable, define

\[
c = (\text{grad}F)^T \cdot \text{Cov} \cdot (\text{grad}F)
\]

where \( \text{grad}F \) is the (parameter) gradient of the model \( F \), evaluated at \( x \) and at the best-fit parameter values, and \( \text{Cov} \) is the covariance matrix computed at the final iteration of the regression.

After computing \( c \), the upper and lower limits of both bands are given by:

**Confidence Band**

\[
\hat{y}(x) \pm c \sqrt{MS_{res}} \text{CriticalT}(\text{conf.level}\%, DF)
\]

**Prediction Band**

\[
\hat{y}(x) \pm (c + 1) \sqrt{MS_{res}} \text{CriticalT}(\text{conf.level}\%, DF)
\]
where
\[ \hat{y}(x) \]
is the predicted value at \( x \).

\( \text{MSres} \) is the mean residual sum of squares.

\( \text{conf.level} \% \) is the percent confidence level.

\( DF \) is the residual degree of freedom (number of data points - number of parameters).

Critical\( T(\text{conf.level}\%, DF) \) is the inverse \( T \)-Distribution with \( DF \) degrees of freedom evaluated \( 1-\alpha/2 \), where \( \alpha \) satisfies \( \text{conf.level}\% = 100(1-\alpha)\% \)

### Changing Confidence and Prediction Band Percentage Values

You add confidence and prediction bands on the Graph Options panel of the Regression Wizard. This value should agree with any confidence interval results in a report.

**Figure 16-23**
Selecting to Add Confidence and Prediction Bands to a graph

While the default confidence level for confidence and prediction bands is 95%, you can change this value in the Report Options for Nonlinear Regression dialog box.

- Click Back if you are viewing the Regression Wizard - Graph Options dialog box to the Numeric Output Options panel. For more information, see “Using the Regression Wizard” on page 633.
Click Report to open the Options for Nonlinear Regression dialog box. Here is where you control what you would like to appear in the report.

Click the More Statistics tab.

Under Confidence Intervals, select the Prediction and Confidence intervals you would like to appear in the report.

Set the percentage for the confidence level in the Confidence Level box.
In the Starting in Column drop-down list, select First Available Column or select (None) if you don’t want the confidence and prediction intervals to appear in the worksheet,

- Click OK to save the changes and close the dialog box.

- Click Next in the Regression Wizard.

The Regression Wizard - Graph Options panel appears with the new percentage for the confidence and prediction bands.

Figure 16-26
Selecting Confidence and Prediction Bands

When you click Finish in the Regression Wizard, the confidence and prediction bands appear on the graph. If you selected First Available Column in the More Statistics tab of the Report Options for Nonlinear Regression dialog box, beginning in the first empty column, four columns of graph data appear in the worksheet which represent the upper and lower limits of the confidence and prediction bands.
Using the Regression and Dynamic Fit Wizards

Figure 16-27
Worksheet Columns Representing Data for the Confidence and Prediction Bands

These results also appear in the report. For more information, see “Confidence and Prediction Bands” on page 664.

Interpreting Regression Reports

The Regression Wizard can automatically generate reports for each curve fitting session. The statistical results are displayed to four decimal places of precision by default.

Reports are displayed using the SigmaPlot report editor. For more information, see “Using the Report Editor” in Chapter 11.

Equation Code

This is a printout of the code used to generate the regression results. For more information, see “Editing Code” in Chapter 17.
R and R Squared

The *multiple correlation coefficient*, R, and the coefficient of determination, $R^2$, are both measures of how well the regression model describes the data. R values near 1 indicate that the equation is a good description of the relation between the independent and dependent variables. R equals 0 when the values of the independent variable does not allow any prediction of the dependent variables, and equals 1 when you can perfectly predict the dependent variables from the independent variables.

Adjusted R Squared

The adjusted $R^2$, $R^2_{adj}$, is also a measure of how well the regression model describes the data, but takes into account the number of independent variables, which reflects the degrees of freedom. Larger $R^2_{adj}$ values (nearer to 1) indicate that the equation is a good description of the relation between the independent and dependent variables.
**Standard Error of the Estimate**

The standard error of the estimate $S_{y|x}$ is a measure of regression plane of the actual variability about the regression plane of the underlying population. The underlying population generally falls within about two standard errors of the observed sample.

**Statistical Summary Table**

The standard error, $t$ and $P$ values are approximations computed at the final iteration of the regression.

- **Estimate.** The value for the constant and coefficients of the independent variables for the regression model are listed.

- **Standard Error.** The asymptotic standard errors measure the uncertainties in the estimates of the regression coefficients (analogous to the standard error of the mean). The true regression coefficients of the underlying population are generally within about two standard errors of the predicted coefficients. Large standard errors may indicate multicollinearity. The default procedure for computing standard errors is based on whether or not the regression problem is weighted. In an unweighted problem, the standard error for each parameter includes a factor that estimates the standard deviation of the observed data. In this case, it is assumed that the errors for all data points have the same variance.

  In a weighted problem, there are two options for computing standard errors. One option includes the factor that estimates the standard deviation of the observed data. This option is called reduced chi-square. The other option omits this factor in the computation. To select the option for standard errors, go to the Equation Options dialog box.

- **$t$ statistic.** The $t$ statistic tests the null hypothesis that the coefficient of the independent variable is zero, that is, the independent variable does not contribute to predicting the dependent variable. $t$ is the ratio of the regression coefficient to its standard error, or

\[
t = \frac{\text{regression coefficient}}{\text{standard error of regression coefficient}}
\]

You can conclude from large values that the independent variable can be used to predict the dependent variable (for example, that the coefficient is not zero).
**P value.** $P$ is the $P$ value calculated for $t$. The $P$ value is the probability of being wrong in concluding that the coefficient is not zero (i.e., the probability of falsely rejecting the null hypothesis, or committing a Type I error, based on $t$). The smaller the $P$ value, the greater the probability that the coefficient is not zero.

Traditionally, you can conclude that the independent variable can be used to predict the dependent variable when $P < 0.05$.

**Analysis of Variance (ANOVA) Table**

The ANOVA (analysis of variance) table lists the ANOVA statistics for the regression and the corresponding F value for each step.

**SS (Sum of Squares).** The sum of squares are measures of variability of the dependent variable.

- The sum of squares due to regression measures the difference of the regression plane from the mean of the dependent variable.
- The residual sum of squares is a measure of the size of the residuals, which are the differences between the observed values of the dependent variable and the values predicted by the regression model.

**DF (Degrees of Freedom).** Degrees of freedom represent the number of observations and variables in the regression equation.

- The regression degrees of freedom is a measure of the number of independent variables.
- The residual degrees of freedom is a measure of the number of observations less the number of parameters in the equation.

**MS (Mean Square).** The mean square provides two estimates of the population variances. Comparing these variance estimates is the basis of analysis of variance.

The mean square regression is a measure of the variation of the regression from the mean of the dependent variable, or

\[
\frac{\text{sum of squares due to regression}}{\text{regression degrees of freedom}} = \frac{SS_{\text{res}}}{DF_{\text{res}}} \cdot MS_{\text{res}}
\]

The residual mean square is a measure of the variation of the residuals about the regression plane, or
Using the Regression and Dynamic Fit Wizards

The residual mean square is also equal to

\[ S^2_{y|x} \]

**F statistic.** The *F* test statistic gauges the contribution of the independent variables in predicting the dependent variable. It is the ratio

\[ \frac{\text{regression variation from the dependent variable mean}}{\text{residual variation about the regression}} = \frac{MS_{reg}}{MS_{res}} = F \]

If *F* is a large number, you can conclude that the independent variables contribute to the prediction of the dependent variable (i.e., at least one of the coefficients is different from zero, and the *unexplained variability* is smaller than what is expected from random sampling variability of the dependent variable about its mean). If the *F* ratio is around 1, you can conclude that there is no association between the variables (i.e., the data is consistent with the null hypothesis that all the samples are just randomly distributed).

**P value.** The *P* value is the probability of being wrong in concluding that there is an association between the dependent and independent variables (i.e., the probability of falsely rejecting the null hypothesis, or committing a Type I error, based on *F*). The smaller the *P* value, the greater the probability that there is an association.

Traditionally, you can conclude that the independent variable can be used to predict the dependent variable when *P* < 0.05.

**PRESS Statistic**

PRESS, the *Predicted Residual Error Sum of Squares*, is a gauge of how well a regression model predicts new data. The smaller the PRESS statistic, the better the predictive ability of the model.

The PRESS statistic is computed by summing the squares of the prediction errors (the differences between predicted and observed values) for each observation, with that point deleted from the computation of the regression equation.
**Durbin-Watson Statistic**

The Durbin-Watson statistic is a measure of correlation between the residuals. If the residuals are not correlated, the Durbin-Watson statistic will be 2; the more this value differs from 2, the greater the likelihood that the residuals are correlated.

Regression assumes that the residuals are independent of each other; the Durbin-Watson test is used to check this assumption. If the Durbin-Watson value deviates from 2 by more than 0.50, a warning appears in the report, i.e., if the Durbin-Watson statistic is below 1.50 or above 2.50.

**Normality Test**

The normality test results display whether the data passed or failed the test of the assumption that the source population is normally distributed around the regression, and the P value calculated by the test. All regressions assume a source population to be normally distributed about the regression line. If the normality test fails, a warning appears in the report.

Failure of the normality test can indicate the presence of outlying influential points or an incorrect regression model.

**Figure 16-29**
Regression Report Showing Normality Test Results
**Constant Variance Test**

The constant variance test results displays whether or not the data passed or failed the test of the assumption that the variance of the dependent variable in the source population is constant regardless of the value of the independent variable, and the \( P \) value calculated by the test. When the constant variance test fails, a warning appears in the report.

If the constant variance test fails, you should consider trying a different model (for example, one that more closely follows the pattern of the data) using a weighted regression, or transforming the independent variable to stabilize the variance and obtain more accurate estimates of the parameters in the regression equation.

If you perform a weighted regression, the normality and equal variance tests use the weighted residuals

\[ w_i \left( y_i - \hat{y}_i \right) \]

instead of the raw residuals

\[ y_i - \hat{y}_i \]

**Power**

The power, or sensitivity, of a regression is the probability that the model correctly describes the relationship of the variables, if there is a relationship.

Regression power is affected by the number of observations, the chance of erroneously reporting a difference \( \alpha \) (alpha), and the slope of the regression.

**Alpha.** Alpha (\( \alpha \)) is the acceptable probability of incorrectly concluding that the model is correct. An \( \alpha \) error is also called a Type I error (a Type I error is when you reject the hypothesis of no association when this hypothesis is true).

Smaller values of \( \alpha \) result in stricter requirements before concluding the model is correct, but a greater possibility of concluding the model is incorrect when it is really correct (a Type II error). Larger values of \( \alpha \) make it easier to conclude that the model is correct, but also increase the risk of accepting an incorrect model (a Type I error).
Regression Diagnostics

The regression diagnostic results display the values for the predicted values, residuals, and other diagnostic results.

**Row.** This is the row number of the observation.

**Predicted Values.** This is the value for the dependent variable predicted by the regression model for each observation.

**Residuals.** These are the unweighted raw residuals, the difference between the observed and predicted values for the dependent variables.

**Standardized Residuals.** The standardized residual is the raw residual divided by the standard error of the estimate

\[ s_{y|x} \]

If the residuals are normally distributed about the regression, about 66% of the standardized residuals have values between -1 and +1, and about 95% of the standardized residuals have values between -2 and +2. A larger standardized residual indicates that the point is far from the regression. Values less than -2.5 or larger than 2.5 may indicate outlying cases.

**Studentized Residuals.** The Studentized residual is a standardized residual that also takes into account the greater confidence of the predicted values of the dependent variable in the middle of the data set. By weighting the values of the residuals of the extreme data points (those with the lowest and highest independent variable values), the Studentized residual is more sensitive than the standardized residual in detecting outliers. This residual is also known as the internally Studentized residual, because the standard error of the estimate is computed using all data.

**Studentized Deleted Residuals.** The Studentized deleted residual, or externally Studentized residual, is a Studentized residual which uses the standard error of the estimate \( s_{y|x} \), computed after deleting the data point associated with the residual. This reflects the greater effect of outlying points by deleting the data point from the variance computation.

**Studentized Deleted Residuals.** The Studentized deleted residual, or externally Studentized residual, is a Studentized residual which uses the standard error of the estimate
computed after deleting the data point associated with the residual. This reflects the greater effect of outlying points by deleting the data point from the variance computation.

The Studentized deleted residual is more sensitive than the Studentized residual in detecting outliers, since the Studentized deleted residual results in much larger values for outliers than the Studentized residual.

**Influence Diagnostics**

**Row.** This is the row number of the observation.

**Cook’s Distance.** Cook’s distance is a measure of how great an effect each point has on the estimates of the parameters in the regression equation. It is a measure of how much the values of the regression coefficients would change if that point is deleted from the analysis.

Values above 1 indicate that a point is possibly influential. Cook’s distances exceeding 4 indicate that the point has a major effect on the values of the parameter estimates.

**Leverage.** Leverage values identify potentially influential points. Observations with leverages two times greater than the expected leverages are potentially influential points.

The expected leverage of a data point is

$$\frac{p}{n}$$

where there are \( p \) parameters and \( n \) data points.

Because leverage is calculated using only the dependent variable, high leverage points tend to be at the extremes of the independent variables (large and small values), where small changes in the independent variables can have large effects on the predicted values of the dependent variable.

**DFFITS.** The DFFITS\(_i\) statistic is a measure of the influence of a data point on regression prediction. It is the number of estimated standard errors the predicted value for a data point changes when the observed value is removed from the data set before computing
the regression coefficients. Predicted values that change by more than 2.0 standard errors when the data point is removed are potentially influential.

Figure 16-30
Regression Report Showing the Influence Diagnostics

Confidence and Prediction Intervals

The confidence level for both intervals has a default value of 95%. You can change it in the Report Options for Nonlinear Regression dialog box.

Confidence intervals about the predicted values define a range of values where the population mean at the dependent variable is located with a certain probability. This probability is called the confidence level.

Figure 16-31
The 95% Confidence Section of the Report

<table>
<thead>
<tr>
<th>Row</th>
<th>Predicted</th>
<th>95% Conf-L</th>
<th>95% Conf-U</th>
<th>95% Pred-L</th>
<th>95% Pred-U</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.604684</td>
<td>0.920776</td>
<td>4.281565</td>
<td>0.149380</td>
<td>5.071191</td>
</tr>
<tr>
<td>2</td>
<td>2.883323</td>
<td>1.797030</td>
<td>3.963264</td>
<td>0.749332</td>
<td>4.017315</td>
</tr>
<tr>
<td>3</td>
<td>3.006644</td>
<td>1.904568</td>
<td>4.108719</td>
<td>0.888825</td>
<td>5.124162</td>
</tr>
<tr>
<td>4</td>
<td>3.140853</td>
<td>2.127048</td>
<td>4.153698</td>
<td>1.058062</td>
<td>5.213322</td>
</tr>
<tr>
<td>5</td>
<td>3.231082</td>
<td>2.337946</td>
<td>4.164919</td>
<td>1.223972</td>
<td>5.277092</td>
</tr>
<tr>
<td>6</td>
<td>3.353014</td>
<td>2.359809</td>
<td>4.363319</td>
<td>1.285183</td>
<td>5.421464</td>
</tr>
<tr>
<td>7</td>
<td>3.460629</td>
<td>2.358813</td>
<td>4.501265</td>
<td>1.341700</td>
<td>5.578707</td>
</tr>
<tr>
<td>8</td>
<td>3.599009</td>
<td>2.554878</td>
<td>4.626940</td>
<td>1.506928</td>
<td>5.674890</td>
</tr>
<tr>
<td>9</td>
<td>3.757374</td>
<td>2.082091</td>
<td>5.431560</td>
<td>1.293446</td>
<td>6.223706</td>
</tr>
</tbody>
</table>

**Row.** This is the row number of the observation.

**Predicted.** This column shows the value for the dependent variable predicted by the regression model for each observation.
Confidence. The confidence interval for the regression gives the range of variable values computed for the region containing the true relationship between the dependent and independent variables, for the specified level of confidence. The 95% Conf-L values are lower limits and the 95% Conf-U values are the upper limits.

Prediction. The confidence interval for the population gives the range of variable values computed for the region containing the population from which the observations were drawn, for the specified level of confidence. The 95% Pred-L values are lower limits and the 95% Pred-U values are the upper limits.

Regression Equation Libraries and Notebooks

Regression equations are stored in notebook files just as other SigmaPlot documents. Notebooks that are used to organize and contain only regression equations are referred to as libraries, and distinguished from ordinary notebooks with a file extension of .sfl. These library notebooks can be opened and modified like any other notebook file. You can also use ordinary SigmaPlot notebooks (.jnb) as equation libraries, as well as save any notebook as a .jfl file.

Regression equations within notebooks are indicated with a regression symbol icon that appears next to the equation name.

The equations that appear in the Regression Wizard are read from a default regression library. The way the equations are named and organized in the equations panel is by using the section name as the category name, and the entry name as the equation name.
For example, the `standard.jfl` regression library supplied with SigmaPlot has twelve categories of built-in equations:

- Polynomial
- Peak
- Sigmoidal
- Exponential Decay
- Exponential Rise to Maximum
- Exponential Growth
- Hyperbola
- Waveform
- Power
- Rational
- Logarithm
- Other
Using the Regression and Dynamic Fit Wizards

- 3D
- Standard Curves
- Ligand Binding
- Piecewise

These categories correspond to the section names within the Standard.jfl notebook. For more information, see “Regression Equation Library” in Appendix C.

To see the library currently in use, click Back in the Regression Wizard equation panel. Previously selected libraries and open notebooks can be selected from the Library drop-down list.

Opening an Equation Library

You can open, view, and modify a regression equation library as you would any ordinary notebook. To open a regression library:

- Click the Open toolbar button, select *.jfl as the file type from the File Type drop-down list, then select the library to open, or

- Click the Open button in the Regression Wizard library panel to open the current library. You can reach the library panel by clicking Back on the Equations panel.

You can copy, paste, rename and delete regression equations as any other notebook item. Opening a regression equation directly from a notebook automatically launches the Regression Wizard with the variables panel selected.

Using a Different Library for the Regression Wizard

You can also select another notebook or library as the source for the equations in the Regression Wizard. Selecting a different equation library changes the categories and equations listed in the Regression Wizard equations panel.
To change the library:

- Start the Regression Wizard by pressing F5 or from the menus select:
  
  Statistics
  Regression Wizard

- Click Back to view the library panel. To change the library used, enter the new library path and name, or click Browse. The File Open dialog box appears.

- Change the path and select the file to use as your regression library. When you start the Regression Wizard next, it will continue to use the equation library selected in the library panel.

*Note:* Opening a regression equation directly from a notebook does not reset the equation library.
Curve Fitting Date And Time Data

You can run the Regression wizard on data plotted versus calendar times and dates. Dates within and near the twentieth century are stored internally as very large numbers. However, you can convert these dates to relatively small numbers by setting Day Zero to the first date of your data, then converting the date data to numbers. After curve fitting the data, you can switch the numbers back to dates. For more information, see “Setting Day Zero” on page 78.

Figure 16-34
You can curve fit dates, but you must convert the dates to numbers first. Time only data (as shown in column 1) does not require a conversion.

Note: If you have entered clock times only, then you can directly curve fit those time without having to convert these to numbers. Time only entries assume the internal start date of 4713 B.C. (the start of the Julian calendar). However, if you have entered times using a more recent calendar date, you must convert these times to numbers as well.
Converting Dates to Numbers

- From the menus select:
  
  Tools
  Options
  
  The Options dialog box appears.

Figure 16-35
Setting Day Zero

- Click the Worksheet tab.

- From the Settings for list, select Date and Time.

- Set Day Zero to be the first date of your data, or to begin very close to the starting date of your data. You must include the year as well as month and day.

- Click OK, then view the worksheet and select your data column.
From the menus select:
Format
Cells

Figure 16-36
Converting Dates to Numbers

The Format Cells dialog box appears.

Figure 16-37
Under Type, click Numeric.

Click OK.

Your dates are converted to numbers. These numbers should be relatively small numbers. If the numbers are large, you did not select a Day Zero near your data starting date.

If the axis range of your graph is manual, convert it back to automatic. Select the axis, then open the Graph Properties dialog box and change the range to Automatic. For more information, see “Changing Axis Range” on page 413.

Click your curve and run your regression. When you are finished, you must convert the original and fitted curve x variable columns back to dates.

**Converting Numbers Back to Dates**

Select each column, then from the menus select:

- Format
- Cells

The Format Cells dialog box appears.

Click the Data tab.

Under Types, select Date and Time.

On the Date drop-down list, click a date format.

Click OK.
Using the Regression and Dynamic Fit Wizards

Figure 16-38
Converting Numeric Data back to Date and Time Data

When the columns are converted back to dates, the graph re-scales and you have completed your date and time curve fit.

Figure 16-39
The Data and Fitted Curve X Variables Converted Back to Dates and Graphed
Regression Results Messages

When the initial results of a regression are displayed, a message about the completion status appears. Explanations of the different messages are found below.

Completion Status Messages

Converged, tolerance satisfied. This message appears when the convergence criterion, which compares the relative change in the norm to the specified tolerance, is satisfied. Note that this result may still be false, caused by a local minimum in the sum of squares.

Converged, zero parameter changes. The changes in all parameters between the last two iterations are less than the computer’s precision.

Did not converge, exceeded maximum number of iterations. More iterations were required to satisfy the convergence criteria. Select More Iterations to continue for the same number of iterations or increase the number of iterations specified in the Options dialog box and rerun the regression.

Did not converge, inner loop failure. There are two nested iterative loops in the Marquardt algorithm. This diagnostic occurs after 50 sequential iterations in the inner loop. The use of constraints may cause this to happen due to a lack of convergence. In some cases, the parameter values obtained with constraints are still valid, in the sense that they result in good estimates of the regression parameters.

Terminated by user. You pressed Esc, or selected the Cancel button and terminated the regression process.

Function overflow using initial parameter values. The regression iteration process could not get started since the first function evaluation resulted in a math error. For example, if you used f = sqrt(-a*x), and the initial a value and all x values are positive, a math error occurs. Examine your equation, parameter values and independent variable values, and make the appropriate changes.

Parameters may not be valid. Array ill conditioned on final iteration. During the regression iteration process the inverse of an array (the product of the transpose of the Jacobian matrix with itself) is required. Sometimes this array is nearly singular (has a nearly zero determinant) for which very poor parameter estimates would be obtained.
SigmaPlot uses an estimate of the "condition" of the array (ill conditioned means nearly singular) to generate this message (see Dongarra, J.J., Bunch, J.R., Moler, C.B., and Stewart, G.W., Linpack User’s Guide, SIAM, Philadelphia, 1979 for the computation of condition numbers).

Usually this message should be taken seriously, as something is usually very wrong. For example, if an exponential underflow has occurred for all x values, part of the equation is essentially eliminated. SigmaPlot still tries to estimate the parameters associated with this phantom part of the equation, which can result in invalid parameter estimates.

A minority of the time the "correct," though poorly conditioned, parameters are obtained. This situation may occur, for example, when fitting polynomial or other linear equations.

**Parameters may not be valid. Array numerically singular on final iteration.** This is the limiting case of the above condition where the array cannot be inverted and the condition number is infinite. In this case, the parameter values are not well specified and their standard errors cannot be properly interpreted.

**Parameters may not be valid. Overflow in partial derivatives.** The partial derivatives of the function to be fit, with respect to the parameters, are computed numerically using first order differences.

Math errors from various sources can cause errors in this computation. For example if your model contains exponentials and the parameters and independent variable values cause exponential underflows, then the numerical computation of the partial derivative will be independent of the parameter(s). SigmaPlot checks for this independence.

Check the parameter values in the results screen, the range of the independent variable(s) and your equation to determine the problem.

**There may be inconsistent constraints. Check constraint equations.** This occurs if you have defined constraints like $a > 0$ and $a < -1$. 
Chapter 16

Error Status Messages

**Bad constraint.** The regression cannot proceed because a constraint you defined either was not linear or contained syntax errors.

**Invalid or missing 'fit to' statement.** The regression lacks a fit to statement, or the fit to statement contains one or more syntax errors.

**No observations to fit.** The regression cannot proceed unless at least one x,y data pair (observation) is included. Check to be sure that the data columns referenced in the regression specifications contain data.

**No parameters to fit.** The regression specifications do not include any parameter definitions. To add parameter definitions, return to the Equation Options dialog box and type the parameter definitions in the Parameters edit window.

**No weight statement.** The regression specifications include a fit to statement with an unknown weight variable. Check the Variables edit window to see if a weight variable has been defined and that this corresponds to the variable in the regression statement.

**Not enough or bad number of observations.** In regression, the x and y data sets must be of the same size. The data sets (x and y columns) you specified contain unequal numbers of values.

**Problem loading the file [Filename]. File too long; truncated.** The fit file you tried to load is too long. Regression files can be up to 50 characters wide and 80 lines long. Any additional characters or lines were truncated when the file was loaded into the Edit Window.

**Section has already been submitted.** This regression section has already been defined.

**Symbol [Variable or Function] has not been defined.** The fit to statement in the regression definition contains an observed variable which is undefined, or the fit to statement in the regression definition contains an undefined function. Examine the regression specifications you have defined and be sure that the dependent variable listed in the regression statement exists and corresponds to the variable defined in the Variables edit window and that the function listed in the regression statement exists and corresponds to the function you defined in the Equations edit window.

**Unreferenced variable.** The regression specifications define a parameter that is not referenced in any other statements. Either delete the parameter definition, or reference it in another statement.
Dynamic Curve Fitting

Nonlinear curve fitting is an iterative process that may converge to find a best possible solution. It begins with a guess at the parameters, checks to see how well the equation fits, then continues to make better guesses until the differences between the residual sum of squares no longer decreases significantly. For more information, see “Curve-fitting Algorithm” on page 631.

For complicated curve fitting problems, use SigmaPlot’s new Dynamic Fit Wizard to find the best the solution. Why? The Dynamic Fit Wizard automates the search for initial parameter values that lead to convergence to the best possible solution. For example, typically for a user-defined function, you would need to edit the code to manually enter the initial parameter values, possibly repeatedly, until you find the best fit. For more information, see “Entering Initial Parameters” on page 713.

But what if you don’t have a good estimate for the initial parameters? The Dynamic Fit Wizard takes away the guesswork. You enter a range for the minimum and maximum initial parameter values, and the Dynamic Fit Wizard does the rest, giving you the confidence that you’ll find the best fit.

Using the Dynamic Fit Wizard

Like the Regression Wizard, the Dynamic Fit Wizard is a step-by-step guide through the curve fitting procedures, but with an additional panel in which you set the search options.

Note that the Dynamic Fit Wizard is especially useful for for more difficult curve fitting problems with three or more parameters and possibly a large amount of variability in the data points. For linear regressions or less difficult problems, such as simple exponential two parameter fits, the Dynamic Fit Wizard is overkill and you should use the Regression Wizard.

Selecting the Data Source

- View the page or worksheet with the data you want to fit.

  **If you select a graph,** right-click the curve you want fitted, and on the shortcut menu, click Dynamic Fit Curve.

  **Note:** If you are running a regression from the graph page, make sure you select the plot itself, not the graph, or Dynamic Fit Curve will not appear on the shortcut menu.
If you are using a worksheet, select the variables in the worksheet you want to fit, then from the menus select:

Statistics
  Dynamic Fit Wizard

The Dynamic Fit Wizard appears.

Selecting the Equation to Use

Select an equation from the Equation Category and Equation Name drop-down lists. You can view different equations by selecting different categories and names. The equation’s mathematical expression and shape appear to the left. For more information, see “Regression Equation Library” in Appendix C.

Figure 16-40
Selecting an Equation Category and Equation Name

If the equation you want to use isn’t on this list, you can create a new equation. For more information, see “Editing Code” in Chapter 17. You can also browse other notebooks and regression equation libraries for other equations. For more information, see “Regression Equation Library” in Appendix C.

Note: SigmaPlot remembers the equation for the next time you open the Dynamic Fit Wizard.

If the Finish button is available, click it to complete your regression. If it is not available, or if you want to further specify your results, click Next.
Selecting the Variables to Fit

Click Next to open the variables panel. From here, you can select or re-select your variables. There are three ways to select variables:

- Selecting a curve on a graph.
- Selecting a column in a worksheet.
- Selecting the variable from the Variable Columns drop-down list in the Regression Wizard. The equation picture to the left prompts you for which variable to select.

You can also modify other equation settings and options from this panel by clicking Options, which opens the Equations Options dialog box. These options include changing initial parameter estimates, parameter constraints, weighting, and other related settings. For more information, see “Equation Options” on page 650.
If you pick variables from a worksheet column, you can also set the data format. For more information, see “Variable Options” on page 648.

When you have selected your variables, you can either click Finish, or click Next to view the Initial Results.

**Setting the Dynamic Curve Fit Options**

Here is where the Dynamic Fit Wizard differs from the Regression Wizard in that you can set the minimum and maximum ranges to search for initial parameter values. These are the values where, if you were to do this manually for a user-defined function, you would click Edit Code on the Variables panel of the Dynamic Fit Wizard (or Regression Wizard). The parameters appear under Initial Parameters.

Using the Regression Wizard, you would have to repeatedly enter the values until you found the best fit. Here, the Dynamic Fit Wizard does this for you. It selects a sequence of parameter estimates that are maximally distant from one another and in this way attempts to span the parameter ranges specified.

**Figure 16-42**

*Setting the Search Options in the Dynamic Fit Wizard*

The values under the Parameter, Initial Estimate, Minimum and Maximum columns contain the range information and the initial parameter estimates for each parameter in the equation file.
To set the number of fits and maximum number of iterations:

- Enter or select a number from the Number of fits drop-down list. The default value is 200. This is a good value to start with, though for more difficult problems, you may want to increase it.

- Set the Marquadt-Levenberg algorithm from the Maximum number of iterations drop-down list. Again, more difficult problems may require a larger value. Check the “Iterations exceeding” percentage in the Dynamic Fit report. If this is greater than 50% then increase the Maximum number of iterations.

Once the process exceeds this limit for a fit, then there is "no convergence" for this fit. The process continues with the next set of starting parameter values.

To change a parameter range:

- Under Select range method select User-defined.

- Select a parameter listing under Select a parameter to modify its range.

- Enter the ranges into the Minimum and Maximum boxes.

- Click Modify.

  These new values appear under the Minimum and Maximum columns.

- Click Next. As the dynamic curve fit procedure begins, a progress bar appears in the status bar in the lower left corner of SigmaPlot, indicating the proportion of fits as they are analyzed over time. Once the set Number of Fits has been reached, the Dynamic Fit Wizard - Fit Results panel appears.

Viewing Fit Results

The fit results also appear if you receive a warning or error message about your fit.
Figure 16-43
The Dynamic Fit Results for a Regression

The minimum sum of squares for the 200 fits is 0.6204662.
The parameter values for this solution are described in the table.
Converged in 15 iterations, tolerance satisfied.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>SDErr</th>
<th>CV(%)</th>
<th>Dependencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>y0</td>
<td>1.057e+0</td>
<td>6.140e-1</td>
<td>5.765e+1</td>
<td>0.9794513</td>
</tr>
<tr>
<td>a</td>
<td>3.427e-1</td>
<td>5.659e-2</td>
<td>2.093e+1</td>
<td>0.9999516</td>
</tr>
<tr>
<td>c</td>
<td>-2.720e-2</td>
<td>5.756e-3</td>
<td>2.770e+1</td>
<td>0.9999407</td>
</tr>
</tbody>
</table>

For more information, see “Interpreting Fit Results” on page 657.

► If you wish to modify the remainder of the results that are automatically saved, click Next. Otherwise, click Finish.

The subsequent panels provide options for the output data.

**Setting Numeric Output Options**

The Numeric Output Options panel lists:

- Which results are saved to the worksheet.
- Whether or not to generate a text report of the regression. For more information, see “Setting Nonlinear Regression Report Options” on page 640.
- Whether or not a copy of the regression equation is saved to the section to the notebook that contains the data that was fitted.
Select which results you want to keep from the Results for best-fit solution list. These settings are remembered between regression sessions.

To select worksheet results options for all converged fits, click More worksheet results. The Result Worksheet Options dialog box appears. For more information, see “Worksheet Result Options” on page 697.

To set the options for the report, click Report. For more information, see “Setting Nonlinear Regression Report Options” on page 640.

Click Next to set the graph options.

**Worksheet Result Options**

This dialog box appears by clicking More worksheet results on the Dynamic Fit Wizard - Numeric Output Options panel. You can select several types of calculations to compare and study fit results obtained from the Dynamic Fit Wizard. These results of these calculations appear in the worksheet for every (convergent) solution.

**Basic results - sum of squares, iteration counts, final parameters.** Selected by default. Select this option to create one column for sum of squares, titled "SumSq", one column for the number of iterations needed for convergence, titled "Iterations", and \( p \) columns of the final, or best-fit, parameter values, where \( p \) is the number of...
parameters in the fit model. The column title for this is ":<parameter value name>:-Final".

All worksheet results are linked to the values in the sum of squares column. Its values are ordered from smallest to largest. Each row of data refers to a particular fit.

Clearing this option disables the Additional options.

**Additional options.** Select to place any of the following options below into the worksheet. To better distinguish columns of data, single blank columns are inserted into the worksheet between the groups of data specified by the options below.

- **Condition number.** Select to create a worksheet column called "Condition Number". This is the condition number of the covariance matrix obtained at the final iteration. For a positive-definite matrix, the condition number is computed as the ratio of the maximum and minimum eigenvalues. It is a measure of the sensitivity of the sum of squares value to a change in parameter values at the final iteration. Larger condition numbers indicate more uncertainty in specifying the best-fit parameters. The values in this column use E notation, with three decimal points of precision. For more information, see “Engineering and E Notation” on page 69.

- **Starting parameters.** These are the initial parameter estimates used to start the fit algorithm. These values are selected from the parameter ranges that you’ve specified. The title for this column is "<parameter-name>-Start".

- **Parameter standard errors.** These are the asymptotic standard errors for the parameters computed at the final iteration. They measure the range of uncertainty in specifying the best-fit parameters. The title of the Parameter standard errors columns is ":<parameter name>-StdErr".

- **Coefficients of variation.** For each parameter value in the best-fit solution, this is the percent value of the ratio of the parameter’s standard error to the parameter’s absolute value. The title for this column is "<parameter name>-CV%".

- **Dependencies.** Given a parameter value in the best-fit solution, this is a number between 0 and 1 that measures the dependency of the rate of change of the predicted values with respect to the parameter on the rates of changes with respect to the other parameters. A value close to 1 indicates uncertainty in specifying the given parameter value in the best-fit solution. The title for this column is "<parameter name>-Dep".
Setting Graph Options

- If you selected your variables from a graph, select Add curve to to automatically add the equation curve to that graph.

  You can also plot the equation on any other graph on that page by selecting one from the drop-down list.

- Select Create new graph to create a new graph of the original data and fitted curve.

  Figure 16-45
  Selecting the results to graph. These settings are retained between sessions.

  ![Dynamic Fit Wizard - Graph Options](Image)

  - Select Add to graph to create a plot of the regression equation for the graph specified by the drop-down list. This option on appears if you ran the regression using a graph curve as a data source.

  - Select 95% Confidence and prediction bands to display confidence and prediction bands on the graph. For more information, see “Confidence and Prediction Bands” on page 664.

    Note: This option only appears if you select either Create new graph or Add to graph.

  - Select Extend fit to axes to extend the equation curve to intersect the Y-axis.

  - Select Add equation to graph title to insert the equation of the curve fit under the title of the graph.
Select Create a dynamic fit profile graph to create a separate graph that plots the base-10 logarithm of the minimum sum of squares of each fit versus the fit index.

After selecting the graphed results you want, click Finish. Click Next only if you want to select the specific columns used to contain the data for the fitted curve.

**Selecting Columns for Graph Data**

To select the specific columns to use for the plotted results, click the columns in the worksheet where you want the curve fit data to appear.

*Tip:* Remember, these settings are reused each time you perform a regression and overwrite data if it exists in these columns in subsequent worksheets. To avoid overwriting data, use First Empty to place the fitted curve results in empty columns.

Click Finish.

Figure 16-46  
Selecting the graph results columns. These settings are retained between sessions.

**Finishing the Dynamic Fit**

After clicking Finish, all your results are displayed in the worksheet, report, and graph. The initial defaults are to save parameter and computed dependent variable values to the worksheet, to create a statistical report, and to graph the results.
To change the results that are saved, click Next to go through the entire wizard, changing your settings as desired.

**Dynamic Curve Fit Reports**

To create a Dynamic Curve Fit report, make sure you select Create Report on the Numeric Output Options panel of the Dynamic Fit Wizard. For more information, see “Setting Numeric Output Options” on page 636.

When you click Finish in the Dynamic Fit Wizard, a report appears, divided into the following sections:

**Dynamic Fit Options.** This section displays the dynamic fit options that you chose on the Search Options panel of the Dynamic Fit Wizard. These include the total number of fits, the maximum number of iterations, and the search ranges for each parameter. For more information, see “Setting the Dynamic Curve Fit Options” on page 694.

**Summary of Fit Results.** This section displays a summary of the outcomes from all of the fits that were executed. As a percent of the total number of fits, the following conditions are reported:

- **Converged.** Those fits that satisfied the convergence criterion.
- **Singular Solutions.** Those convergent fits whose covariance matrix is singular.
- **Ill-Conditioned Solutions.** Those convergent fits whose covariance matrix is ill-conditioned (to machine precision).
- **Evaluation Failures.** Fits that failed to converge due to an evaluation error of the fit equation induced by certain (out of domain) parameter values.
- **Iterations Exceeding <Iterations Exceeding>.** Fits that failed to converge after the iteration limit was reached. This user specified limit is inserted into the brackets above.
- **Inner-Loop Failures.** Fits where the Levenberg-Marquardt parameter has increased above a prescribed value when searching for a parameter direction to decrease the residual sum of squares.

The precision of the percentage value that is displayed for each above condition is determined by the total number of fits specified by the user. This precision (number of places to the right of the decimal point) equals the order of magnitude of the total number of fits minus one. Also, a condition is only listed in the report if there was at least one fit that satisfied it - no zeroes are entered.
Results for the Overall Best-Fit Solution. This section is a detailed analysis of the best solution that was found out of the total number of fits. This section mimics the output of an ordinary nonlinear regression report.

The combined percentage of singular and ill-conditioned solutions is less than or equal to the percentage of convergent solutions and the combined percentages of convergent solutions, evaluation failures, fits exceeding maximum number of iterations and inner loop failures equaling 100.

Dynamic Fit Profile Graph

To create a dynamic fit profile graph, make sure to select Create dynamic fit profile graph on the Graph Options panel of the Dynamic Fit Wizard before you click Finish. For more information, see “Setting Graph Options” on page 699. The graph that appears contains one plot of the base-10 logarithm of the minimum sum of squares of each fit versus the fit index. For this graph, the sum of squares data has been sorted from smallest to largest. The data only represents convergent fits.

A single column of the graph data for this graph is entered into the worksheet. Missing values in this data column indicate that the corresponding fit is perfect and so are not represented in the graph. In the rare event that all fits are perfect, the graph page is not produced and a message is displayed to explain the situation.
The reason for using logarithmic values is because sum-of-squares values typically differ over several orders of magnitude. This graph provides information on the complexity of the sum of squares surface in proceeding from the various starting parameters in the search ranges to obtaining the final parameters in the solution.
Editing Code

You can edit a regression equation by clicking the Edit Code button in the Regression Wizard or the Dynamic Fit Wizard. This opens the Functions dialog box. Regression equations can be selected from within the wizard, or opened from a notebook directly. You can also create new regression equations. Creating a new equation requires entry of all the code necessary to perform a regression. This chapter covers:
- Selecting an equation for editing (see page 706).
- Entering equation code (see page 710).
- Defining constants (see page 711).
- Entering variables (see page 711).
- Entering parameters code (see page 721).
- Entering code for parameter constraints and other options (see page 713).

About Regression Equations

Equations contain not only the regression model function, but other information needed by SigmaPlot to run a regression. All regression equations contain code defining the equations, parameter settings, variables, constraints, and other options used. To edit the code for an equation, you need to either open and edit an existing equation, or create a new equation.

Protected Code for Built-in Equations

All built-in equations provided in standard.jfl have protected portions of code which can be viewed and copied but not edited. However, you may use Add As to create a duplicate entry that can be edited, and you can also copy a built-in equation from the library to another notebook or section and edit it.
**Opening an Existing Equation**

You can open an equation by:

- Double-clicking an equation icon in a notebook window, or selecting the equation then clicking Open.
- Starting either the Regression Wizard or Dynamic Fit Wizard, then selecting the equation by category and name.

**Figure 17-1**
Opening an equation from the Notebook Manager

You can also double-click an equation in a notebook while the Regression Wizard is open to switch to that equation. Once an equation is opened, you can edit it by clicking the **Edit Code** button.
Creating a New Equation

If you require an equation that does not appear in the standard equation library, you can create a new equation using the Functions dialog box.

Figure 17-2
You can create equations of your own in the Function dialog box.

You can open the Functions dialog box by:
- Clicking the New button in the Regression Wizard.
- Choosing File menu New command, and selecting Regression Equation.
- Right-clicking in the Notebook Manager, and choosing New, Regression Equation from the shortcut menu.

A new equation document has no default settings for the equations, parameters, variables, constraints, or other options.

To create a new equation from within the Regression Wizard:

- On the Statistics menu click Regression Wizard.
- Click New to create a new equation. The Function dialog box appears.
To create an equation from the Notebook Manager:

- Right-click the section where you want the equation to go. If you want the equation to be created in a new section, right-click the notebook icon.

- On the shortcut menu, click New from the shortcut menu, and then click Equation. The Function dialog box appears.

Copying Equations

You can copy an existing equation from any notebook view to another, and modify it as desired.

Adding Equations as New Entries

To edit equations from within the Regression Wizard, and add them as new equations to the current library, click Add As button in the Function dialog box. The Add As dialog box appears, in which you can enter the equation name.

Entering Regression Equation Settings

To enter the settings for new equations, click the desired edit window in the Function dialog box and enter your settings.

Note: Open the Function dialog box by clicking New or Edit Code on the Regression Wizard. For more information, see “Viewing and Editing Code” in Chapter 16.
This section covers the minimum steps required to enter the code for a regression equation. For more information on entering the code for each section, see:

- Equations (see page 714).
- Variables (see page 717).
- Weight Variables (see page 719).
- Initial Parameters (see page 721).
- Constraints (see page 723).
- Other Options (see page 724).

**Adding Comments**

Place comments in the edit box by preceding them with an apostrophe (’), or a semicolon (;). You can also use apostrophes or semicolons to comment out equations instead of deleting them.


**Entering Equations**

To enter the code for the Equation section:

- Click in the **Equation** window and type the regression equation model, using the transform language operators and functions.

  The equation should contain all of the variables you plan to use as independent variables, as well as the name for the predicted dependent variable (which is not your y variable). You can use any valid variable name for your equation variables and parameters, but short, single letter names are recommended for the sake of simplicity. Omit the observed dependent variable name from the regression model. The observed dependent variable (typically your y variable) is used in the fit statement.

- Press the Enter key when finished with the regression equation model, then type the fit statement. The simplest form of the fit statement is: **fit f to y** Where f is the predicted dependent variable from the regression model, and y is the variable that will be defined as the observed dependent variable (typically the variable plotted as y in the worksheet).

  You can also define whether or not weighting is used. For more information, see “Weight Variables” on page 719.
**Example:** The code $f=m\times x+b$ fit $f$ to $y$ can be used as the model for the function $f$, and also defines $y$ as the observed dependent variable. In this example, $x$ is the independent variable, and $m$ and $b$ the equation parameters.

**Defining Constants**

Constants that appear in the equations can also be defined under the equations heading. If you decide that an equation parameter should be a constant rather than a parameter to be determined by the regression, define the value for that constant here, then make sure you don’t enter this value in the parameters section.

Constants defined here appear under the **Constants** option in **Equation Options** dialog box. For more information, see “Equation Options” in Chapter 16.

**Entering Variables**

Independent, dependent, and weighting variables are defined in the Variables section. One of the variables defined must be the observed values of the dependent variable: that is, the "unknown" variable to be solved for. The rest are the independent variables (predictor, or known variables) and an optional weighting variable.
To define your variables:

- Click in the Variables section and type the character or string you used for the first variable in your regression equation.

- Type an equal sign (=), then enter a range for the variable. Ranges can be any transform language function that produces a range, but typically is simply a worksheet column.

Note: The variable values used by the Regression Wizard and Dynamic Fit Wizard depend entirely on what are selected from the graph or worksheet; the values entered here are only used if the From Code data format is selected, or if the regression is run directly from the Function dialog box.

Repeat these steps for each variable in your equation. Up to ten independent variables can be defined, but you must define at least one variable for a regression equation to function. The curve fitter checks the variable definitions for errors and for consistency with the regression equation.

Figure 17-5
Entering the variable definitions

Example: To define \(x\) and \(y\) as the variables for the equation code \(f=m\times x+b\), fit \(f\) to \(y\) you could enter the code \(x=col(1)\), \(y=col(2)\) which defines an \(x\) variable as column 1 and a \(y\) variable as column 2, using these columns whenever the regression is run directly from the code.
Automatic Initial Parameter Estimation Functions

Any user-defined functions you plan on using to compute initial parameter estimates must be entered into the Variables section. For more information, see “Automatic Initial Parameter Estimation Functions” on page 713.

Entering Initial Parameters

Parameters are the equation coefficients and offset constants that you are trying to estimate in your equation model. The definitions or functions entered into the Parameters sections determine which variables are used as parameters in your equation model, and also their initial values for the curve fitter.

The curve fitter checks the parameter equations for errors and for consistency with the regression equations.

To enter initial parameter values:

- Click in the Initial Parameters section and type the name of the first parameter as it appears in your equation model, followed by an equals (=) sign.

- Enter the initial parameter value used by the curve fitter. Ideally, this should be as close to the real value as possible. This value can be numeric, or a function that computes a good guess for the parameter.

Using a function for the initial parameter value is called automatic parameter estimation. For more information, see “Automatic Initial Parameter Estimation Functions” on page 713.

Example: If your data for the equation code \( f=m \times x + b \), fit \( f \) to \( y \) appear to rise to the right and run through the origin, you could define your initial parameter as \( m=0.5, b=0 \). These are good initial guesses, since the \( m \) coefficient is the slope and the \( b \) constant is the \( y \)-intercept of a straight line.

Parameter Constraints

Parameter Constraints are completely optional. Use them to limit the parameter ranges to meaningful values for your particular problem.
Options

The Iterations, Step Size and Tolerance options sometimes can be used to improve or limit your curve fit. The default settings work for the large majority of cases, so you do not need to change these setting unless truly required. For more information, see “Other Options” on page 724.

Saving Equations

Once you are satisfied with the settings you have entered into the Function dialog box, you can save the equation. Clicking OK automatically updates the equation entry in the current notebook or regression library. If you created a new equation, you are prompted to name it before it is added to your notebook. If you are editing an existing equation, you can click Add As to add the code as a new equation to the current library or notebook. In order to save your changes to disk, you must also save the notebook or library. Changes to your current regression library are automatically saved when you close the wizard. You can also save changes before you close the wizard by clicking Save. Click Save As to save the regression library to a new file. If your equation is part of a visible notebook, you can save changes by saving the notebook using the Save button or the File menu Save or Save As commands.

Note that when an equation is edited using the Equation Options dialog box, all the changes are also automatically updated and saved.

Saving Equation Copies with Results

You can save equations along with the targeted page or worksheet while saving your regression results. Just check the Add Equation to Notebook option in the results panel, and a copy of the equation used is added to the same section as reports and other results.

Equations

The Equation section of the Function dialog box defines the model used to perform the regression as well as the names of the variables and parameters used. The regression equation code is defined using the transform language operators and functions. The equation must contain all of the variables you wish to use. These include
all independent variables, the predicted dependent variable, and observed dependent variable. All parameters and constants used are also defined here. The Equation code consists of two required components:

- The **equation model** describing the function(s) to be fit to the data.
- The **fit statement**, which defines the predicted dependent variable and, optionally, the name of a weighting variable.

The independent variable and parameters are defined within the equation function. Also, any constants that are used must also be defined under the Equations section.

### Defining the Equation Model

The equation model sets the predicted variable (called *f* in all built-in functions) to be a function of one or more independent variables (called *x* in the built-in two-dimensional Cartesian functions) and various unknown coefficients, called parameters.

The model may be described by more than one function. For example, the following three equations define a dependent variable *f*, which is a constant for *x* < 1 and a straight line for *x* ≥ 1.

\[
f = \begin{cases} 
\text{constant (x)} & \text{if } (x < 1) \\
\text{line (x)} & \text{if } (x \geq 1)
\end{cases}
\]

- constant (x) = c
- line (x) = a + b * x

### Number of Parameters

You can enter and define up to 25 parameters, but a large number of parameters will slow down the regression process. You can determine if you are using too many parameters by examining the **parameter dependencies** of your regression results. Dependencies near 1.0 (0.999 for example) indicate that the equation is overparameterized, and that you can probably remove one or more dependent parameters. For more information, see “Interpreting Fit Results” in Chapter 16.

### Defining the Fit Statement

The most general form of the fit statement is:

\[
\text{fit f to y with weight w}
\]
Chapter 17

Identifies the predicted dependent variable to be fit to the data in the set of equations, as defined by the model.

\( y \) is the observed dependent variable, later defined in the Variables section, whose value is generally determined from a worksheet column.

\( w \) is the optional weight variable, also defined in the Variables section.

Any valid variable name can be used in place of \( f, y, \) and \( w \).

If the optional weighting variable is not used, the fit statement has the form:

\[
\text{fit } f \text{ to } y
\]

**Defining Constants**

Define constants by setting one of the parameters of the equation model to a value, using the form

\[
\text{constant=value}
\]

For example, one commonly used constant is \( \pi \), defined as

\[
\pi=3.14159265359
\]

**Defining Alternate Fit Statements**

You can create alternate fit statements that call different weight variables. These statements appear as fit statements preceded by two single quotes ("", not a double quote).

For each weight variable you define, you can create a weighting option by adding commented fit statements to the equation window.

For example, an Equation window that reads:

\[
f=a*\exp(-b*x)+c*\exp(-d*x)+g*\exp(-h*x)
\]

\[
\text{fit } f \text{ to } y \text{ with Weight Reciprocal}
\]

"\[
\text{fit } f \text{ to } y
\]

with weight Reciprocal would display the option Reciprocal in the Regressions Options dialog box Fit With Weight list.
**Variables**

Independent, dependent, and weighting variables are defined in the Variables edit window of the Function dialog box. One of the variables defined must be the observed values of the dependent variable; that is, the unknown variable to be solved for. The rest are the independent variables (predictor, or known variables) and any optional weighting variables. Up to ten independent variables can be defined.

To define your variables, select the Variables edit window, then type the variable definitions. You generally need to define at least two variables—one for the dependent variable data, and at least one for the independent variable data.

**Variable Definitions**

Variable definitions use the form:

```
variable = range
```

You can use any valid variable name, but short, single letter names are recommended for the sake of simplicity (for example, x and y). The range can either be the column number for the data associated with each variable, or a manually entered range.

Most typically, the range is data read from a worksheet. The curve fitter uses SigmaPlot’s transform language, so the notation for a column of data is:

```
col(column,top,bottom)
```

The column argument determines the column number or title. To use a column title for the column argument, enclose the column title in quotation marks. The top and bottom arguments specify the first and last row numbers and can be omitted. The default row numbers are 1 and the end of the column, respectively. If both are omitted, the entire column is used. For example, to define the variable x to be column 1, enter:

```
x = col(1)
```

Data may also be entered directly in the variables section. For example, you can define y and z variables by entering:

```
y = {1,2,4,8,16,32,64}
z = data(1,100)
```
This method can have some advantages. For example, in the example above the data function was used to automatically generate \( z \) values of 1 through 100, which is simpler than typing the numbers into the worksheet.

*Note:* The Regression Wizard generally ignores the default variable settings, although it requires valid variable definitions in order to evaluate an equation. Variables are redefined when the variables are selected from within the wizard. However, you can force the use of the hard-coded variable definitions, either by selecting From Code as the data source, or running the regression directly from the Function dialog box.

**Transform Language Operations**

You can use any transform language operator or function when defining a variable. For example:

\[
x = 10^\text{data(-2, log(10.8),0.5)}
\]

\[
y = ((\text{col(2)}-\text{col(2)}*\text{(0.277*col(1))^0.8}))*1.0e-12
\]

\[
z = 1/\text{sqrt(abs(col(3))})
\]

are all valid variable names.

**User-Defined Functions**

Any user-defined functions that are used later in the regression code must be defined in the Variables section.

**Concatenating Columns**

Constructor notation can be used to concatenate data sets. For example, you may want to fit an equation simultaneously to multiple y columns paired with one x column. If the x data is in column 1 and the y data is in columns 2 through 6, you can enter the following variable statements:

\[
x = \{\text{col (1), col (1), col (1), col (1), col (1)}\}
\]

\[
y = \{\text{col (2), col (3), col (4), col (5), col (6)}\}
\]
The variable x is then column 1 concatenated with itself four times, and variable y is the concatenation of columns 2 through 6.

If the function to be fit is f, then the fit statement

```
fit f to y
```

fits f to the dependent variable values in columns 2 through 6 for the independent variable values in column 1.

**Weight Variables**

Variables used to perform weighted regressions are known as weight variables. All weight variables must be defined along with other variables in the Variables window.

**Specifying the Weight Variable to Use**

The use of weighting is specified by the Equation section code, which can call weight variables defined under Variables. Weight variables are selected from the fit statement, using the syntax:

```
fit f to y with weight w
```

where w is the weight variable defined under Variables. For more information, see “Equations” on page 714. Generally, a weight variable is defined as the reciprocal of either the observed dependent variable or its square. For example, if y=col(2) is the observed dependent variable, the weighting variable can defined as 1/col(2) or as 1/col(2)^2. For more information, see “Example 2: Weighted Regression” in Chapter 18.

**Defining Optional Weight Variables**

You can define more than one possible weight variable, and select the one to use from the Equation Options dialog box. Simply create multiple weight variables, then create alternate fit statement entries selecting the different weight variables in the Equations window. For more information, see “Defining Alternate Fit Statements” on page 716.
When to Use Weighting

Least squares regressions assumes that the errors at all data points are equal. When the error variance is not homogeneous, weighting should be used. If variability increases with the dependent variable value, larger dependent variable values will have larger residuals. Large residuals will cause the squared residuals for large dependent variable values to overwhelm the small dependent variable value residuals. The total sum of squares will be sensitive only to the large dependent variable values, leading to an incorrect regression.

You may also need to weight the regression when there is a requirement for the curve to pass through some point. For example, the (0,0) data point can be heavily weighted to force the curve through the origin.

Note: If you use weighted least squares, the regression values are valid, but the statistical values produced for the curve are not.

The Weighting Process: Norm and Residuals Changes

The weight values are proportional to the reciprocals of the variances of the dependent variable. Weighting multiplies the corresponding squared term in the sum of squares, dividing the absolute value of the residual by its standard error. This causes all terms of the sum of squares to have a similar contribution, resulting in an improved regression.

For weighted least squares, the weights \( w \) are included in the sum of squares to be minimized:

\[
SS = \sum_{i=1}^{n} w_i \left( y_i - \hat{y}_i \right)^2
\]

When weighting is used, the norm that is computed and displayed in the Progress dialog box is

\[
\sqrt{SS}
\]

and includes the effect of weighting. The residuals computed are the weighted residuals.
**Initial Parameters**

The code under the Initial Parameters section of the Function dialog box specifies which equation coefficients and constants to vary and also sets the initial parameter values for the regression. To enter parameters, select the Initial Parameters window, then type the parameters definitions using the form:

```
parameter=initial value
```

All parameters must appear in the equation model. All equation unknowns not defined as variables or constants must be defined in Initial Parameters.

**Initial Parameter Values**

For the initial values, a "best guess" may speed up the regression process. If your equation is relatively simple (only two or three parameters), the initial parameter values may not be important. For more complex equations, however, good initial parameter values can be critical for a successful convergence to a solution.

**Automatic Parameter Estimation**

All built-in equations use a technique called *automatic parameter estimation*, which computes an approximation of the function parameters by analyzing the raw data. You can indicate the parameter value you wish to appear as the Automatic setting by typing two single quotes followed by the string Auto after the parameter setting. For example, entering the parameter line

```
a=max(y) ''Auto
```
tells the Equation Options dialog box to use \( \text{max}(y) \) as the Automatic parameter value for \( a \). For more information, see “Automatic Determination of Initial Parameters” below.
Automatic Determination of Initial Parameters

SigmaPlot automatically obtains estimates of the initial parameter values for all built-in equations found in Standard.jfl. For more information, see “About SigmaPlot’s User and Program Files” in Chapter 1. When automatic parameter estimation is used, you no longer have to enter static values for parameters yourself—the parameters determine their own values by analyzing the data.

Note: It is only important that the initial parameter values are robust among varying data sets, i.e., that in most cases the curve fitter converges to the correct solution. The estimated parameters only have to be a “best guess” (somewhere in the same ballpark as the real values, but not right next to them). You can create your own methods of parameter determination using the new transform function provided just for this purpose.

The general procedure is to smooth the data, if required, and then use functions specific to each equation to obtain the initial parameter estimates.

Consider the logistic function as an example. This function has the stretched s shape that changes gradually from a low value to a high value or vice versa. The three parameters for this function determine the high value \(a\), the \(x\) value at which the function is 50% of range of the function’s amplitude \(x_0\) and the width of the transition \(b\). As expressed in the transform language, the function is entered into the Equation window as \(f=a/(1+\exp(-(x-x_0)/b))\) fit \(f\) to \(y\). Noise in the data can lead to significant errors in the estimates of \(x_0\) and \(b\). Therefore, a smoothing algorithm is used to reduce the noise in the data and three functions are then used on the smoothed data to obtain the parameter estimates.

To estimate the parameter \(a\) the maximum use the \(y\) value. Use the \(x\) value at 50% of the amplitude to estimate \(x_0\), and the difference between the \(x\) values at 75% and 25% of the amplitude is used to estimate \(b\). As entered into the Initial Parameters window, these are:

\[
a=\text{max}(y)
\]

"Auto \(b=\text{xwtr}(x,y,.5)/4\)

"Auto \(x_0=\text{x50}(x,y,.5)\)

"Auto

Both the fwhm and xwtr transform functions have been specifically designed to aid the estimation of function parameters. For more information, see “Example 1: Curve Fitting Pitfalls” in Chapter 18.
The "Auto" comment that follows each parameter is used to identify that parameter value as the Automatic setting from within the Equation Options dialog box. Note that these values may not at all reflect the final values, but they are approximate enough to prevent the curve fitter from finding false or invalid results.

Alternate Parameter Values

You can insert alternate parameter values that appear in the Equation Options dialog box Initial Parameter Values drop-down lists. To add an alternate, insert a new line after the default value, then type two single quotes, followed by the alternate parameter setting. For example, the two lines d=-F(0)[2] "Auto, "d=0.01 cause an alternate value of 0.01 to appear in the Equation Options dialog box Initial Parameter Values drop-down list for d. Alternate parameter values are automatically inserted when different parameter values are entered into the Equation Options dialog box.

Constraints

Linear parameter constraints are defined under the Constraints section. A maximum of 25 constraints can be entered. Use of constraints is optional. Constraints are used to set limits and conditions for parameter values, restricting the regression search range and improving regression speed and accuracy. Liberal use of constraints in problems which have a relatively large number of parameters is a convenient way to guide the regression and avoid searching in unrealistic regions of parameter space.

Valid Constraints

A constraint must be a linear equation of the parameters using an equality (=) or inequality (< or >). For example, the following constraints for the parameters a, b, c, d, and e are valid:

\[
\begin{align*}
a &< 1 \\
10b + c/20 &> 2 \\
d - e &= 15 \\
a &> b + c + d + e
\end{align*}
\]
whereas

\[ a^*x < 1 \]

is illegal since \( x \) is not a constant, and

\[ b + c^2 > 4 \]
\[ d*e = 1 \]

are illegal because they are nonlinear.

Tip: Although the curve fitter checks the constraints for consistency, you should still examine your constraint definitions before executing the regression. For example, the two constraints:

\[ a < 1 \]
\[ a > 2 \]

are inconsistent. The parameter \( a \) cannot be both less than 1 and greater than 2. If you execute a regression with inconsistent constraints, a message appears in the Results dialog box warning you to check your constraint equations.

Other Options

You can use several special options to influence regression operation. The different options can be used to speed up or improve the regression process, but their use is optional. The three options are:

- **Iterations**, the maximum number of repeated regression attempts. For more information, see “Iterations” below.
- **Step Size**, the limit of the initial change in parameter values used by the regression as it tries different parameter values. For more information, see “Step Size” below.
- **Tolerance**, one of the conditions that must be met to end the regression process. For more information, see “Tolerance” below.

When the absolute value of the difference between the norm of the residuals from one iteration to the next is less than the tolerance, this condition is satisfied and the regression considered to be complete. Options are entered in the Options section edit boxes. The default values are displayed for new equations. These settings will work for
most cases, but can be changed to overcome any problems encountered with the regression, or to perform other tasks, such as evaluating parameter estimation.

**Iterations**

Setting the number of iterations, or the maximum number of repeated regression attempts, is useful if you do not want to regression to proceed beyond a certain number of iterations, or if the regression exceeds the default number of iterations.

The default iteration value is 1.00. To change the number of iterations, simply enter the maximum number of iterations in the Iterations edit box.

**Evaluating Parameter Values Using 0 Iterations**

Iterations must be non-negative. However, setting Iterations to 0 causes no iterations occur; instead, the regression evaluates the function at all values of the independent variables using the parameter values entered under the Initial Parameters section and returns the results.

If you are trying to evaluate the effectiveness of automatic parameter estimation function, setting Iterations to 0 allows you to view what initial parameter values were computed by your algorithms.

Using zero iterations can be very useful for evaluating the effect of changes in parameter values. For example, once you have determined the parameters using the regression, you can enter these values plus or minus a percentage, run the regression with zero iterations, then graph the function results to view the effect of the parameter changes.

**Step Size**

The initial step size used by the Marquardt-Levenberg algorithm is controlled by the Step Size option. The value of the Step Size option is only indirectly related to changes in the parameters, so only relative changes to the step size value are important.

The default step size value is 100. To change the step size value, type a new value into the edit box. The step size number equals the largest step size allowed when changing parameter values. Changing the step size to a much smaller number can be used to prevent the curve fitter from taking large initial steps when searching around suspected minima.
For more information, see “Example 1: Curve Fitting Pitfalls” in Chapter 18.
If you are familiar with this algorithm, step size is the inverse of the Marquardt parameter.

**Tolerance**

The Tolerance option controls the conditions that must be met in order to end the regression process. When the absolute value of the difference between the norm of the residuals from one iteration to the next is less than the tolerance, the regression is considered to be complete.

The curve fitter uses two stopping criteria:

- When the absolute value of the difference between the norm of the residuals (square root of the sum of squares of the residuals), from one iteration to the next, is less than the tolerance value, the iteration stops.
- When all parameter values stop changing in all significant places, the regression stops.

When the tolerance condition has been met, a minimum has usually been found.

The default value for tolerance is 1.0e-10. To change the tolerance value, type the required value in the Tolerance edit box. The tolerance number sets the value that must be met to end the iterations.

More precise parameter values can be obtained by decreasing the tolerance value. If there is a sharp sum of squares response surface near the minimum, then decreasing the tolerance from the default value will have little effect.

However, if the response surface is shallow about the minimum (indicating a large variability for one or more of the parameters), then decreasing tolerance can result in large changes to parameter values. For more information, see “Example 1: Curve Fitting Pitfalls” in Chapter 18.
Example 1: Curve Fitting Pitfalls

This example demonstrates some of the problems that can be encountered during nonlinear regression fits.

Peaks in chromatograph data are sometimes fit with sums of Gaussian or Lorentzian distributions. A simplified form of the Lorentzian distribution is:

\[ y = \frac{1}{1 + (x - x_0)^2} \quad -\infty < x < \infty \]

where \( x_0 \) is the location of the peak value.

- Open the Pitfalls worksheet and graph by double-clicking the Pitfalls Graph in the Nonlin.jnb notebook. Note the positions of data points on the curve.

- Open the Simplified Lorentzian regression equation by double-clicking it in the Regression Examples notebook. The Regression Wizard opens and displays the variables panel.

- Click one of the symbols on the graph so that the selected Variables are Columns 1 and 2.

The object is to determine the peak location \( x_0 \) for the data. Since this data was generated from the Lorentzian function above using \( x_0 = 0 \), the regression should always find the parameter value \( x_0 = 0 \).

How the Curve Fitter Finds the Peak Value Location

To find \( x_0 \), the curve fitter computes the sum of squares function:
as a function of the parameter \( x_0 \). The curve fitter then searches this parameter space for any \( x_0 \) value where a relative minimum exists.

The sum of squares for \( x_0 \) has two minima—an absolute minimum at \( x_0 = 0 \) and a relative minimum at \( x_0 = 4.03 \)—and a maximum at 2.5. As the curve fitter searches for a minimum, it may stumble upon the local minimum and return an incorrect result. If you start exactly at a maximum, the curve fitter may also remain there.

**Figure 18-1**
The plot of the sum of squares for the location of the peak value of a Simplified Lorentzian Distribution

\[
\sum_{j=1}^{3} \left[ f(x_j) - y_j \right]^2
\]

**False convergence caused by a small step size.** Click Options. Note that the value of \( x_0 \) is set to 1000, and the Step Size option is set to 0.000001.
Click OK, then click Next.

Using the large initial value of $x_0$ and a small step size, the curve fitter takes one small step, finds that there is no change in the sum of squares using the default value for tolerance (0.0001), and declares the tolerance condition is satisfied. The very low slope in the sum of squares at this large $x_0$ value causes the regression to stop.

**False convergence caused by a large step size and tolerance.** Click Back, then click Options. Open the Step Size list and select 100; this is the default step size value.
Chapter 18

Figure 18-4
Selecting a step size of 100

Click OK, then click Next. The curve fitter takes a large step, reaches negative \( x_0 \) values, and finds a value \( x_0 = -546 \) for which the tolerance is satisfied.

Figure 18-5
The results using a step size of 100

The sum of squares function asymptotically approaches the same value for both large positive and negative values of \( x \), so the difference of the sum of squares for \( x_0 = 1000 \) and \( x_0 = -546 \) is within the default value for the tolerance.

- **Reducing tolerance for a successful convergence.** Click Back, then click Options again. Change the Tolerance value to 0.000001, then click OK.
Figure 18-6
Changing the tolerance to 0.0001

Click Next. The regression continues beyond $x_0 = -546$ and successfully finds the absolute minimum at $x_0 = 0$.

Summary

When you used a poor initial parameter value, you needed to use a large initial step size to get the regression started, and you had to decrease the tolerance to keep the regression from stopping prematurely. Poor initial parameters can arise also when using the Automatic method of determining initial parameters as well as when constant values are used.

You will now use initial parameter values which result in convergence to a local minimum and a local maximum.

Finding a local minimum Click Back, then click the Options button.
Chapter 18

Figure 18-7
The results of using a step size of 100 and tolerance of 0.000001

In the Tolerance drop-down list, change the tolerance back to the default value of 0.0001, then click OK.

Click Next. The regression converges to $x_0 = 4.03$, which corresponds to the local minimum.
In this example, you know that a local minimum was found by viewing the sum of squares function for the single parameter $x_0$. However, when there are many parameters, it is usually not obvious whether an absolute minimum or a local minimum has been found.

Finding a local maximum Click Back, then click Options. Change the initial parameter value of $x_0$ to 2.5, then click OK.

Click Next. Because this initial parameter value happens to correspond to the maximum of the sum of squares function, the regression stops immediately. The slope is zero within the default tolerance, so the curve fitter falsely determines that a minimum has been found.

Finding the absolute minimum Click Back, then click Options. Change the initial value of $x_0$ to 2.0.
Click OK to close the Options dialog box, then click Next to execute the regression. The initial parameter value is reasonably close to the optimum value, so the regression converges to the correct value \( x_0 = 0.0 \).

Figure 18-11
Nonlinear regression results

These last examples demonstrate how the curve fitter can find a local minimum and even a local maximum using poorly chosen initial parameter values.

Example 2: Weighted Regression

The data obtained from the lung washout of intravenously injected dissolved Xenon 133 is graphed in the Weighted Graph in the Weighted Regression section of the Nonlin.jnb notebook.

Open the Weighted worksheet and graph by double-clicking the graph page icon in the Weighted section of the Nonlin.jnb notebook.

The data in the graph displays the compartmental behavior of Xenon in the body. Three behaviors are seen: the wash-in from the blood (rapid rise), the washout from the lung (rapid decrease), and the recirculation of Xenon shunted past the lung (slow decrease).
The sum of three exponentials (a triple exponential) is used as a compartmental model:

\[ \text{CountRate} = a_1 e^{-t/t_1} + a_2 e^{-t/t_2} + a_3 e^{-t/t_3} \]

Least squares curve fitting assumes that the standard deviations of all data points are equal. However, the standard deviation for radioactive decay data increases with the count rate. Radioactive decay data is characterized by a Poisson random process, for which the mean and the variance are equal. Weighting must be used to account for the non-uniform variability in the data. These weights are the reciprocal of the variance of the data.

For a Poisson process, the variance equals the mean. You can use the inverse of the measurements as an estimate of the weights. The initial weighting variable only needs to be proportional to the inverse variance.

- Double-click the Weighted Triple Exponential equation in the Weighted Regression section.
Figure 18-13
The weighted triple exponential equation

Click Edit Code, and examine the Variable value:

\[ w = \frac{1}{\text{col}^2} \]

This sets \( w \) to equal the reciprocal of the data in column 2. Click Cancel to close the dialog box.

- Click the datapoints to select your variables. To use the \( w \) variable as the weighting variable, click Options, and select \( w \) as the Fit With Weight value.

Figure 18-14
Selecting a weight variable

Click OK to close the dialog box.

- Click Next to run the regression. The curve fitter finds a solution quickly.

- Click Finish to complete the regression.
What would be the result without weighting? Press F5, then click Next and click Options. Change the weighting to (none), then click OK.

Click Finish. The curve fitter goes through many more iterations. When it is completed, view the Weighted graph page.

The graph shows the nonlinear regression results with and without weighting. The weighted results fit the very small recirculation data (represented by the third exponential) quite well. However, when weighting is not used, the curve fitter ignored the relatively small values in the recirculation portion of the data, resulting in a poor fit.

Figure 18-15
Comparing the function results of weighted and unweighted nonlinear regression fits

Example 3: Piecewise Continuous Function

The Piecewise section of SigmaPlot fit functions in standard.jfl contains piecewise linear functions. For more information, see “About SigmaPlot’s User and Program Files” in Chapter 1. But these functions need not be linear. This is an example of a function that is a piecewise combination of a straight line and a one-minus-exponential function.

The piecewise line-exponential function consists of two functions - straight line and a one-minus-exponential - defined before and after the join-point \( x_0 \).
\[ f_1 = a_1 + b_1 \times x \quad 0 < x \leq x_0 \]
\[ f_2 = a_2 + b_2 \times (1 - \exp(-c(x - x_0))) \quad x_0 < x < \infty \]

To make the piecewise function you want the two conditions:

- The functions are equal at \( x_0 \)
  \[ f_1(x_0) = f_2(x_0) \]
- The slopes of the functions are equal at \( x_0 \)
  \[ f_1'(x_0) = f_2'(x_0) \]

The first and second condition give respectively
\[ a_1 + b_1 \times x_0 = a_2 \]
\[ b_1 = b_2 \times c \]

Using these conditions you can rewrite the equations as
\[ f_1 = a_1 + b_1 \times x \quad 0 < x \leq x_0 \]
\[ f_2 = (a_1 + b_1 \times x_0) + (b_1/c) \times (1 - \exp(-c \times (x - x_0))) \quad x_0 < x < \infty \]

- Double-click Piecewise Continuous Graph in the section Piecewise Continuous section of the nonlin.jnb notebook in the Samples directory of SigmaPlot’s Program Files. For more information, see “About SigmaPlot’s User and Program Files” in Chapter 1. The Piecewise Continuous graph page and worksheet appear. The data appears to be described by a straight line followed by a curve to a plateau.

- View the notebook and double-click the Piecewise Continuous Regression equation. The Regression Wizard - Variables panel appears.
Figure 18-16
The Piecewise Continuous Regression Equation,

- View the graph page and select a data point on the graph (x:Column1, y:Column2), then click Next to run the regression. The equation with parameters $a_1$, $b_1$, $x_0$ and $c$ is fit to the data.

- Click Finish and view the graph page. A smooth transition at the join-point $= 5.3$ between the line and the one-minus-exponential is shown.
Example 4: Using Dependencies

This example demonstrates the use of dependencies to determine when the data has been “over-parameterized”. Too many parameters result in dependencies very near 1.0. If a mathematical model contains too many parameters, a less complex model may be found that adequately describes the data. Sums of exponentials are commonly used to characterize the dynamic behavior of compartmental models. In this example you model data generated from the sum of two exponentials with one, two, and three exponential models, and you examine the parameter dependencies in each case.
Dependencies Over a Restricted Range

The first fit is made to data over a restricted range, which does not reveal the true nature of the data.

- Open the Dependencies worksheet and graph by double-clicking the graph page icon in the Dependencies section of the Regression Examples notebook. The data generated from the sum of two exponentials:

\[ f(t) = 0.9e^{-t} + 0.1e^{-0.2t} \]

is graphed on a semi-logarithmic scale over the range 0 to 3.

Figure 18-18
The dependencies graph showing the data for the sum of two exponentials

Although the data is slightly curved, the "break" associated with the two distinct exponentials is not obvious.

- Right-click the curve on the shortcut menu click Fit Curve to open the Regression Wizard.

- Select the Exponential Decay category and the Single, 2 Parameter exponential decay equation, then click Next twice.
The results show that the dependencies are not near 1.0, indicating that the single exponential parameters, $a_1$ and $b_1$, are not dependent on one another.

Figure 18-20
The results of fitting the data to a single exponential

- Click Back twice, and change the equation to the Double, 4 parameter exponential decay equation. Click Next twice.
The results show that the parameter dependencies for the double exponential are acceptable, indicating that they are unlikely to be dependent, and that using a double exponential produces a better fit (the curve fitter in fact finds the exact parameter values used to generate the data, producing a perfect fit with an \( R^2 \) of 1).

**Dependencies Over an Extended Range**

- Click Back twice, and change the equation to a Triple, 6 Parameter exponential decay equation. Click Next twice.
The results show that the parameter dependencies for \( a, b, c, \) and \( d \) are 1.00, suggesting that the three exponential model is too complex and that one exponential may be eliminated. Click Cancel when finished.

**Example 5: Solving Nonlinear Equations**

You can use the nonlinear regression to solve nonlinear equations. For example, given a \( y \) value in a nonlinear equation, you can use the nonlinear regression to solve for the \( x \) value by making the \( x \) value an unknown parameter.

Consider the problem of finding the LD\(_{50}\) of a dose response experiment. The LD\(_{50}\) is the function of the four parameter logistic equation:
where $x$ is the dose and $f(x)$ is the response, then using nonlinear regression, you can find the value for $x$ where:

$$50 = \frac{a_1}{1 + e^{b(x-c)}} + d$$

Open the Solving Nonlinear Equations worksheet and graph file by double-clicking the graph page icon in the Solving Nonlinear Equations section of the Nonlin.jnb notebook. Note that the value for $x$ at $y = 50$ appears to be approximately 150.

Figure 18-25
The Solving Nonlinear Equations Graph, a four parameter logistic curve

Double-click the Solving Nonlinear Equation and click Edit Code.
Examine the regression statements. Note that \( x \) is a parameter, \( y = 0 \), and the fit equation is modified:

\[ f = \frac{p1}{1 + \exp(p2*(x - p3))} + p4 - 50 \]

Since you are fitting \( f \) to \( y = 0 \), these statements effectively solve the original problem for \( x \) when \( y = 50 \). The values for parameters \( a, b, c, \) and \( d \) were obtained by fitting the four parameter logistic equation to a given set of dose response data.

Click Finish to execute the regression. The parameter solution is the unknown \( x \). For this example, \( x \) is approximately 149.5.
Example 6: Multiple Function Nonlinear Regression

You can use the Regression Wizard to fit more than one function at a time. This process involves combining your data into additional columns, then creating a third column which identifies the original data sets.

This example fits three separate equations to three data sets.

\[
\begin{align*}
    f_1(x) &= \frac{t \left( \frac{x}{E_1} \right)^n}{1 + \left( \frac{x}{E_1} \right)^n}, \\
    f_2(x) &= \frac{t \left( \frac{x}{E_2} \right)^n}{1 + \left( \frac{x}{E_2} \right)^n}, \\
    f_3(x) &= \frac{t \left( \frac{x}{E_3} \right)^n}{1 + \left( \frac{x}{E_3} \right)^n}
\end{align*}
\]

Open the Multiple Function worksheet and graph by double-clicking the graph page icon in the Multiple Function section of the Nonlin.jnb notebook. The data points are for three dose responses.

Columns 1 and 2 hold the combined data for the three curves. Column 3 is used to identify the three different data sets. A 0 corresponds to the first dataset, 1 to the second, and 2 to the third.
Double-click the Multiple Functions Equation. The Regression Wizard opens with the variables panel displayed. Click Edit Code.

Figure 18-29
The multiple function statements
Examine the fit statements. The fit equation is an if statement which uses different equations depending on the value of d, which is the data set identifier variable. If \( d = 0 \), the data is fit to f1; if \( d = 1 \), the data is fit to f2; and if \( d = 2 \), the data is fit to f3.

The functions share the \( T \) and \( n \) parameters, but have individual \( E \) parameters of \( E_1 \), \( E_2 \), and \( E_3 \).

Click Run to execute the regression. The fit proceeds slowly but fits each data set to the separate equation. Click Next to ensure that the Predicted function results are saved to the worksheet, then Next again and make sure no graph is being created. Click Finish to end the fit.

To graph the results, you need to create a plot of the predicted results. View the page and select the graph, then create a straight line plot of rows 1-12 of column 1 versus rows 1-12 of the predicted results column.

Figure 18-30
Creating a plot of a restricted data range

Create two more line plots of rows 13-23 and 24-34. The results plots appear as three separate curves.
Example 7: Advanced Nonlinear Regression

Consider the function:

\[ f = 1 - e^{-\frac{a(b+cx)}{x+a}} \]

When fitted to the data in columns 1 and 2 in the Advanced Techniques worksheet, this equation presents several problems:

- Parameter identifiability.
- Very large x values.
- Very large y error value range.

These problems are outlined and solved below.

If you want to view the regression functions for this equation, open the Advanced Techniques worksheet and graph in the Advanced Techniques section of the Nonlin.jnb notebook. Double-click the Advanced Techniques Equation to open the Regression Wizard. If you want to run the equation, use the graph of the transformed data.
**Overparameterized Equations**

The equation has four parameters, $a$, $b$, $c$, and $d$. The numerator in the exponential:

$$-dx(b+cx)$$

can have identical values for an infinite number of possible parameter combinations. For example, the parameter values:

$b = c = 1$ and $d = 2$

and the values:

$b = c = 2$ and $d = 1$

result in identical numerator terms.

The curve fitter cannot find a unique set of parameters. The parameters are not uniquely identifiable, as indicated by the large values for variance inflation factor (VIF), and dependency values near 1.0.

The solution to this problem is to multiply the $d$ parameter with the other terms to create the equation:

$$f = 1 - e^{-\frac{x(d(b+cx))}{x+d}}$$

then treat the $db$ and $dc$ terms as single parameters. This reduces the number of parameters to three.

**Scaling Large Variable Values**

The data used for the fit has enormous $x$ values, around a value of $1 \times 10^{24}$ (see column 1 in the worksheet above). These $x$ values appear in the argument of an exponential which is limited to about $\pm 700$, which is much smaller than $10^{24}$. However, when the curve fitter tries to find the parameter values which are multiplied with $x$, it does not try to keep the argument value within $\pm 700$. Instead, when the curve fitter varies the parameters, it overflows and underflows the argument range, and does not change the parameter values.

The solution to this problem is to scale the $x$ variable and redefine some of the parameters. Multiply and divide each $x$ value by $1 \times 10^{24}$ to get:
If you let $X = x(10^{-24})$, then the equation becomes:

$$f = 1 - e^{-\frac{-X(10^{-24} x)}{X + 10^{-24} a}}$$

If you let $CD = 10^{24} dc$ and $A = 10^{-24} a$, the resulting scaled equation is simplified to:

$$f = 1 - e^{-\frac{-X(db + CDY)}{X + A}}$$

The exponent argument now does not cause underflows and overflows.

The graph of the transformed $x$ data is displayed below the original data.
Small Independent Variable Values: Weighting for Non-Uniform Errors

The y values for the data range from very small values to very large values. However, for this problem, we know that the y values do not have the same errors - smaller y values have smaller errors.

The curve fitter fits the data by minimizing the sum of the squares of the residuals. Because the squares of the residuals extend over an even larger range than the data, small residual squared numbers are essentially ignored.

The solution to this non-uniform error problem is to use weighting, so that all residual squared terms are approximately the same size.

Fitting with a weighting variable of $1/y^2$ (the inverse of y squared), which is proportional to the inverse of the variance of the y data, produces a better fit for low y value data.

To see the results of the regression without weighting, open the Options dialog box and change the weighting to (none) before finishing.
Figure 18-32
The graph showing the results of weighted and unweighted nonlinear regressions
OLE Automation is a technology that lets other applications, development tools, and macro languages use a program. Using SigmaPlot Automation, you can integrate SigmaPlot with the applications you have developed. Automation can also be an effective tool to customize or automate frequent tasks you want to perform.

Automation uses objects to manipulate a program. Objects are the fundamental building block of macros; nearly all macro programs involve modifying objects. Every item in SigmaPlot - graphs, worksheets, axes, tick marks, reports, notebooks, and so on - can be represented by an object.

SigmaPlot uses a VBA®-like macro language to access automation internally. For more information, see “Recording Macros” on page 519.

About Objects and Collections

An object represents any type of identifiable item in SigmaPlot. Graphs, axes, notebooks, worksheets, and worksheet columns are all objects.

A collection is an object that contains several other objects, usually of the same type; for example, all the items in a notebook are contained in a single collection object. Collections can have methods and properties that affect the all objects in the collection.

Use properties and methods to modify objects and collections of objects. To specify the properties and methods for an object that is part of a collection, you need to return that individual object from the collection first.

About Properties

A property is a setting or other attribute of an object. Think of a property as an "adjective." For example, properties of a graph include the size, location, type and style of plot, and the data that is plotted.
To change the settings of an object, change the properties settings. Properties are also used to access the objects that are below the current object in the hierarchy.

To change a property setting, type the object reference followed with a period, then type the property name, an equal sign (=), and the property value.

Example

Set Notebook.Title = "My Notebook"

Sets the name of the referenced SigmaPlot notebook to "My Notebook".

Note that some properties cannot be set, and only retrieved. The Help topic for each property indicates whether you can both set and retrieve that property (read-write), only retrieve the property (read-only), or only set the property (write-only).

You can get information about an object by returning the values of its properties.

Example

Set CurrentDoc = ActiveDocument.NotebookItems(3)

The fourth item in the current notebook (specified by ActiveDocument) is assigned to the variable CurrentDoc (item counts start with 0).

About Methods

A Method is an action that can be performed on or by an object. Think of methods as verbs. For example, the WorksheetEditItem object has Copy and Clear methods.

Methods can have parameters that specify the action (adverbs).

Example

Notebooks(0).NotebookItems(2).Close(True)

This example closes the second item in the NotebookItems collection object while saving it first. Note that the NotebookItems collection is selected using the Notebooks object NotebookItems property.
Returning Objects

In order to work with an object, you must be able to define the specific object by returning it. In general, most objects are returned using a property of the object above it in the object tree.

Returning Objects from Collections

Other objects are returned by specifying a single object from a collection. Once you define the collection, you can return a specific object by using an index value (as you would with an array).

Set Worksheet = Notebooks("My Notebook").NotebookItems.Item(2)

The collection index value returns the notebook "My Notebook" from the Notebooks collection, then the Item property and index number returns the third item from the NotebookItems collection as the variable Worksheet.

The Notebooks collection contains a list of all the open notebooks in SigmaPlot, and the NotebookItems collection contains all items in the specified notebook.

Defining Variables

You can also return and use objects by defining the object to be a variable, generally using the Dim (dimension) statement.

Although you can implicitly declare variables just by using the variable for the first time, you can avoid bugs caused by typos using Option Explicit. For example, the script:

Option Explicit

Sub Main
  Dim ItemCount
  Dim SPWorksheets$()
  ItemCount = ActiveDocument.NotebookItems.Count
  ReDim SPWorksheets$(ItemCount)
  Dim SPItems
  Set SPItems = ActiveDocument.NotebookItems
  Dim Index
Index = 0
Dim Item
For Each Item In SPItems
If SPItems(Index).ItemType = 1 Then
    SPWorksheets$(Index) = SPItems(Index).Name
End If
Index = Index + 1
Next Item

Begin Dialog UserDialog 320,119, "Worksheets in Active Notebook" %GRID:10,7,1,1
    OKButton 210,14,90,21
    ListBox 20,14,170,91,SPWorksheets(), ListBox 1
End Dialog
Dim dlg As UserDialog
Dialog dlg
End Sub

Uses the Dim (Dimension) statement to define several variables, and uses the Set instruction to define a declared variable as an object.
Transform Function Reference

SigmaPlot 10.0 provides many predefined functions, including arithmetic, statistical, trigonometric, and number-generating functions. In addition, you can define functions of your own.

Function Arguments

Function arguments are placed in parentheses following the function name, separated by commas. Arguments must be typed in the sequence shown for each function.

You must provide the required arguments for each function first, followed by any optional arguments desired. Any omitted optional arguments are set to the default value. Optional arguments are always omitted from right to left. If only one argument is omitted, it will be the last argument. If two are omitted, the last two arguments are set to the default value.

You can use a missing value (i.e., 0/0) as a placeholder to omit an argument.

Example

The col function has three arguments: column, top, and bottom. Therefore, the syntax for the col function is: col(column,top,bottom)

The column number argument is required, but the first (top) and last (bottom) rows are optional, defaulting to row 1 as the first row and the last row with data for the last row.

col(2) returns the entirety of column 2.

col(2,5) returns column 2 from row 5 to the end of the column.

col(2,5,100) returns column 2 from row 5 to row 100.

col(2,0/0,50) returns column 2 from row 1 to the 50th row in the column.
User-Defined Functions

You can create any user-defined function, consisting of any expression in the transform language, and then refer to it by name.

For example, the following transform defines the function dist2pts, which returns the distance between two points: dist2pts(x1,y1,x2,y2) = \sqrt{(x2-x1)^2+(y2-y1)^2}.

You can then use this custom-defined function, instead of the expression to the right of the equal sign, in subsequent equations.

For example, to plot the distances between two sets of XY coordinates, with the first points stored in columns 1 and 2, and the second in columns 3 and 4, enter:

\[ \text{col(5)} = \text{dist2pts(col(1),col(2),col(3),col(4))} \]

The resulting distances are placed in column 5.

Transform Function Descriptions

You can modify and manipulate worksheet data by entering SigmaPlot’s extensive mathematical transformation language into the User-Defined Transform dialog box. Type transform instructions into the Edit Transform field. You can enter up to 32,000 characters. For more information, see “Entering Transforms” on page 553.

The following list groups transforms by function type. It is followed by an alphabetical reference containing complete descriptions of all transform functions and their syntax, with examples.

Worksheet Functions. These worksheet functions are used to specify cells and columns from the worksheet, either to read data from the worksheet for transformation, or to specify a destination for transform results.

- **block.** The block function returns a specified block of cells from the worksheet. See “block” on page 772.

- **blockheight, blockwidth.** The blockheight and blockwidth functions return a specified block of cells or block dimension from the worksheet. See “blockheight, blockwidth” on page 773.

- **cell.** The cell function returns a specific cell from the worksheet. See “cell” on page 773.

- **col.** The col function returns a worksheet column or portion of a column. See “col” on page 776.
**Transform Function Reference**

- **put into.** The put into function places variable or equation results in a worksheet column. See “put into” on page 807.

- **subblock.** The subblock function returns a specified block of cells from within another block. See “subblock” on page 816.

**Data Manipulation Functions.** The data manipulation functions are used to generate non-random data, and to sample, select, and sort data.

- **data.** The data function generates serial data. For more information, see “data” on page 779.

- **if.** The if function conditionally selects between two data sets. For more information, see “if” on page 789.

- **nth.** The nth function returns an incremental sampling of data. For more information, see “nth” on page 804.

- **sort.** The sort function rearranges data in ascending order. For more information, see “sort” on page 813.

**Trigonometric Functions.** SigmaPlot and SigmaStat provide a complete set of trigonometric functions.

- **arccos.** This function returns the arccosine, of the specified argument. For more information, see “arccos” on page 769.

- **arcsin.** This function returns the arcsine of the specified argument. For more information, see “arcsin” on page 769.

- **arctan.** This function returns the arctangent of the specified argument. For more information, see “arctan” on page 770.

- **cos.** This function returns the cosine of the specified argument. For more information, see “cos” on page 777.

- **sin.** This function returns the sine of the specified argument. For more information, see “sin” on page 811.

- **tan.** This function returns the tangent of the specified argument. For more information, see “tan” on page 818.

- **cosh.** This function returns the hyperbolic cosine of the specified argument. For more information, see “cosh” on page 778.

- **sinh.** This function returns the hyperbolic sine of the specified argument. For more information, see “sinh” on page 812.

- **tanh.** This function returns the hyperbolic tangent of the specified argument. For more information, see “tanh” on page 818.
**Numeric Functions.** The numeric functions perform a specific type of calculation on a number or range of numbers and returns the appropriate results.

- **abs.** The abs function returns the absolute value. For more information, see “abs” on page 767.
- **exp.** The exp function returns the values for e raised to the specified numbers. For more information, see “exp” on page 781.
- **factorial.** The factorial function returns the factorial for each specified number. For more information, see “factorial” on page 781.
- **mod.** The mod function returns the modulus, or remainder of division, for specified numerators and divisors. For more information, see “mod” on page 801.
- **ln.** The ln function returns the natural logarithm for the specified numbers. For more information, see “ln” on page 794.
- **log.** The log function returns the base 10 logarithm for the specified numbers. For more information, see “log” on page 795.
- **sqrt.** The sqrt function returns the square root for the specified numbers. For more information, see “sqrt” on page 814.

**Range Functions.** The following functions give information on ranges.

- **count.** The count function returns the number of numeric values in a range. For more information, see “count” on page 778.
- **missing.** The missing function returns the number of missing values and text strings in a range. For more information, see “missing” on page 801.
- **size.** The size function returns the number of data points in a range, including all numbers, missing values, and text strings. For more information, see “size” on page 813.

**Accumulation Functions.** The accumulation functions return values equal to the accumulated operation of the function.

- **diff.** The diff function returns the differences of the numbers in a range. For more information, see “diff” on page 779.
- **sum.** The sum function returns the cumulative sum of a range of numbers. For more information, see “sum” on page 817.
- **total.** The total function returns the value of the total sum of a range. For more information, see “total” on page 821.

**Random Generation Functions.** The two “random” number generating functions can be used to create a series of normally or uniformly distributed numbers.
Transform Function Reference

- **gaussian.** The Gaussian function is used to generate a series of normally (Gaussian or “bell” shaped) distributed numbers with a specified mean and standard deviation. For more information, see “gaussian” on page 787.
- **random.** The random function is used to generate a series of uniformly distributed numbers within a specified range. For more information, see “random” on page 807.

**Precision Functions.** The precision functions are used to convert numbers to whole numbers or to round off numbers.
- **int.** The int function converts numbers to integers. For more information, see “int” on page 791.
- **prec.** The prec function rounds numbers off to a specified number of significant digits. For more information, see “prec” on page 806.
- **round.** The round function rounds numbers off to a specified number of decimal places. For more information, see “round” on page 809.

**Statistical Functions.** The statistical functions perform statistical calculations on a range or ranges of numbers.
- **avg.** The avg function calculates the averages of corresponding numbers across ranges. It can be used to calculate the average across rows for worksheet columns. For more information, see “avg” on page 771.
- **max.** The max function returns the largest value in a range. For more information, see “max” on page 799.
- **min.** The min function returns the smallest value in a range. For more information, see “min” on page 800.
- **mean.** The mean function calculates the mean of a range. For more information, see “mean” on page 799.
- **runavg.** The runavg function produces a range of running averages. For more information, see “runavg” on page 810.
- **stddev.** The stddev function returns the standard deviation of a range. stderr The stderr function calculates the standard error of a range. For more information, see “stddev” on page 815.

**Area and Distance Functions.** These functions can be used to calculate the areas and distances specified by X,Y coordinates. Units are based on the units used for X and Y.
- **area.** The area function finds the area of a polygon described in X,Y coordinates. For more information, see “area” on page 771.
Chapter 20

- **distance.** The distance function calculates the distance of a line whose segments are described in X,Y coordinates. For more information, see “dist” on page 780.

- **partdist.** The partdist function calculates the distances from an initial X,Y coordinate to successive X,Y coordinates in a cumulative fashion. For more information, see “partdist” on page 805.

**Curve Fitting Functions.** These functions are designed to be used in conjunction with SigmaPlot’s nonlinear curve fitter, to allow automatic determination of initial equation parameter estimates from the source data. You can use these functions to develop your own parameter determination function by using the functions provided with the Standard Regression Equations library provided with SigmaPlot.

- **ape.** This function is used for the polynomials, rational polynomials and other functions which can be expressed as linear functions of the parameters. A linear least squares estimation procedure is used to obtain the parameter estimates. For more information, see “ape” on page 768.

- **dsinp.** This function returns an estimate of the phase in radians of damped sine functions. For more information, see “dsinp” on page 780.

- **fwhm.** This function returns the x width of a peak at half the peak’s maximum value for peak shaped functions. For more information, see “dsinp” on page 780.

- **inv.** The inv function generates the inverse matrix of an invertible square matrix provided as a block. For more information, see “inv” on page 792.

- **lowess.** The lowess algorithm is used to smooth noisy data. “Lowess” means *locally weighted regression*. Each point along the smooth curve is obtained from a regression of data points close to the curve point with the closest points more heavily weighted. For more information, see “lowess” on page 797.

- **lowpass.** The lowpass function returns smoothed y values from ranges of x and y variables, using an optional user-defined smoothing factor that uses FFT and IFFT. For more information, see “lowpass” on page 798.

- **sinp.** This function returns an estimate of the phase in radians of sinusoidal functions. For more information, see “sinp” on page 812.

- **x25.** This function returns the x value for the y value 25% of the distance from the minimum to the maximum of smoothed data for sigmoidal shaped functions. For more information, see “x25” on page 821.

- **x50.** This function returns the x value for the y value 50% of the distance from the minimum to the maximum of smoothed data for sigmoidal shaped functions. For more information, see “x50” on page 822.
- **x75.** This function returns the x value for the y value 75% of the distance from the minimum to the maximum of smoothed data for sigmoidal shaped functions. For more information, see “x75” on page 823.
- **xatymax.** This function returns the x value for the maximum y in the range of y coordinates for peak shaped functions. For more information, see “xatymax” on page 824.
- **xwtr.** This function returns x75-x25 for sigmoidal shaped functions. For more information, see “xwtr” on page 825.

**Miscellaneous Functions.** These functions are specialized functions which perform a variety of operations.

- **choose.** The choose function is the mathematical “n choose r” function. For more information, see “choose” on page 776.
- **histogram.** The histogram function generates a histogram from a range or column of data. For more information, see “histogram” on page 787.
- **interpolate.** The interpolate function performs linear interpolation between X,Y coordinates. For more information, see “interpolate” on page 792.
- **polynomial.** The polynomial function returns results for specified independent variables for a specified polynomial equation. For more information, see “polynomial” on page 805.
- **rgbcolor.** The rgbcolor(r,g,b) color function takes arguments r,g, and b between 0 and 255 and returns color to cells in the worksheet. For more information, see “rgbcolor” on page 809.

**Special Constructs.** Transform constructs are special structures that allow more complex procedures than functions.

- **for.** The for statement is a looping construct used for iterative processing. For more information, see “for” on page 785.
- **if...then...else.** The if...then...else construct proceeds along one of two possible series of procedures based on the results of a specified condition. For more information, see “if...then...else” on page 790.

**Fast Fourier Transform Functions.** Use these functions to remove noise from and smooth data using frequency-based filtering.

- **fft.** The fft function finds the frequency domain representation of your data. For more information, see “fft” on page 783.
Chapter 20

- **invfft.** The invfft function takes the inverse fft of the data produced by the fft to restore the data to its new filtered form. For more information, see “invfft” on page 794.

- **real.** The real function strips the real numbers out of a range of complex numbers. For more information, see “real” on page 808.

- **img.** The img function strips the imaginary numbers out of a range of complex numbers. For more information, see “imaginary (img)” on page 791.

- **complex.** The complex function converts a block of real and/or imaginary numbers into a range of complex numbers. For more information, see “complex” on page 777.

- **mulcpx.** The mulcpx function multiplies two ranges of complex numbers together. For more information, see “mulcpx” on page 802.

- **invcpx.** The invcpx takes the reciprocal of a range of complex numbers. For more information, see “invcpx” on page 793.

**Probability Functions.** Use these functions to compute and verify statistical measures such as significant probabilities, critical values of statistics, confidence intervals and histogram comparisons.

- **normdist.** This function is the cumulative normal (or Gaussian) distribution function. It returns the probability that a normal random variable is less than a specified independent variable value. For more information, see “normdist” on page 803.

- **norminv.** This function is the inverse cumulative normal (or Gaussian) distribution function. The probability that a normally distributed random variable is less than the return value is equal to the argument you specify. For more information, see “norminv” on page 804.

- **normden.** This function is the normal (or Gaussian) probability density function. The graph of this function is the familiar “bell curve”. It returns the value of the slope of the cumulative distribution function at the specified argument value. For more information, see “normden” on page 802.

- **chisquaredist.** This function is the cumulative chi-square distribution function. It returns the probability that a chi-square distributed random variable is less than a specified independent variable value. For more information, see “chisquaredist” on page 774.

- **chisquareinv.** This function is the inverse cumulative chi-square distribution function. The probability that a chi-square distributed random variable is less than
the return value is equal to the argument you specify. For more information, see “chisquareinv” on page 775.

- **chisquareden.** This function is the chi-square probability density function. It returns the value of the slope of the cumulative distribution function at the specified argument value. For more information, see “chisquareden” on page 774.

- **tdist.** This function is Student’s T-distribution function. It returns the probability that a T-distributed random variable is less than a specified independent variable value. For more information, see “tdist” on page 819.

- **tinv.** This function is the inverse of Student’s T-distribution function. The probability that a T-distributed random variable is less than the return value is equal to the argument you specify. For more information, see “tinv” on page 820.

- **tden.** This function is the T-distribution’s probability density function. It returns the value of the slope of the cumulative distribution function at the specified argument value. For more information, see “tden” on page 819.

- **fdist.** This function is the F-distribution function. It returns the probability that an F-distributed random variable is less than a specified independent variable value. For more information, see “fdist” on page 783.

- **finv.** This function is the inverse F-distribution function. The probability that an F-distributed random variable is less than the return value is equal to the argument you specify. For more information, see “finv” on page 784.

- **fden.** This function is the F-distribution’s probability density function. It returns the value of the slope of the cumulative distribution function at the specified argument value. For more information, see “fden” on page 782.

---

**abs**

The abs function returns the absolute value for each number in the specified range.

**Syntax**

```
abs(numbers)
```

The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value.
Example

The operation \( \text{col}(2) = \text{abs}(\text{col}(1)) \) places the absolute values of the data in column 1 in column 2.

ape

The ape function is used for the polynomials, rational polynomials and other functions which can be expressed as linear functions of the parameters. A linear least squares estimation procedure is used to obtain the parameter estimates. The ape function is used to automatically generate the initial parameter estimates for SigmaPlot’s nonlinear curve fitter from the equation provided.

Syntax

\[
\text{ape}(x \text{ range}, y \text{ range}, n, m, s, f)
\]

The \( x \text{ range} \) and \( y \text{ range} \) arguments specify the independent and dependent variables, or functions of them (e.g., \( \ln(x) \)). Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. \( x \text{ range} \) and \( y \text{ range} \) must be the same size.

The \( n \) argument specifies the order of the numerator of the equation. The \( m \) argument specifies the order of the denominator of the equation. \( n \) and \( m \) must be greater than or equal to 0 (\( n, m, \geq 0 \)). If \( m \) is greater than 0 then \( n \) must be less than or equal to \( m \) (if \( m > 0, n \leq m \)).

The \( s \) argument specifies whether or not a constant is used. \( s=0 \) specifies no constant term \( y_0 \) in the numerator, \( s=1 \) specifies a constant term \( y_0 \) in the numerator. \( s \) must be either 0 or 1. If \( n = 0, s \) cannot be 0 (there must be a constant).

The number of valid data points must be greater than or equal to \( n = m = s \).

The optional \( f \) argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. \( f \) must be greater than or equal to 0 and less than or equal to 1. 0 \( \leq f \leq 1 \). If \( f \) is omitted, no smoothing is used.

Example

For \( x = \{0,1,2\}, y=\{0,1,4\} \), the operation \( \text{col}(1)=\text{ape}(x,y,1,1,0,5) \) places the 3 parameter estimates for the equation
\[ f(x) = \frac{a + bx}{1 + cx} \]

as the values \{5.32907052e-15, 0.66666667, -0.33333333\} in column 1.

**arccos**

This function returns the inverse of the corresponding trigonometric function.

**Syntax**

\[ \text{arccos(numbers)} \]

The \textit{numbers} argument can be a scalar or range. You can also use the abbreviated function name acos.

The values for the numbers argument must be within -1 and 1, inclusive. Results are returned in degrees, radians, or grads, depending on the Trigonometric Units selected in the User-Defined Transform dialog box. Any missing value or text string contained within a range is ignored and returned as the string or missing value.

The function range (in radians) is arccose 0 to \(\pi\)

**Example**

The operation \(\text{col(2)} = \text{acos(col(1))}\) places the arccosine of all column 1 data points in column 2.

**arcsin**

This function returns the inverse of the corresponding trigonometric function.

**Syntax**

\[ \text{arcsin(numbers)} \]
The *numbers* argument can be a scalar or range. You can also use the abbreviated function name `asin`.

The values for the numbers argument must be within -1 and 1, inclusive. Results are returned in degrees, radians, or grads, depending on the Trigonometric Units selected in the User-Defined Transform dialog box. Any missing value or text string contained within a range is ignored and returned as the string or missing value.

The function range (in radians) is:

\[
\text{arcsin} \quad \frac{-\pi}{2} \to \frac{\pi}{2}
\]

**Example**

The operation `col(2) = asin(col(1))` places the arcsine of all column 1 data points in column 2.

**arctan**

This function returns the inverse of the corresponding trigonometric function.

**Syntax**

`arctan(numbers)`

The *numbers* argument can be a scalar or range. You can also use the abbreviated function name `atan`.

The numbers argument can be any value. Results are returned in degrees, radians, or grads, depending on the Trigonometric Units selected in the User-Defined Transform dialog box.

The function range (in radians) is:

\[
arctan \quad -\frac{\pi}{2} \to \frac{\pi}{2}
\]
Example

The operation \( \text{col}(2) = \text{atan}(\text{col}(1)) \) places the arctangent of all column 1 data points in column 2.

Note: A convenient way of obtaining the value of \( \pi \) is \( \pi = 4 + \text{atan}(1) \).

area

The area function returns the area of a simple polygon. The outline of the polygon is formed by the xy pairs specified in an x range and a y range. The list of points does not need to be closed. If the last xy pair does not equal the first xy pair, the polygon is closed from the last xy pair to the first. The area function only works with simple non-overlapping polygons. If line segments in the polygon cross, the overlapping portion is considered a negative area, and results are unpredictable.

Syntax

\[
\text{area}(x \text{ range}, y \text{ range})
\]

The \( x \) range argument contains the \( x \) coordinates, and the \( y \) range argument contains the \( y \) coordinates. Corresponding values in these ranges form xy pairs.

If the ranges are uneven in size, excess \( x \) or \( y \) points are ignored.

Example

For the ranges \( x = \{0, 1, 1, 0\} \) and \( y = \{0, 0, 1, 1\} \), the operation \( \text{area}(x, y) \) returns a value of 1. The \( x \) and \( y \) coordinates provided describe a square of 1 unit.

avg

The avg function averages the numbers across corresponding ranges, instead of within ranges. The resulting range is the row-wise average of the range arguments. Unlike the mean function, avg returns a range, not a scalar.

The avg function calculates the arithmetic mean, defined as:
Chapter 20

The avg function can be used to calculate averages of worksheet data across rows rather than within columns.

**Syntax**

\[
\bar{x} = \frac{1}{n} \sum_{i=1}^{n} x_i
\]

The avg function can be used to calculate averages of worksheet data across rows rather than within columns.

**Syntax**

\[
\text{avg}({x_1,x_2...},{y_1,y_2...},{z_1,z_2...})
\]

The \( x_1, y_1, \) and \( z_1 \) are corresponding numbers within ranges. Any missing value or text string contained within a range returns the string or missing value as the result.

**Example**

The operation \( \text{avg}((1,2,3),(3,4,5)) \) returns \( \{2,3,4\} \). 1 from the first range is averaged with 3 from the second range, 2 is averaged with 4, and 3 is averaged with 5. The result is returned as a range.

**block**

The block function returns a block of cells from the worksheet, using a range specified by the upper left and lower right cell row and column coordinates.

**Syntax**

block(column 1,row 1,column 2,row 2)

The \( \text{column 1} \) and \( \text{row 1} \) arguments are the coordinates for the upper left cell of the block; the \( \text{column 2} \) and \( \text{row 2} \) arguments are the coordinates for the lower right cell of the block. All values within this range are returned. Operations performed on a block always return a block.

If \( \text{column 2} \) and \( \text{row 2} \) are omitted, then the last row and/or column is assumed to be the last row and column of the data in the worksheet. If you are equating a block to another block, then the last row and/or column is assumed to be the last row and column of the equated block (see the following example).
All column and row arguments must be scalar (not ranges). To use a column title for
the column argument, enclose the column title in quotes; block uses the column in the
worksheet whose title matches the string.

**Example**

The command `block(5,1) = -block(1,1,3,24)` reverses the sign for the values in the range
from cell (1,1) to cell (3,24) and places them in a block beginning in cell (5,1).

**blockheight, blockwidth**

The blockheight and blockwidth functions return the number of rows or columns,
respectively, of a defined block of cells from the worksheet.

**Syntax**

```
blockheight(block) blockwidth(block)
```

The block argument can be a variable defined as a block, or a block function statement.

**Example**

For the statement `x = block(2,1,12,10)`

```
    cell(1,1) = blockheight(x)
```

places the number 10 in column 1, row 1 of
the worksheet.

```
    cell(1,2) = blockwidth(x)
```

places the number 11 in column 1, row 2 of
the worksheet.

**cell**

The cell function returns the contents of a cell in the worksheet, and can specify a cell
destination for transform results.

**Syntax**

```
cell (column,row)
```
Both column and row arguments must be scalar (not ranges). To use a column title for the column argument, enclose the column title in quotes; cell uses the column in the worksheet whose title matches the string.

Data placed in a cell inserts or overwrites according to the current insert mode.

**chisquareden**

This function is the chi-square probability density function. It returns the value of the slope of the cumulative distribution function at the specified argument value.

**Syntax**

chisquareden(x, n)

The \( x \) argument represents the independent variable and can either be a scalar or a range of numbers. If \( x \) is a range, then it must be defined by either using braces \{ \} or by specifying a worksheet column. Any value for \( x \) must be non-negative. The \( n \) argument can be any positive integer and equals the degrees of freedom.

**Example**

The density function can be used to estimate the probability that the values of a chi-square distributed random variable \( X \) lie in a small interval. If \( X \) has 8 degrees of freedom, then to estimate the probability that the values of \( X \) lie between 5 and 5.1, multiply the density of \( X \) at 5 by the length of the interval .1:

\[
\text{chisquareden}(5, 8) \times .1 = .10688
\]

**chisquaredist**

This function is the cumulative chi-square distribution function. It returns the probability that a chi-square distributed random variable is less than a specified independent variable value.

A chi-square random variable is defined as a sum of squares of independent standard normal distribution variables. The number of normal variables in the sum is called the degrees of freedom.
This distribution is used in goodness-of-fit measures. It describes the distribution of sample variance for a set of normally distributed observations and describes the distribution of the residual sum of squares in regression.

**Syntax**

chisquaredist(x,n)

**Example**

Suppose a random variable X is chi-square distributed with 11 degrees of freedom. To compute the probability that the values of this variable are less than 5, we calculate:

chisquaredist(5,11) = .06883

**chisquareinv**

This function is the inverse cumulative chi-square distribution function. The probability that a chi-square distributed random variable is less than the return value is equal to the argument you specify.

**Syntax**

chisquareinv(x,n)

The x argument can either be a scalar or a range of numbers. If x is a range, then it must be defined by either using braces { } or by specifying a worksheet column. Any scalar value for x represents a probability and so must be between 0 and 1. The n argument can be any positive integer and equals the degrees of freedom.

**Example**

Suppose a chi-square distributed random variable X has 19 degrees of freedom. To compute the median of X, we calculate:

chisquareinv(0.5,19) = 18.33765
choose

The choose function determines the number of ways of choosing \( r \) objects from \( n \) distinct objects without regard to order.

**Syntax**

\[
\text{choose}(n,r)
\]

For the arguments \( n \) and \( r \), \( r < n \) and \( \binom{n}{r} \) is defined as:

\[
\binom{n}{r} = \frac{n!}{r!(n-r)!}
\]

**Example**

To create a function for the binomial distribution, enter the equation:

\[
\text{binomial}(p,n,r) = \text{choose}(n,r) \times (p^r) \times (1-p)^{n-r}
\]

col

The col function returns all or a portion of a worksheet column, and can specify a column destination for transform results.

**Syntax**

\[
\text{col}(\text{column},\text{top},\text{bottom})
\]

The \textit{column} argument is the column number or title. To use a column title for the column argument, enclose the title in quotation marks. The \textit{top} and \textit{bottom} arguments specify the first and last row numbers, and can be omitted. The default row numbers are 1 and the end of the column, respectively; if both are omitted, the entire column is used. All parameters must be scalar. Data placed in a column inserts or overwrites according to the current insert mode.
complex

Converts a block of real and imaginary numbers into a range of complex numbers.

**Syntax**

complex (range,range)

The first range contains the real values, the second range contains the imaginary values and is optional. If you do not specify the second range, the complex transform returns zeros for the imaginary numbers. If you do specify an imaginary range, it must contain the same number of values as the real value range.

**Example**

If x = {1,2,3,4,5,6,7,8,9,10}, the operation complex(x) returns {{1,2,3,4,....,9,10}, {0,0,0,0,....,0,0}}.

If x = {1.0,-0.75,3.1} and y = {1.2,2.1,-1.1}, the operation complex(x,y) returns {{1.0,-0.75,3.1}, {1.2,2.1,-1.1}}.

**cos**

This function returns ranges consisting of the cosine of each value in the argument given. This and other trigonometric functions can take values in radians, degrees, or grads. This is determined by the Trigonometric Units selected in the User-Defined Transform dialog box.

**Syntax**

cos(numbers)

The numbers argument can be a scalar or range.

If you regularly use values outside of the usual -2π to 2π (or equivalent) range, use the mod function to prevent loss of precision. Any missing value or text string contained within a range is ignored and returned as the string or missing value.
Example

If you choose Degrees as your Trigonometric Units in the User-Defined Transform dialog box, the operation \( \cos(\{0,60,90,120,180\}) \) returns values of \( \{1,0.5,0,-0.5,-1\} \).

\textit{cosh}

This function returns the hyperbolic cosine of the specified argument.

\textit{Syntax}

\textit{cosh(numbers)}

The numbers argument can be a scalar or range.

Any missing value or text string contained within a range is ignored and returned as the string or missing value.

Example

The operation \( x = \cosh(\text{col}(2)) \) sets the variable \( x \) to be the hyperbolic cosine of all data in column 2.

\textit{count}

The count function returns the value or range of values equal to the number of non-missing numeric values in a range. Missing values and text strings are not counted.

\textit{Syntax}

\textit{count(range)}

The range argument must be a single range (indicated with the \{ \} brackets) or a worksheet column.
**data**

The data function generates a range of numbers from a starting number to an end number, in specified increments.

**Syntax**

data(start,stop,step)

All arguments must be scalar. The start argument specifies the beginning number and the end argument sets the last number. If the step parameter is omitted, it defaults to 1. The start parameter can be more than or less than the stop parameter. In either case, data steps in the correct direction. Remainders are ignored.

**Example**

The operation \( \text{data}(1,5) \) returns the range of values \( \{1,2,3,4,5\} \).

The operation \( \text{data}(10,1,2) \) returns the values \( \{10,8,6,4,2\} \).

*Note:* If start and stop are equal, this function produces a number of copies of start equal to step. For example, the operation \( \text{data}(1,1,4) \) returns \( \{1,1,1,1\} \).

**diff**

The diff function returns a range or ranges of numbers which are the differences between a given number in a range and the preceding number. The value of the preceding number is subtracted from the value of the following number.

Because there is no preceding number for the first number in a range, the value of the first number in the result is always the same as the first number in the argument range.

**Syntax**

diff(range)

The *range* argument must be a single range (indicated with the \( \{ \) brackets) or a worksheet column. Any missing value or text string contained within the range is returned as the string or missing value.
Example

For \( x = \{9,16,7\} \), the operation \( \text{diff}(x) \) returns a value of \( \{9,7,-9\} \).
For \( y = \{4,-6,12\} \), the operation \( \text{diff}(y) \) returns a value of \( \{4,-10,18\} \).

dist

The dist function returns a scalar representing the distance along a line. The line is described in segments defined by the X,Y pairs specified in an x range and a y range.

Syntax

dist(x range, y range)

The \( x \) range argument contains the X coordinates, and the \( y \) range argument contains the Y coordinates. Corresponding values in these ranges form X,Y pairs. If the ranges are uneven in size, excess X or Y points are ignored.

Example

For the ranges \( x =\{0,1,1,0,0\} \) and \( y =\{0,0,1,1,0\} \), the operation \( \text{dist}(x,y) \) returns 4.0. The X and Y coordinates provided describe a square of 1 unit x by 1 unit y.

dsinp

The dsinp function automatically generates the initial parameter estimates for a damped sinusoidal functions using the FFT method. The four parameter estimates are returned as a vector.

Syntax

dsinp(x range, y range)

The \( x \) range argument specifies the x variable, and the \( y \) range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. \( x \) range and \( y \) range must be the same size, and the number of valid data points must be greater than or equal to 3.
Note: dsinp is especially used to estimate parameters on waveform functions. This is only useful when this function is used in conjunction with nonlinear regression.

**exp**

The exp function returns a range of values consisting of the number e raised to each number in the specified range. This is numerically identical to the expression $e^{numbers}$.

**Syntax**

exp(numbers)

The *numbers* argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value.

**Example**

The operation `exp(1)` returns a value of 2.718281828459045.

**factorial**

The factorial function returns the factorial of a specified range.

**Syntax**

factorial({range})

The range argument must be a single range (indicated with the `{ }` brackets) or a worksheet column. Any missing value or text string contained within a range is ignored and returned as the string or missing value. Non-integers are rounded down to the nearest integer or 1, whichever is larger.

For factorial($x$):

- $x < 0$ returns a missing value,
- $0 \leq x < 180$ returns $x!$, and
- $x \geq 170$ returns $+\infty$
**Example 1**

The operation `factorial({1,2,3,4,5})` returns `{1,2,6,24,120}`.

**Example 2**

To create a transform equation function for the Poisson distribution, you can type:

```
Poisson(m,x)=(m^x)*exp(-m)/factorial(x)
```

**fden**

This function is the F-distribution’s probability density function. It returns the value of the slope of the cumulative distribution function at the specified argument value.

**Syntax**

```
fden(x,m,n)
```

The `x` argument represents the independent variable and can either be a scalar or a range of numbers. If `x` is a range, then it must be defined by either using braces `{ }` or by specifying a worksheet column. Any value for `x` must be non-negative. The `m` argument is any positive integer and equals the numerator degrees of freedom. The `n` argument is any positive integer and equals the denominator degrees of freedom.

**Example**

The density function can be used to estimate the probability that the values of an F-distributed random variable `F` lie in a small interval. If `F` has a numerator degrees of freedom equal to `3` and a denominator degrees of freedom equal to `14`, then to estimate the probability that the values of `F` lie between `2` and `2.1`, multiply the density of `F` at `2` by the length of the interval `.1`:

```
fden(2,3,14) *.1 = .014882
```
**fdist**

This function is the F-distribution function. It returns the probability that an F-distributed random variable is less than a specified independent variable value.

An F-distributed random variable is defined as a scaled ratio of two chi-square variables. The *numerator and denominator degrees of freedom* of an F-distributed variable equal the degrees of freedom of the corresponding chi-square variables.

This distribution is used to test goodness-of-fit in regression problems and for testing the homogeneity of populations for many groups of normally distributed observations.

**Syntax**

\[ \text{fdist}(x, n) \]

The \( x \) argument represents the independent variable and can either be a scalar or a range of numbers. If \( x \) is a range, then it must be defined by either using braces { } or by specifying a worksheet column. Any value for \( x \) must be non-negative. The \( m \) argument is any positive integer and equals the numerator degrees of freedom. The \( n \) argument is any positive integer and equals the denominator degrees of freedom.

**Example**

Suppose an F-distributed random variable \( F \) has a numerator degrees of freedom equal to 3 and a denominator degrees of freedom equal to 14. To compute the probability that the values of \( F \) exceed 2, we calculate:

\[ P( F > 2 ) = 1 - P( F < 2 ) = 1 - \text{fdist}(2,3,14) = .16035 \]

**fft**

The fft function finds the frequency domain representation of your data using the Fast Fourier Transform.

**Syntax**

\[ \text{fft}(\text{range}) \]
The parameter can be a range of real values or a block of complex values. For complex values there are two columns of data. The first column contains the real values and the second column represents the imaginary values. This function works on data sizes of size $2^n$ numbers. If your data set is not $2^n$ in length, the `fft` function pads 0 at the beginning and end of the data range to make the length $2^n$.

The `fft` function returns a range of complex numbers.

**Example**

For $x = \{1,2,3,4,5,6,7,8,9,10\}$, the operation `fft(x)` takes the Fourier transform of the ramp function with real data from 1 to 10 with 3 zeros padded on the front and back and returns a 2 by 16 block of complex numbers.

**finv**

This function is the inverse F-distribution function. The probability that an F-distributed random variable is less than the return value is equal to the argument you specify.

**Syntax**

`finv(x,m,n)`

The $x$ argument can either be a scalar or a range of numbers. If $x$ is a range, then it must be defined by either using braces `{ }` or by specifying a worksheet column. Any scalar value for $x$ represents a probability and so must be between 0 and 1. The $m$ argument is any positive integer and equals the numerator degrees of freedom. The $n$ argument is any positive integer and equals the denominator degrees of freedom.

**Example**

Suppose an F-distributed random variable $F$ has a numerator degrees of freedom equal to 3 and a denominator degrees of freedom equal to 14. To calculate the tail of this distribution whose probability is .05, we need to find a number $f$ such that $P( F > f ) = .05$. This is the same as finding $f$ such that $P( F < f ) = .95$. Therefore, we calculate:

```
finv(.95, 3, 14) = 3.34389
```
The for statement is a looping construct used for iterative processing.

**Syntax**

```
for loop variable = initial value to end value step increment do
equation
equation
.
.
end for
```

Transform equation statements are evaluated iteratively within the for loop. When a for statement is encountered, all functions within the loop are evaluated separately from the rest of the transform.

The *loop variable* can be any previously undeclared variable name. The *initial value* for the loop is the beginning value to be used in the loop statements. The *end value* for the loop variable specifies the last value to be processed by the for statement. After the end value is processed, the loop is terminated. In addition, you can specify a loop variable step *increment*, which is used to “skip” values when proceeding from the initial value to end value. If no increment is specified, an increment of 1 is assumed.

*Note:* You must separate *for, to, step, do, end* for, and all condition statement operators, variables and values with spaces. The for loop statement is followed by a series of one or more transform equations which process the loop variable values.

Inside for loops, you can:

- Indent equations.
- Nest for loops.

Note that these conditions are allowed only within for loops. You cannot redefine variable names within for loops.
The operation:

```plaintext
for i = 1 to size(col(1)) do
  cell(2,i) = cell(1,i)*i
end for
```

multiplies all the values in column 1 by their row number and places them in column 2.

The operation:

```plaintext
for j = cell(1,1) to cell(1,64) step 2 do col(10) = col(9)^j
end for
```
takes the value from cell (1,1) and increments by 2 until the value in cell (1,64) is reached, raises the data in column 9 to that power, and places the results in column 10.

The fwhm function returns value of the x width at half-maxima in the ranges of coordinates provided, with optional Lowess smoothing.

**Syntax**

`fwhm(x range, y range, f)`

The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3.

The optional f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1. 0 ≤ f ≤ 1. If f is omitted, no smoothing is used.
Example

For \( x = \{0,1,2\} \), \( y = \{0,1,4\} \), the operation

\[
\text{col}(1) = \text{fwhm}(x,y)
\]

places the \( x \) width at half-maxima 1.00 into column 1.

gaussian

This function generates a specified number of normally (Gaussian or “bell” shaped) distributed numbers from a seed number, using a supplied mean and standard deviation.

Syntax

\[
gaussian(number,seed,mean,stddev)
\]

The \textit{number} argument specifies how many random numbers to generate. The \textit{seed} argument is the random number generation seed to be used by the function. If you want to generate a different random number sequence each time the function is used, enter 0/0 for the seed. Enter the same number to generate an identical random number sequence. If the seed argument is omitted, a randomly selected seed is used.

The \textit{mean} and \textit{stddev} arguments are the mean and standard deviation of the normal distribution curve, respectively. If mean and stddev are omitted, they default to 0 and 1.

Note that function arguments are omitted from right to left. If you want to specify a stddev, you must either specify the mean argument or omit it by using 0/0.

Example

The operation \texttt{gaussian(100)} uses a seed of 0 to produce 100 normally distributed random numbers, with a mean of 0.0 and a standard deviation of 1.0.

histogram

The histogram function produces a histogram of the values range in a specified range, using a defined interval set.
**Syntax**

```plaintext
histogram(range, buckets)
```

The `range` argument must be a single range (indicated with the `{ }` brackets) or a worksheet column. Any missing value or text string contained within a range is ignored.

The `buckets` argument is used to specify either the number of evenly incremented histogram intervals, or both the number and ranges of the intervals. This value can be scalar or a range. In both versions, missing values and strings are ignored.

If the buckets parameter is a scalar, it must be a positive integer. A scalar buckets argument generates a number of intervals equal to the buckets value. The histogram intervals are evenly sized; the range is the minimum value to the maximum value of the specified range.

If the buckets argument is specified as a range, each number in the range becomes the upper bound (inclusive) of an interval. Values from $-\infty$ to ≤ the first bucket fall in the first histogram interval, values from > first bucket to ≤ second bucket fall in the second interval, etc. The buckets range must be strictly increasing in value. An additional interval is defined to catch any value which does not fall into the defined ranges. The number of values occurring in this extra interval (including 0, or no values outside the range) becomes the last entry of the range produced by histogram function.

**Example 1**

For `col(1) = {1,20,30,35,40,50,60}`, the operation `col(2) = histogram(col(1),3)` places the range `{2,3,2}` in column 2. The bucket intervals are automatically set to 20, 40, and 60, so that two of the values in column 1 fall under 20, three fall under 40, and two fall under 60.

**Example 2**

For `buckets = {25,50,75}`, the operation `col(3) = histogram(col(1),buckets)` places `{2,4,1,0}` in col(3). Two of the values in column 1 fall under 25, four fall under 50, one under 75, and no values fall outside the range.
The if function either selects one of two values based on a specified condition, or proceeds along a series of calculations based on a specified condition.

**Syntax**

if(condition,true value,false value)

The *true value* and *false value* arguments can be any scalar or range. For a true *condition*, the true value is returned; for a false condition, the false value is returned.

If the false value argument is omitted, a false condition returns a missing value. If the condition argument is scalar, then the entire true value or false value argument is returned.

If the condition argument contains a range, the result is a new range. For each true entry in the condition range, the corresponding entry in the true value argument is returned. For a false entry in the condition range, the corresponding entry in false value is returned.

If the false value is omitted and the condition entry is false, the corresponding entry in the true value range is omitted. This can be used to conditionally extract data from a range.

**Example 1**

The operation \( \text{col}(2) = \text{if} \left( \text{col}(1) < 75, \text{"FAIL"}, \text{"PASS"} \right) \) reads in the values from column 1, and places the word “FAIL” in column 2 if the column 1 value is less than 75, and the word “PASS” if the value is 75 or greater.

**Example 2**

For the operation \( y = \text{if}(x < 2 \text{ or } x > 4, 99, x) \), an \( x \) value less than 2 or greater than 4 returns a \( y \) value of 99, and all other \( x \) values return a \( y \) value equal to the corresponding \( x \) value.

If you set \( x = \{1,2,3,4,5\} \), then \( y \) is returned as \( \{99,2,3,4,99\} \). The condition was true for the first and last \( x \) range entries, so 99 was returned. The condition was false for \( x = 2, 3, \) and 4, so the \( x \) value was returned for the second, third, and fourth \( x \) values.
**if...then...else**

The if...then...else function proceeds along one of two possible series of calculations based on a specified condition.

**Syntax**

```plaintext
if condition then
    statement
    statement...
else
    statement
    statement...
end if
```

To use the if...then...else construct, follow the if *condition* then statement by one or more transform equation statements, then specify the else statement(s). When an if...then...else statement is encountered, all functions within the statement are evaluated separately from the rest of the transform.

*Note:* You must separate if, then, and all condition statement operators, variables, and values with spaces.

Inside if...then...else constructs, you can:

- Type more than one equation on a line
- Indent equations.
- Nest additional if constructs.

Note that these conditions are allowed only within if...else statements. You cannot redefine variable names within an if...then...else construct.

**Example**

The operations:

```plaintext
i = cell(1,1)
j = cell(1,2)
If i < 1 and j > 1 then x = col(3)
else x = col(4)
end if
```
sets x equal to column 3 if i is less than 1 and j is greater than 1; otherwise, x is equal to column 4.

**imaginary (img)**

The imaginary function strips the imaginary values out of a range of complex numbers.

**Syntax**

`img(block)`

The range is made up of complex numbers.

**Example**

If \( x = \{ \{1,2,3,4,5,6,7,8,9,10\}, \{0,0,0,...,0,0\} \} \), the operation \( img(x) \) returns \( \{0,0,0,0,0,0,0,0,0,0\} \).

If \( x = \{ \{1.0,-0.75,3.1\}, \{1.2,2.1,-1.1\} \} \), the operation \( img(x) \) returns \( \{1.2,2.1,-1.1\} \).

**int**

The int function returns a number or range of numbers equal to the largest integer less than or equal to each corresponding number in the specified range. All numbers are rounded down to the nearest integer.

**Syntax**

`int(numbers)`

The `numbers` argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value.

**Example**

The operation \( int([9,1.2,2.2,-3.8]) \) returns a range of \( \{0.0,1.0,2.0,-4.0\} \).
The `interpolate` function performs linear interpolation on a set of X,Y pairs defined by an x range and a y range. The function returns a range of interpolated y values from a range of values between the minimum and maximum of the x range.

**Syntax**

`interpolate(x range, y range, range)`

Values in the `x range` argument must be strictly increasing or strictly decreasing.

The `range` argument must be a single range (indicated with the `{ }` brackets) or a worksheet column. Missing values and text strings are not allowed in the `x range` and `y range`. Text strings in range are replaced by missing values.

Extrapolation is not possible; missing value symbols are returned for range argument values less than the lowest `x` range value or greater than the highest `x` range value.

**Example**

For `x = {0,1,2}`, `y = {0,1,4}`, and `range = data(0,2,.5)` (this data operation returns numbers from 0 to 2 at increments of 0.5), the operation `col(1) = interpolate(x,y,range)` places the range `{0.0,0.5,1.0,2.5,4.0}` into column 1.

If `range` had included values outside the range for x, missing values would have been returned for those out-of-range values.

The `inv` function generates the inverse matrix of an invertible square matrix provided as a block.

**Syntax**

`inv(block)`

The `block` argument is a block of numbers with real values in the form of a square matrix. The number of rows must equal the number of columns. The function returns
a block of numbers with real values in the form of the inverse of the square matrix provided.

**Example**

For the matrix:

```
| 1.00 | 3.00 | 4.00 |
| 2.00 | 1.00 | 3.00 |
| 3.00 | 4.00 | 2.00 |
```

in block(2,3,4,5) the operation `block(2,7)=inv(block(2,3,4,5))` generates the inverse matrix:

```
| -0.40 | 0.40 | 0.20 |
| 0.20  | -0.40 | 0.20 |
| 0.20  | 0.20 | -0.20 |
```

in block (2,7,4,9).

**invcpx**

This function takes the reciprocal of a range of complex numbers.

**Syntax**

```
invcpx(block)
```

The input and output are blocks of complex numbers. The invcpx function returns the range 1/c for each complex number in the input block.

**Example**

If `x = complex ([3,0,1], [0,1,1])`, the operation `invcpx(x)` returns `[[0.33333, 0.0, 0.5], [0.0,-1.0,-0.5]]`. 
invfft

The inverse fft function (invfft) takes the inverse Fast Fourier Transform (fft) of the data produced by the fft to restore the data to its new filtered form.

Syntax

invfft(block)

The parameter is a complex block of spectral numbers with the real values in the first column and the imaginary values in the second column. This data is usually generated from the fft function. The invfft function works on data sizes of size $2^n$ numbers. If your data set is not $2^n$ in length, the invfft function pads 0 at the beginning and end of the data range to make the length $2^n$.

The function returns a complex block of numbers.

Example

If $x = \{1,2,3,...,9,10\}, \{0,0,0,...,0,0\}$, the operation $\text{invfft(fft(x))}$ returns $\{0,0,0,1,2,3,...,9,10,0,0,0\}, \{0,0,0,...,0,0\}$.

ln

The ln function returns a value or range of values consisting of the natural logarithm ($base e$) of each number in the specified range.

Syntax

ln(numbers)

The numbers argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value.

For $\ln(x)$:

$x < 0$ returns an error message, and

$x = 0$ returns $-\infty$.
The largest value allowed is approximately $x < 10^{309}$.

**Example**

The operation $\ln(2.71828)$ returns a value $\approx 1.0$.

**log**

The log function returns a value or range of values consisting of the base 10 logarithm of each number in the specified range.

**Syntax**

log(numbers)

The `numbers` argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value.

For `log(x)`:

- $x < 0$ returns an error message,
- $x = 0$ returns $-\infty$

The largest value allowed is approximately $x < 10^{309}$.

**Example**

The operation `log(100)` returns a value of 2.

**lookup**

The lookup function compares values with a specified table of boundaries and returns either a corresponding index from a one-dimensional table, or a corresponding value from a two-dimensional table.

**Syntax**

lookup(numbers,x table,y table)
The *numbers* argument is the range of values looked up in the specified *x table*. The *x* table argument consists of the upper bounds (inclusive) of the *x* intervals within the table and must be ascending in value. The lower bounds are the values of the previous numbers in the table (\(-\infty\) for the first interval).

You must specify numbers and an *x* table. If only the numbers and *x* table arguments are specified, the lookup function returns an index number corresponding to the *x* table interval; the interval from \(-\infty\) to the first boundary corresponds to an index of 1, the second to 2, etc.

If a number value is larger than the last entry in *x* table, lookup will return a missing value as the index. You can avoid missing value results by specifying 1/0 (infinity) as the last value in *x* table.

The optional *y* table argument is used to assign *y* values to the *x* index numbers. The *y* table argument must be the same size as the *x* table argument, but the elements do not need to be in any particular order. If *y* table is specified, lookup returns the *y* table value corresponding to the *x* table index value, i.e., the first *y* table value for an index of 1, the second *y* table value for an index of 2, etc.

*Note:* The *x* table and *y* table ranges correspond to what is normally called a “lookup table”.

**Example 1**

For \(n=\{-4,11,31\}\) and \(x=\{1,10,30\}\), \(col(1)=\text{lookup}(n,x)\) places the index values of 1, 3, and -- (missing value) in column 1.

**Figure 20-1**

<table>
<thead>
<tr>
<th>Index #</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>x table</em></td>
<td>1</td>
<td>10</td>
<td>30</td>
</tr>
<tr>
<td>-4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
<td></td>
<td>(missing value)</td>
</tr>
</tbody>
</table>

-4 falls beneath 1, or the first *x* boundary; 11 falls beyond 10 but below 30, and 31 lies beyond 30.
Example 2

To generate triplet values for the range \{9,6,5\}, you can use the expression `lookup(data(1/3,3,1/3),data(1,3),\{9,6,5\})` to return \{9,9,6,6,6,5,5,5\}. This looks up the numbers 1/3, 2/3, 1, 1 \frac{1}{3}, 1 \frac{2}{3}, 2, 2 \frac{1}{3}, 2 \frac{2}{3}, and 3 using x table boundaries 1, 2, and 3 and corresponding y table values 9, 6, and 5.

Figure 20-2

<table>
<thead>
<tr>
<th>y table</th>
<th>9</th>
<th>6</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>x table</td>
<td>1</td>
<td>2</td>
<td>3</td>
</tr>
</tbody>
</table>

\begin{itemize}
  \item \frac{1}{3}
  \item \frac{2}{3}
  \item 1
  \item 1 \frac{1}{3}
  \item 1 \frac{2}{3}
  \item 2
  \item 2 \frac{1}{3}
  \item 2 \frac{2}{3}
  \item 3
\end{itemize}

lowess

The lowess function returns smoothed y values as a range from the ranges of x and y variables provided, using a user-defined smoothing factor. "Lowess" means locally weighted regression. Each point along the smooth curve is obtained from a regression of data points close to the curve point with the closest points more heavily weighted.

Syntax

`lowess(x range, y range, f)`
Chapter 20

The *x range* argument specifies the x variable, and the *y range* argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. *x range* and *y range* must be the same size, and the number of valid data points must be greater than or equal to 3.

The *f* argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. *f* must be greater than or equal to 0 and less than or equal to 1. $0 \leq f \leq 1$. Note that unlike lowpass, lowess requires an *f* argument.

**Example**

For $x = \{1, 2, 3, 4\}$, $y = \{0.13, 0.17, 0.50, 0.60\}$, the operation

```
col(1)=lowess(x,y,1)
```

places the smoothed y data 0.10, 0.25, 0.43, 0.63 into column 1.

**lowpass**

The lowpass function returns smoothed y values from ranges of x and y variables, using an optional user-defined smoothing factor that uses FFT and IFFT.

**Syntax**

```
lowpass(x range, y range, f )
```

The *x range* argument specifies the x variable, and the *y range* argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. *x range* and *y range* must be the same size, and the number of valid data points must be greater than or equal to 3.

The optional *f* argument defines whether FFT and IFFT are used. *f* must be greater than or equal to 0 and less than or equal to 100. If *f* is omitted, no Fourier transformation is used.

*Note:* lowpass is especially designed to perform smoothing on waveform functions as a part of nonlinear regression.
Example

For \( x = \{0,1,2\} \), \( y = \{0,1,4\} \), the operation

\[ \text{col(1)} = \text{lowpass}(x,y,88) \]

places the newly smoothed data 0.25, 1.50, 2.25 into column 1.

\[ \text{max} \]

The max function returns the largest number found in the range specified.

Syntax

\[ \text{max}(\text{range}) \]

The \textit{range} argument must be a single range (indicated with the \( \{ \} \) brackets) or a worksheet column. Any missing value or text string contained within a range is ignored.

Example

For \( x = \{7,4,-4,5\} \), the operation \( \text{max}(x) \) returns a value of 7, and the operation \( \text{min}(x) \) returns a value of -4.

\[ \text{mean} \]

The mean function returns the average of the range specified. Use this function to calculate column averages (as opposed to using the \text{avg} function to calculate row averages).

The mean function calculates the arithmetic mean, defined as:
Figure 20-3

\[ x = \frac{1}{n} \sum_{i=1}^{n} x_i \]

**Syntax**

`mean(range)`

The `range` argument must be a single range (indicated with the `{ }` brackets) or a worksheet column. Any missing value or text string contained within a range is ignored.

**Example**

The operation `mean({1,2,3,4})` returns a value of 2.5.

**min**

The min function returns the smallest number in the range specified.

**Syntax**

`min(range)`
The range argument must be a single range (indicated with the { } brackets) or a worksheet column. Any missing value or text string contained within a range is ignored.

**Example**

For \( x = \{7,4,-4,5\} \), the operation \( \max(x) \) returns a value of 7, and the operation \( \min(x) \) returns a value of -4.

**missing**

The missing function returns a value or range of values equal to the number of missing values and text strings in the specified range.

**Syntax**

```
missing(range)
```

The range argument must be a single range (indicated with the { } brackets) or a worksheet column.

**mod**

The mod function returns the modulus (the remainder from division) for corresponding numbers in numerator and divisor arguments. This is the real (not integral) modulus, so both ranges may be nonintegral values.

**Syntax**

```
mod(numerator,divisor)
```

The numerator and divisor arguments can be scalars or ranges. Any missing value or text string contained within a range is returned as the string or missing value.

For any divisor \( \divisor \neq 0 \), the mod function returns the remainder of

For \( \mod(x,0) \), that is, for \( \divisor = 0 \),

\( x > 0 \) returns \( +\infty \)
Chapter 20

\[ x = 0 \text{ returns } +\infty \]
\[ x < 0 \text{ returns } -\infty \]

Example

The operation \( \text{mod}((4,5,4,5),(2,2,3,3)) \) returns the range \{0,1,2\}. These are the remainders for \( 4 + 2 \), \( 5 + 2 \), \( 4 + 3 \), and \( 5 + 3 \).

\textit{mulcpx}

The \textit{mulcpx} function multiplies two blocks of complex numbers together.

\textit{Syntax}

\textit{mulcpx}(block, block)

Both input blocks should be the same length. The \textit{mulcpx} function returns a block that contains the complex multiplication of the two ranges.

Example

If \( u = \{ \{1,1,0\},\{0,1,1\} \} \), the operation \textit{mulcpx}(u,u) returns \{\{1,0,-1\}, \{0,2,0\}\}.

\textit{normden}

This function is the normal (or Gaussian) probability density function. The graph of this function is the familiar "bell curve". It returns the value of the slope of the cumulative distribution function at the specified argument value.

\textit{Syntax}

\textit{normden}(x,m,s)

The \( x \) argument represents the independent variable and can either be a scalar or a range of numbers. If \( x \) is a range, then it must be defined by either using braces \{\} or by specifying a worksheet column. The \( m \) argument can be any number and equals the
mean of the distribution. The \( s \) argument can be any positive number and equals the standard deviation of the distribution.

**Example**

The density function can be used to estimate the probability that the values of a normally distributed random variable \( X \) lie in a small interval. If \( X \) has mean 0 and standard deviation 1, then to estimate the probability that the values of \( X \) lie between .5 and .6, multiply the density of \( X \) at .5 by the length of the interval .1:

\[
\text{normden}(0.5, 0, 1) \times 0.1 = 0.03521
\]

**normdist**

This function is the cumulative normal (or Gaussian) distribution function. It returns the probability that a normal random variable is less than a specified independent variable value.

**Syntax**

\[
\text{normdist}(x, m, s)
\]

The \( x \) argument represents the independent variable and can either be a scalar or a range of numbers. If \( x \) is a range, then it must be defined by either using braces \{ \} or by specifying a worksheet column. The \( m \) argument can be any number and equals the mean of the distribution. The \( s \) argument can be any positive number and equals the standard deviation of the distribution.

A normal distribution is called **standard** if the mean is 0 and the standard deviation is 1.

**Example**

Suppose a random variable \( X \) is normally distributed with mean .5 and standard deviation 2. Then to compute the probability that its values lie between -1 and 1, we calculate:

\[
P(-1 < X < 1) = P(X < 1) - P(X < -1)
= \text{normdist}(1, 0.5, 2) - \text{normdist}(-1, 0.5, 2)
= 0.59871 - 0.22663 = 0.37208
\]
**norminv**

This function is the inverse cumulative normal (or Gaussian) distribution function. The probability that a normally distributed random variable is less than the return value is equal to the argument you specify.

**Syntax**

\[
\text{norminv}(x,m,s)
\]

The \( x \) argument can either be a scalar or a range of numbers. If \( x \) is a range, then it must be defined by either using braces \{ \} or by specifying a worksheet column. Any scalar value for \( x \) represents a probability and so must be between 0 and 1. The \( m \) argument can be any number and equals the mean of the distribution. The \( s \) argument can be any positive number and equals the standard deviation of the distribution.

**Example**

Suppose a random variable \( X \) is normally distributed with mean 0.5 and standard deviation 2. To compute the 0.25 quartile of \( X \), we calculate:

\[
\text{norminv}(0.25,0.5,2) = -0.84898
\]

**nth**

The nth function returns a sampling of a provided range, with the frequency indicated by a scalar number. The result always begins with the first entry in the specified range.

**Syntax**

\[
\text{nth}(\text{range},\text{increment})
\]

The \( \text{range} \) argument is either a specified range (indicated with the \{ \} brackets) or a worksheet column. The \( \text{increment} \) argument must be a positive integer.
**Example**

The operation `col(1)=nth({1,2,3,4,5,6,7,8,9,10},3)` places the range `{1,4,7,10}` in column 1. Every third value of the range is returned, beginning with 1.

**partdist**

The partdist function returns a range representing the distance from the first X,Y pair to each other successive pair. The line segment X,Y pairs are specified by an x range and a y range. The last value in this range is numerically the same as that returned by dist, assuming the same x and y ranges.

**Syntax**

`partdist(x range,y range)`

The `x range` argument specifies the x coordinates, and the `y range` argument specifies the y coordinates. Corresponding values in these ranges form xy pairs.

If the ranges are uneven in size, excess x or y points are ignored.

**Example**

For the ranges `x = {0,1,1,0,0}` and `y = {0,0,1,1,0}`, the operation `partdist(x,y)` returns a range of `{0,1,2,3,4}`. The X and Y coordinates provided describe a square of 1 unit x by 1 unit y.

**polynomial**

The polynomial function returns the results for independent variable values in polynomials. Given the coefficients, this function produces a range of y values for the corresponding x values in range.

The function takes one of two forms. The first form has two arguments, both of which are ranges. Values in the first range are the independent variable values. The second range represents the coefficients of the polynomial, with the constant coefficient listed first, and the highest order coefficient listed last.

The second form accepts two or more arguments. The first argument is a range consisting of the independent variable values. All successive arguments are scalar and
represent the coefficients of a polynomial, with the constant coefficient listed first and the highest order coefficient listed last.

**Syntax**

polynomial(range,coefficients) or polynomial(range,a0,a1,...,an)

The `range` argument must be a single range (indicated with the `{ }` brackets) or a worksheet column. Text strings contained within a range are returned as a missing value.

The `coefficients` argument is a range consisting of the polynomial coefficient values, from lowest to highest. Alternately, the coefficients can be listed individually as scalars.

**Example**

To evaluate the polynomial \( y = x^2 + x + 1 \) for \( x \) values of 0, 1, and 2, type the equation `polynomial({0,1,2},1,1,1)`. Alternately, you could set \( x = \{1,1,1\} \), then enter `polynomial({0,1,2},x)`. Both operations return a range of \( \{1,3,7\} \).

**prec**

The `prec` function rounds a number or range of numbers to the specified number of significant digits, or places of significance. Values are rounded to the nearest integer; values of exactly 0.5 are rounded up.

**Syntax**

prec(numbers,digits)

The `numbers` argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value.

If the `digits` argument is a scalar, all numbers in the range have the same number of places of significance.

If the `digits` argument is a range, the number of places of significance vary according to the corresponding range values. If the size of the digits range is smaller than the
numbers range, the function returns missing values for all numbers with no corresponding digits.

**Example**

For \( x = \{13570,3.141,.0155,999,1.92\} \), the operation \( \text{prec}(x,2) \) returns \( \{14000,3.100,.0160,1000,1.90\} \).

For \( y = \{123.5,123.5,123.5,123.5\} \), the operation \( \text{prec}(y,\{1,2,3,4\}) \) returns \( \{100.0,120.0,124.0,123.5\} \).

**put into**

The put into function places calculation results in a designated column on the worksheet. It operates faster than the equivalent equality relationship.

**Syntax**

\[
\text{put results into col(column)}
\]

The `results` argument can be either the result of an equation, function or variable. The `column` argument is either the column number of the destination column, or the column title, enclosed in quotes.

Data put into columns inserts or overwrites according to the current insert mode.

**Example**

To place the results of the equation \( y = \text{data}(1,100) \) in column 1, you can type `col(1) = y`. However, entering `put y into col(1)` runs faster.

**random**

This function generates a specified number of uniformly distributed numbers within the range. Rand and rnd are synonyms for the random function.
**Syntax**

random(number,seed,low,high)

The *number* argument specifies how many random numbers to generate.

The *seed* argument is the random number generation seed to be used by the function. If you want to generate a different random number sequence each time the function is used, enter 0/0 for the seed. If the seed argument is omitted, a randomly selected seed is used.

The *low* and *high* arguments specify the beginning and end of the random number distribution range. The low boundary is included in the range. If low and high are omitted, they default to 0 and 1, respectively.

*Note:* Function arguments are omitted from right to left. If you want to specify a high boundary, you must specify the low boundary argument first.

**Example**

The operation `random(50,0/0,1,7)` produces 50 uniformly distributed random numbers between 1 and 7. The sequence is different each time this random function is used.

**real**

The real function strips the real values from a complex block of numbers.

**Syntax**

real (range)

The *range* argument consists of complex numbers.

**Example**

If `x = complex ({1,2,3,...,9,10}, {0,0,...,0})`, the operation `real(x)`returns `{1,2,3,4,5,6,7,8,9,10}`, leaving the imaginary values out.
**rgbcolor**

The transform function `rgbcolor` takes arguments `r`, `g`, and `b` between 0 and 255 and returns the corresponding color to cells in the worksheet. This function can be used to apply custom colors to any element of a graph or plot that can use colors chosen from a worksheet column.

**Syntax**

`rgbcolor(r,g,b)`

The `r,g,b` arguments define the red, green, and blue intensity portions of the color. These values must be scalars between 0 and 255. Numbers for the arguments less than 0 or greater than 255 are truncated to these values.

**Example**

The operation `rgbcolor(255,0,0)` returns red.

The operation `rgbcolor(0,255,0)` returns green.

The operation `rgbcolor(0,0,255)` returns blue.

The following statements place the secondary colors yellow, magenta, and cyan into rows 1, 2, and 3 into column 1:

```
cell(1,1)=rgbcolor(255,255,0)
cell(1,2)=rgbcolor(255,0,255)
cell(1,3)=rgbcolor(0,255,255)
```

Shades of gray are generated using equal arguments. To place black, gray, and white in the first three rows of column 1:

```
cell(1,1)=rgbcolor(0,0,0)
cell(1,3)=rgbcolor(255,255,255)
cell(1,2)=rgbcolor(127,127,127)
```

**round**

The `round` function rounds a number or range of numbers to the specified decimal places of accuracy. Values are rounded up or down to the nearest integer; values of exactly 0.5 are rounded up.
**Syntax**

round(numbers, places)

The `numbers` argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. If the `places` argument is negative, rounding occurs to the left of the decimal point. To round to the nearest whole number, use a `places` argument of 0.

**Example**

The operation `round(92.1541, 2)` returns a value of 92.15. The operation `round(0.19112, 1)` returns a value of 0.2. The operation `round(92.1541, -2)` returns a value of 100.0.

**runavg**

The `runavg` function produces a range of running averages, using a window of a specified size as the size of the range to be averaged. The resulting range is the same length as the argument range.

**Syntax**

`runavg(range, window)`

The `range` argument must be a single range (indicated with the `{ }` brackets) or a worksheet column. Any missing value or text string contained within a range is replaced with 0. If the `window` argument is even, the next highest odd number is used. The tails of the running average are computed by appending additional initial and final values to their respective ends of range.
Example

The operation \( \text{runavg}(\{1,2,3,4,5\},3) \) returns \( \{1.33,2,3,4,4.67\} \). The value of the window argument is 3, so the first result value is calculated as:

Figure 20-5

\[
\frac{(3 - 1)}{2} + 1 + 2
\]

The second value is calculated as:

Figure 20-6

\[
\frac{1 + 2 + 3}{3}
\]

\( \sin \)

This function returns ranges consisting of the sine of each value in the argument given. This and other trigonometric functions can take values in radians, degrees, or grads. This is determined by the Trigonometric Units selected in the User-Defined Transform dialog box.
**Syntax**

\[ \text{sin(numbers)} \]

The \textit{numbers} argument can be a scalar or range. If you regularly use values outside of the usual \(-2\pi\) to \(2\pi\) (or equivalent) range, use the \textit{mod} function to prevent loss of precision. Any missing value or text string contained within a range is ignored and returned as the string or missing value.

**Example**

If you choose Degrees as your Trigonometric Units in the Transform dialog box, the operation \(\text{sin}([0,30,90,180,270])\) returns values of \(\{0,0.5,1,0,-1\}\).

**sinh**

This function returns the hyperbolic sine of the specified argument.

**Syntax**

\[ \text{sinh(numbers)} \]

The \textit{numbers} argument can be a scalar or range. Like the circular trig functions, this function also accepts numbers in degrees, radians, or grads, depending on the units selected in the User-Defined Transform dialog box.

**Example**

The operation \(x = \text{sinh}(\text{col}(3))\) sets the variable \(x\) to be the hyperbolic sine of all data in column 3.

**sinp**

The \textit{sinp} function automatically generates the initial parameter estimates for a sinusoidal functions using the FFT method. The three parameter estimates are returned as a vector.
**Syntax**

\[ \text{sinp}(x \ \text{range}, \ y \ \text{range}) \]

The \( x \ \text{range} \) argument specifies the \( x \) variable, and the \( y \ \text{range} \) argument specifies the \( y \) variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. \( x \ \text{range} \) and \( y \ \text{range} \) must be the same size, and the number of valid data points must be greater than or equal to 3.

*Tip:* \text{sinp} is especially used to perform smoothing on waveform functions, used in determination of initial parameter estimates for nonlinear regression.

**size**

The \text{size} function returns a value equal to the total number of elements in the specified range, including all numbers, missing values, and text strings. Note that \text{size}(X) = \text{count}(X) + \text{missing}(X).

**Syntax**

\[ \text{size}(\text{range}) \]

The \text{range} argument must be a single range (indicated with the \{ \} brackets) or a worksheet column.

**sort**

This function can be used to sort a range of numbers in ascending order, or a range of numbers in ascending order together with a block of data.

**Syntax**

\[ \text{sort}(\text{block},\text{range}) \]

The \text{range} argument can be either a specified range (indicated with the \{ \} brackets) or a worksheet column. If the \text{block} argument is omitted, the data in range is sorted in ascending order.
Example 1

The operation `col(2) = sort(col(1))` returns the contents of column 1 arranged in ascending order and places it in column 2. To reverse the order of the sort, you can create a custom function:

```plaintext
reverse(x) = x[1:data(size(x),1)]
```

then apply it to the results of the sort. For example, `reverse(sort(x))` sorts range `x` in descending order.

Example 2

The operation:

```plaintext
block(3,1) = sort(block(1,1,2,size(col(2)),col(2))
```

sorts data in columns 1 and 2 using column 2 as the key column and places the sorted data in columns 3 and 4.

sqrt

The `sqrt` function returns a value or range of values consisting of the square root of each value in the specified range. Numerically, this is the same as `{numbers}^0.5`, but uses a faster algorithm.

Syntax

```plaintext
sqrt(numbers)
```

The `numbers` argument can be a scalar or range of numbers. Any missing value or text string contained within a range is ignored and returned as the string or missing value. For numbers < 0, `sqrt` generates a missing value.

Example

The operation `sqrt([-1,0,1,2])` returns the range `{--0,1,1.414}`.
**stddev**

The `stddev` function returns the standard deviation of the specified range, as defined by:

![Figure 20-7](image)

\[
S = \left[ \frac{1}{n-1} \sum_{i=1}^{n} (x_i - \bar{x})^2 \right]^{1/2}
\]

**Syntax**

`stddev(range)`

The `range` argument must be a single range (indicated with the `{ }` brackets) or a worksheet column. Any missing value or text string contained within a range is ignored.

**Example**

For the range \( x = \{1,2\} \), the operation `stddev(x)` returns a value of \( .70711 \).

**stderr**

The `stderr` function returns the standard error of the mean of the specified range, as defined by
where $s$ is the standard deviation.

**Syntax**

```plaintext
stderr(range)
```

The `range` argument must be a single range (indicated with the `{ }` brackets) or a worksheet column. Any missing value or text string contained within a range is ignored.

**Example**

For the range $x = \{1,2\}$, the operation `stderr(x)` returns a value of 0.5.

**subblock**

The subblock function returns a block of cells from within another previously defined block of cells from the worksheet. The subblock is defined using the upper left and lower right cells of the subblock, relative to the range defined by the source block.

**Syntax**

```plaintext
subblock (block, column 1, row 1, column 2, row 2)
```
The block argument can be a variable defined as a block, or a block function statement. The column 1 and row 1 arguments are the relative coordinates for the upper left cell of the subblock with respect to the source block. The column 2 and row 2 arguments are the relative coordinates for the lower right cell of the subblock. All values within this range are returned. Operations performed on a block always return a block. If column 2 and row 2 are omitted, then the last row and/or column is assumed to be the last row and column of the source block.

All column and row arguments must be scalar (not ranges).

**Example**

For \( x = \text{block}(3,1,20,42) \) the operation \( \text{subblock}(x,1,1,1,1) \) returns cell (3,1) and the operation \( \text{subblock}(x,5,5) \) returns the block from cell (7, 5) to cell (20, 42).

**sum**

The function sum returns a range of numbers representing the accumulated sums along the list. The value of the number is added to the value of the preceding cumulative sum.

Because there is no preceding number for the first number in a range, the value of the first number in the result is always the same as the first number in the argument range.

**Syntax**

\[ \text{sum}(\text{range}) \]

The range argument must be a single range (indicated with the \{ \} brackets) or a worksheet column. Any text string or missing value contained within the range is returned as the string or missing value.

**Example**

For \( x = \{2,6,7\} \), the operation \( \text{sum}(x) \) returns a value of \{2,8,15\}.

For \( y = \{4,12,-6\} \), the operation \( \text{sum}(y) \) returns a value of \{4,16,10\}.
This function returns ranges consisting of the tangent of each value in the argument given. This and other trigonometric functions can take values in radians, degrees, or grads. This is determined by the Trigonometric Units selected in the User-Defined Transform dialog box.

**Syntax**

tan(numbers)

The *numbers* argument can be a scalar or range.

If you regularly use values outside of the usual $-2\pi$ to $2\pi$ (or equivalent) range, use the mod function to prevent loss of precision. Any missing value or text string contained within a range is ignored and returned as the string or missing value.

**Example**

If you choose Degrees as your Trigonometric Units in the transform dialog box, the operation `tan((0,45,135,180))` returns values of \{0,1,-1,0\}.

**tanh**

This function returns the hyperbolic tangent of the specified argument.

**Syntax**

tanh(numbers)

The *numbers* argument can be a scalar or range.

**Example**

The operation `x = tanh(col(3))` sets the variable *x* to be the hyperbolic tangent of all data in column 3.
### tden

This function is the T-distribution’s probability density function. It returns the value of the slope of the cumulative distribution function at the specified argument value.

**Syntax**

tden(x,n)

The `x` argument represents the independent variable and can either be a scalar or a range of numbers. If `x` is a range, then it must be defined by either using braces `{ }` or by specifying a worksheet column. The `n` argument can be any positive integer and equals the degrees of freedom.

**Example**

The density function can be used to estimate the probability that the values of a T-distributed random variable `T` lie in a small interval. If `T` has 16 degrees of freedom, then to estimate the probability that the values of `T` lie between 1 and 1.1, multiply the density of `T` at 1 by the length of the interval .1:

```
tden(1,16) * .1 = .02346
```
The $x$ argument represents the independent variable and can either be a scalar or a range of numbers. If $x$ is a range, then it must be defined by either using braces $\{ \}$ or by specifying a worksheet column. The $n$ argument can be any positive integer and equals the degrees of freedom.

### Example

Suppose $T$ is a $T$-distributed random variable with 14 degrees of freedom. To compute the probability that the absolute values of $T$ exceed 2, we calculate:

\[
P(|T| > 2) = P(T > 2) + P(T < -2) = 2\cdot P(T > 2) = 2\cdot (1 - P(T < 2)) = 2\cdot (1 - tdist(2, 14)) = 0.06529
\]

This is a typical calculation that is used to test whether two normally distributed groups of observations have the same mean. In this context, the value 2 in our example is called the critical value and is equal to the absolute difference in the sample means of the two groups divided by the pooled standard deviation of the groups. The resulting probability, 0.06529, is called the probability of significance.

### tinv

This function is the inverse of Student’s $T$-distribution function. The probability that a $T$-distributed random variable is less than the return value is equal to the argument you specify.

**Syntax**

\[tinv(x, n)\]

The $x$ argument can either be a scalar or a range of numbers. If $x$ is a range, then it must be defined by either using braces $\{ \}$ or by specifying a worksheet column. Any scalar value for $x$ represents a probability and so must be between 0 and 1. The $n$ argument can be any positive integer and equals the degrees of freedom.
Example
Suppose a T-distributed random variable T has 23 degrees of freedom. .75 quartile of T, we calculate:

\[ \text{tinv(.75,23)} = .68531 \]

total
The function total returns a single value equal to the total sum of all numbers in a specified range. Numerically, this is the same as the last number returned by the sum function.

Syntax
\[ \text{total(range)} \]
The range argument must be a single range (indicated with the \{ \} brackets) or a worksheet column. Missing values and text strings contained within the range are ignored.

Example
For \( x = \{9,16,7\} \), the operation total(x) returns a value of 32.
For \( y = \{4,12,-6\} \), the operation total(y) returns a value of 10.

x25
The x25 function returns an interpolated value of the x data at:

\[ y_{\text{min}} + \frac{\text{range}}{4} \]

in the ranges of coordinates provided, with optional Lowess smoothing. This is typically used to return the x value for the y value at 25% of the distance from the minimum to the maximum of smoothed data for sigmoidal shaped functions.
Syntax

\texttt{x25(x range, y range, f )}

The \textit{x range} argument specifies the \textit{x} variable, and the \textit{y range} argument specifies the \textit{y} variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. \textit{x range} and \textit{y range} must have the same size, and the number of valid data points must be greater than or equal to 3.

The optional \textit{f} argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. \( f \) must be greater than or equal to 0 and less than or equal to 1. If \( f \) is omitted, no smoothing is used.

Example

For \( x = \{0,1,2\}, y=\{0,1,4\} \), the operation

\texttt{col(1)=x25(x,y)}

places the \textit{x} at \( y_{\text{min}} + \frac{r \text{range}}{4} \)

as 1.00 into column 1.

\textbf{x50}

The \textit{x50} function returns an interpolated value of the \textit{x} data at:

\[ y_{\text{min}} + \frac{r \text{range}}{2} \]

in the ranges of coordinates provided, with optional Lowess smoothing. This is typically used to return the \textit{x} value for the \textit{y} value at 50\% of the distance from the minimum to the maximum of smoothed data for sigmoidal shaped functions.

Syntax

\texttt{x50(x range, y range, f )}
The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3.

The optional f argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. f must be greater than or equal to 0 and less than or equal to 1.0 ≤ f ≤ 1. If f is omitted, no smoothing is used.

**Example**

For \( x = \{0, 1, 2\} \), \( y = \{0, 1, 4\} \), the operation

\[
\text{col}(1) = \text{x75}(x, y)
\]

places the x at

\[
y_{\min} + \frac{y_{\text{range}}}{2}
\]

as 1.00 into column 1.

**x75**

The x75 function returns an interpolated value of the x data at:

\[
y_{\min} + \frac{3y_{\text{range}}}{4}
\]

in the ranges of coordinates provided, with optional Lowess smoothing. This is typically used to return the x value for the y value at 75% of the distance from the minimum to the maximum of smoothed data for sigmoidal shaped functions.

**Syntax**

\( \text{x75}(x \text{ range, y range, f } ) \)

The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is
ignored and will not be treated as a data point. x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3.

The optional $f$ argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. $f$ must be greater than or equal to 0 and less than or equal to $1.0 \leq f \leq 1$. If $f$ is omitted, no smoothing is used.

**Example**

For $x = \{0,1,2\}$, $y=\{0,1,4\}$, the operation

$$\text{col}(1)=x^{75}(x,y)$$

places the $x$ at

$$y_{\text{min}} + \frac{3\text{range}}{4}$$

as 2.00 into column 1.

**xatymax**

The xatymax function returns the interpolated x value at the maximum y value found, with optional Lowess smoothing.

**Syntax**

xatymax(x range, y range, f)

The x range argument specifies the x variable, and the y range argument specifies the y variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. x range and y range must have the same size, and the number of valid data points must be greater than or equal to 3. The optional $f$ argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. $f$ must be greater than or equal to 0 and less than or equal to $1.0 \leq f \leq 1$. If $f$ is not defined, no smoothing is used.

*Note:* If duplicate y maximums are found xatymax will return the average value of all the x at y maximums.
**Example**

For \( x = \{0, 1, 2\} \), \( y = \{0, 1, 4\} \), the operation

\[
\text{col}(1) = \text{xatymax}(x, y)
\]

places the \( x \) at the \( y \) maximum as 2.00 into column 1.

**xwtr**

The \( xwtr \) function returns value of \( x_{75} - x_{25} \) in the ranges of coordinates provided, with optional Lowess smoothing.

**Syntax**

\[
xwtr(x \text{ range}, y \text{ range}, f)
\]

The \( x \text{ range} \) argument specifies the \( x \) variable, and the \( y \text{ range} \) argument specifies the \( y \) variable. Any missing value or text string contained within one of the ranges is ignored and will not be treated as a data point. \( x \text{ range} \) and \( y \text{ range} \) must have the same size, and the number of valid data points must be greater than or equal to 3.

The optional \( f \) argument defines the amount of Lowess smoothing, and corresponds to the fraction of data points used for each regression. \( f \) must be greater than or equal to 0 and less than or equal to 1.0 \( \leq f \leq 1 \). If \( f \) is omitted, no smoothing is used.

**Example**

For \( x = \{0, 1, 2\} \), \( y = \{0, 1, 4\} \), the operation

\[
\text{col}(1) = \text{xwtr}(x, y)
\]

places the \( x_{75} - x_{25} \) as double 1.00 into column 1.
Chapter 20
Regression Equation Library

This appendix lists the equations found in the Regression Equation Library.

**Polynomial**

**Linear**

\[ y = y_0 + ax \]

**Quadratic**

\[ y = y_0 + ax + bx^2 \]

**Cubic**

\[ y = y_0 + ax + bx^2 + cx^3 \]

**Inverse First Order**

\[ y = y_0 + \frac{a}{x} \]
Chapter 21

Inverse Second Order

\[ y = y_0 + \frac{a}{x} + \frac{b}{x^2} \]

Inverse Third Order

\[ y = y_0 + \frac{a}{x} + \frac{b}{x^2} + \frac{c}{x^3} \]

Peak

Four Parameter Gaussian

\[ y = ne^{-0.5 \frac{(x-x_0)^2}{b^2}} \]

Five Parameter Gaussian

\[ y = y_0 + ne^{-0.5 \frac{(x-x_0)^2}{b^2}} \]

Three Parameter Modified Gaussian

\[ y = ne^{-0.5 \frac{(x-x_0)^2}{b^2}} \]
**Four Parameter Modified Gaussian**

\[ y = y_0 + a e^{-\frac{b}{(x-x_0)^2}} \]

**Three Parameter Lorentzian**

\[ y = \frac{a}{1 + \left(\frac{x-x_0}{b}\right)^2} \]

**Four Parameter Lorentzian**

\[ y = y_0 + \frac{a}{1 + \left(\frac{x-x_0}{b}\right)^2} \]

**Four Parameter Pseudo-Voigt**

\[ y = a \left[ e^{-\frac{1}{1 + \left(\frac{x-x_0}{b}\right)^2}} + (1 - e) e^{-0.5\left(\frac{x-x_0}{b}\right)^2} \right] \]

**Five Parameter Pseudo-Voigt**

\[ y = a \left[ e^{-\frac{1}{1 + \left(\frac{x-x_0}{b}\right)^2}} + (1 - e) e^{-0.5\left(\frac{x-x_0}{b}\right)^2} \right] \]

**Three Parameter Log Normal**

\[ y = a e^{-0.5 \left(\frac{\ln\left(\frac{x}{x_0}\right)}{b}\right)^2} \]
Chapter 21

**Four Parameter Log Normal**

\[
y = y_0 \left( \frac{\ln\left( \frac{x}{x_c} \right)}{b} \right)^c
\]

**Four Parameter Weibull**

\[
y = y_0 \left( \frac{\ln\left( \frac{x}{x_c} \right)}{b} \right)^c
\]

**Five Parameter Weibull**

\[
y = y_0 + c \left( \frac{\ln\left( \frac{x}{x_c} \right)}{b} \right)^c \left[ \left( \frac{\ln\left( \frac{x}{x_c} \right)}{b} \right) + \left( \frac{1}{3} \right) \right], c < 1
\]

**Sigmoidal**

**Three Parameter Sigmoid**

\[
y = \frac{c}{1 + e^{-\left( \frac{x-x_0}{b} \right)}}
\]

**Four Parameter Sigmoid**

\[
y = y_0 + \frac{c}{1 + e^{-\left( \frac{x-x_0}{b} \right)}}
\]

**Five Parameter Sigmoid**

\[
y = y_0 + \frac{c}{\left[ 1 + e^{-\left( \frac{x-x_0}{b} \right)} \right]^c}
\]
Three Parameter Logistic

\[ y = \frac{d}{1 + \left( \frac{X}{x_0} \right)^b} \]

Four Parameter Logistic

\[ y = y_0 + \frac{d}{1 + \left( \frac{X}{x_0} \right)^b} \]

Four Parameter Weibull

\[ y = a \left[ 1 - e^{\left( \frac{X-x_1 + e\ln b}{b} \right)^c} \right] \]

Five Parameter Weibull

\[ y = y_0 + a \left[ 1 - e^{\left( \frac{X-x_1 + e\ln b}{b} \right)^c} \right] \]

Three Parameter Gompertz Growth Model

\[ y = a e^{e^{\frac{X-x_1}{b}}} \]

Four Parameter Gompertz Growth Model

\[ y = y_0 + ae^{e^{\frac{X-x_1}{b}}} \]
Chapter 21

Three Parameter Hill Function
\[ y = \frac{a \cdot b}{x^b} \]

Four Parameter Hill Function
\[ y = y_0 + \frac{a \cdot b}{c + x^b} \]

Three Parameter Chapman Model
\[ y = \sigma (1 - e^{-kx}) \]

Four Parameter Chapman Model
\[ y = y_0 + \sigma (1 - e^{-kx}) \]

Exponential Decay

Two Parameter Single Exponential Decay
\[ y = a e^{-b \cdot x} \]

Three Parameter Single Exponential Decay
\[ y = y_0 + a e^{-b \cdot x} \]
Four Parameter Double Exponential Decay
\[ y = a e^{-bx} + c e^{-dx} \]

Five Parameter Double Exponential Decay
\[ y = y_0 + a e^{-bx} + c e^{-dx} \]

Six Parameter Triple Exponential Decay
\[ y = a e^{-bx} + c e^{-dx} + g e^{-hx} \]

Seven Parameter Triple Exponential Decay
\[ y = y_0 + a e^{-bx} + c e^{-dx} + g e^{-hx} \]

Modified Three Parameter Single Exponential Decay
\[ y = \left( \frac{y}{y_0} \right) \cdot \left( \frac{a}{c} \right) e^{-e \cdot x} \]

Exponential Linear Combination
\[ y = \left( \frac{y}{y_0} \right) \cdot \left( \frac{a}{c} \right) e^{-e \cdot x} \]

Exponential Rise to Maximum
Two Parameter Single Exponential Rise to Maximum
\[ y = a (1 - e^{-bx}) \]
Chapter 21

Three Parameter Single Exponential Rise to Maximum
\[ y = y_0 + a(1 - e^{-bx}) \]

Four Parameter Double Exponential Rise to Maximum
\[ y = y_0 + a(1 - e^{-bx}) + c(1 - e^{-dx}) \]

Five Parameter Double Exponential Rise to Maximum
\[ y = y_0 + a(1 - e^{-bx}) + c(1 - e^{-dx}) + e(1 - e^{-fx}) \]

Two Parameter Simple Exponent Rise to Maximum
\[ y = y_0 + a(1 - e^{bx}) \]

Three Parameter Simple Exponent Rise to Maximum
\[ y = y_0 + a(1 - e^{bx}) \]

Exponential Growth

One Parameter Single Exponential Growth
\[ y = e^{cx} \]

Two Parameter Single Exponential Growth
\[ y = e^{cx} \]
Three Parameter Single Exponential Growth

\[ y = y_0 + ae^{bx} \]

Four Parameter Double Exponential Growth

\[ y = ae^{bx} + ce^{dx} \]

Five Parameter Double Exponential Growth

\[ y = y_0 + ae^{bx} + ce^{dx} \]

Modified One Parameter Single Exponential Growth

\[ y = ae^{dx} \]

Modified Two Parameter Single Exponential Growth

\[ y = e^{c(x-x_0)} \]

Stirling Model

\[ y = y_0 + \alpha \left( \frac{e^{by} - 1}{b} \right) \]

Two Parameter Simple Exponent

\[ y = ab^x \]
Three Parameter Simple Exponent

\[ y = y_0 + ab^x \]

Modified Two Parameter Simple Exponent

\[ y = y_0 + (\log a)x \]

Hyperbola Library

Two Parameter Rectangular Hyperbola

\[ y = \frac{ax}{b + x} \]

Three Parameter Rectangular Hyperbola I

\[ y = y_0 + \frac{ax}{b + x} \]

Three Parameter Rectangular Hyperbola II

\[ y = \frac{ax}{b + x} + cx \]

Four Parameter Double Rectangular Hyperbola

\[ y = \frac{ax}{b + x} + \frac{cx}{d + x} \]
**Regression Equation Library**

**Five Parameter Double Rectangular Hyperbola**

\[ y = \frac{ab}{b + x} + \frac{cd}{d + x} + ex \]

**Two Parameter Hyperbolic Decay**

\[ y = \frac{ab}{b + x} \]

**Three Parameter Hyperbolic Decay**

\[ y = j_0 + \frac{ab}{b + x} \]

**Modified Hyperbola I**

\[ y = \frac{ax}{1 + bx} \]

**Modified Hyperbola II**

\[ y = \frac{x}{a + bx} \]

**Modified Hyperbola III**

\[ y = a - \frac{b}{(1 + cx)^d} \]
Waveform

Three Parameter Sine

\[ y = a \sin \left( \frac{2\pi x}{b} + c \right) \]

Four Parameter Sine

\[ y = y_0 + a \sin \left( \frac{2\pi x}{b} + c \right) \]

Three Parameter Sine Squared

\[ y = \left[ \sin \left( \frac{2\pi x}{b} + c \right) \right]^2 \]

Four Parameter Sine Squared

\[ y = y_0 + \left[ \sin \left( \frac{2\pi x}{b} + c \right) \right]^2 \]

Four Parameter Damped Sine

\[ y = a e^{-\frac{x}{d}} \sin \left( \frac{2\pi x}{b} + c \right) \]

Five Parameter Damped Sine

\[ y = y_0 + a e^{-\frac{x}{d}} \sin \left( \frac{2\pi x}{b} + c \right) \]
**Modified Sin**

\[ y = a \sin \left( \frac{\pi(x - x_0)}{b} \right) \]

**Modified Sine Squared**

\[ y = a \left[ \sin \left( \frac{\pi(x - x_0)}{b} \right) \right]^2 \]

**Modified Damped Sine**

\[ y = a e^{-\left( \frac{x}{b} \right)} \sin \left( \frac{\pi(x - x_0)}{b} \right) \]

**Power**

**Two Parameter**

\[ y = ax^b \]

**Three Parameter**

\[ y = y_0 + ax^b \]

**Pareto Function**

\[ y = 1 - \frac{1}{x^n} \]
**Three Parameter Symmetric**

\[ y = a |x - x_0|^b \]

**Four Parameter Symmetric**

\[ y = y_0 + a |x - x_0|^b \]

**Modified Two Parameter I**

\[ y = a(1 - x^b) \]

**Modified Two Parameter II**

\[ y = a(1 + x)^b \]

**Modified Pareto**

\[ y = \frac{1}{(1 + ax)^b} \]

**Rational**

**One Parameter Rational I**

\[ y = \frac{1}{x + a} \]
Regression Equation Library

**One Parameter Rational II**
\[ y = \frac{1}{1 + ax} \]

**Two Parameter Rational I**
\[ y = \frac{1}{a + bx} \]

**Two Parameter Rational II**
\[ y = \frac{a}{1 + bx} \]

**Three Parameter Rational I**
\[ y = \frac{a + bx}{1 + cx} \]

**Three Parameter Rational II**
\[ y = \frac{1 + ax}{b + cx} \]

**Three Parameter Rational III**
\[ y = \frac{a + bx}{e + x} \]

**Three Parameter Rational IV**
\[ y = \frac{a + x}{b + cx} \]
Chapter 21

**Four Parameter Rational**

\[ y = \frac{a + bx}{1 + cx + dx^2} \]

**Five Parameter Rational**

\[ y = \frac{a + bx + cx^2}{1 + dx + ex^2} \]

**Six Parameter Rational**

\[ y = \frac{a + bx + cx^2}{1 + dx + ex^2 + fx^3} \]

**Seven Parameter Rational**

\[ y = \frac{a + bx + cx^2 + dx^3}{1 + cx + fx^2 + gx^3} \]

**Eight Parameter Rational**

\[ y = \frac{a + bx + cx^2 + dx^3}{1 + cx + fx^2 + gx^3 + hx^4} \]

**Nine Parameter Rational**

\[ y = \frac{a + bx + cx^2 + dx^3 + ex^4}{1 + fx + gx^2 + hx^3 + ix^4} \]

**Ten Parameter Rational**

\[ y = \frac{a + bx + cx^2 + dx^3 + ex^4}{1 + fx + gx^2 + hx^3 + ix^4 + jx^5} \]
Eleven Parameter Rational

\[ y = \frac{a + bx + cx^2 + dx^3 + ex^4 + fx^5}{1 + gx + hx^2 + ix^3 + jx^4 + kx^5} \]

Logarithm

Two Parameter I

\[ y = y_0 + a \ln x \]

Two Parameter II

\[ y = a \ln(x - x_0) \]

Two Parameter III

\[ y = \ln(a + bx) \]

Second Order

\[ y = y_0 + a \ln x + b(\ln x)^2 \]

Third Order

\[ y = y_0 + a \ln x + b(\ln x)^2 + c(\ln x)^3 \]
3 Dimensional

**Plane**

\[ z = z_0 + ax + by \]

**Paraboloid**

\[ z = z_0 + ax + by + cx^2 + dy^2 \]

**Gaussian**

\[ z = \sigma e^{\frac{(x-x_0)^2}{a} + \frac{(y-y_0)^2}{b}} \]

**Lorentzian**

\[ z = \frac{a}{1 + \left(\frac{x-x_0}{b}\right)^2} \left[1 + \left(\frac{y-y_0}{c}\right)^2\right] \]

**Standard Curves**

**Linear Curve**

\[ y = y_0 + ax \]
Four Parameter Logistic Curve

\[ y = \min + \frac{(\max - \min)}{1 + \left(\frac{\min}{R_{50}}\right)^{b_{slope}}} \]

Ligand Binding

One Site Saturation

\[ y = \frac{B_{\max} x}{K_d + x} \]

Two Site Saturation

\[ y = \frac{B_{\max} x}{K_{d1} + x} + \frac{B_{\max} x}{K_{d2} + x} \]

One Site Saturation + Nonspecific

\[ y = \frac{B_{\max} x}{K_d + x} + N_s x \]

Two Site Saturation + Nonspecific

\[ y = \frac{B_{\max} x}{K_{d1} + x} + \frac{B_{\max} x}{K_{d2} + x} + N_s x \]

Sigmoidal Dose Response

\[ y = \min + \frac{(\max - \min)}{1 + 10^{b_{slope} \cdot x}} \]
Chapter 21

Sigmoidal Dose Response (Variable Slope)

\[ y = \min + \frac{\text{max} - \min}{1 + 10^{(\log_{10}(\text{IC}_{50}^{\text{new}}) - x)}} \]

One Site Competition

\[ y = \frac{B_{\text{max}} x}{K_x + x} \]

Two Site Competition

\[ y = \frac{B_{\text{max}1} x}{K_{x1} + x} + \frac{B_{\text{max}2} x}{K_{x2} + x} \]

Four-Parameter Logistic Function

\[ y = D + \frac{(A - D)}{1 + 10^{(x - x_0) / p}} \]

Four-Parameter Logistic Function (Linear)

\[ y = D + \frac{(A - D)}{x} \]

One Site Competition, Max = 100

\[ y = \min + \frac{\text{max} - \min}{1 + 10^{(\log_{10}(\text{IC}_{50}^{\text{new}}) - x)}} \]

One Site Competition, Min = 0, Max = 100

\[ y = \min + \frac{\text{max} - \min}{1 + 10^{(\log_{10}(\text{IC}_{50}^{\text{new}}) - x)}} \]
**Piecewise**

**Two Segment Linear**

\[ y = \begin{cases} 
\frac{y_1(T_1 - t) + y_2(t - t_1)}{(T_1 - t_1)} & t_1 \leq t \leq T_1 \\
\frac{y_2(T_2 - t) + y_3(t - t_2)}{(T_2 - t_2)} & T_2 < t \leq t_2 
\end{cases} \]

**Three Segment Linear**

\[ y = \begin{cases} 
\frac{y_1(T_1 - t) + y_2(t - t_1)}{(T_1 - t_1)} & t_1 \leq t \leq T_1 \\
\frac{y_2(T_2 - t) + y_3(t - t_2)}{(T_2 - t_2)} & T_2 < t \leq T_3 \\
\frac{y_3(t_3 - t) + y_4(t - t_3)}{(t_3 - t_3)} & T_3 < t \leq t_4 
\end{cases} \]

**Four Segment Linear**

\[ y = \begin{cases} 
\frac{y_1(T_1 - t) + y_2(t - t_1)}{(T_1 - t_1)} & t_1 \leq t \leq T_1 \\
\frac{y_2(T_2 - t) + y_3(t - t_2)}{(T_2 - t_2)} & T_2 < t \leq T_3 \\
\frac{y_3(T_3 - t) + y_4(t - T_3)}{(T_3 - t_3)} & T_3 < t \leq T_4 \\
\frac{y_4(t_4 - t) + y_5(t - t_4)}{(t_4 - t_4)} & T_4 < t \leq t_5 
\end{cases} \]

**Five Segment Linear**

\[ y = \begin{cases} 
\frac{y_1(T_1 - t) + y_2(t - t_1)}{(T_1 - t_1)} & t_1 \leq t \leq T_1 \\
\frac{y_2(T_2 - t) + y_3(t - t_2)}{(T_2 - t_2)} & T_2 < t \leq T_3 \\
\frac{y_3(T_3 - t) + y_4(t - T_3)}{(T_3 - t_3)} & T_3 < t \leq T_4 \\
\frac{y_4(T_4 - t) + y_5(t - T_4)}{(T_4 - t_4)} & T_4 < t \leq T_5 \\
\frac{y_5(t_5 - t) + y_6(t - t_5)}{(t_5 - t_5)} & T_5 < t \leq t_6 
\end{cases} \]
Angular Axis. The angular axes of polar plot are drawn along the inner (if applicable) and outer circumferences of the graph. By default, the inner axis is not displayed, but if your radial axes are offset from the center of the graph, you can choose to display the inner angular axis.

Apex. The maximum/minimum or tip of the triangle for ternary plot axes.

Aspect Ratio. The Aspect Ratio option allows for resizing of graphs and objects without distortion. To maintain the aspect ratio (the ratio of length to height) of a graph or object during manual resizing, make sure the Stretch Maintains Aspect Ratio option is selected on the Page tab of the Options dialog box.

Axis. In a Cartesian graph, an axis indicates the direction and range of X, Y, or Z values. In SigmaPlot, axes define the origin and scaling of a plot, and include tick and label definitions. Multiple axes for 2D graphs can be created using the Graph menu Add Axis command. Because each 2D Cartesian plot can be associated with only one set of X and Y axes, you can only create new axes if your graph contains multiple plots. However, since a graph can contain an unlimited number of plots, you can create an unlimited number of X and Y axes for a graph. Note that an unlimited number of plots can share a single axis.

Axis Break. A range along the axis where portions of a plot are omitted. If there is a large empty range between two sets of data, you can use an axis break to omit the empty range.

Axis Direction. For ternary axes, the direction that the data increases. This can be counter-clockwise (by default) or clockwise.

Axis Label. Axis titles and tick labels. Axis titles can be automatically taken from the Axis name (as shown in the Axis tab of the Graph Properties dialog box) or manually typed using the Tools menu Text command. Tick labels can be numeric, time series, or taken from a worksheet column.
**Backplane.** The plane at the back of a graph formed by the axes. Grid lines are attached to backplanes. Backplanes are selected and modified on the Graph tab of the Graph Properties dialog box.

**Bad Points.** Any of three types of data points: 1) data that fall outside the range specified for the axes; 2) empty, missing, or non-data cells; 3) data outside the legal range for an axis, for example, a non-positive value on a logarithmic scale. You can ignore bad points using the Data settings of the Plots panel in the Graph Properties dialog box.

**Base (of an exponent).** The number that is raised to the exponential power (for example, 10 or e).

**Bitmap.** A general description for an image composed of individual bits, or pixels. Also a term for the Window bitmap graphic file format. The resolution of a bitmap is dependent on the dpi, or dots per inch, it is created with. Because the number of pixels that compose a bitmap is constant, making a bitmap appear smaller increases its relative resolution by increasing its dpi. Conversely, making a bitmap larger reduces the dpi and its resolution.

**Block.** 1) A selected, rectangular region of worksheet cells. Blocks can be copied, deleted, pasted, transposed, sorted, printed, and exported. 2) A transform language function that operates on worksheet blocks.

**Box Plot.** A plot type that displays the 10th, 25th, 50th, 75th, and 90th percentiles as lines on a bar centered about the mean, and the 5th and 95th percentiles as error bars. The mean line and data points beyond the 5th and 95th percentiles can also be displayed.

**Bubble Plots.** A special case of scatter plot where a third dimension is graphed using the areas of the symbols.

**Cartesian.** A graph using a rectangular XY (or XYZ) coordinate system. SigmaPlot can create both 2D and 3D Cartesian graphs.

**Category Scale.** A scale which uses numerical values or text from a worksheet column used to generate a plot. Each distinct entry in the column is a separate category against which the corresponding data values are plotted.
Cell. 1) A location on the worksheet that holds a single data value or label, described by its column and row number. 2) A transform language function that specifies the coordinates and contents of a worksheet cell.

Column Averaging. Plotting the mean value of each column. This is most often used as a means of creating error bars. Standard deviation, standard error, or 95% or 99% confidence values can be used as error bar values.

Column Statistics. A collection of statistics computed for each column. Open the Column Statistics window by choosing the View menu Column Statistics command.

Confidence Line. For a regression line, there is a probability that any given data point will fall within a certain distance from the line. A confidence interval is the region where a data point will fall with a specific degree of probability. SigmaPlot can calculate 95% and 99% confidence intervals.

Coordinate System. A system that defines the method of defining data point placement on a graph. SigmaPlot supports 2D and 3D Cartesian graphs, polar plots, ternary plots, and pie charts. 1) Cartesian graphs use two or three rectangular axes to describe data point location. 2) A polar plot describes data using angle and radius within a circular region. 3) Ternary graphs plot data along three axis ranges that have a sum of 100%. 4) A pie chart uses polar coordinates to assign slice sizes to data point values. A graph’s coordinate system is fixed when you create the graph and cannot be changed.

Correlation Coefficient (R). R, or the measure of closeness of a regression to the data. Specifically, it is the covariance divided by the product of the sample standard deviations. SigmaPlot calculates the correlation coefficient for linear regressions.

Cubic Spline Interpolation. A mathematical formula connecting data points with a smooth curve. It can be roughly described as a running interpolation of cubic polynomials.

Delimiter. A symbol or character used to separate data fields within a data file format; for example, white space, commas, semicolons, or colons.

Drop Lines. Lines which can be added to 2D and 3D plots which use symbols.
**Embed.** Use the Edit menu Paste Special to embed an object on a graph page. Embedding an object on the page places a copy of the object on the graph page and enables you to edit the object by activating the object’s source application when you double-click it, but does not change the original file from which the object was pasted.

**Encapsulated Postscript File (EPS).** Encapsulated PostScript files are scalable line art graphic files. Use this file format to export SigmaPlot graphs to other word processor and graphic applications. To create an EPS file, you must have a correctly installed Postscript printer driver supported by Windows.

**Error Bar.** A graphical display of the data variability. Error bar values can be automatically calculated through column averaging, or they can be entered in the worksheet columns.

**Exploding Pie Slice.** A slice in a pie chart that is separated from the rest of the chart for emphasis.

**Exponent.** The power to which the base is raised. See Base.

**Final Parameters.** These are the best-fit parameter values obtained when the fit process converges.

**Frame Lines.** Lines which are drawn to complete the “cube” outlining a 3D Cartesian graph. Frame lines can be drawn using either the viewer or the origin as the reference. Use the Frame Lines settings in the Graph Tab of the Graph Properties dialog box to turn on/off frame lines.

**Gaussian.** 1) A continuous probability distribution defined by two parameters, mean, and variance. Also called the normal distribution. 2) A transform language function used to generate random normally distributed data.

**Iterations.** The number of iterations needed for convergence.

**Novice Prompting.** Messages alerting you to certain situations or which double check some choices (for example, telling you that data contains missing values or asking for confirmation before clearing data). Novice prompting can be disabled using the Tools menu Options command.
OLE2. Objects pasted from the Clipboard to a graph page can be linked, embedded, or placed on the page as a generic object without any kind of file reference. Linked and embedded objects use OLE2, Object Linking and Embedding version 2.

Orientation (page). Describes the orientation of a page. Page orientation can be either portrait (right-side up) or landscape (sideways). Page orientation is controlled using the File menu Page Setup command or Printer Properties options in the Print dialog box.

Origin Axes. For 3D Cartesian graphs, the axes intersecting at the X, Y, and Z coordinates closest to zero. The origin axes are used as a point of reference when rotating the view of a 3D graph, and appear as red lines in the 3D View panel of the Graph Properties dialog box.

Percentage Scale. A scale ranging from 0-100 as the absolute minimum and maximum, used for ternary graphs.

Perspective. A 3D graph view option, controlling the apparent “depth” of the graph. Use the Rotation settings of the 3D View panel in the Graph Properties dialog box to change a 3D graph’s perspective.

Pie Chart. A graph where each data point in a column is represented as a pie slice equivalent to its percentage of the total.

Polar Plot. Polar plots show data in $r = f(\theta)$ format where $r$ is the distance from the origin of the graph, and theta ($\theta$) is the angle described by a line passing through the center of the graph and the plotted data point, and another line passing through the center of the graph horizontally on the page.

Radial Axes. The radial axes of a polar plot are drawn along the radius of the graph, and by default are displayed as four axes extending from the center of the graph to the outer edge of the graph.

Standard Method. You can set SigmaPlot to use this method to compute percentiles for box and quartile plots on the General tab of the Options dialog box. If the data in increasing order is $x_1, x_2, ..., x_N$ and the percentile is $p$, the Standard method computes the data percentile value $v$ using the formula: Let $k$ be the largest integer less than or equal to $(N+1)*p/100$, and let $f = (N+1)*p/100 - k$. Both the Standard and Cleveland methods use the formula $v = f*x_k + 1 + (1-f)*x_k$ to compute the percentile value.
**Sum of Squares.** When the fit has converged, this is sum of squares of the residuals between the observed values and the values of the final fit equation summed over all values of the independent variable(s).
Index

.Scan files
  opening, 40, 41

.CVS files
  opening, 40, 41

.DBF files
  opening, 40, 41

.DIF files
  opening, 40, 41

.FIT files, 632
  Adding to library or notebook, 632

.ini files, 8

.jfl files, 8

.jgg files, 8

.JNB files
  exporting as non-notebook files, 224
  saving, 36

.JNT files
  defined, 2

.jnt files, 8

.MOC files
  opening, 40, 41

.PRN files
  opening, 40, 41

.SMB files
  importing, 53

.SP5 files
  opening, 40, 41

.SPG files
  opening, 40, 41

.SPW files
  opening, 40, 41

.TIFF files
  post-processing, 513

.TXT files
  opening, 40, 41

.WK* files
  opening, 40, 41

10th/90th percentiles
  box plots, 333

1st derivative
  computing, 540

21CFR, 43

2D graphs
  adding plots, 171
  area plots, 300, 336, 345
  arranging data, 141
  asymmetric error bar plots, 142
  asymmetric error bars, 313
  bar charts, 301
  box plots, 301, 333
  column averaged error bar plots, 142
  creating, 302
  creating multiple axes for single plot, 358
  creating plots with asymmetric error bars, 313
  creating plots with error bars, 308
  error bars, 308
  examples, 16, 20
  grouped bar charts, 325, 326
  grouped bar charts with error bars, 325
  linear regression lines, 487, 489
  modifying plots, 487, 494
  multiple axes, 358
  multiple plots, 171
  plotting data, 141, 299, 300, 301, 331
  plotting multiple curves, 140
  plotting multiple curves, same X or Y, 141
  plotting X or Y using row numbers, 141
  polar axes, 460
  quartile plots, 314
  range plots, 312
Index

reference lines, 333
3D bar charts
  data format, 111
  fills, 198
3D graphs
  adding plots, 171
  axes placement during rotation, 375
  bar chart data format, 111
  bar charts, 361
  changing view, 371
  creating, 363, 364, 365
  creating mesh, 367
  data format, 111
  examples, 21, 24
  generating mesh data, 4
  light source, 371
  lighting, 371
  line data format, 111
  mesh, 360
  mesh data format, 111
  mesh lines/fills, 368
  mesh plots, 367
  modifying mesh lines and fill color, 368
  origin axes, 371
  perspective, 371
  plotting data, 149, 359
  positioning axes, 375
  rotation, 371
  Scatter and line, 359
  scatter data format, 111
  smoothing mesh data, 4
  trajectory, 364
  waterfall plots, 362, 365
3D mesh plots
  data format, 111
3D mesh with contour projections, 370
3D scatter plots
  adding drop lines, 207, 209
  symbols, 180, 189
95% confidence interval, 678
95% confidence intervals, 678
95% prediction interval, 678
abs function, 767
absolute minimum
  sum of squares, 733, 734
accumulation functions, 762
Add Procedure dialog box, 528
adding
  axes, 358
  axis breaks, 424
  contour fills, 382
  contour labels, 387, 388
  exploding slices to pie charts, 397, 398
  frame lines, 376
  graphs to pages, 232, 233
  labels to page, 280
  macros to macros, 527
  multiple axes for single plot, 358
  plots to graphs, 171
  prefix/suffix to tick labels, 445
  procedures to macros, 528
  reference lines, 333
  regression equations to graph pages, 638, 699
  styles to Graph Style Gallery, 158
  suffixes/prefixes, 387
  text to page, 280
algorithm
  Marquardt-Levenberg, 631, 655, 725
aligning
  axis titles, 429
  legends, 289
  objects/graphs/labels, 2, 278
  snap-to grids, 279
  text, 280
  using crosshairs, 279
  using snap-to, 279
  with grids, 279
  with rulers, 279
alpha value, 675
alphanumeric symbols, 184
angular axes
  about, 453
  arc, 454
  modifying, 460
  range, 454
  rotation, 454
  scale, 454
angular values, 143
Angular, 407, 450, 453, 454, 456, 468, 849
ANOVA
  one way ANOVA transform, 583
ANOVA table
  regression results, 672
ape function, 768
Apex, 463, 465, 471, 545, 849
apex
  dragging to modify ternary axis ranges, 465
applying
  data transforms, 4
  graph styles using the Graph Style Gallery, 159
arc
  angular axis, 454
arccos function, 769
arcsin function, 769
arctan function, 770
area and distance
  functions, 763
Area Below Curves, 537
area beneath a curve
  transform, 584
area function, 771
area plot data formats
  multiple area plot, 127
  multiple vertical area plot, 127
  simple area plot, 127
  vertical area plot, 127
area plots, 336
  changing area fill direction, 344
  changing fill color, 345
  climographs, 346
  converting multiple into complex, 343
  creating complex area plots, 341
  creating multiple and multiple vertical area plots, 339
  creating simple straight line area plots, 336
  creating vertical area plots, 336
  examples, 300
  identifying regions, 343
  shading between two curves, 346
arguments, transform, 759
arithmetic operators
  transforms, 563
arranging
  data for 2D graphs, 141
  data for 3D graphs, 149
  data for bubble plots, 145
  data for contour plots, 149
  data for polar plots, 144
  graphs, 276
  graphs on a page, 272
  radial and angular values for polar plots, 143
  XY data for polar plots, 143
arranging data, 138, 148
  asymmetric error bar plots, 142
  column averaged error bar plots, 142
  column means, 142
  polar plots, 143
Arrhenius plot, 411
Arrhenius scale, 418
arrow keys
  moving graphs and objects using, 270
arrows
  drawing, 260
  modifying arrow heads, 265
ASCII files, 63
aspect ratio
  options, 224
Aspect, 268, 509, 849
assumption checking
  options, 640
asymmetric error bar plots, 142
asymmetric error bars
  creating 2D plots with, 313
asymmetrical error bars
  quartile plots, 314
attributes, 242
  changing line, 421
  text formatting, 281
audit trails, 43
automatic
  determination of initial parameters, 722
automatic legend updating, 289
automatic legends, 3, 14, 283, 289
displaying, 286, 288
Index

editing, 286
locking, 289
restoring to default settings, 286
automation, 524
Add Procedure dialog box, 528
adding macros to macros, 527
automating routine tasks, 519
creating custom dialog boxes, 527
creating macros, 519
creating menu commands, 534
creating user-defined functions, 530
Debug Window, 530
editing macro code, 526
editing macros, 522
macro window, 525
Macro Window toolbar, 523
Object Browser, 528
parts of macro programming language, 525
running macros, 549
user-defined functions, 529
AutoRecover, 37
available statistics, 67
averaging, 67
avg function, 771
axes
displaying, 419
engineering notation, 442
hiding, 419
modifying, 419
polar plots, 453
turning on/off, 419
viewing, 419
Axis, 267, 279, 411, 413, 418, 421, 422, 423, 424, 425, 427, 539, 849
axis
3D placement during rotation, 375
about, 355
adding, 358
additional for multiple plots, 355
angular, 460
breaks, 3, 424
category scale, 410, 416
changing scale, 408, 409, 410, 411
changing scale types, 415, 418
common log, 408
contour range values, 384
creating multiple for single plot, 358
custom scale, 418
date/time, 411
dragging to modify ternary ranges, 465
Extreme Value Distribution axis scale, 418
labels, 429
line attributes, 421
linear scale, 408
logit scale, 410
modifying, 375
modifying range by dragging, 465
moving 2D, 423
multiple, 3
multiple pairs, 358
natural log scale, 409
origin axes, 371
polar, 460
positioning 3D, 375
positioning using Graph Properties dialog, 423
probability scale, 409
probit scale, 409
radial, 460
radial tick labels, 460
range values, 413
range, changing, 413
reciprocal, 411
scale types, 408, 409, 410, 411, 415, 418
scale values, 445
tick labels, 445
tick marks, 435, 474
titles, 429
types, 408, 409, 410, 411
using drawing tools, using formatting commands, 4
using Object Properties dialog, 421
x and y, 3
Axis Break, 3, 424, 453, 463, 849
axis breaks
creating, 424
Axis Direction, 463, 469, 849
axis range
scale, 413
values, 413
axis scale
Arrhenius, 418
Extreme Value Distribution, 418
switching to category, 416
switching to custom, 418
types, 408
axis titles
editing, 426
hiding, 427
moving, 429
rotating, 427
viewing, 427
axis, range
contour plots, 384
Axis, 428, 460, 849
Axon files
importing, 64

back planes
color, 450
grid lines, 452
Backplane, 370, 450, 850
backup files, 14
Bad, 176, 850
bar charts
automatic reference lines, 493
creating, 302
drawing, 260
edges, 262
error bars, 323
elements, 301
fills, 198, 262
grouped bars with error bars, 328
histograms, 481, 485
horizontal data format, 111
needle, 481
needle plot, 203
spacing bars, 203, 206, 327
step, 481
bar charts, 3D
creating, 363, 364
elements, 361
bar widths
variable, 206
bars
drawing, 260
Index

fills, 198, 262
Box, 301, 331, 850
breaking
  links, 255
breaks, 424
bubble plots, 180
  2D, 354
    applications, 354
  arranging data, 145
  arranging data for size, 146
  converting area data to diameters, 146
  plotting data, 145
  transforms dialog box, 146
  X, Y values, 146
Bubble, 354, 850
By Group Data Split, 539

calculating
  confidence intervals, 491
  error bar mean, 323
  error bars, 323
  linear regressions, 491
  prediction intervals, 491
cancelling a regression, 657
Cartesian, 1, 15, 407, 424, 450, 460, 536, 546, 850
category axis scale, 410
category data, 138
  creating graphs using, 304
  using to create plots, 316
category scale
  creating, 416
  modifying, 416
Category, 410, 416, 850
Cell, 84, 85, 851
cell, 773
  engineering notation, 81
  formatting in worksheets, 81
  moving to, 50
  setting decimal places in worksheets, 81
  using as column or row titles, 93
  wrapping text, 81
centering
  axis titles, 429
Changing
  axis color, 421
  axis thickness, 421
changing
  3D graph view, 371
  area plot fill color, 345
  axis range, 413
  axis scale, 408
  axis scale types, 415, 418
  bar/box fills, 262
  color of fill pattern lines and edge lines, 262
  colors, 195
  column width, 71, 73
  contour labels, 387, 388
  contour plots, 380, 388
  contour range values, 384
  default layout template file, 276
  fill patterns, 262
  fills, 195
  grids, 450
  inserted object icons, 253
  line end attributes, 265
  line types, 191, 263
  multiple selected objects, 266
  object background fills, 262
  objects fills, 262
  page color, 293
  pasted object icons, 251
  pattern and edge line thickness, 262
  pattern density of plot fills, 195
  patterns, 195
  pie charts, 398
  polar plot axes, 453
  polar plots, 144
  radial axes, 457, 460
  radial axes tick labels, 460
  range direction, 469
  scale direction, 469
  slice fills, 262
  source files for links, 255
  symbol fills, 262
ternary axis direction, 469
ternary graphs, 405
ternary range, 469
ternary scale type, 468
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>text formatting, 281</td>
</tr>
<tr>
<td>tick label text, 442</td>
</tr>
<tr>
<td>tick values, 445</td>
</tr>
<tr>
<td>units of measurement, 292</td>
</tr>
<tr>
<td>characters</td>
</tr>
<tr>
<td>non-keyboard, 280</td>
</tr>
<tr>
<td>using as symbols, 184</td>
</tr>
<tr>
<td>chart fills</td>
</tr>
<tr>
<td>color incrementing, 198</td>
</tr>
<tr>
<td>charts</td>
</tr>
<tr>
<td>creating pie charts, 138</td>
</tr>
<tr>
<td>chi-square</td>
</tr>
<tr>
<td>reduced, 671</td>
</tr>
<tr>
<td>chisquareden function, 774</td>
</tr>
<tr>
<td>chisquaredist function, 774</td>
</tr>
<tr>
<td>chisquareinv function, 775</td>
</tr>
<tr>
<td>Cholesky decomposition, 491</td>
</tr>
<tr>
<td>choose, 776</td>
</tr>
<tr>
<td>clearing, 86</td>
</tr>
<tr>
<td>graph titles, 260</td>
</tr>
<tr>
<td>graphs/objects, 260</td>
</tr>
<tr>
<td>legends, 260</td>
</tr>
<tr>
<td>Cleveland percentile method</td>
</tr>
<tr>
<td>using for box plots, 335</td>
</tr>
<tr>
<td>using for quartile box plots, 335</td>
</tr>
<tr>
<td>climographs, 346</td>
</tr>
<tr>
<td>Clipboard</td>
</tr>
<tr>
<td>cutting and copying data, 80, 245</td>
</tr>
<tr>
<td>using, 245</td>
</tr>
<tr>
<td>clockwise angular units</td>
</tr>
<tr>
<td>setting for polar plots, 401</td>
</tr>
<tr>
<td>coefficient of determination</td>
</tr>
<tr>
<td>stepwise regression results, 658, 670</td>
</tr>
<tr>
<td>coefficient of determination (R Squared) transform, 589</td>
</tr>
<tr>
<td>coefficient of variation</td>
</tr>
<tr>
<td>parameters, 659</td>
</tr>
<tr>
<td>coefficients</td>
</tr>
<tr>
<td>regression results, 671</td>
</tr>
<tr>
<td>col, 776</td>
</tr>
<tr>
<td>col function, 759</td>
</tr>
<tr>
<td>color</td>
</tr>
<tr>
<td>axis lines, 421</td>
</tr>
<tr>
<td>bars, 198</td>
</tr>
<tr>
<td>box plots, 198, 334</td>
</tr>
<tr>
<td>changing, 195</td>
</tr>
<tr>
<td>contour fills, 382</td>
</tr>
<tr>
<td>contour lines, 381</td>
</tr>
<tr>
<td>custom incrementing schemes, 199</td>
</tr>
<tr>
<td>custom, using, 295, 298</td>
</tr>
<tr>
<td>error bars, 317</td>
</tr>
<tr>
<td>frame lines, 376</td>
</tr>
<tr>
<td>graph back planes, 450</td>
</tr>
<tr>
<td>grids, 450</td>
</tr>
<tr>
<td>incrementing chart fills, 198</td>
</tr>
<tr>
<td>line, 263</td>
</tr>
<tr>
<td>lines, 191</td>
</tr>
<tr>
<td>mesh lines/fills, 368</td>
</tr>
<tr>
<td>page, 293</td>
</tr>
<tr>
<td>radial axes, 459</td>
</tr>
<tr>
<td>reference lines, 494</td>
</tr>
<tr>
<td>tick marks, 438, 474</td>
</tr>
<tr>
<td>color incrementing</td>
</tr>
<tr>
<td>assigning to worksheet, 199</td>
</tr>
<tr>
<td>customizing, 199, 206</td>
</tr>
<tr>
<td>symbols, 182</td>
</tr>
<tr>
<td>Color Transition Values, 540</td>
</tr>
<tr>
<td>colors</td>
</tr>
<tr>
<td>creating gradients, 540</td>
</tr>
<tr>
<td>column averaged error bar plots, 142</td>
</tr>
<tr>
<td>arranging data, 142</td>
</tr>
<tr>
<td>Column Averaging, 324, 328, 851</td>
</tr>
<tr>
<td>column averaging</td>
</tr>
<tr>
<td>grouped bar chart, 328</td>
</tr>
<tr>
<td>column means, 142</td>
</tr>
<tr>
<td>column picker dialog</td>
</tr>
<tr>
<td>normalizing ternary data, 569</td>
</tr>
<tr>
<td>Column picker dialog box</td>
</tr>
<tr>
<td>Graph Wizard, 167</td>
</tr>
<tr>
<td>column statistics</td>
</tr>
<tr>
<td>maximum value, 67</td>
</tr>
<tr>
<td>mean, 67</td>
</tr>
<tr>
<td>minimum positive value, 67</td>
</tr>
<tr>
<td>minimum value, 67</td>
</tr>
<tr>
<td>missing values, 67</td>
</tr>
<tr>
<td>other values, 67</td>
</tr>
<tr>
<td>printing, 104, 105</td>
</tr>
<tr>
<td>setting Options, 14</td>
</tr>
</tbody>
</table>
Index

size of sample, 67
standard deviation, 67
standard error, 67
sum of sample, 67
viewing, 4, 66
column titles
duplicate, 48
using transforms as, 568
column width
changing, 71, 73
columns
asymmetric error bar plots, 142
averaging, 67
column and row titles dialog box, 89
column averaged error bar plots, 142
deleting, 88
inserting empty, 86
inserting graphic cells, 199, 346
inserting symbol size values, 189
key, 568
merging, 543
multiple Z, 148
picking different data for current plot, 167
plotting multiple curves, same X or Y, 141
plotting X or Y using row numbers, 141
plotting XYZ, 149
selecting, 84
sizing, 71, 82
sorting data, 568
statistics, 66
switching from rows to columns, 88
tick labels, 388, 448
titles, 89, 93
type labels, 448
using as row titles, 92
Column, 67, 68, 104, 142, 851
Comma Delimited (.CSV)
importing, 53
command prompt
using to run SigmaPlot macros, 534
commands
creating using macros, 534
embedded graphs, 178
comments
entering regression, 709
common logarithmic axis scale, 408
completion status messages
regression results, 688
complex, 777
complex area plots, 341, 343
compression formats
post-processing .TIFF files, 513
Compute 1st Derivative, 540
computing, 491
1st derivative, 540
computing percentile methods, 335
cumulative percentages, 547
power spectral density, 547
quartiles, 335
rank and percentile, 547
confidence and prediction bands, 638, 699
confidence bands, 664
nonlinear regression, 644
confidence interval, 678
95%, 678
regression results, 678
confidence intervals
adding to 2D graphs, 489
calculating, 491
linear regressions, 489
view in nonlinear regression reports, 644
confidence lines
95% and 99% confidence interval, 67
defined, 491
Confidence, 489, 851
configuring
printer settings, 104, 106, 107
constant variance, 640
P values, 641
testing, 640
constant variance test
regression results, 675
constraints
entering, 652
in Regression Wizard, 651
parameter, 651
Constraints, parameter
defining, 653
constraints, parameter
badly formed, 690
entering, 723
viewing, 660
constructor notation
elementary of use, 583
regression example, 718
contour fills
color, 382
modifying, 383
contour labels
changing frequency, 387
numeric, 389
rotating, 387
skipping, 448
suffixes/prefixes, 387
text attributes, 392
turning on/off, 387
contour lines
color, 381
line types, 381
modifying, 381
showing/hiding, 381
thickness, 381
contour plot, 20
contour plots
adding fills, 382
adding labels, 387, 388
creating, 378
data format, 111
editing contour labels, 392
example, 20
frequency of contour labels, 387
line types, 381
modifying, 380, 388
modifying contour lines, 381
modifying fills, 383
modifying labels, 387, 388
modifying Z data range/scale, 384
plotting data, 149, 378
setting line intervals, 386
setting the direction of fills, 382
X,Y,Z values, 149
contours
adding to 3D mesh plots, 370
projecting onto 3D mesh plots, 370
converting
area data to diameters for bubble plots, 146
date and time data to numbers, 684
numeric and date and time data: Date and time data:converting to numeric, 83
numeric data to date and time data, 686
Cook’s Distance, 645
Cook’s Distance test
results, 677
Coordinate, 15, 364, 367, 378, 536, 546, 851
copy and Paste, 63
Copy shortcut, 51
copying
data, 55, 85
graphs, 233
notebook items between notebooks, 39, 41
objects/graphs, 245
correlation coefficient
regression results, 658, 670
Correlation, 489, 585, 851
cos, 777
cosh, 778
count, 778
COUNT function, 583
creating
additional axes for multiple plots, 355
additional plots, 171
axis breaks, 424
category scale, 416
complex area plots, 341
contour plots, 378
creating pie charts, 138
custom dialog boxes, 527
custom graph page layout, 275
custom scale, 418
embedded graphs, 178
equation, 38
equations to plot, 209
Excel worksheets, 38
files for figure submission to journals, 511
filled contour plots, 378
graph pages, 38
graphs, 151
graphs using Excel worksheets, 102
graphs using the Graph Style Gallery, 157, 158
graphs with Graph Toolbar, 152
graphs with Graph Wizard, 152
histograms, 481, 485
labels, 280, 281
legends, 280, 281
macros, 38, 519, 520
menu commands using macros, 534
multiple area plots, 339
multiple axes for single plot, 358
multiple curves, 140
new graph for current page, 233
new notebook files and items, 38
new object to insert, 253
page templates, 240, 257
pie charts, 138
plots using category data, 316
plots with date and time scale, 417
polar plots, 144, 401
reports, 38
sections, 38
simple straight line area plots, 336
survival curves, 548
ternary graphs, 403
text labels, legends, 280
transforms, 38
user-defined functions, 530
vector plots, 549
vertical area plots, 336
worksheets, 38
crosshairs, 279
Cubic, 592, 851
cumulative percentages
  computing, 547
curve fitter
  introduction, 631
curve fitting
  date and time data, 683
curves
  coefficient of determination, 589
  column averaged error bar plots, 142
  fitting date and time data, 683
  multiple for polar plots, 143
  multiple in graph, 303
  multiple, same X or Y, 141
  plotting multiple, 140, 303
  plotting X or Y using row numbers, 141
  transform for integrating under a curve, 584
  using category data, 304
custom color, 295, 298
custom dialog boxes, 527
custom error bars, 321
custom graph styles
  Graph Style Gallery, 157, 159
  saving, 157, 159
custom scale
  creating, 418
custom tick mark intervals, 435
customer service, 27
customizing
  color increments, 199, 206
  error bar directions, 321
  fill increments, 199, 206
  graph styles, 157, 158
  line increments, 199, 206
  symbol increments, 199, 206
  tick labels, 388, 448
  tick mark intervals, 435
Cut shortcut, 51
cutting
data, 85
  notebook items between notebooks, 39, 41
objects/graphs, 245
data, 779
  2D graphs, 299, 331
  3D graphs, 359
  applying transforms, 4
  arranging for 2D graphs, 141
  arranging for 3D graphs, 149
  arranging for bubble plots, 145
  arranging for contour plots, 149
  arranging for polar plots, 143, 144
column statistics, 66
contour plots, 149, 378
converting bubble plot area, 146
converting data to diameters for bubble plots, 146
converting date and time data to numeric data, 684
converting numeric data to date and time data, 686
converting to mesh format, 4
copying and pasting from other applications, 55
curve fitting date and time data, 683
cutting, 85
deleting, 85, 86
entering, 47, 104
entering into a worksheet, 52
exporting, 65
generating random data, 551
highlighting outliers, 96
importing, 53, 55, 63, 94
inserting, 53
long form mesh format, 149
mesh, converting to, 4
moving, 86
multiple-curve plots (ternary triplets), 144
normalizing for ternary graphs, 569
one column for multiple curves in polar plot, 144
pasting, 85
plotting additional, 171
plotting different data for current plot, 167
plotting portion of, 174
plotting X or Y using row numbers, 141
polar plots, 144
previewing before printing, 105
printing, 104, 105
protecting data on the Web, 509
radial and angular values, 143
rearranging, 88
regression, 4
removing outlying data, 94
sampling, 174
saving, 36
selecting, 84
selecting for ternary graphs, 403
single-curve plot (ternary triplets), 144
smoothing, 4
smoothing 2D high-frequency data, 572
smoothing 3D mesh data, 577
sorting, 568
ternary graphs, 403
transposing, 88
using transform language, 551
viewing for embedded graphs, 179
X.Y, many Z for contour and mesh plots, 149
XY values for polar plots, 143
data brushing, 72, 94, 96
data feedback
set colors on worksheet, 72
data format
3D bar chart, 111
3D graphs, 111
3D line plot, 111
3D mesh plot, 111
3D scatter plot, 111
box plots, 111
contour plot, 111
graph styles, 114
graph types, 111
horizontal bar chart, 111
horizontal dot plot, 115
line and scatter plot, 111
line plot, 111
long form mesh, 149
multiple area plot, 127
multiple horizontal step plot, 121
multiple regressions, 115
multiple scatter plot, 115
multiple spline curves, 121
multiple straight line, 124
multiple vertical area plot, 127
multiple vertical step plot, 121
pie chart, 111
polar plot, 111
scatter plot, 111
simple area plot, 127
simple scatter plot, 115
simple spline curve, 124
simple straight line, 124
simple vertical plot, 121
ternary, 111
vertical area plot, 127
vertical bar chart, 111
vertical dot plot, 115
data format options
Regression Wizard, 648
data formats, 138, 148
pie charts, 138
polar plots, 143
data manipulation functions, 761
databases
importing, 55
date and time
Options, 14
Index

tick intervals, 434
Date and Time axis scale
tick labels, 447
date and time axis scale
tick labels, 446
tick labels for contour plots, 390
tick marks, 434
date and time data
converting to numeric data, 684
curve fitting, 683
formatting in worksheets, 81
date and time format
date delimiters, 78
entering, 52
regional settings, 78
using with Excel, 80
worksheet display, 76, 80
date and time scales
creating plots with, 417
date delimiters
date and time formats, 78
date/time axis scale, 411
Day Zero
leap years in SigmaPlot, 78
setting in worksheets, 78
dBase (.DBF)
importing, 53
Debug Window, 530
Intermediate tab, 531
Stack tab, 532
tabs, 531
toolbar buttons, 530
Watch tab, 531
decimal places
setting in worksheets, 73
defaults
setting graph, 109
defining, 719
degrees, 567
degrees of freedom, 479
regression results, 672
Delete Cells... command, 51
Delete shortcut, 51
deleting, 85
columns and rows, 88
data, 85, 86
graph titles, 260
legends, 260
objects, 260
Delimiter, 52, 79, 80, 851
density
changing pattern of plot fills, 195
dependencies
exponential equation, 741
parameter, 659, 740
dependent variables
entering, 711
derivatives
computing, 540
descriptions
of transform functions, 760
design
graphing references, 29
principles of graphing, 29
suggested reading, 29
determining
initial parameters, 722
DFFITS, 645
DFFITS test
regression results, 677
diagnostics
influence, 677
regression results, 676
dialog boxes
creating in SigmaPlot, 527
diff, 779
DIFF function, 584
differential equation
solving, 585
digital pre-press
preparing graphs, 511
direction
customized error bars, 321
error bars, 318
reference lines, 494
display formats
date and time format, 76, 80
numbers, 74
displaying
  automatic legends, 286, 288
  axes, 419
  contour fills, 382
  contour labels, 387, 388
  contour lines, 381
  grid lines, 452
  outlying data, 96
  page margins, 291
  reference lines, 494
  toolbars, 11
dist, 780
distance
  functions, 763
dividing
  data into multiple columns, 539
docking
  Graph Style Gallery, 158
  Notebook Manager, 34
DOS files
  importing, 53
dot plot
  horizontal data format, 115
  vertical data format, 115
dpi, 514
dragging
  2D axes, 422
  Notebook Manager, 34
  objects, 267
  radial axes, 457
  ternary axes, 465
drawing
  arrows, 260
  ellipses, 260
  lines, 260
  objects, 4, 260
  Page toolbar, 260
drawing speed, 174
drop lines
  adding to plots, 207, 209
  attributes, 207
  for single point, 209
  modifying, 207
  Drop, 207, 209, 851
dsinp, 780
duplicate column titles, 48
Durbin-Watson, 640
Dynamic Fit Wizard, 691
  adding equation to the page, 691
  creating new equations, 647
  default results, 691
  Equation Library, 691
  equation options, 650
  selecting data, 691
  selecting the equation, 691
  selecting variables, 691
  setting graph options, 691
  setting results options, 691
  using to add equations to graph pages, 699
  viewing initial results, 691
E Notation Always
display, 74
E Notation When Needed
display, 74
edge lines, 195
  setting the color, 262
  setting thickness, 262
edges
  bar/box, 262
  plot line thickness, 195
  slice, 262
Edit menu commands, 85
  Copy, 85
  Cut, 85
  Delete Cells..., 86
  Insert New Object, 253
  paste, 85
  Transpose Paste, 88
editing
  automatic legends, 286
  axis tick labels, 440
  axis titles, 426, 429
  contour labels, 387, 392
  embedded graphs, 178, 179
  equations, 647
  Graph Style Gallery graphs, 160
  graph titles, 167
  macros, 522, 526
notebook items, 39
notebook sections, 39
object links, 255
page format, 290
pasted graphs in other applications using OLE2, 245, 255
plot name, 166
radial axes tick labels, 460
text, 281
tick labels, 442
ellipses
drawing, 260
Embed, 224, 245, 247, 248, 253, 852
Embedded graphs
resizing, 179
embedded graphs
available menus and command, 178
ing, 178, 179
opening inside SigmaPlot, 179
viewing data, 179
viewing data, 179
embedding
objects, 247, 256
Reports, 247
embedding objects in graphs
identifying objects on page, 249
viewing as an icon, 248
Encapsulated Postscript File (EPS), 225, 511, 513, 852
engineering notation, 74
setting in worksheets, 81
tick labels, 442
using as axis values, 442
entering
column titles, 89, 93
constraints, 652
constraints, parameter, 723
data, 47, 104
data into worksheets, 52
equations, 209
equations, regression, 710
Greek symbols, 280
iterations, 654, 725
labels, 280
options, 724
parameters, 721
regression comments, 709
regression equation settings, 708
regression statements, 710
row titles, 89, 93
step size, 655, 725
symbols in legends, 280
text, 280, 281
tolerance, 655, 726
variables, 711
EPS files, 513
equation curves
extending to axes, 638, 699
equation solving, 744
equations
adding a regression equation to graph page, 633, 691
adding to graph pages, 638, 699
confidence intervals, 491
creating, 209
creating within Notebook Manager, 38
editing, 647
linear regression, 491
manually entering, 209
overparameterized, 750
plotting, 209, 220
prediction intervals, 493
saving, 714
setting options in the Dynamic Fit Wizard, 693
setting options in the Regression Wizard, 635
setting parameters, 209, 214
solving, 217
solving guidelines, 220
equations, regression
entering, 710
fit statements, 727
iterations, 654
logistic, 744
parameters, 721
regression statements, 690, 710
results, 657
results messages, 688
running again, 659
saving results, 688
solving, 744
step size, 655, 725
tolerance, 655, 726
variables, 711
weight variables, 715
equations, transform
variables, 564
error bar direction, 318, 321
error bar plots
arranging data, 142
error bars
asymmetric, 313
bidirectional data format, 115
bidirectional error bars, 115
calculating, 323
cap width, 317
color, 317
creating 2D plots with, 308
creating grouped bar charts with, 325
custom directions, 321
direction, 318
generating, 323
grouped bar charts, 328
horizontal data format, 115
line thickness, 317
mean computation method, 323
methods for generating, 324
modifying, 317
modifying appearance, 317
multiple and regressions data format, 115
multiple data format, 115
plot types, 308
quartile plots, 314
range plots, 312
relative direction, 318
simple and regression data format, 115
simple data format, 115
vertical point plot, 115
error status messages
regression results, 690
Error, 299, 301, 308, 312, 313, 314, 316, 317, 318, 852
European address and phone number, 27
evaluating
F at, 217
mathematical expressions, 220
mathematical expressions, 217
Examples
mesh plot, 22, 25
pie chart, 16
examples, 20
2D graphs, 16, 20
3D graphs, 21, 24
of macro uses, 532
pie charts, 16
polar plot, 19
transforms, 583
Excel
importing, 60
Excel files
batch processing, 537
Excel workbooks
options, 14
Excel worksheets, 103
creating graphs, 102
creating within Notebook Manager, 38
limitations, 100
opening, 97
opening data files, 100
regression, 103
statistics, 100
system requirements, 7
toolbars, 102
transforms, 103
unprotecting workbooks, 99
using, 97, 104
using date and time format, 80
using Excel print commands, 101
workbooks, 4
executing
one-line functions, 565
exp, 781
exploding pie chart slices, 397, 398
Exploding, 397, 398, 852
Exponent, 752, 852
exponential equations
dependency example, 741
exponents
numeric tick labels, 389, 442
exporting
data associated with graph, 510
data only, not the graph, 510
Excel worksheets, 101
graphs and pages, 224
graphs as webpages, 510
inserting graphs into FrontPage, 510
into HTML, 508
reports, 500
to Systat, 66
worksheet data, 65, 104
worksheets, 65
worksheets as text files, 65
extending
equation curves to axes, 638, 699
Extreme Value Distribution scale, 418

F statistic
regression results, 672
factor
axis tick labels, 442
factorial, 781
FAQs, 27
fast Fourier functions, 765
fast page open, 14
fden function, 782
fdist function, 783
feedback
mouse-over, 231
fft, 783
file formats, 53
File menu commands
Page Setup, 291
file types, 100
files
as objects to insert, 253
breaking links between source and object, 255
changing source for linked objects, 255
embedding objects, 247, 256
exporting as non-notebook files, 224
importing data from, 53, 63, 94
linking objects, 247, 256
notebook templates, 240, 257
opening non-notebook, 40, 41
saving, 36
saving notebook, 36
text, 63
updating links, 255
fill color
modifying, 368
filled contour plots
creating, 378
modifying, 383
fills
area plots, 344, 345
bar chart, 262
box plot, 262
box plots, 334
change color of pattern lines and edge lines, 262
change object fill background color, 262
change object fill pattern, 262
changing, 195
contour plots, 383
custom incrementing schemes, 199
increment customizing, 199, 206
mesh plots, 368
modifying, 198
object, 262
pie chart, 262
symbol, 262
Final, 697, 852
finv function, 784
fit f to y with weight w, 715
fit statements
modifying, 727
fit with weight, 653
Fixed Decimal
display, 74
fonts
Greek, 280
PostScript, 280
symbols, 280
TrueType, 280
for, 785
Format menu commands
Align, 278
line, 263
formats
submitting graphs for publication, 511
Formatting
Date and Time tick labels, 447
formatting
cells, 81
date and time data, 81
date and time tick labels, 446
labels, 3
numeric data in worksheets, 81
text, 281
text in cells, 81
fractional defective control chart transform, 590
frame lines
color, 376
line type, 376
modifying, 376
relative to origin, 376
relative to viewer, 376
Frame, 376, 420, 852
freezing panes, 49
frequency
contour labels, 387
frequency plots
creating, 541
frequently asked questions, 27
FrontPage
inserting graphs into, 510
function arguments, 759
Function dialog box, 647
functions
abs, 767
accumulation, 762
ape, 768
arccos, 769
arcsin, 769
arctan, 770
area, 771
area and distance, 763
avg, 771
block, 772
blockheight, 773
blockwidth, 773
cell, 773
chisquareden, 774
chisquaredist, 774
chisquareinv, 775
choose, 776
col, 776
colL, 759
complex, 777
cos, 777
cosh, 778
count, 583, 778
curve fitting, 764
data, 779
data manipulation, 761
descriptions, 760
diff, 584, 779
dist, 780
distance, 763
dsincp, 780
exp, 781
factorial, 781
fast Fourier, 765
fden, 782
fdist, 783
fft, 783
finv, 784
for, 785
fwhm, 786
gaussian, 787
histogram, 787
IF, 565
if, 583, 789
if...then...else, 790
imaginary (img), 791
int, 791
interpolate, 792
inv, 792
invcpx, 793
invfft, 794
ln, 794
log, 795
logistic, 744
lookup, 795
lowess, 797
lowpass, 798
max, 799
mean, 583, 585, 799
min, 800
miscellaneous, 765
missing, 801
mod, 801
mulcpx, 802
Index

normden, 802
normdist, 803
norminv, 804
nth, 804
numeric, 762
one-line, 565
partdist, 805
polynomial, 805
prec, 806
precision, 763
put into, 807
random, 807
random number, 762
range, 762
real, 808
regression, 747
gaussian, 787
Gaussian Cumulative Distribution, 541
Gaussian, 409, 536, 541, 596, 607, 608, 609, 727, 852
generating
error bars, 323
linear regression lines, 487, 489
mesh data, 4
global
changing multiple page objects, 266
global text changes, 281
Go to...
worksheet cell, 50
goolbars
graph, 152
gradient colors
creating, 540
grads, 567
graph defaults, 3, 14
options, 109
setting, 109
graph dialog boxes
Graph Properties, 226
Graph Wizard, 226
graph page
setting options, 224
graph pages
creating within Notebook Manager, 38
naming, 39
printing, 226
selecting objects, 227
Graph Properties dialog box, 226
customizing tick labels, 448
modifying graphs, 163
modifying grids and planes, 163
modifying tick appearance, 429, 437
modifying titles and legends, 163
moving axes, 423
pie charts, 138
positioning 2D axes, 423
radial axes, 457
galleries
graph style, 157
Gaussian, 409, 536, 541, 596, 607, 608, 609, 727, 852
Gaussian, 787
Gaussian Cumulative Distribution, 541

sqrt, 590, 814
statistical, 763
stddv, 585, 590, 815
stderr, 815
subblock, 816
sum, 817
tan, 818
tanh, 818
tden, 819
tdist, 819
tinv, 820
total, 583, 585, 821
transforms, 759
trigonometric, 761
worksheet, 760
x25, 821
x50, 822
x75, 823
xatymax, 824
xwtr, 825
fwhm, 786
viewing/hiding axis, 419

graph style
- custom, 157
  - Graph Style Gallery, 157
  - multiple straight lines, 121
  - saving, 157
  - simple straight line, 121

graph style data format
- Horizontal dot plot, 115
- horizontal point plot, 115
- horizontal error bars, 115
- multiple area plot, 127
- multiple error bars, 115
- multiple error bars and regressions, 115
- multiple horizontal step plot, 121
- multiple regressions, 115
- multiple scatter plot, 115
- multiple spline curves, 121
- multiple straight line, 124
- multiple vertical area plot, 127
- multiple vertical step plot, 121
- simple area plot, 127
- simple error bars, 115
- simple error bars and regression, 115
- simple horizontal step plot, 121
- simple regression, 115
- simple scatter plot, 115
- simple spline curve, 121, 124
- simple straight line, 124
- simple vertical step plot, 121
- vertical area plot, 127
- vertical dot plot, 115

Graph Style Gallery
- adding styles, 158
- applying graph styles, 159
- creating graphs, 157, 158
- docking graphs, 158
- editing graphs, 160
- moving, 158
- using, 157

graph styles
- custom graph styles, 159
- Graph Style Gallery, 159
- using the Graph Style Gallery, 157, 158

graph titles
- deleting, 260

Graph Toolbar, 152

graph toolbars
- 2D, 3D, 233

graph type data format
- 3D bar chart, 111
- 3D line plot, 111
- 3D mesh plot, 111
- 3D scatter plot, 111
- box plots, 111
- contour plot, 111
- horizontal bar chart, 111
- line and scatter plot, 111
- line plot, 111
- pie chart, 111
- polar plot, 111
- scatter plot, 111
- ternary, 111
- vertical bar chart, 111

Graph Wizard
- additional axes, 355
- area plots, 336
- bubble plots, 354
- changing graph type/style, 169
- creating 3D graphs, 363, 364, 365
- creating graphs, 152
- creating mesh plots, 367
- multiple plots, 355

Graphs
- anatomy of, ??–21, ??–24
- pie charts, 16

graphs
- 2D example, 16
- 3D example, 21, 24
- adding drop lines, 207, 209
- adding plots, 171
- adding to page, 232, 233
- aligning, 278
- anatomy of, 15
- arranging on a page, 272, 276
- asymmetric error bar plots, 142
- automatic legends, 283, 289
- axes, 375
- box plots, 333
- centering, 278
- column averaged error bar plots, 142
- contour plots, 20, 395
Index

copying, 245
creating, 151
cutting, 245
data format for graph styles, 114
data format for graph types, 111
defaults, setting, 109
displaying automatic legends, 286, 288
editing in Graph Style Gallery, 160
editing in other applications using OLE2, 245, 255
grid lines, 452
grouped bar charts, 325, 326
grouping/ungrouping objects/text, 271
hiding, 258
hiding automatic legend, 286, 288
hiding graph titles, 259
hiding on page, 257, 258
hiding using shortcut menu, 258
legends, 280
modifying 2D plots, 487, 494
modifying type/style, 169
modifying using Graph Properties dialog, 163
moving, 266, 269
multiple curves, same X or Y, 141
naming plots, 166
pasting without data, 250
picking different data for current plot, 167
pie charts, 16, 395
plotting data, 141
plotting multiple curves, 140
plotting X or Y using row numbers, 141
polar plots, 19, 395
references for design, 29
resizing for publication, 514
resizing labels/legends automatically, 224
saving, 36
scaling, 266, 269
scatter, 3D, 148
selecting, 164
selecting style, 114, 151
selecting type, 111
sizing, 266, 269
styles, 114
symbols, 180, 189
ternary, 395
titles, 167
types, 111
types and styles, 1

using Paste Special, 245, 249
viewing on page, 257, 258
working on pages, 256, 257, 262, 266, 295, 298
zooming in/out, 234
graphs, 2D, 302
Greek symbols
entering, 280
Gregorian calendar, 78
grid
changing colors, 72
grids
aligning graphs and objects, 279
color, 451
displaying in front/behind, 451
graph back planes, 452
hiding, 452
line types, 451
mesh graphs, 4
modifying, 375
snap-to, 279
turning on/off, 452
grouped bar charts
column averages, 328
creating, 325, 326
creating with error bars, 325
error bars, 328
examples, 325
spacing bars, 203, 206
grouped data, 304
grouping
objects/text, 271
guidelines
equation solving, 220
for submitting graphs for publication, 511

halting, 289
hardware
system requirements, 7
Help system
using, 26
hiding
automatic legends, 286, 288
axes, 419
axis titles, 427
countour lines, 381
graph titles, 259
graphs on page, 257, 258
graphs using shortcut menu, 258
grid lines, 452
legends, 259
notebooks in Notebook Manager, 33
radial axis labels, 460
statistics, 68
tick marks, 427
 toolbars, 11
high-frequency data
smoothing, 572
highlighting
outliers, 96
histogram, 787
Histogram Wizard
using, 482
histograms
bin values, 482
creating, 481, 485
histogram transform function, 481
Histogram Wizard, 481, 485
histogram.xfm transform, 485
macro for creating, 539
homoscedasticity
constant variance test, 675
horizontal bar chart
data format, 111
horizontal dot plot
data format, 115
horizontal error bars
data format, 115
horizontal point plot
data format, 115
HTML
exporting graphs into, 508
icons
changing display for inserted objects, 253
changing display for pasted objects, 251
displaying inserted objects as, 253
displaying pasted objects as, 251
on graph pages, 248
identifying
area plot intersections, 343
if, 789
IF function, 583
logical operators, 565
if...then...else, 790
ignoring
outliers, 94
imaginary (img), 791
Importing
SigmaPlot files, 61
SigmaScan files, 61
SigmaStat files, 61
importing
Axon files, 64
data by copying and pasting, 55
data files, 53, 63, 94
data from multiple Excel files, 537
databases, 55
Excel files, 60
Lotus 1-2-3 files, 61
Microsoft Excel files, 61
ODBC databases, 55
Quattro files, 61
SPSS files, 64
text files, 63
inches
page units, 292
incrementing
lines, 193
symbol color, 182
incrementing colors
chart fills, 198
incrementing schemes
customized, 199
independent graph pages, 39
independent t-test, 481
performing, 479
independent variables
entering, 711
indexed data, 138, 304
influence, 645
Index

influence diagnostics
  regression results, 677
influential point tests, 677
Insert Cells shortcut, 51
Insert Date and Time command for reports, 506
inserting
  columns and rows, 86
data, 53
displaying inserted objects as icons, 253
graphs into FrontPage, 510
graphs into Microsoft Word, 541
linked objects, 253
modifying inserted object icons, 253
new object, 253
objects from file, 253
Insertion mode
  turning on/off, 53
installing SigmaPlot, 7
  serial numbers, 8
types of folders, 8
int, 791
integrating under curve transform, 584
interpolate, 792
Interpolating data
  setting mesh range values, 577
interpreting results
  regression, 657, 661
intersections
  identifying in area plots, 343
intervals
  confidence/prediction, 67, 489
  setting for contour plots, 386
  tick mark values assigned to a worksheet, 435
inv, 792
invcpx, 793
invfft, 794
Iterations, 697, 852
iterations
  convergence, 631
  entering, 654, 725
  exceed maximum numbers, 688
  more iterations, 688
  JNT files, 272
  journals
    preparing graphs for publication, 514
  Kaplan-Meier survival curve, 548
  key column, 568
  keyboard
    moving around worksheet, 50
    moving graphs and objects using arrow keys, 270
  keystrokes
    functions, 50
  Kolmogorov-Smirnov test, 640
  label notation, 442
  labeling
    with symbols, text from column, 542
  labels
    adding to page, 280
    aligning, 3, 278
    automatic scaling with graphs, 224
    axis titles, 429
    axis values, 445
    column titles, 89, 93
    column type, 448
    contour, 387, 388
    creating, 280, 281
    editing tick, 442
    entering non-keyboard characters, 280
    formatting, 3
    frequency of contour, 387
    graph titles, 167
    grouping/ungrouping, 271
    numeric tick, 388
    radial axes, 460
    reference lines, 494
    rotating, 280
    rotating contour, 387
    row titles, 89, 93
    suffixes/prefixes, 387
    tick mark, 445
    using column and row title dialog box, 89
Index

landscape
- page orientation, 292

layering in front/behind
- grid lines, 451
- reference lines, 494

layout
- graph design references, 29
- layout files, 14
- leap years
  - as observed in SigmaPlot, 78
- least squares
  - regression, 735

legends, 259
- adding symbols, 280
- adding to page, 280
- aligning, 289
- automatic, 3, 283, 289
- automatic scaling with graphs, 224
- creating, 280, 281
- deleting, 260
- editing, 286
- hiding, 286
- locking, 289
- restoring to default settings, 286
- showing, 286
- ungrouping, 289

leverage, 645

leverage test
- regression results, 677

light source
- 3D graphs, 371

line and scatter plot
- multiple straight line data format, 124
- simple straight line data format, 124

line and scatter plots
- adding drop lines, 207, 209
- creating, 302
- data format, 111
- examples, 299

line plot data formats
- multiple horizontal step plot, 121
- multiple spline curves, 121
- multiple vertical step plot, 121

line plots
- 3D data format, 111
- adding drop lines, 209
- adding drop lines to, 207, 209
- color, 191
- creating, 302
- data format, 111
- examples, 299
- midpoint step, 191
- multiple straight lines, 121
- step, 191
- straight, 191
- symbols, 180, 189

line type
- frame lines, 376
- modifying, 263
- reference lines, 494

line/scatter graphs
- asymmetric error bars, 313
- error bars, 308
- quartile plots, 314
- range plots, 312
- symbols, 180, 189
- linear axis scale, 408, 442

linear interpolation
- for computing percentile methods, 335

linear regression dialog box
- parameter values transform, 590
- standard deviation, 589, 590

linear regressions
- calculating, 491
- confidence/prediction intervals, 489
- defined, 491
- generating, 487, 489
- multiple curves, 487
- polynomial order, 487
- results, 489

lines
- adding arrow heads, 265
- assigning to worksheet, 199
- attributes, 421
- axis, 421
changing end attributes, 265
changing thickness, 191
changing type, 191
color, 191
contour, 381
custom incrementing schemes, 199
drawing, 260
drop, 207, 209
error bars, 317
frame, 376
grid, 452
grid line types, 451
increment customizing, 199, 206
incrementing, 193
layering in front/behind symbols, 191
linear regression, 487, 489
mesh plots, 368
midpoint step plots, 191
modifying properties, 263
radial axes, 457, 460
reference, 333
setting intervals for contour plots, 386
smoothed, 191
spline curves, 191
step plots, 191
type, 191
linking
objects, 247, 256
Reports, 247
links
breaking, 255
changing source files, 255
editing, 255
manual/automatic updating, 255
viewing object links, 255, 256
ln, 794
local maximum
sum of squares, 733
local minimum
finding, 731
locking
legends, 289
log, 795
log axes, 442
logarithmic axis scale, 408, 442
logical operators
transforms, 565
logistic function
four parameter, 744
logit axis scale, 410
lookup, 795
Lorentzian distribution
regression example, 727
Lotus 1-2-3 (WK*)
importing, 53
journals
preparing graphs for publication, 511
lowess, 797
lowpass, 798
LZW compression algorithm
post-processing .TIFF files, 513
macro language
creating macros using, 520
macro programming language, 525
Macro Window, 524
opening, 520
options, 525
macro window
appearance, 525
Macro Window toolbar, 523
macros, 524, 537, 539, 540, 541, 542, 543, 544, 546, 547, 548, 549
adding macros to macros, 527
adding procedures, 528
creating, 519, 520
creating as menu commands, 534
creating custom dialog boxes, 527
creating user-defined functions, 530
creating within Notebook Manager, 38
editing, 522, 526
examples, 532
for Microsoft Word/Excel, 532
included with SigmaPlot, 535
programming language, 525
recording, 519
running, 549
running from a command line, 534
setting options, 525
user-defined functions, 529
using Macro Window toolbar, 523
using the Add Procedure dialog box, 528
using the Debug Window, 530
using the Object Browser, 528
using to automate routine tasks, 519
window options, 525

magnifying
page view, 234

magnitude data
plotting as vector, 549

major ticks
date and time axis scale, 434

Marquardt-Levenberg Algorithm
references, 632
Marquardt-Levenberg algorithm, 631, 655, 725
max, 799
maximum value (max)
column statistics, 67
mean, 799
column statistics, 67
error bar computation method, 323
mean computation method, 323
MEAN function, 583, 585
mean lines, 333
box plots, 334
mean squares
regression results, 672
median lines, 333

menu commands
creating using macros, 534
menus
creating menu commands using macros, 534
using with embedded graphs, 178

merging
columns, 543
mesh data
converting, 4
generating, 4
interpolating, 4
mesh lines
modifying, 368

Mesh plots
elements, 22, 25
mesh plots
3D data format, 111
adding contours, 370
creating, 367
dependencies, 360
fills/color, 368
light source, 371
mesh data, 4
mesh lines, 368
modifying lines/fills, 368
plotting data, 149
projecting contours, 370
smoothing data, 4
transparent, 367
X, Y, Z values, 149

messages
completion status, 688
error status, 690
regression results, 688
regression status, 658

metafiles, 246
Microsoft Excel
opening SigmaPlot within, 532
Microsoft Excel (.XLS)
importing, 53
Microsoft Word
inserting graphs, 541
opening SigmaPlot within, 532

millimeters
page units, 292

min, 800
minimum positive value (min pos)
column statistics, 67
minimum value (min)
column statistics, 67

Minitab
importing, 53
minor ticks
date and time axes, 434
modifying, 434
missing, 801
missing values
column statistics, 67
mistakes
  undoing mistakes, 15
Mocha Worksheets
  importing, 53
Mocha worksheets, 61
mod, 801
modifying
  2D plots, 487, 494
  3D graph view, 371
  adding plots, 171
  area plots, 344, 345
  attributes for new pages, 242
  automatic legends, 283, 289
  axes, 375, 419
  axis range by dragging, 465
  axis scale, 408
  axis scale types, 415, 418
  background colors, 198
  box fills/color, 334
  box plots, 333
  box widths, 334
  category scales, 416
  contour labels, 387, 388
  contour lines, 381
  contour plots, 380, 388
  drawn objects, 262, 266
  drop lines, 207, 209
  edges, 195
  embedded graphs, 178, 179
  error bar appearance, 317
  error bar computation method, 323
  error bar direction, 318
  error bars, 317
  fill color, 368
  fills, 198
  frame lines, 376
  graph lighting, 371
  graph perspective, 371
  graph rotation, 371
  graph styles, 169
  graph titles, 167
  graph types, 169
  graphs using Graph Properties dialog, 163
  grid lines, 375
  grids, 450
grids and planes, 163
inserted object icon's, 253
line color, 263
line end attributes, 265
line thickness, 263
line type, 263
mesh lines, 368
mesh plots, 368
modifying, 198
multiple selected objects, 266
multiple text labels, 281
object fills, 262
object links, 255, 256
page color, 293
page view, 234
pasted object icon, 251
patterns, 198
pie charts, 398
plot name, 166
plot pattern line thickness, 195
polar axes, 460
polar plot axes, 453
polar plots, 144
radial axes, 460
radial axes arc, 457, 460
radial axes tick labels, 460
source files for links, 255
symbol attributes, 180
symbols, 180, 189
ternary axis direction, 469
ternary plots, 405
ternary tick labels, 476
ternary tick marks, 474
text formatting, 281
tick labels, 445
tick marks, 375
titles and legends, 163
whisker cap widths, 333
modifying for new pages, 242
mouse
  moving objects, 267
  sizing objects, 267
mouse-over feedback, 231
moving
  2D axes, 423
  2D axes manually, 422
Index

2D axes with mouse, 422
around the worksheet, 50
axes to precise location, 423
axes with Graph Properties dialog, 423
axis titles, 429
data, 86
graphs, 266, 269
graphs and objects using arrow keys, 270
notebook items between notebooks, 39, 41
objects, 266, 269
objects to back/front, 270
radial axis, 457, 460
to worksheet cell, 50
toolbars, 14
moving objects, 267
mulcpx, 802
multiple, 15
multiple area plots
creating, 339
multiple axes
creating, 358
multiple curves
creating, 303
plotting data, 303
regression options, 487
using category data, 304
multiple error bars
data format, 115
multiple error bars and regressions
data format, 115
multiple independent variables, 648
multiple plots, 171
additional axes, 355
multiple regressions
data format, 115
multiple scatter plot
data format, 115
multiple spline curve
format, 121
multiple straight line
data format, 124
multiple users, 8
multiple Z columns, 148
naming
graph pages, 39
graphs, 167
notebook files, 39
notebook items, 39
plots, 166
sections, 39
worksheets, 39
natural log axis scale, 409
needle plot
creating, 203
new
equation, 38
Excel worksheets, 38
graph pages, 38
graphs with templates, 237
macros, 38
notebook files and items, 38
pages with templates, 237
reports, 38
sections, 38
transforms, 38
worksheets, 38
new features, 5
noisy data
smoothing, 572
non-keyboard characters, 280
nonlinear regression, 589
assumption checking, 640
confidence intervals, 644
constant variance, 640
Cook’s Distance, 645
DFFITS, 645
Durbin-Watson, 640
influence, 645
Kolmogorov-Smirnov test, 640
leverage, 645
normality, 640
power, 645
prediction intervals, 644
PRESS Prediction Error, 644
setting options, 637, 697
standardized coefficients, 644
view in regression reports, 642
nonlinear regression reports, 640
  confidence intervals, 644
  include confidence intervals, 644
  predicted values, 642
  prediction intervals, 644
  raw residuals, 642
  report flagged values only, 642
  Studentized deleted residuals, 642
  Studentized residuals, 642
non-notebook files
  exporting to original file format, 224
  opening, 40, 41
norm
  effect of weighting, 720
normal
  using as source template for new pages, 242
normality, 640
  P values, 641
  testing, 640
normality test
  regression, 674
normalize, 569
normden function, 802
normdist function, 803
norminv function, 804
notebook files
  AutoRecover, 37
  creating, 38
  naming, 39
  opening, 40, 41
  saving, 36, 37
  summary information, 39
  template notebook files, 240, 257
  viewing, 40, 41
notebook items, 39
  creating within Notebook Manager, 38
  cutting/copying between notebooks, 39, 41
  exporting as non-notebook files, 224
  naming, 39
  opening, 40, 41
  printing selected notebook items, 36
  saving, 36
  viewing, 40, 41
Notebook Manager
  cutting/copying between notebooks, 41
docking, 34
dragging, 34
opening and closing notebooks, 33
overview, 31
sizing, 34
notebooks
  closing, 33
  opening, 33
  password protecting, 42
  summary information, 39
  using the Notebook Manager, 31
  viewing, 33
novice prompting, 14
Novice, 288, 852
nth, 804
nudging
  graphs and objects, 270
numbers
  display formats, 74
  functions, 762
  options, 14
  precision functions, 763
  random generation functions, 762
numeric axis values
  factoring out, 442
numeric data
  converting to date and time data, 83, 686
  formatting in worksheets, 81
  setting decimal places in worksheets, 81
  setting engineering notation in worksheets, 81
numeric functions, 762
numeric values
  changing contour labels, 389
  tick labels, 389
Object Browser, 528
Object Properties dialog
  program options, 224
  specifying size, 269
Object Properties dialog box
  axis attributes, 421
  modifying line, 263
  specifying location, 269
objects
aligning, 4, 278
breaking links, 255
change background color, 262
change color of fill pattern lines and edge lines, 262
change fill patterns, 262
changing source files for links, 255
copying, 245
cutting, 245
displaying as icons, 251, 253
dragging, 267
drawing, 4, 260
editing linked, 247, 256
editing links, 255
embedding, 247, 256
fills, 262
grouping/ungrouping, 271
identifying on page, 249
inserting from file, 253
inserting linked objects, 253
inserting new, 253
linking, 247, 256
modifying, 262, 266
modifying object links, 255, 256
mouse, using to size, 267
moving, 266, 269
moving front/back, 270
multiple selection, 266
pasting as linked/embedded, 251
pasting as specified file type, 251
pasting to a page, 245, 257
scaling, 266, 269
selecting on a page, 227
set pattern and edge line thickness, 262
sizing, 266, 269
updating links, 255
using the Paste Special command, 245, 249
viewing object links, 255, 256
working on pages, 256, 257, 262, 266, 295, 298

ODBC databases, 55
importing Excel, 60

OLE
viewing objects as icons, 248

OLE2, 1, 245, 497, 853
embedding, 245, 255
linking, 245, 255

pasting graphs, 245, 255

one way analysis of variance (ANOVA) transform, 583

one-line functions
executing, 565

opening
data files into Excel worksheets, 100
embedded graphs, 179
Excel worksheets, 97
non-notebook files, 40, 41
notebook files, 40, 41
notebook items, 40, 41
notebooks, 33
SigmaPlot as a command line, 534
SigmaPlot in other applications, 532
transforms, 41
worksheets, 41

operators
transform operators, 561

options
automatic, 224
automatic legends, 14
backup files, 14
column statistics, 14, 68
Excel workbooks, 14
fast page open, 14
for assumption checking, 640
graph defaults, 14, 109
graph pages, 224
grid colors, 224
grid density, 224
grids, 224
layout files, 14
macro window, 525
nonlinear regression reports, 640, 642
novice prompting, 14
numbers, 14
page, 14
page undo, 224
page units, 224
residuals, 642
retain window states, 14
setting date and time, 14
setting program, 224
show rulers, 224
Snap-to, 224
statistics, 14
stretch maintains aspect ratio, 224
templates, 14
worksheet, 14
Options button
  Regression Wizard, 647
options, regression, 654
step size, 655, 725
tolerance, 655, 726, 727
Orientation (page), 237, 292, 499, 853
Origin Axes, 372, 376, 853
origin axes, 371
other values
  column statistics, 67
outliers
  box plots, 333
  highlighting, 96
  removing, 94
Overwrite mode, 53

P value
  regression results, 672
P values for normality and constant variance, 641
page
  adding graphs, 232, 233
  aligning objects/graphs, 278
  automatic legends, 283, 289
  changing format, 290
  clearing graphs/objects, 260
  color, 293
  copying graphs, 233
  copying objects/graphs, 245
  creating graphs for current, 233
  creating new objects to insert, 253
  cutting objects/graphs, 245
  deleting objects, 260
  editing format, 290
  embedding objects, 247, 256
  exporting as non-notebook file, 224
  hiding graph titles, 259
  hiding graphs, 257, 258
  hiding legends, 259
  inserting objects from files, 253
  legends, 280
  linking objects, 247, 256
  magnifying, 234
  moving between notebooks, 39, 41
  moving objects/graphs, 266, 269
  naming, 39
  paper size, 292
  pasting graphs, 233
  pasting graphs/objects, 245, 249
  setting grid color, 224
  setting grid density, 224
  setting Options, 14
  setting options, 224
  setting snap-to grids, 224
  setting units of measurement, 224
  setup, 290
  showing grids, 224
  showing rulers, 224
  sizing graphs and objects, 266, 269
  specifying graph and object location, 269
  specifying graph and object size, 269
  templates, 240, 257
  text and labels, 280
  units of measurement, 292
  viewing full, 234
  viewing graphs, 257, 258
  working with graphs, 256, 257, 262, 266, 295, 298
  working with objects, 256, 257, 262, 266, 295, 298
  zooming in/out, 234
page objects
  selecting on a page, 227
Page toolbar, 260
Page undo
  options, 224
pages
  selecting graphs, 227
  selecting objects, 227
  selecting text, 227
paired t-test
  performing, 479
paper size, 292
parameters
  coefficient of variation, 659
  constraints, 650, 723
  convergence message, 688
default settings in Regression Wizard, 650
defined but not referenced, 690
dependencies, 659, 740
determining initial values, 722
entering, 650, 721
identifiability, 750
initial values, 721
invalid, 688
missing, 690
regression results, 659
setting in equations, 214
standard error, 659
viewing constraints, 660
parametric equations
plotting, 546
partdist, 805
password protecting data, 509
passwords
password protecting, 509
protecting notebooks, 42
Paste shortcut, 51
Paste Special
command, 245, 249
displaying pasted objects as icons, 251
embedding objects, 247, 256
linking objects, 247, 256
modifying pasted object icons, 251
pasting graphs without data, 250
pasting
data, 55, 85
graphs as metafiles, 246
graphs to page, 233
graphs to PowerPoint, 543
graphs/objects with the Paste Special command, 245, 249
objects, 245, 249
transpose, 88
patterns
assigning to worksheet, 199
changing, 195
changing color lines of fills and edges, 262
changing density of plot fills, 195
changing object fills, 262
modifying, 198
plot line thickness, 195
set pattern and edge line thickness, 262
setting thickness, 262
Percentage, 145, 404, 468, 853
percentile methods
box plots, 335
percentiles, 335
performing
quick transforms, 565
Perspective, 371, 377, 853
perspective
3D graphs, 371
Photoshop
post-processing .TIFF files, 513
picking data
different columns to plot, 167
different data for current plot, 167
Pie charts
example, 16
pie charts, 198
adding exploding slices, 397, 398
creating, 138
data format, 111
data formats, 138
example, 16
examples, 395
fills, 198, 262
modifying, 398
plotting data, 138
rotating, 397
slice edges, 262
Pie, 395, 853
Piper plots, 544
Plain Text (.TXT, .PRN, .DAT, .ASC)
importing, 53
plot fills
pattern density, 195
plot styles
multiple curves, 303, 304
plot types
error bars, 308
plots
about, 355
adding new, 171
contour, 395
custom incrementing schemes, 199
Index

dummy, 358
frequency, 541
layering lines in front/behind symbols, 191
multiple, 171
multiple axes for single, 358
naming, 166
needle plot, 203
offsetting radial axes, 457
pattern line thickness, 195
picking different data, 167
pie charts, 395
Piper plots, 544
polar, 395
polar axes, 460
selecting, 164
survival curve, 548
symbols, 180, 189
ternary, 395
types, 1
vector plots, 549
plots, 2D
box plots, 333
creating with asymmetric error bars, 313
creating with error bars, 308
grouped bar charts, 325, 326
line, 299
line and scatter, 299
linear regression lines, 487, 489
modifying 2D, 487, 494
multiple curves, 303
reference lines, 333
scatter, 299
types available, 299, 300, 301, 331
using category data, 304
plots, 3D
bar charts, 361
mesh, 360
scatter and line plots, 359
types available, 359
waterfall plots, 362
plotting
equations onto existing graphs, 212
magnitude data as vector, 549
polar and parametric equations, 546
portion of data, 174
saved equations, 215
plotting data
2D graphs, 141
3D graphs, 149
additional data, 171
asymmetric error bar plots, 142
bubble plots, 145
column averaged error bar plots, 142
tour plots, 149
multiple curves, 140, 303
multiple curves, same X or Y, 141
polar plots, 144, 401
portion of, 174
scatter graphs, 3D, 148
using category data, 304
using row numbers for X or Y values, 141
plotting equations, 209, 220
point plot
horizontal data format, 115
vertical data format, 115
points
page units, 292
polar and parametric equations
plotting, 546
polar axes
modifying, 460
radial tick labels, 460
polar plots
angular axes, 454
arranging data, 143, 144
clockwise angular units, 401
creating, 144, 401
data for multiple curves, 143
data format, 111
date, 19
modifying, 144
modifying axes, 453
offsetting radial axes, 457
plotting data, 144
radial and angular values, 143
radial axes, 457, 460
symbols, 180, 189
using XY values, 143
polar plots, multiple curves
data from one column, 144
Polar, 1, 395, 401, 407, 853
Index

polynomial, 805
polynomial order
  regression lines, 487
population
  confidence interval results, 678
portrait
  page orientation, 292
positioning
  2D axes using Graph Properties dialog, 423
  2D axis, 423
  3D axes, 375
  toolbars, 14
power, 645, 675
  alpha value, 675
  regression results, 675
power spectral density
  computing, 547
PowerPoint
  creating slides with graphs, 543
prec, 806
precise location
  moving axes to, 423
precision functions, 763
precision options, 442
predicted values
  regression diagnostic results, 676
  regression results, 677
  view in nonlinear regression reports, 643
  view in regression reports, 642
prediction bands, 664
  nonlinear regression, 644
prediction interval, 678
  95%, 678
  regression results, 678
prediction intervals
  adding to 2D graphs, 489
  calculating, 491
  defined, 493
  linear regressions, 489
  view in nonlinear regression reports, 644
prefixes
  contour labels, 387
  tick labels, 445
preparing
  graphs for publication, 511, 514
PRESS Prediction Error, 644
previewing
  worksheets before printing, 105
printer settings
  configuring, 104, 106, 107
printing
  column statistics, 104, 105
  Excel worksheets, 101
  graph pages, 226
  guidelines for submitting graphs for publication, 511
  previewing, 105
  reports, 501
  selected notebook items, 36
  setting options, 104, 106
  worksheet, 104, 105
  worksheet data, 104, 105
printing options
  setting, 226
probability axis scale, 409
probit axis scale, 409
procedures
  adding to macros, 528
producing
  file for publication, 511
producing files for publication
  .EPS files, 511
  .TIFF files, 511
  SigmaPlot files, 511
program folders, 8
projecting
  contours onto 3D mesh plots, 370
properties
  modifying text, 281
protecting
  notebooks with passwords, 42
publishing
  graphs in journals, 511, 514
  journal submission requirements, 511
  on the World Wide Web, 507
publishing graphs, 508
  .EPS, 513
  about dpi, 514
Index

tips and tricks, 514
  using the Submission Assistant, 516
put into, 807

quality control lines, 333
quartile plots, 314
quartiles
  computing for box plots, 335
Quattro/DOS (.WK*)
  importing, 53
quick re-plot, 547
Quick Transforms
  using as column titles, 568
  quick transforms, 565

Radial Axes, 407, 450, 453, 457, 853
radial axes
  about, 457
  attributes, 459
  lines, 457, 460
  modifying, 457, 460
  moving, 457, 460
  offset from graph center, 457
  tick labels, 460
  turning on/off, 457, 460
radial labels
  turning on/off, 460
radial values, 143
radians, 567
random, 807
random generation functions, 762
range
  angular axis, 454
  Z data for contour plots, 384
range plots, 312
range, axis
  axis values, 384
  modifying, 413
  modifying by dragging, 465
ranges
  functions, 762
  operators, 562
rank and percentile
  computing, 547
raw residuals
  view in regression reports, 642
real, 808
rearranging data, 88
reciprocal axis scale, 411
recording
  macros, 519
redo, 15
reduced chi-square, 671
reference lines
  adding to 2D graphs, 333
  direction, 494
  displaying, 494
  displaying in front/behind, 494
  labels, 494
  line attributes, 494
  line thickness, 494
  line type, 494
  lower specification, 494
  statistics, 494
  turning on/off, 494
references
  graph design, 29
  Marquardt-Levenberg Algorithm, 632
regional settings
  date and time format, 78
regression, 589, 629
  absolute minimum, 727
  adding equations to graph pages, 638, 699
  advanced techniques, 750
  cancelling, 657
  completion status messages, 658
  confidence bands, 664
  constraints, parameter, 651, 723
  entering equation settings, 708
  error status messages, 690
  extending equation curves to axes, 638, 699
  fit statements, 727
  generating a regression equation, 710
  influencing operation, 724
  iterations, 631, 654, 725
local minimum, 731
Marquardt-Levenberg algorithm, 631
multiple function, 747
options, 724
parameters, 721, 740
prediction bands, 664
quitting, 660
report, 669
results, 657
results messages, 688
running a regression again, 659
saving results, 661
scaling x variable, 750
solving equations, 744
step size, 655, 725
tolerance, 655, 726, 727
transform functions, 718
variables, 711
weight variables, 719
weighted regression, 734
Regression Equation Library, 633, 691
regression equations
entering setting, 708
iterations, 725
regression examples
advanced techniques, 750
constructor notation, 718
dependencies, 740
Lorentzian distribution, 727
multiple function, 747
weighted regression, 734
regression examples:
solving equations, 744
regression functions
multiple function, 747
regression options
entering, 724
iterations, 725
regression equations, 708
regression overview, 629
regression results
ANOVA table, 672
coefficients, 671
confidence interval, 677
certainty interval for the regression, 678
constant variance test, 675
constants, 671
Cook’s Distance test, 677
DFFITS, 677
diagnostics, 676
Durbin-Watson statistic, 674
F statistic, 672
influence diagnostics, 677
leverage, 677
normality test, 674
P value, 672
power, 675
predicted values, 677
prediction interval for the regression, 678
PRESS statistic, 673
standard error, 671
standard error of the estimate, 671
statistics, 671
sum of squares, 672
regression statements
bad or missing, 690
containing unknown function, 690
editing, 727
unknown variable, 690
Regression Wizard, 4, 487, 629
.FIT files, 632
about the curve fitter, 631
Adding .FIT files to library or notebook, 632
add canceled equation to the page, 633
cancelling a regression, 657
constraints, 651
creating new equations, 647
default results, 633
Equation Library, 633
equation options, 650
fit with weight, 653
interpreting initial results, 657
introduction, 629
iterations, 654
multiple independent variables, 648
parameters, 650
running regression from a notebook, 646
saving equation changes, 648
selecting data, 633
selecting the equation, 633
selecting variables, 633
setting graph options, 633
Index

setting results options, 633
step size, 655
tolerance, 655
using to add equations to graph pages, 638
variable options, 648
viewing and editing code, 647
viewing initial results, 633
watching the fit progress, 656
regression:
  weight variables, 715, 735
regression:variables
  Poisson distribution, 735
regressions
  fitting data, 4
  using data in Excel worksheets, 103
relational operators
  transforms, 564
removing
  outliers, 94
Report Editor, 4
  formatting paragraphs, 505
  formatting text, 505
  formatting toolbar, 505
  ruler, 502
  setting paragraph indents, 504
  setting tabs, 503
report options for nonlinear regression, 640, 642
reports
  creating, 499
  creating reports, 499
  creating within Notebook Manager, 38
  embedding objects, 247
  exporting, 500
  inserting date and time, 505
  linking objects, 247
  printing, 501
  regression, 669
  Report Editor, 4
  reports, 499
  setting page size and margins, 499
  setting ruler units, 497
requirements
  submitting graphs for publication, 511
residual tests
  Durbin-Watson statistic, 674
  PRESS statistic, 673
residuals, 642
  effect of weighting, 720
  regression diagnostic results, 676
  standardized, 676
  Studentized, 676
  Studentized deleted, 676
resize
  symbols, 285
Resizing
  embedded graphs, 179
resizing
  graphs for publication, 514
restoring
  legends to default settings, 286
results
  completion status messages, 688
  error status messages, 690
  linear regressions, 489
  regression, 657
  regression messages, 658, 688
  saving regression, 661
  t-test, 479
  viewing constraints, 660
retain window states, 14
rgbcolor, 809
right-clicking
  custom color, 298
  hiding graphs, 258
  selected graphs and objects, 227
rotating
  3D graphs, 371
  3D graphs axes placement, 375
  angular axis, 454
  axis titles, 427
  contour labels, 387
  labels, 280
  pie charts, 397, 398
  text, 280
round, 809
rows
  deleting, 88
  inserting empty, 86
  selecting, 84
  sizing, 71, 82
titles, 89, 93
transposing, 88
using as column titles, 90, 93
rulers
aligning graphs and objects, 279
runavg, 810
running
macros, 549
quick transforms, 565
sampling
data, 174
SAS Data Set
importing, 53
SAS Export File
importing, 53
satisfying
tolerance, 688
saving
AutoRecover, 37
data, 36
graphs, 36
linear regression results, 489
notebook files, 36
pages, 36
regression equation changes, 648
regression results, 661
time using the Graph Style Gallery, 157
t-test results, 479
worksheets, 36
saving time
using the Graph Style Gallery, 157
Sax Basic
getting Help, 523
scalars
operators, 562
scalars and ranges, 562
scale
angular, 454
axis, 3
base/exponent labels, 442
category, 410, 416
changing, 408
common log, 408
custom, 418
date/time, 411
linear, 408
logit, 410
natural log, 409
probability, 409
probit, 409
reciprocal, 411
tick labels, 445
tick marks, 435, 474
types, 3, 408, 415, 418
scale type
changing, 415, 418
scale, axis
base/exponent labels, 389
contour plots, 384
scales
Arrhenius, 418
Extreme Value Distribution, 418
using a date and time scale, 417
scaling
graphs, 266, 269
objects, 266, 269
resizing labels/legends automatically with graphs, 224
setting aspect ratio option, 224
using mouse, 267
using Object Properties, 269
scatter and line plots
examples, 359
scatter plots
asymmetric error bars, 313
creating, 302
data format, 111
drop lines, 209
error bars, 308
examples, 299, 300, 301
quartile plots, 314
range plots, 314
symbols, 180, 189
scatter plots, 3D
creating, 363, 364, 365
scientific notation
tick labels, 442
using as axis values, 389, 442
scientific notation

Index
Index

section
creating within Notebook Manager, 38
editing, 39
naming, 39
security
password protecting notebooks, 42
selecting
all data in worksheet, 84
columns, 84
data, 84
entire worksheet, 84
graph style, 114, 151
graph type, 111
graphs, 164
graphs on page, 227
objects on page, 227
page objects, 227
plots, 164
right-clicking graphs, 227
rows, 84
text on page, 227
Selection mode, 227
serial numbers, 8
set auto recovery
options, 14
setting
axis breaks, 424
decimal places, 73
equation parameters, 214
equations options in the Dynamic Fit Wizard, 693
equations options in the Regression Wizard, 635
line intervals for contour plots, 386
macro window options, 525
options for nonlinear regression, 637, 697
page options, 224
passwords, 509
passwords for the World Wide Web, 509
printing options, 104, 106, 226
report options, 497
trigonometric units for Quick Transforms, 567
setting up
graph page format, 290
settings, 224
3D graph view, 371
angular axis, 454
aspect ratio, 224
axis range, 413
column statistics, 14
error bars, 317
frame lines, 376
graph defaults, 109
object location on page, 269
radial axes, 457, 460
reference lines, 494
regression equations, 708
statistics, 68
template files, 242
worksheet, 14
shading
3D graphs, 371
between two curves on an area plot, 346
shapes
lines, 191
Shortcut menu
hide, 258
shortcuts
worksheet, 51
showing, 258
SigmaPlot
folders, 8
installing, 7, 8
registration, 8
system requirements, 7
using in Windows, 10
using OLE2 to edit graphs pasted to other applications, 245, 255
SigmaPlot 1.0 and 2.0 (.SPW)
importing, 53
SigmaPlot Macintosh 4 and 5 Worksheet
importing, 53
SigmaPlot macros
Area Below Curves, 537
Batch Process Excel Files, 537
Border Plots, 539
By Group Data Split, 539
Color Transition Values, 540
Compute 1st Derivative, 540
Frequency Plot, 541
Gaussian Cumulative Distribution, 541
Insert Graphs into Word, 541
Label Symbols, 542
Merge Columns, 543
Paste to PowerPoint Slide, 543
Piper Plots, 544
Plotting Polar and Parametric Equations, 546
Power Spectral Density, 547
Quick Re-Plot, 547
Rank and Percentile, 547
Survival Curve, 548
Vector Plot, 549
SigmaScan (.SPW) importing, 53
SigmaStat 1.0 (.SMB) importing, 53
simple error bars data format, 115
simple error bars and regression data format, 115
simple regression data format, 115
simple scatter plot data format, 115
simple spline curve data format, 121, 124
simple straight line data format, 124
simple straight line plot data format, 121
sin, 811
sinh, 812
sinp, 812
size, 813
column statistics, 67
symbols, 285
values from column for symbols, 189
sizing
columns and Rows, 71
columns and rows, 82
graphs, 266, 269
Notebook Manager, 34
objects, 266, 269
resizing labels/legends automatically with graphs, 224
setting aspect ratio preference, 224
using mouse, 267
using Object Properties dialog box, 269
slices, pie chart
edges, 262
exploding, 397, 398
rotating, 397, 398
smoothing
unordered XYZ data, 577
smoothing data
mesh plots, 4
snap-to, 279
solving
differential equations, 585
equations, 217, 220
equations for x within range, 217
functions, 217, 220
solving equations, 209, 220
sort, 813
sorting
data, 568
source
templates for new pages, 242
spacing
bars, 203, 206
bars from different plots, 203, 206, 327
special construct functions, 765
speed
increasing drawing speed, 174
SPSS files
importing, 64
sqrt, 590, 814
stacked bar charts
automatic reference lines, 493
standard deviation
column statistics, 67
standard deviation of linear regression coefficients transform, 590
standard error
column statistics, 67
parameter, 659
regression results, 671
standard error of the estimate
regression results, 671
Submission Assistant, 516
editing a profile, 517
submitting
graphs to journals, 511, 514
Subscript, 280
suffixes/prefixes
contour labels, 387
tick labels, 445
sum, 817
column statistics, 67
Sum of Squares, 697, 854
sum of squares
absolute minimum, 733
local maximum, 733
regression results, 672
summary information
editing in notebooks, 39
Superscript, 280
survival curves
creating, 548
switching
between date and time and numeric display, 83
symbols
alphanumeric, 184
assigning to worksheet, 199
box plots, 334
changing edge color, 180
changing edge thickness, 180
changing fills, 180
changing size, 180
changing type, 180
characters used as, 184
color incrementing, 182
custom incrementing schemes, 199
dot/crosshair color, 180
fills, 262
Greek, 280
increment customizing, 199, 206
inserting in legends, 280
layering lines in front/behind, 191
modifying attributes, 180
modifying in plots, 180, 189
resize, 285
restoring to default settings, 286
size values from a worksheet column, 189
Index

using characters as, 184
using macro to label with, 542

Systat
European office, 27
exporting to, 66

system requirements, 7
Excel workbooks, 7
hardware, 7

t -test
  calculation of t, 481
  paired test, 481
  unpaired test, 481
tan, 818
tanh, 818
tden function, 819
tdist function, 819

template files
  settings, 242
  TEMPLATE.JNT, 244

templates, 14, 272, 273, 275, 276, 295
  adding styles to gallery, 158
  creating, 240, 257
  Graph Style Gallery, 157, 158, 159
  JNT files, 244
  notebook files, 240, 257
  options, 14
  page, 240, 257
ternary axes
  about, 463
  dragging, 465
ternary axis direction
  modifying, 469
ternary data
  normalizing, 569
ternary graphs
  changing axis direction, 469
  changing scale direction, 469
  changing scale type, 468
  creating, 403
  data for multiple -curve plot, 144
  data for single plot curve, 144
  data format, 111
defined, 144
line plots, 404
line/scatter plots, 404
modifying plots, 405
modifying tick labels, 476
modifying tick marks, 474
multiple-curve plots, 144
normalizing data for, 569
plot data set, 403
scatter plots, 404
selecting data, 403
selecting worksheet data, 569
third-column data, 144
ternary triplets
  data for, 144
testing
  constant variance, 640
  normality, 640
text
  adding to page, 280
  alignment, 280
  editing contour labels, 392
  editing tick labels, 442
  entering, 280, 281
  formatting, 281
  grouping/ungrouping, 271
  labels to page, 280
  rotating, 280
  subscript, 280
  superscript, 280
  using as plot symbols, 184
text files
  exporting worksheets, 65
  importing, 63
text labels
  creating, 280
text mode
  entering non-keyboard characters, 280

Text Properties dialog box
  changing text labels, 440
thickness
  axis lines, 421
  contour lines, 381
  grid lines, 451
  line, 191, 263
Index

radial axes, 459
reference lines, 494
tick marks, 438, 474
thickness plot pattern lines, 195
Three dimensional, 21, 24
tick intervals
  Date and Time, 434
Tick labels
  Date and Time axes, 447
tick labels
  custom, 388, 448
date and time, 388
date and time axes, 446
  editing text, 442
  engineering notation, 442
  factors, 442
  formatting numeric tick labels, 442
  modifying, 445
  modifying ternary, 476
  numeric notation, 388
  prefix/suffix, 445
  radial axes, 460
  scientific notation, 442
  text attributes, 440
time and date, 444
  using from a worksheet column, 388, 448
tick line options, 438
tick mark direction, 437
tick marks
  customizing intervals, 435
date and time axes, 434
  hiding, 427
  intervals assigned to a worksheet, 435
  labels, 445
  length, 438, 474
  modifying, 435, 474
  modifying ternary, 474
  turning on/off, 438
  viewing, 427
ticks
  specifying direction, 437
time and date
  see also, 444
tiny function, 820
tips and tricks
  avoid repeating the same steps, 157
  for publication, 514
titles
  axis, 429
column, 89, 93
column and row titles dialog box, 89
graph, 167
  hiding graph, 259
  row, 89, 93
  using cells as column or row titles, 93
  using worksheet columns as row titles, 92
  using worksheet rows as column titles, 90
tolerance
  :entering, 726
default setting, 655
  entering, 655
  reducing, 727
  satisfying, 688
toolbars
  displaying, 11
drawing, 260
  Excel, 102
  hiding, 11
  positioning, 14
  using Macro Window toolbar, 523
Tools menu
  draw arrow, 260
draw box, 260
draw ellipse, 260
draw line, 260
Tools menu commands
  Text, 281
text, 280
ToolTip, 14
total, 821
TOTAL function, 583, 585
Trajectory plots
  symbols, 180
trajectory plots
  creating, 363, 364
  symbols, 189
transform
  order of precedence, 561
transform components
  relational operators, 561
Index

scalars & ranges, 562
transform operators, 561
variables, 564
transform examples, 583
analysis of variance table, 583
anova table, 583
bivariate statistics, 585
coefficient of determination for nonlinear regressions, 589
control chart, 590
differential equation solving, 585
fractional defective control chart, 590
F-test to determine statistical improvement in regression, 587
linear regression parameters, 590
linear regression standard deviations, 590
trapezoidal rule beneath a curve, 584
transform functions, 759
arguments, 759
defining variables, 718
descriptions, 760
multiple regression, 747
transform functions and examples, 759
transform operators, 561
arithmetic, 563
defining variables, 718
logical, 565
order of operation, 561
ranges & scalars, 562
relational, 564
transform variables
relational operators, 561
transform operators, 561
transforms
ANOVA.XFM, 583
applying to data, 4
AREA.XFM, 584
arguments, 759
as column titles, 568
BIVARIAT.XFM, 585
defined, 4
DIFFEQN.XFM, 585
duplicate column titles, 48
F_TEST.XFM, 587
function descriptions, 760
functions, 759
histogram.xfm, 485
normalize ternary data, 569
opening, 41
operators, 561
quick, 565
R2.XFM, 589
ranges & scalars, 562
STDV_REG.XFM, 590
using data in Excel worksheets, 103
using transform language, 551
variables, 564
transparent mesh
creating plots, 367
selecting shading, 367
Transpose Paste shortcut, 51
transposing
rows and columns, 88
trapezoidal rule, 537
trapezoidal rule transform, 584
trigonometric functions, 761
trigonometric units
setting, 567
t-test
performing, 479
Tukey plot, 333
turning on/off
axes, 419
contour labels, 387
contour lines, 381
grids, 452
insertion mode, 53
radial axes, 457, 460
radial labels, 460
reference lines, 494
tick marks, 438
toolbars, 11
two dimensional, 16, 20
types
graph, 111
lines, 191
types of graphs, 1
undo, 15
setting for worksheets, 48
ungrouping
  legends, 289
  objects/text, 271
units of measurement
  page, 292
unpaired -test, 481
unprotecting
  Excel workbooks, 99
updating
  object links, 255
user accounts, 8
user folders, 8
user-defined
  command with bubble plots, 146
  differential equations, 585
  F-test, 587
user-defined functions
  creating, 530
  in macros, 529
user-defined transforms, 551
function descriptions, 760
UserDialog Editor, 527
using
  the equation solver, 217, 220

values
  angular, 143
  axis range, 384
  axis scale, 384
  bucket, 482
  minimum, 67
  minimum and maximum, 67
  minimum positive, 67
  missing, 67
  radial, 143
  Z data for contour plots, 384
values, axis
  factors, 442
  labels, 445
  numeric labels, 389
  range, 384, 413
  time and date, 390, 444
variable bar widths, 206
variables
  :dependent, 711
  defining, 717
  entering, 711
  independent, 711
  relational operators, 564
  scaling large values, 750
  unknown, 690
  weight variable, 719, 735
variables:
  weight variable, 715
VBA
  creating macros using, 520
vector formats, 513
vector plots
  creating, 549
vertical bar chart
  data format, 111
vertical dot plot
  data format, 115
vertical point plot data format, 115
view
  3D graphs, 371
View menu commands, 234
  drawing toolbar, 260
  full screen, 234
  zoom, 234
viewing, 419
  axes, 419
  axis titles, 427
  column statistics, 4, 66
  column statistics in Excel worksheets, 100
  constraints, parameter, 660
  contour lines, 381
  data for embedded graphs, 179
  full page, 234
  graphs, 234, 258
  graphs on page, 257, 258
  inserted objects as icons, 253
  linear regression results, 489
  Macro Window, 520
  notebook files, 40, 41
  notebook items, 40, 41
  object links, 255, 256
objects as icons, 248
pasted objects as icons, 251
tick marks, 427
toolbars, 11, 102

waterfall plots
creating, 365
waterfall plots
examples, 362
WebViewer, 507
publishing graphs on the World Wide Web, 507

Weibull scale, 418
weight variables, 719
  entering, 711
  non-uniform errors, 750
  norm and residual changes, 720
  regression, 735
  when to use, 715, 720
weighted regression
  regression examples, 734
  weight variables, 720
whiskers
box plots, 333
widths
box widths, 334
whisker caps, 333

Wizards
  histogram, 485
  Regression, 4
wizards
  histogram, 481
worksheet
  changing grid color and thickness, 72
  column statistics, 66, 100
  column titles, 89, 93
  column type labels, 448
  deleting columns and rows, 88
  entering data, 47, 104
  Excel, 97, 104
  exporting as non-notebook file, 65, 224
  exporting data, 104, 105
  going to a cell, 50
  importing data, 53, 63, 94
inserting columns and rows, 86
inserting graphic cells, 199
inserting symbol size values, 189
insertion mode, 53
moving around, 50
moving between notebooks, 39, 41
moving data, 86
naming, 39
overwrite mode, 53
previewing before printing, 105
printing, 104, 105
printing column statistics, 105
right-click pop-up menu shortcuts, 51
row titles, 89, 93
selecting all data, 84
selecting data, 84
selecting entire, 84
set data feedback colors, 72
setting Options, 14
setting printing options, 106
size, 3
sorting data, 568
statistics, 4
Statistics, showing/hiding, 68
transposing rows and columns, 88
worksheet functions
overview, 760
worksheets
  creating within Notebook Manager, 38
  entering data, 52
  exporting as text files, 65
  formatting date and time data, 81
  formatting numeric data, 81
  formatting text, 81
  macro to split data into multiple columns, 539
  setting Day Zero, 78
  setting decimal places, 73
  wrap text, 81
World Wide Web
  publishing graphs to, 508
  setting passwords to protect your data, 509
  using the WebViewer, 507
wrapping text
in worksheet cells, 81
Index

X,Y values
  bubble plots, 146
X,Y, many Z
  Contour plots, 149
  Mesh plots, 149
X,Y,Z values
  contour plots, 149
x25, 821
x50, 822
x75, 823
xatymax, 824
xwtr, 825
XY error bars, 321

zooming in/out
  on graphs, 234